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Jþsu dro¹ïbai
Izlasiet ¹os vienkàr¹os noràdïjumus. To neievºro¹ana var 
bþt bïstama vai pretlikumïga. Lai iegþtu pla¹àku 
informàciju, izlasiet visu lietotàja rokasgràmatu.

IESLªDZIET DRO©ÀS VIETÀS Nelietojiet 
ierïci vietàs, kur mobilo tàlruñu lieto¹ana ir 
aizliegta vai var radït traucºjumus un ir 
bïstama.

SATIKSMES DRO©ÏBA IR PIRMAJÀ VIETÀ 
Ievºrojiet visus vietºjos likumus. Autovadïtàja 
rokàm vienmºr jàbþt brïvàm, lai nekas 
netraucºtu vadït transportlïdzekli. Vadot 
automa¹ïnu, satiksmes dro¹ïbai jàbþt pirmajà 
vietà.

DARBÏBAS TRAUCªJUMI Ikviena mobilà 
ierïce var bþt jutïga pret traucºjumiem, kas 
ietekmº tàs darbïbas kvalitàti.

IZSLªDZIET SLIMNÏCÀ Ievºrojiet visus 
ierobe¾ojumus. Izslºdziet ierïci, atrodoties 
medicïnisko ierïèu tuvumà.

IZSLªDZIET LIDMA©ÏNÀ Ievºrojiet visus 
ierobe¾ojumus. Mobilàs ierïces var radït 
traucºjumus lidma¹ïnàs.

IZSLªDZIET, UZPILDOT DEGVIELU 
Nelietojiet ierïci degvielas uzpildes stacijàs. 
Nelietojiet to degvielas vai óïmisku vielu 
tuvumà.

IZSLªDZIET SPRIDZINÀ©ANAS DARBU 
TUVUMÀ Ievºrojiet visus ierobe¾ojumus. 
Nelietojiet ierïci spridzinà¹anas darbu 
tuvumà. 

LIETOJIET SAUDZÏGI Lietojiet izstràdàjumu 
tikai standarta pozïcijà, kà aprakstïts tà 
dokumentàcijà. Bez vajadzïbas neaiztieciet 
antenu.

KVALIFICªTA APKOPE ©ï izstràdàjuma 
uzstàdï¹anu un remontu drïkst veikt tikai 
kvalificºti speciàlisti.

PAPILDIERÏCES UN AKUMULATORI Lietojiet 
tikai apstiprinàtas papildierïces un 
akumulatorus. Nesavienojiet nesaderïgus 
izstràdàjumus.

ÞDENSIZTURÏBA ©ï ierïce nav þdensizturïga. 
Sargàjiet to no mitruma.
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DUBLªJUMKOPIJAS Atcerieties, ka visai 
svarïgajai informàcijai jàizveido 
dublºjumkopijas vai tà jàpieraksta.

SAVIENO©ANA AR CITÀM IERÏCªM 
Savienojot ar jebkàdu citu ierïci, detalizºtus 
dro¹ïbas noràdïjumus skatiet tàs lietotàja 
rokasgràmatà. Nesavienojiet nesaderïgus 
izstràdàjumus.

ZVANÏ©ANA ÀRKÀRTAS SITUÀCIJÀS Ierïcei 
jàbþt ieslºgtai un jàdarbojas. Nospiediet un 
turiet , lai ekrànà tiktu ràdïta tàlruña 
tastatþra. Ievadiet avàrijas dienestu 
izsauk¹anas numuru, pºc tam nospiediet . 
Paziñojiet savu atra¹anàs vietu. 
Nepàrtrauciet sarunu, pirms jums to neat¶auj.

Par ¹o ierïci
©ajà rokasgràmatà aprakstïtà mobilà ierïce ir apstiprinàta 
lieto¹anai EGSM 900, GSM 1800 un GSM 1900 tïklà. 
Pla¹àku informàciju par ¹iem sakaru tïkliem lþdziet 
pakalpojumu sniedzºjam.

Lietojot ¹ïs ierïces funkcijas, ievºrojiet visas likumu 
prasïbas, kà arï citu personu privàtàs intereses un 
likumïgàs tiesïbas.

UZMANÏBU! Jebkuru ¹ïs ierïces funkciju, izñemot 
aktivizºtos signàlus, var lietot tikai tad, ja ierïce ir 

ieslºgta. Neieslºdziet ierïci, ja mobilà tàlruña lieto¹ana 
var radït traucºjumus un ir bïstama.

Tïkla pakalpojumi
Lai varºtu lietot tàlruni, jàizmanto mobilo sakaru 
pakalpojumu sniedzºja pakalpojumi. Daudzu ¹ïs ierïces 
funkciju darbïba ir atkarïga no funkcijàm mobilo sakaru 
tïklà. ©ie tïkla pakalpojumi, iespºjams, nav pieejami visos 
tïklos, vai arï tos var izmantot tikai tad, ja par to esat ïpa¹i 
vienojies ar pakalpojumu sniedzºju. Iespºjams, jums 
nepiecie¹ami pakalpojumu sniedzºja papildu noràdïjumi 
par ¹o pakalpojumu lieto¹anu, kà arï informàcija par 
izmaksàm. Atsevi¹óos tïklos pastàv ierobe¾ojumi, kas 
nosaka iespºjas izmantot tïkla pakalpojumus. Piemºram, 
ne visi tïkli nodro¹ina visas valodai raksturïgàs rakstzïmes 
un pakalpojumus.

Pakalpojumu sniedzºjs var pieprasït, lai atsevi¹óas jþsu 
ierïces funkcijas tiktu atspºjotas vai netiktu aktivizºtas. 
Tàdà gadïjumà ¹ïs funkcijas netiek ràdïtas ierïces izvºlnº. 
Pla¹àku informàciju lþdziet pakalpojumu sniedzºjam.

©ï ierïce atbalsta WAP 2.0 protokolus (HTTP un SSL), kuri 
izmanto TCP/IP protokolus. Lai lietotu atsevi¹óas ¹ïs ierïces 
funkcijas, piemºram, multivides ziñapmaiñu un Web 
pàrlþku, tïklam jànodro¹ina ¹ïs tehnolo»ijas.
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Koplietotà atmiña
Ierïces atmiñu var koplietot ¹àdas funkcijas: kontaktu 
katalogs, ïsziñas, multiziñas, attºli, zvana signàli, 
audiofaili, videoklipi, kalendàrs un uzdevumi, kà arï 
ielàdºtàs programmas. Lietojot vienu vai vairàkas no ¹ïm 
funkcijàm, var samazinàties atmiñas apjoms, kas pieejams 
pàrºjàm funkcijàm, kuras koplieto atmiñu. Piem., 
saglabàjot daudz attºlu, var tikt izlietota visa pieejamà 
atmiña. Ja mº»inàt lietot kàdu koplietotàs atmiñas 
funkciju, ierïce var paràdït ziñojumu, ka atmiña ir pilna. Lai 
¹àdà gadïjumà turpinàtu ierïces izmanto¹anu, izdzºsiet 
da¶u informàcijas vai ierakstu, kuri tiek glabàti koplietotàs 
atmiñas funkcijàs.

Papildierïces, akumulatori un 
làdºtàji
Pirms izmantojat làdºtàju ¹ai ierïcei, pàrbaudiet làdºtàja 
mode¶a numuru. ©o ierïci ir paredzºts lietot, ener»ijas 
padevi nodro¹inot ar ACP-12 un AC-1.

UZMANÏBU! Lietojiet tikai akumulatorus, làdºtàjus un 
papildierïces, kuras Nokia ir apstiprinàjusi lieto¹anai 
kopà ar ¹o modeli. Izmantojot cita veida akumulatorus, 
làdºtàjus un papildierïces, at¶aujas vai garantijas var 
zaudºt spºku, kà arï tas var bþt bïstami.

Pirms akumulatora noñem¹anas vienmºr izslºdziet ierïci 
un atvienojiet làdºtàju.

Informàciju par apstiprinàtajàm papildierïcºm lþdziet 
vietºjam izplatïtàjam. Atvienojot papildierïces stràvas 
vadu, satveriet un velciet kontaktdak¹u, nevis vadu.

Ierïce un papildierïces satur sïkas deta¶as. Glabàjiet tàs 
maziem bºrniem nepieejamà vietà!
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Darba sàk¹ana
Multivides viedtàlrunis Nokia 7710 piedàvà da¾àdas 
multivides programmas — kameru, mþzikas atskañotàju, 
radio Visual RadioTM, multivides atskañotàju RealPlayer un 
Web pàrlþku. Turklàt viedtàlrunim ir daudz da¾àdu ikdienà 
noderïgu funkciju — teksta redaktors, pulkstenis, 
kalkulators un kalendàrs.

Viedtàlruña da¶as

Priek¹puse (viedtàlrunis vºrsta uz 
aug¹u)

1. attºls. Priek¹puse (viedtàlrunis vºrsts uz aug¹u)

1  Balss taustiñ¹. Nospiediet, lai balss zvana laikà 
pàrslºgtos no ska¶ruña uz klausuli un pretºji. 
Nospiediet, lai sàktu vai beigtu balss ierakstï¹anu. 
Nospiediet un turiet, lai aktivizºtu balss iezvani.

2  Nospiediet, lai beigtu vai atteiktu zvanu. 
Nospiediet, lai atvºrtu programmas Telephone 
(Tàlrunis) skatu Dialler (Numuru izsauk¹ana).

3  Nospiediet, lai atbildºtu uz zvanu. Programmas 
Telephone skatà Dialler un programmà Desk 
(Darbvirsma) nospiediet, lai apskatïtu pºdºjos izsauktos 
numurus.

4 Ritinà¹anas taustiñ¹. Nospiediet uz aug¹u , uz leju 
, pa kreisi  un pa labi , lai pàrvietotu kursoru 

ekrànà un lai izvºlºtos objektus. Nospiediet centrà, lai 
aktivizºtu vai izvºlºtos. Nospiediet, lai zvanïtu uz 
iepriek¹ zvanïtu numuru, uz àtrà zvana numuru vai 
zvanïtu kontaktpersonai. Nospiediet pa labi vai pa 
kreisi, lai regulºtu klausules, austiñu vai ska¶ruña 
ska¶umu.

5  Izvºlnes taustiñ¹. Nospiediet, lai atvºrtu izvºlni. 
Nospiediet atkàrtoti, lai pàrvietotos no vienas dialoga 
lapas uz citu.

6 Mikrofons.
7  Darbvirsmas taustiñ¹. Nospiediet, lai atvºrtu 

programmu Desk (Darbvirsma), kura ir viedtàlruña  
galvenais skats. Pla¹àku informàciju sk. sada¶à “Desk 
(Darbvirsma)” 31. lpp. Ilgàk turot nospiestu, tiek atvºrts 
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nesen lietoto lietojumprogrammu saraksts. Jþs varat 
pàrslºgties uz ¹ïm programmàm.

8  Taustiñ¹ Esc. Aizver dialogus vai atgrie¾as 
iepriek¹ºjà skatà. Ar to var atsaukt darbïbas arï 
dialogos, kuros ir pieejama poga Cancel (Atcelt).

9 Klausule.
10 Pàrslºg¹anas taustiñ¹  programmàs ¶auj pàrslºgties 

no viena skata uz citu. 
11 Tàlummaiñas taustiñ¹. Atbilsto¹às funkcijàs  padara 

pieejamu tàlummaiñas iespºju. 

 un  funkcija ir atkarïga no programmas un lietotà 
skata. Sarunas laikà nospiediet , lai atvºrtu audio 
uzstàdïjumus, un nospiediet  vai , lai attiecïgi 
samazinàtu vai palielinàtu ska¶umu. ©ie abi taustiñi tiek 
izmantoti arï spºlºs.

Apak¹da¶a un labais sàns

2. attºls. Apak¹da¶a un labais sàns

1 Làdºtàja savienotàjs.

2 Pop-Port savienotàjs austiñàm, savienojuma 
kabelim un induktïvajai saitei.

3 Irbu¶a turºtàjs.
4  Ieslºg¹anas/izslºg¹anas taustiñ¹. Nospiediet un 

turiet, lai viedtàlruni ieslºgtu vai izslºgtu. Ïsi 
nospiediet, lai mainïtu profilu.

Aizmugure

3. attºls. Kameras objektïvs un ska¶runis

SIM kartes un akumulatora 
ievieto¹ana
• SIM kartes glabàjiet bºrniem nepieejamàs vietàs. 

Informàciju par SIM kar¹u pakalpojumu pieejamïbu un 
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to lieto¹anu lþdziet SIM kartes izsniedzºjam. Tas var 
bþt pakalpojumu sniedzºjs, tïkla operators vai tre¹à 
puse.

• SIM karti un tàs kontaktus var viegli sabojàt, 
saskràpºjot vai saliecot tos, tàpºc rïkojieties uzmanïgi, 
ievietojot vai izñemot SIM karti.

• Pirms aizmugurºjà vàciña noñem¹anas vienmºr 
izslºdziet viedtàlruni un atvienojiet no tà làdºtàju un 
citas papildierïces. Glabàjiet un lietojiet viedtàlruni ar 
uzliktu aizmugurºjo vàciñu.

1 Lai noñemtu aizmugurºjo vàciñu, pavºrsiet viedtàlruni 
pret sevi, nospiediet aizmugurºjà vàciña fiksº¹anas 
pogu un noceliet aizmugurºjo vàciñu (4. att.).

4. attºls. Aizmugurºjà vàciña noñem¹ana

2 Ja viedtàlruñi ir ievietots akumulators, izceliet to no 
viedtàlruña. (Sk. 5. att.)
Pirms akumulatora izñem¹anas vienmºr izslºdziet 
viedtàlruni un atvienojiet làdºtàju.

5. attºls. Akumulatora izñem¹ana

3 Atveriet SIM kartes atveres fiksatoru (sk. 6. att.) un ar 
sànu pa priek¹u iebïdiet SIM karti atverº (sk. 7. att.). 
SIM karte jàievieto ar no¹óelto stþri pa priek¹u un 
zeltïtajiem kontaktiem uz leju.

6. attºls. SIM kartes atveres fiksatora atvºr¹ana
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7. attºls. SIM kartes un atmiñas kartes ievieto¹ana

4 Aizveriet SIM kartes atveres fiksatoru (sk. 8. att.).

8. attºls. SIM kartes atveres fiksatora aizvºr¹ana

5 Lai ievietotu akumulatoru, savietojiet akumulatora 
zeltïtos kontaktus ar atbilsto¹ajiem savienotàjiem 
akumulatora nodalïjumà. Spiediet uz leju akumulatora 
otru malu, lïdz akumulators nofiksºjas vietà (sk. 9. att.). 

9. attºls. Akumulatora ievieto¹ana

6 Iespiediet vàciñu vietà. (Sk. 10. att.)

10. attºls. Aizmugurºjà vàciña uzlik¹ana
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Atmiñas kartes izñem¹ana un 
ievieto¹ana
©ï viedtàlruña komplektàcijà ietilpst lieto¹anai gatava 
atmiñas karte (MMC). Kartº var bþt da¾i preinstalºti faili 
un lietojumprogrammas. ©o atmiñas karti var izmantot, 
lai stràdàtu ar failiem, programmàm, dublºjumkopijàm un 
citàm iespºjàm tàpat kà ar atbilsto¹ajiem objektiem 
viedtàlruni.

Svarïgi! Neñemiet karti àrà kartes darbïbas laikà. 
Kartes izñem¹ana tàs darbïbas laikà var kaitºt gan 
atmiñas kartei, gan ierïcei, bet kartº saglabàtie dati var 
tikt bojàti.

Atmiñas kartes glabàjiet maziem bºrniem nepieejamàs 
vietàs.

Lai izñemtu atmiñas karti, pavºrsiet viedtàlruni pret 
sevi, nospiediet aizmugurºjà vàciña fiksº¹anas pogu 
un noceliet aizmugurºjo vàciñu (sk. 4. att.). Uzmanïgi 
izvelciet atmiñas karti no atveres. Piesargieties, lai 
nesaskràpºtu kartes zeltïtos kontaktus.

Lai ievietotu atmiñas karti, pavºrsiet viedtàlruni pret 
sevi, nospiediet aizmugurºjà vàciña fiksº¹anas pogu 
un noceliet aizmugurºjo vàciñu (sk. 4. att.). Uzmanïgi 
iebïdiet atmiñas karti vietà (sk. 7. att.). Kartes 
zeltïtajiem kontaktiem ir jàbþt vºrstiem uz leju.

Piezïme. ©ajà ierïcº izmantojiet tikai saderïgas 
multivides kartes (MultiMedia Card —MMC). Citas 
atmiñas kartes, piemºram, Secure Digital (SD) kartes, 

nav piemºrotas MMC kartes slotam un nav saderïgas ar 
¹o ierïci. Nesaderïgas atmiñas kartes lieto¹ana var 
kaitºt gan atmiñas kartei, gan ierïcei, bet nesaderïgajà 
kartº saglabàtie dati var tikt bojàti.

Akumulatora uzlàde
Uzlàdes laikà nelietojiet tàdas funkcijas kà Web pàrlþks vai 
RealOne atskañotàjs, jo tàs patºrº daudz ener»ijas. Pàràk 
daudz darbïbu ar ierïci, kuràs tiek patºrºts daudz ener»ijas, 
ne¶auj akumulatoram pilnïbà uzlàdºties.
1 Pievienojiet làdºtàja savienotàju viedtàlruña apak¹da¶à 

(2. att. 13. lpp.).
2 Savienojiet làdºtàju ar sienas kontaktligzdu. Statusa 

indikatora apgabalà sàk ritinàties akumulatora 
indikators. Uzlàdes laikà viedtàlruni var lietot. Kad 
akumulators ir pilnïgi tuk¹s, var paiet da¾as minþtes, 
lïdz tiek paràdïts uzlàdes indikators.

3 Ja akumulators ir pilnïgi uzlàdºts, indikators pàrstàj 
ritinàties. Atvienojiet làdºtàju no viedtàlruña un pºc 
tam no sienas kontaktligzdas.

Sk. arï “Informàcija par akumulatoriem” 154. lpp. un 
“Papildierïces, akumulatori un làdºtàji” 11. lpp.

Viedtàlruña ieslºg¹ana
UZMANÏBU! Jebkuru ¹ïs ierïces funkciju, izñemot 
aktivizºtos signàlus, var lietot tikai tad, ja ierïce ir 
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ieslºgta. Neieslºdziet ierïci, ja mobilà tàlruña lieto¹ana 
var radït traucºjumus un ir bïstama.

Lai viedtàlruni ieslºgtu vai izslºgtu, nospiediet un 
turiet ieslºg¹anas/izslºg¹anas taustiñu . Ja 
viedtàlruni ir izvºlºts profils Flight (Lidojums), tà ir 
izmantojama bez tàlruña funkcionalitàtes. Pla¹àku 
informàciju sk. sada¶à “Profiles (Profili)” 45. lpp.

Ja viedtàlrunis prasa ievadït PIN kodu, ievadiet to 
(tiek ràdïts kà ****) un pieskarieties OK (Labi). PIN kods 
aizsargà SIM karti pret neat¶autu lieto¹anu. Parasti to 
izsniedz kopà ar SIM karti. Ja trïs reizes pºc kàrtas 
ievada nepareizu PIN kodu, PIN kods tiek bloóºts. Lai 
SIM karte atkal bþtu lietojama, PIN kods ir jàatbloóº, 
izmantojot PUK kodu. Ja ¹ie kodi nav izsniegti kopà ar 
SIM karti, sazinieties ar operatoru, kura SIM karte ir 
ievietota multivides ierïcº.

Ja viedtàlrunis prasa ievadït bloóº¹anas kodu, 
ievadiet to (tiek ràdïts kà *****) un pieskarieties OK. 
Bloóº¹anas kods aizsargà ierïci pret neat¶autu 
lieto¹anu. Sàkotnºji uzstàdïtais bloóº¹anas kods ir 
12345. Nomainiet kodu un neizpaudiet jauno kodu; 
glabàjiet to dro¹à vietà atsevi¹ói no viedtàlruña. 
Bloóº¹anas kodà var bþt no pieciem lïdz desmit 
cipariem.

Piezïme. ©im viedtàlrunim ir 
iek¹ºjà antena. Tàpat kà jebkurai 
citai radiovi¶ñu ierïcei bez 
vajadzïbas neaiztieciet antenu, kad 
viedtàlrunis ir ieslºgts. Antenas 
aiztik¹ana var ietekmºt sakaru 
kvalitàti, un viedtàlrunis var patºrºt 
vairàk ener»ijas, nekà tas citkàrt 
bþtu nepiecie¹ams. Izvairoties no 
saskares ar antenas vietu 
viedtàlruña lieto¹anas laikà, tiek 
optimizºta antenas darbïba un 
akumulatora ekspluatàcijas ilgums. 

Attºlà paràdïts, kà jàtur 
viedtàlrunis, runàjot pa tàlruni. 
Antenas apgabals ir iekràsots pelºkà 
kràsà.

Pirmà ieslºg¹ana
Ieslºdzot viedtàlruni pirmo reizi, pºc atbilsto¹a 
uzaicinàjuma jàkalibrº skàrienekràns un jànoràda vairàki 
uzstàdïjumi. Atkarïbà no izmantotàs SIM kartes veida ¹ï 
ierïce, iespºjams, var automàtiski pievienot pareizos Web 
pàrlþko¹anas un MMS uzstàdïjumus. 
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Visus ¹os uzstàdïjumus vºlàk var labot programmà Control 
Panel (Vadïbas panelis) vai atbilsto¹ajàs programmàs.
1 Ieslºdzot viedtàlrunis veic pa¹pàrbaudi. Kad 

pa¹pàrbaude ir paveikta, tiek paràdïts aicinàjums 
kalibrºt skàrienekrànu. Izpildiet ekrànà sniegtos 
noràdïjumus.

2 Ja viedtàlrunis prasa ievadït PIN kodu, ievadiet to (tiek 
ràdïts kà ****) un pieskarieties OK (Labi). Tiek paràdïts 
sveiciena ekràns.

3 Lai laiks un datums tiktu uzstàdïts automàtiski, 
atzïmºjiet izvºles rþtiñu Auto-update: (Automàtiska 
atjauninà¹ana). Pieskarieties Finish (Beigt). Ja 
izvºlaties iespºju Auto-update un ¹is pakalpojums ir 
pieejams, viedtàlrunis ir jàrestartº. Ja automàtiskà 
atjauninà¹ana ir izvºlºta pºc noklusºjuma, un 
pakalpojums ir pieejams, tiek paràdïts dialogs Settings 
(Uzstàdïjumi) (sk. 6. soli). Ievºrojiet, ka da¾i tïkla 
operatori neatbalsta funkciju Auto-update.

4 Ja automàtiskà atjauninà¹ana nav aktivizºta vai nav 
pieejama, noràdiet viedtàlruña màjas pilsºtu.

5 Ja automàtiskà atjauninà¹ana nav aktivizºta, 
uzstàdiet laiku un datumu. Ja nevºlaties turpinàt 
uzstàdï¹anu, pieskarieties Finish (Beigt).

6 Var redi»ºt da¾àdus izvºles uzstàdïjumus, piem., 
e-pasta kontu uzstàdïjumus vai personisko 
informàciju. Sarakstà izvºlieties redi»ºjamo 
uzstàdïjumu un pieskarieties Open (Atvºrt). Ja 
nevºlaties pa¹laik redi»ºt uzstàdïjumus, pieskarieties 
Finish, lai pabeigtu uzstàdï¹anu.

Kopº¹ana no SIM kartes uz viedtàlruña 
atmiñu
Ja SIM kartº ir saglabàti vàrdi un tàlruñu numuri, tos var 
iekopºt viedtàlruña atmiñà.

Lai pàrsþtïtu visus kontaktus, atveriet programmu 
Contacts (Kontakti), nospiediet  un izvºlieties Tools 
(Rïki) > Copy SIM directory to Contacts... (Kopºt SIM 
katalogu uz kontaktu katalogu). Pieskarieties Copy 
(Kopºt). Lai pàrsþtïtu atsevi¹óus kontaktus, atveriet 
programmu Contacts, nospiediet  un izvºlieties 
Tools > SIM directory... (SIM katalogs). Izvºlieties 
kontaktpersonu un pieskarieties Copy to Contacts 
(Kopºt uz kontaktu katalogu).

Displeja elementi

11. attºls. Desk (Darbvirsma)
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1 Nosaukuma apgabals. Ràda programmas nosaukumu 
un grupas nosaukumu vai citu informàciju par 
programmas statusu. Pieskarieties, lai piek¶þtu 
izvºlnºm, vai nospiediet .

2 Statusa indikatora apgabals. Statusa ikonas sk. sada¶à 
“Statusa indikatori” 22. lpp.

3 Rïkjosla. Tajà ir saïsnes uz bie¾i lietotàm programmàm 
vai, ja ir atvºrta programma, — saïsnes uz noderïgiem 
rïkiem. Programmà Desk (Darbvirsma) ràda arï 
pa¹reizºjo laiku. Pieskarieties ar irbuli, lai paràdïtu 
¹odienas datumu. Lai paslºptu rïkjoslu, nospiediet  
un izvºlieties Display (Ràdït). Notïriet izvºles rþtiñu 
Toolbar (Rïkjosla).

4 Ritjosla. Pieskarieties tai vai velciet, lai ritinàtu ekrànu.

©im viedtàlrunim ir ekrànsaudzºtàjs. Ja noteiktu laiku 
netiek veiktas nekàdas darbïbas, k¶þst redzams 
ekrànsaudzºtàjs. Lai deaktivizºtu ekrànsaudzºtàju, 
pieskarieties ekrànam vai nospiediet jebkuru taustiñu. 
Ievºrojiet — ekrànsaudzºtàja izskatu nevar mainït. Pla¹àku 
informàciju sk. sada¶à “Display” 113. lpp.

Navigàcija un objektu atlase
Viedtàlruni var vadït divºjàdi: nospie¾ot viedtàlruña 
ritinà¹anas taustiñu un citus taustiñus vai pieskaroties 
ekrànam ar ierïcei pievienoto irbuli. Varat kombinºt ¹ïs 
abas metodes, lai atrastu sev vispiemºrotàko veidu. Kà 
atrast irbuli, sk. 2. att. 13. lpp.

Svarïgi! Izmantojiet vienïgi tàdus irbu¶us, ko Nokia 
apstiprinàjusi lieto¹anai kopà ar ¹o viedtàlruni. Izmantojot 
citus irbu¶us, garantijas, kas sniegtas attiecïbà uz ¹o 
viedtàlruni, var zaudºt spºku, kà arï var tikt bojàts ekràns. 
Neieskràpºjiet ekrànu. Rakstï¹anai uz ekràna 
neizmantojiet parasto pildspalvu vai zïmuli vai kàdu citu 
asu priek¹metu.

Lai atvºrtu programmas, veiciet dubultpieskàrienu 
programmas ikonai darbvirsmà vai ritiniet lïdz 
programmai un nospiediet ritinà¹anas taustiñu centrà. 
Lai atvºrtu mapes, failus vai pielikumus, veiciet 
dubultpieskàrienu objektam vai ritiniet lïdz tam un 
nospiediet ritinà¹anas taustiñu centrà.

Ar vàrdiem ‘veikt dubultpieskàrienu’ tiek apzïmºta ¹àda 
darbïba: vispirms ar irbuli pieskaras objektam, lai to 
atlasïtu, un pºc tam objektam pieskaras vºlreiz, lai to 
atvºrtu.

Padoms. Ja ¹óiet, ka skàrienekràns nerea»º pareizi, 
tas, iespºjams, ir jàkalibrº. Ar ritinà¹anas taustiña 
palïdzïbu atveriet programmu Control Panel (Vadïbas 
panelis), izvºlieties Screen calibration (Ekràna 
kalibrº¹ana) un izpildiet noràdïjumus.

Lai aizvºrtu programmas un atgrieztos darbvirsmà, 
ekràna kreisajà malà nospiediet  vai statusa 
indikatora apgabalà pieskarieties ikonai . Tàs 
precïzu atra¹anàs vietu ekrànà skatiet 11. att. 18. lpp. 
Desk (Darbvirsma) ir vieta, no kuras varat piek¶þt visàm 
programmàm un izveidot saïsnes uz da¾àdiem 
objektiem, piem., dokumentiem, attºliem vai kontaktu 
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kartïtºm. Pla¹àku informàciju sk. sada¶à “Desk 
(Darbvirsma)” 31. lpp.

Lai programmu izvºlnºs izvºlºtos komandas, 
nospiediet , ritiniet lïdz komandai un nospiediet 
ritinà¹anas taustiñu centrà, lai izvºlºtos komandu. Vai 
arï pieskarieties loga nosaukuma apgabalam (sk. 
“Displeja elementi” 18. lpp.), lai atvºrtu izvºlni, 
pieskarieties izvºlnei un pieskarieties komandai.

Lielàkajà da¶à programmu da¾as visnoderïgàkàs 
komandas ir pieejamas arï, nospie¾ot komandu pogas 
ekràna labajà malà.

Padoms. Izvºlñu komandas un komandu pogas mainàs 
atbilsto¹i ekrànà veiktajai izvºlei. Ritiniet lïdz 
objektam vai pieskarieties tam; pºc tam izvºlieties 
atbilsto¹o izvºlnes komandu vai komandas pogu.

Lai izvºlºtos atsevi¹óus saraksta objektus vai failus, 
pieskarieties objektam, nospiediet  un izvºlieties 
Edit (Redi»ºt) > Mark/Unmark (Atzïmºt/Noñemt atzïmi) 
> Mark (Atzïmºt). Tagad ar irbu¶a pieskàrieniem varat 
atzïmºt pàrºjos objektus. Blakus atlasïtajiem 
objektiem tiek ievietota kontrolzïme. Lai sarakstà 
atlasïtu visus objektus, nospiediet  un izvºlieties 
Edit > Mark/Unmark > Mark all (Atzïmºt visus). Lai 
atlasïtu secïgus objektus, ar irbuli velciet pàr failiem.

Lai tiktu ràdïtas vai paslºptas komandu pogas vai 
rïkjosla, nospiediet  un izvºlieties Display (Ràdït) > 
Command bar (Komandu josla) vai Toolbar (Rïkjosla). Ja 
komandas poga ir pelºkota, to nevar lietot.

Komandu pogas labajà malà, rïkjosla displeja lejasda¶à 
un statusa indikatori displeja aug¹ºjà labajà stþrï 
mainàs atbilsto¹i programmai un konkrºtajai situàcijai.

Lai aktivizºtu dialoga da¶as, pieskarieties tàm. 
Izmº»iniet pieskar¹anos dialoga laukiem — 
tekstlodziñiem, loga ràmjiem un citàm displeja da¶àm.

Padoms. Ja tekstlodziñà vai dokumentà ierakstàt 
tàlruña numuru, e-pasta adresi vai Web adresi, to var 
izmantot kà hipersaiti. Pieskarieties ar irbuli numuram 
vai adresei vai ar ritinà¹anas taustiña palïdzïbu 
ievietojiet tajà kursoru; objekts k¶þst par saiti ar nelielu 
ikoniñu. Pieskarieties ikonai, lai piezvanïtu uz tàlruña 
numuru, atvºrtu e-pasta redaktoru vai piek¶þtu Web 
vietai (ja ir izveidots interneta savienojums).

Lai objektu vilktu, pieskarieties tam un, aptuveni 
vienu sekundi neatlai¾ot irbuli no ekràna, pàrvietojiet 
objektu uz jauno vietu. Izmº»iniet to darït ar 
darbvirsmas programmàm.

Pamatdarbïbas ar viedtàlruni
Lai piezvanïtu, viedtàlruña aug¹da¶à nospiediet 
taustiñu , lai atvºrtu skatu Dialler (Numuru 
izsauk¹ana). Skatu Dialler var atvºrt arï, darbvirsmà 
veicot dubultpieskàrienu programmai Telephone 
(Tàlrunis) vai rïkjoslà pieskaroties tàlruña ikonai, ja 
tàda ir pieejama. Izmantojot skata Dialler ekràna 
tastatþru, ievadiet tàlruña numuru un pieskarieties 
iespºjai Call (Zvanït). Ja, ievadot ciparus, k¶þdàties, 
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pieskarieties , lai ciparus nodzºstu. Mikrofons un 
klausules elements atrodas viedtàlruña priek¹pusº (sk. 
1. att. 12. lpp.). Lai beigtu zvanu, pieskarieties End 
(Beigt) vai nospiediet . 

Lai atbildºtu uz zvanu, pieskarieties Answer (Atbildºt) 
vai nospiediet  viedtàlruña aug¹da¶à. Mikrofona 
un klausules elementa atra¹anàs vietu sk. 1. att. 
12. lpp. Lai atteiktu zvanu, pieskarieties Reject 
(Atteikt) vai nospiediet . Pla¹àku informàciju sk. 
sada¶à “Telephone (Tàlrunis)” 37. lpp.

Lai izslºgtu viedtàlruña skañas, izvºlieties profilu 
Silent (Klusums). Lai izvºlºtos ¹o profilu, atveriet 
programmu Profiles (Profili) vai nospiediet ieslºg¹anas/
izslºg¹anas taustiñu  un sarakstà izvºlieties Silent.

Lai rakstïtu tekstu, pieskarieties teksta laukam vai 
lodziñam, kurà jàievada teksts. Tiek atvºrta ekràna 
tastatþra vai rokraksta atpazï¹anas logs. Sàciet 
rakstï¹anu, pieskaroties rakstzïmºm tastatþrà vai 
ievadot burtus teksta ievades laukà. Pla¹àku 
informàciju sk. sada¶à “Teksta rakstï¹ana” 33. lpp.

Lai uzñemtu attºlu vai ierakstïtu video, atveriet 
programmu Camera (Kamera). Kameras objektïvs 
atrodas ierïces aizmugurº virs aizmugurºjà vàciña (sk. 
2. att. 13. lpp.). Lai pàrslºgtos no kameras uz 
videoieraksta re¾ïmu, pieskarieties atbilsto¹ajam 
attºlam ekràna kreisajà pusº. Izmantojot displeju kà 
skatu meklºtàju, iekadrºjiet objektu; nospiediet 
ritinà¹anas taustiñu centrà vai pieskarieties Capture 
(Uzñemt), lai uzñemtu attºlu. Lai ierakstïtu video, 

nospiediet Record (Ierakstït). Attºls vai videoklips tiek 
saglabàts mapº, kura noràdïta nosaukuma joslà. Ja 
nevºlaties saglabàt attºlu, pieskarieties Delete (Dzºst). 
Pla¹àku informàciju sk. sada¶à “Images” 82. lpp.

Lai klausïtos radio, pievienojiet viedtàlrunim 
saderïgas austiñas. Austiñu vads darbojas kà 
radioantena, tàpºc tam jàkaràjas brïvi. Atveriet 
programmu Visual Radio, nospiediet  un izvºlieties 
Tools (Rïki) > Speaker in use (Lietotais ska¶runis) > 
Headset (Austiñas). Nospiediet , lai sàktu klausïties 
radio. Izmantojot programmu Visual Radio, varat 
klausïties gan parastàs FM radiopàrraides, gan ïpa¹as 
pàrraides, kur vienlaikus tiek sniegts arï vizuàlais 
saturs, ja tàds ir pieejams. Pla¹àku informàciju sk. 
sada¶à “Visual Radio” 93. lpp.

Lai visàs viedtàlrunï iek¶autajàs programmàs un 
failos meklºtu noteiktu tekstu vai faila veidus, 
atveriet programmu Find un pieskarieties Find (Atrast). 
Ierakstiet tekstu meklº¹anas laukà un pieskarieties 
Find. Lai meklº¹anu konkretizºtu, pieskarieties 
iespºjai Advanced search (Papla¹inàta meklº¹ana), 
ierakstiet tekstu meklº¹anas laukà, noràdiet atra¹anàs 
vietas un datuma diapazonu un pieskarieties OK (Labi). 
Lai atvºrtu atrasto objektu, pieskarieties tam.

Padoms. Teksta virknes var meklºt arï programmàs, ja 
¹àda iespºja tiek piedàvàta kà komanda izvºlnº. 
Nospiediet  un izvºlieties Edit (Redi»ºt) > Find....

Lai izveidotu mapes, atveriet programmu File 
manager (Failu pàrvaldïba). Nospiediet  un 
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izvºlieties File (Fails) > New folder... (Jauna mape). 
Pie¹óiriet jaunajai mapei nosaukumu un izvºlieties 
atra¹anàs vietu. Da¾às programmàs var izveidot jaunu 
mapi, ja izvºlnº vispirms izvºlas komandu Change folder 
(Mainït mapi).

Bie¾àkàs darbïbas programmàs
©àdas darbïbas var veikt vairàkàs programmàs:

Lai objektam pievienotu saïsni, atlasiet objektu 
programmà File manager (Failu pàrvaldïba) vai cità 
programmà, kurà var apstràdàt failus, nospiediet  
un izvºlnº atrodiet komandu Add to Desk... (Pievienot 
darbvirsmai), ja tàda ir pieejama. Piem., programmà 
Images (Attºli) izvºlieties Tools (Rïki) > Add to Desk... 
Atlasiet darbvirsmas grupu, kurai jàpievieno saïsne, un 
pieskarieties OK (Labi).

Lai nosþtïtu objektu, iezïmºjiet to, nospiediet  un 
izvºlieties komandu File >Send (Sþtït), ja tàda ir 
pieejama. Izvºlieties vajadzïgo sþtï¹anas metodi.

Lai izgrieztu un ielïmºtu objektu, atlasiet to, 
nospiediet  un izvºlieties Edit (Redi»ºt) > Cut 
(Izgriezt). Izvºlieties, kur objekts jàievieto, nospiediet 

 un izvºlieties Edit > Paste (Ielïmºt).

Lai kopºtu un ielïmºtu objektu, iezïmºjiet to, 
nospiediet  un izvºlieties Edit > Copy (Kopºt). 
Izvºlieties, kur objekts jàievieto, nospiediet  un 
izvºlieties Edit > Paste (Ielïmºt).

Padoms. Da¾u dialogu aug¹ºjà kreisajà stþrï atrodas 
bultiñas ikona . Pieskarieties ¹ai bultiñai, lai 
izgrieztu vai kopºtu atlasïto tekstu vai ielïmºtu tekstu 
atlasïtajà laukà.

Lai izdzºstu objektu, atlasiet to, nospiediet  un 
izvºlieties File > Delete (Dzºst).

Lai displejà redzamo objektu tuvinàtu vai tàlinàtu, 
nospiediet  un izvºlieties Display (Ràdït) > Zoom in 
(Tuvinàt) vai Zoom out (Tàlinàt).

Statusa indikatori
Pieskaroties atsevi¹óàm statusa ikonàm, var atvºrt 
programmu vai dialogu. Piem., pieskarieties , lai 
atvºrtu programmu Inbox (Sañemtàs ziñas), kur varat 
izlasït sañemto ziñu. ©àdas un vºl citas statusa ikonas tiek 
ràdïtas, lietojot noklusºjuma motïvu:

 Sañemto ziñu mapº ir viena vai vairàkas nelasïtas 
ziñas.

 Sañemta viena vai vairàkas balss ziñas. Pieskarieties 
ikonai, lai izsauktu balss pastkasti. Ja ir divas tàlruña 
lïnijas, cipars noràda lïniju.

 Notiek balss zvans. Pieskarieties, lai atvºrtu zvana 
apstràdes skatu.

 Mikrofons ir izslºgts.

 Ska¶uma regulº¹ana. Pieskarieties ¹ai ikonai sarunas 
laikà, lai atvºrtu ska¶uma regulº¹anas logu.
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 Viedtàlruña skàrienekràns un taustiñi ir bloóºti. Sk. 
“Skàrienekràna un tastatþras bloóº¹ana” 25. lpp.

Tiek lietots profils Silent (Klusums). Sañemot zvanu vai 
ziñu, tàlrunis par to neinformº zvanot. Pieskarieties, lai 
atvºrtu profilu izvºles dialogu.

Modinàtàjs ir ieslºgts.

 Visi zvani tiek pàradresºti uz citu numuru. Ja ir divas 
tàlruña lïnijas, cipars noràda lïniju, uz kuru zvans tiek 
pàradresºts.  nozïmº, ka visi zvani tiek pàradresºti uz 
balss pastkasti. Pieskarieties ikonai, lai mainïtu zvanu 
pàradresàcijas uzstàdïjumus.

 Ja ir divas tàlruña lïnijas, cipars noràda izvºlºto lïniju. 
Pieskarieties ikonai, lai pàrslºgtos no vienas tàlruña lïnijas 
uz otru.

 vai  Viedtàlrunim ir pievienotas austiñas vai 
induktïvàs saites ierïce.

 Viedtàlrunis ir savienota ar personàlo datoru, 
izmantojot savienojuma kabeli.

Akumulatora uzlàdes lïmenis
 Akumulators ir gandrïz tuk¹s. Uzlàdºjiet to. 

 Akumulators tiek làdºts. Kad indikatora josla neritinàs 
un tiek ràdïtas visas èetras ieda¶as, akumulators ir pilnïbà 
uzlàdºts.

Signàla stiprums
 Viedtàlrunim ir savienojums ar mobilo sakaru tïklu. Ja 

tiek ràdïtas visas èetras ieda¶as, mobilo sakaru signàls ir 
labi uztverams. Ja signàls ir vàj¹, uztveri varat mº»inàt 
uzlabot, viedtàlruni nedaudz pàrvietojot vai izmantojot 
brïvroku re¾ïmu.

 Viedtàlrunis ir ieslºgta, bet atrodas àrpus tïkla 
pàrklàjuma.

 Viedtàlruña tàlruña funkcionalitàte ir izslºgta. Jþs 
nevarat ne zvanït, ne arï sañemt zvanus vai ziñas nevienà 
no sakaru programmàm (ïsziñu, datu vai e-pasta).

Datu savienojumu indikatori
 Bluetooth savienojums. Pieskarieties, lai atvºrtu 

dialogu, kurà var izslºgt Bluetooth savienojumu. Pla¹àku 
informàciju par tehnolo»iju Bluetooth sk. sada¶à 
“Bluetooth savienojums” 143. lpp.

 Notiek datu zvans. Pieskarieties, lai atvºrtu zvana 
apstràdes skatu.

 Notiek HSCSD datu zvans. Pieskarieties, lai atvºrtu 
zvana apstràdes skatu.

 GPRS savienojums ir aktïvs. Ja GPRS savienojuma 
laikà, piem., sañemat vai veicat zvanu, tiek ràdïts GPRS 
simbols , kas nozïmº, ka GPRS savienojums ir aizturºts. 
Pieskarieties ikonai, lai atvºrtu dialogu Connection 
manager (Savienojumu pàrvaldïba).
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Vispàrïga informàcija
Komplektàcijà iek¶autàs uzlïmes
Uzlïmºs ir minºta svarïga informàcija par pakalpojumu un 
klientu atbalsta nodro¹inà¹anu. Komplektàcijà sniegti arï 
noràdïjumi, kà ¹ïs uzlïmes jàlieto.

Piek¶uves kodi 
©ajà sada¶à ir aprakstïti da¾àdi dro¹ïbas kodi, kuri varºtu 
bþt nepiecie¹ami:
• Bloóº¹anas kods (5–10 cipari). Bloóº¹anas kods 

aizsargà viedtàlruni pret neat¶autu lieto¹anu; tas tiek 
izsniegts kopà ar viedtàlruni. Sàkotnºjais kods ir 
12345. Nomainiet kodu un neizpaudiet jauno kodu; 
glabàjiet to dro¹à vietà atsevi¹ói no viedtàlruña.

• PIN kods un PIN2 kods (4–8 cipari). PIN (Personal 
Identification Number — personiskàs identifikàcijas 
numurs) kods aizsargà SIM karti pret neat¶autu tàs 
lieto¹anu. PIN kodu parasti izsniedz kopà ar SIM karti. 
Ja trïs reizes pºc kàrtas ievada nepareizu PIN kodu, PIN 
kods tiek bloóºts. Lai SIM karte atkal varºtu lietot, kods 
vispirms ir jàatbloóº. 
PIN2 kods arï tiek izsniegts kopà ar atsevi¹óàm SIM 
kartºm; tas nepiecie¹ams, lai piek¶þtu noteiktàm 
funkcijàm, piemºram, fiksºto zvanu numuram.

• PUK un PUK2 kods (8 cipari). PUK (Personal 
Unblocking Key — personiskà atbloóº¹anas atslºga) 

kods ir nepiecie¹ams, lai izmainïtu bloóºtu PIN kodu. 
PUK2 kods ir nepiecie¹ams, lai mainïtu bloóºtu PIN2 
kodu. Ja ¹ie kodi nav izsniegti kopà ar SIM karti, 
sazinieties ar operatoru, kura SIM karte ir ievietota 
viedtàlrunï.

• Lieguma parole (4 cipari). Lieguma parole ir 
nepiecie¹ama, ja lietojat zvanu lieguma pakalpojumu. 
Paroli izsniedz pakalpojumu sniedzºjs.
Viedtàlruña interneta programmas izmanto paroles un 
lietotàjvàrdus, lai aizsargàtu pret neat¶autu interneta 
un tà pakalpojumu lieto¹anu. ©ïs paroles tiek mainïtas 
interneta programmu uzstàdïjumos.

Atmiñas pàrvaldïba
Daudzas viedtàlruña funkcijas datu saglabà¹anas laikà 
patºrº atmiñu. Tie ir videoieraksti, mþzikas faili, spºles, 
kontaktu katalogs, ziñas, attºli un zvana melodijas, 
kalendàrs un uzdevumi, kà arï dokumenti un ielàdºtàs 
programmas. Pieejamàs atmiñas apjoms ir atkarïgs no tà, 
cik daudz datu jau ir saglabàts viedtàlruña atmiñà.

Kà papildu atmiñas vietu var izmantot atmiñas karti. Ja 
viedtàlruña atmiñà atlicis maz vietas, datus var pàrvietot 
uz atmiñas karti. Atmiñas kartes ir pàrrakstàmas, tàdºjàdi 
datus atmiñas kartº var saglabàt vairàkkàrt, kà arï pºc 
vajadzïbas izdzºst.
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Piezïme. Atsevi¹óas kartes ir tikai lasàmas. Tajàs ir 
preinstalºti dati, kurus nevar ne atinstalºt no kartes, ne 
rakstït tiem pàri.

Lai apskatïtu atmiñas patºriñu, atveriet programmu 
Control Panel (Vadïbas panelis) un Memory (Atmiña). 
Varat apskatït, kàda veida dati glabàjas viedtàlrunï un 
atmiñas kartº un cik daudz atmiñas patºrº da¾àdas 
datu grupas.

Atmiñas atbrïvo¹ana
Instalºjot daudz spº¶u vai saglabàjot daudz attºlu, mþzikas 
failu vai videoklipu, var iztºrºt lielu pieejamàs atmiñas 
apjomu. Viedtàlrunis informº, ja atmiñà palicis maz vietas. 
©àdà gadïjumà vºl citus datus nevar saglabàt, kamºr 
atmiñas atbrïvo¹anas nolþkà netiek izdzºsta da¶a spº¶u, 
attºlu vai citu elementu. Lai atmiñu pàrmºrïgi neaizñemtu, 
dati ir regulàri jàizdzº¹ vai jàpàrvieto uz atmiñas karti.

Var izdzºst kontaktinformàciju, kalendàra ierakstus, spºles, 
ziñas, e-pasta ziñas vai citus datus. Lai izdzºstu datus, 
atveriet atbilsto¹o programmu.

Skàrienekràna un tastatþras 
bloóº¹ana
Skàrienekrànu un taustiñus var nobloóºt, lai novºrstu 
nejau¹u nospie¹anu.

Lai bloóºtu skàrienekrànu un taustiñus, nospiediet 
 un pºc tam . Ja skàrienekràns un taustiñi ir 

bloóºti, statusa indikatoru apgabalà tiek paràdïts . 
Taustiñslºgu var aktivizºt arï, nospie¾ot ieslºg¹anas/
izslºg¹anas taustiñu  un izvºloties Lock touch screen 
and keys (Bloóºt skàrienekrànu un taustiñus). Lai 
atbloóºtu, nospiediet  un pºc tam .

Lai atbildºtu uz zvanu, ja taustiñslºgs ir ieslºgts, 
nospiediet . Zvana laikà ar tàlruni var rïkoties kà 
parasti. Kad zvans tiek pàrtraukts vai atteikts, 
skàrienekràns un taustiñi tiek atkal automàtiski 
bloóºti.

Lai ieslºgtu automàtisko taustiñslºgu, atveriet 
programmu Control panel (Vadïbas panelis) un 
izvºlieties Display (Displejs). Atzïmºjiet izvºles rþtiñu 
Screen saver locks display & keys: (Ekrànsaudzºtàjs bloóº 
displeju un taustiñus) un pieskarieties OK (Labi). 
Skàrienekràns un taustiñi tiek bloóºti automàtiski, 
tiklïdz tiek aktivizºts ekrànsaudzºtàjs.

Ska¶uma regulº¹ana
Lai sarunas laikà regulºtu ska¶umu, nospiediet , 
lai atvºrtu audio uzstàdïjumus. Nospiediet  un  
vai ritinà¹anas taustiñà nospiediet  un , lai 
attiecïgi samazinàtu vai palielinàtu ska¶umu. Varat arï 
izvºlºties lietot ska¶runi vai izslºgt viedtàlruña skañu.

Lai regulºtu ska¶umu, kad lietojat austiñas vai 
ska¶runi, ritinà¹anas taustiñà nospiediet  vai .
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UZMANÏBU! Klausieties mþziku mºrenà ska¶umà. 
Ilgsto¹i klausoties ska¶u mþziku, var tikt bojàta dzirde.

Ska¶runis
©ajà viedtàlrunï ir iebþvºts ska¶runis, kas ¶auj viedtàlruni 
lietot brïvroku re¾ïmà (sk. 3. att. 13. lpp.). Ska¶runis sniedz 
iespºju runàt un klausïties viedtàlruni no neliela attàluma, 
neturot to pie auss, bet, piem., blakus uz galda. Ska¶runi 
var izmantot tàlruña sarunas laikà, skañu programmàs, kà 
arï skatot multiziñas.

Lai notieko¹as sarunas laikà ieslºgtu ska¶runi, 
nospiediet . Tàlruña sarunàs ska¶runis ir 
jàaktivizº katru reizi atsevi¹ói, taèu skañu 
programmas, piem., Music Player, ska¶runi izmanto pºc 
noklusºjuma. Lai izslºgtu ska¶runi un atkal lietotu 
klausuli, nospiediet .

UZMANÏBU! Lietojot ska¶runi, neturiet ierïci pie auss, 
jo skaña var bþt àrkàrtïgi ska¶a.

Austiñas
Radio un mþzikas atskañotàju ¹ajà multivides ierïcº varat 
klausïties, izmantojot komplektàcijà iek¶autàs austiñas 
HS-3.

Lai austiñas pievienotu ierïcei, ievietojiet austiñu 
kabe¶a galu Pop-Port™ savienotàjà ierïces apak¹da¶à. 
(Sk. 2. att. 13. lpp.) Austiñu vads darbojas kà 
radioantena, tàpºc tam jàkaràjas brïvi.

Lai, lietojot austiñas, atbildºtu uz zvanu, nospiediet 
tàlvadïbas pogu, kura atrodas austiñu mikrofona da¶à. 
Lai beigtu zvanu, vºlreiz nospiediet to pa¹u pogu.

UZMANÏBU! Stereoaustiñu lieto¹ana var ietekmºt 
spºju uztvert apkàrtºjàs skañas. Nelietojiet 
stereoaustiñas, ja tas var apdraudºt jþsu dro¹ïbu.

Programmu un programmatþras 
instalº¹ana
©ajà viedtàlrunï var instalºt divu veidu programmas un 
programmatþru:
• programmas un programmatþru, kas ir ïpa¹i paredzºta 

viedtàlrunim Nokia 7710 vai ir piemºrota 
operºtàjsistºmai Symbian. ©o instalàcijas failu 
papla¹inàjums ir .SIS. Sk. “Programmatþras 
instalº¹ana” 27. lpp.

• J2Micro EditionTMJava programmas, kuras piemºrotas 
operºtàjsistºmai Symbian. ©o failu papla¹inàjums ir 
.JAD vai .JAR. Neielàdºjiet viedtàlrunï PersonalJavaTM 
programmas, jo tàs nevar instalºt. Sk. “JavaTM 
programmu instalº¹ana” 27. lpp.

Instalàcijas failus uz viedtàlruni var pàrsþtït no saderïga 
personàlà datora, ielàdºt pàrlþko¹anas laikà vai atsþtït kà 
multiziñu vai e-pasta pielikumu, kà arï izmantojot 
Bluetooth savienojumu. 
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Svarïgi! Instalºjiet programmas tikai no tiem avotiem, 
kuri piedàvà atbilsto¹u aizsardzïbu pret kaitïgu 
programmatþru.

Instalº¹anas laikà viedtàlrunis pàrbauda instalºjamàs 
pakotnes integritàti. Viedtàlrunis ràda informàciju par 
veiktajàm pàrbaudºm, un jums tiek piedàvàta iespºja 
turpinàt instalº¹anu vai to atcelt.

Informàciju par ciparparakstiem un sertifikàtiem sk. 
noda¶à “Certificate manager” 111. lpp.

Programmatþras instalº¹ana
Ja instalºjat eso¹as programmas atjauninàjuma vai 
labojuma failu, sàkotnºjo programmu varºsit atjaunot tikai 
tad, ja jums ir ori»inàlais instalàcijas fails vai pilna 
noñemtàs programmatþras pakotnes dublºjumkopija. Lai 
atjaunotu sàkotnºjo programmu, vispirms programmu 
noñemiet un pºc tam to vºlreiz instalºjiet no ori»inàlà 
instalàcijas faila vai dublºjumkopijas.

Lai instalºtu programmatþru, viedtàlruña atmiñà vai 
atmiñas kartº atrodiet instalàcijas failu un veiciet tam 
dubultpieskàrienu, lai sàktu instalº¹anu. Piem., ja 
instalàcijas failu esat sañºmis kà e-pasta pielikumu, 
atveriet pastkasti un vajadzïgo e-pasta ziñu un veiciet 
dubultpieskàrienu instalàcijas failam, lai sàktu 
instalº¹anu.

Kà noñemt programmatþru, sk. noda¶à “Application 
manager” 109. lpp.

Padoms. Pla¹àku informàciju par programmatþras 
instalº¹anu sk. noda¶à “Application manager” 109. lpp.

JavaTM programmu instalº¹ana
1 Viedtàlruña atmiñà vai atmiñas kartº atrodiet 

instalàcijas failu, atlasiet to un veiciet 
dubultpieskàrienu, lai sàktu instalº¹anu. Piem., ja 
instalàcijas failu esat sañºmis kà e-pasta pielikumu, 
atveriet pastkasti un vajadzïgo e-pasta ziñu un veiciet 
dubultpieskàrienu instalàcijas failam, lai sàktu 
instalº¹anu.

2 Apstipriniet instalº¹anu. Instalº¹anai ir nepiecie¹ams 
.JAR fails. Ja tà trþkst, viedtàlrunis iespºjams, paràdïs 
aicinàjumu to ielàdºt. Ja nav noràdïts piek¶uves 
punkts, tas ir jàizvºlas. Ielàdºjot .JAR failu, iespºjams, 
jàievada servera piek¶uves lietotàjvàrds un parole. To 
varat uzzinàt no programmas pàrdevºja vai ra¾otàja. 
Viedtàlrunis informº par instalº¹anas pabeig¹anu.
Padoms. Pàrlþko¹anas laikà instalàcijas failu varat 
ielàdºt un uzreiz instalºt. Taèu ñemiet vºrà, ka 
instalº¹anas laikà fonà joprojàm ir aktïvs savienojums.

Datu pàrsþtï¹ana
Lai sþtïtu multiziñas, ïsziñas un e-pasta ziñas, kà arï 
izveidotu savienojumus ar attàlajiem datoriem, ¹ï ierïce 
izmanto GSM tïkla piedàvàtàs datu pàrsþtï¹anas iespºjas.

Bezvadu datu savienojumus var izveidot gandrïz visàs 
vietàs, kur darbojas ¹is viedtàlrunis. Tomºr ieteicams ierïci 
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novietot vietà, kur ir visspºcïgàkais mobilo sakaru signàls. 
Kad signàls ir spºcïgs, datu pàrsþtï¹ana norit efektïvi. 
Tomºr nevajadzºtu pa¶auties, ka mobilie datu sakari ir 
tikpat kvalitatïvi kà stacionàrie, jo mobilo sakaru videi 
piemït vairàkas ïpatnïbas.

Bezvadu savienojumus var traucºt (izpau¾oties, kà trok¹ñi, 
vàj¹ signàls vai signàla pàrtrþkums, ierïces k¶þdaina 
darbïba vai deformºts attºls) ¹àdi faktori:

Trok¹ñi — elektronisku ierïèu un aparatþras, kà arï citu 
tàlruñu radïti radiotraucºjumi ietekmº datu bezvadu 
pàrsþtï¹anas kvalitàti.

Viesabonº¹ana — viedtàlruña lietotàjam pàrvietojoties 
no vienas tïkla ¹þnas uz citu, kanàla signàla stiprums 
pavàjinàs un mobilo tàlruñu centràle var novirzït lietotàju 
uz citu ¹þnu un frekvenci, kurà signàls ir spºcïgàks. ©þnu 
pàrbïde var notikt arï, lietotàjam nemainot atra¹anàs 
vietu, bet mainïgas tïkla noslodzes dº¶. ©àdas pàrbïdes var 
radït nelielu pàrraides aizkavi. 

Elektrostatiskà izlàde — statiskàs elektrïbas izlàde no 
pirkstiem vai vadïtàja var izraisït k¶þmes elektronisko 
ierïèu darbïbà. Izlàdes dº¶ var deformºties attºls vai 
rasties nestabilitàte programmatþras darbïbà. Bezvadu 
savienojumi var k¶þt nestabili, dati — bojàti, bet datu 
pàrraide var pàrtrþkt. ©àdà gadïjumà pàrtrauciet eso¹o 
zvanu (ja tàds ir), izslºdziet ierïci (ja tà ir ieslºgta) un 
izñemiet akumulatoru. Pºc tam ievietojiet akumulatoru 
atpaka¶ un izveidojiet jaunu bezvadu savienojumu.

Klusuma zonas un pàrràvumi — klusuma zonas ir 
apgabali, kur nevar uztvert radiosignàlus. Pàrràvumi rodas, 
ja viedtàlruña lietotàjs nok¶þst apgabalà, kur radiosignàls 
ir bloóºts vai vàjinàts »eogràfisku objektu vai lielu 
konstrukciju dº¶.

Signàla bojàjumi — attàluma un ¹óºr¹¶u dº¶ signàlam var 
zust fàze. Tie var izraisït arï signàla atstaro¹anos. Abos 
gadïjumos signàls pavàjinàs.

Vàj¹ signàls — attàluma vai ¹óºr¹¶u dº¶ radiosignàls no 
¹þnas atra¹anàs vietas var nebþt pietiekami spºcïgs vai 
stabils, lai sakariem nodro¹inàtu uzticamu datu 
savienojumu. Tàdº¶, lai nodro¹inàtu vislabàkos sakarus, 
paturiet pràtà ¹àdus ieteikumus:
• Datu savienojums darbojas vislabàk, ja ierïce atrodas 

nekustïgà stàvoklï. Nav ieteicams censties izmantot 
mobilos datu sakarus, ja atrodaties brauco¹à 
automa¹ïnà.

• Nenovietojiet ierïci uz metàla virsmas.
• Pàrbaudiet, vai indikators viedtàlruña displejà ràda, ka 

signàls ir pietiekami spºcïgs. Ja viedtàlruni pàrvieto uz 
citu telpas vietu, ïpa¹i loga virzienà, var iegþt 
spºcïgàku signàlu. Ja signàls nav pietiekami spºcïgs 
balss zvanam, necentieties izveidot datu savienojumu, 
kamºr neesat atradis vietu, kur signàls ir labàk 
uztverams.
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Datu savienojumi

GSM datu zvani
GSM datu zvans nodro¹ina datu pàrraidi ar àtrumu lïdz 
14,4 Kb/s. Informàciju par datu pakalpojumu pieejamïbu 
un abonº¹anu vaicàjiet tïkla operatoram vai pakalpojumu 
sniedzºjam.

Àtrdarbïgie datu zvani (àtrdarbïgo 
komutºto óº¾u dati — High Speed 
Circuit Switched Data, HSCSD)
HSCSD nodro¹ina datu pàrraidi ar àtrumu lïdz 43,2 Kb/s 
jeb èetras reizes àtràk nekà standarta àtrums GSM tïklà. 
HSCSD var pielïdzinàt àtrumam, ar kàdu darbojas daudzu 
datoru modemi komunikàcijà ar fiksºto tàlruñu sakaru 
tïkliem.

Informàciju par àtrdarbïgo datu pakalpojumu pieejamïbu 
un abonº¹anu vaicàjiet tïkla operatoram vai pakalpojumu 
sniedzºjam.

Piezïme. Datu sþtï¹ana HSCSD re¾ïmà ierïces 
akumulatora jaudu var àtràk iztºrºt nekà parastie balss 
vai datu zvani, jo ierïce bie¾àk sþta datus uz tïklu.

Pake¹dati (vispàrºjais pake¹u 
radiopakalpojums — General Packet 
Radio Service, GPRS)
GPRS nodro¹ina mobilo tàlruñu bezvadu piek¶uvi datu 
tïkliem (tïkla pakalpojums). GPRS izmanto pake¹datu 
tehnolo»iju, tas ir, informàcija pa mobilo sakaru tïklu tiek 
sþtïta nelielàs datu kopàs. Datu sþtï¹ana paketºs ir 
izdevïga tàpºc, ka tïkls tiek aizñemts tikai datu sþtï¹anas 
un sañem¹anas brïdï. Tà kà GPRS tïklu izmanto racionàli, 
datu savienojumi tiek izveidoti ïsà laikà un dati tiek 
pàrraidïti ¶oti àtri.

GPRS pakalpojums ir jàabonº. Informàciju par GPRS 
pieejamïbu un abonº¹anu vaicàjiet tïkla operatoram vai 
pakalpojumu sniedzºjam.

(E)GPRS (Enhanced GPRS — uzlabotais GPRS) ir lïdzïgs 
GPRS, taèu nodro¹ina vºl àtràku savienojumu. Pla¹àku 
informàciju par (E)GPRS pieejamïbu un datu pàrraides 
àtrumu lþdziet tïkla operatoram vai pakalpojumu 
sniedzºjam. Ievºrojiet — ja par datu nesºju esat izvºlºjies 
GPRS, viedtàlrunis GPRS vietà izmanto (E)GPRS, ja tas 
tïklà ir pieejams.

GPRS un programmu izcenojumi
Visa datu pàrsþtï¹ana, izmantojot GPRS un (E)GPRS, 
notiek par maksu, ko noteicis operators par datu 
pàrsþtï¹anu. Pla¹àku informàciju par pakalpojumu cenàm 
vaicàjiet tïkla operatoram vai pakalpojumu sniedzºjam.
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Piek¶uves punkti
Datu savienojums savieno viedtàlruni ar internetu, 
izmantojot piek¶uves punktu. ©is viedtàlrunis atbalsta trïs 
veidu datu savienojumus:
• GSM datu zvans ( ) 
• GSM àtrdarbïgo datu zvans jeb HSCSD ( )
• pake¹datu (GPRS) savienojums ( )

Lai, piem., sþtïtu un sañemtu multiziñas vai e-pasta ziñas, 
pàrlþkotu lapas, ielàdºtu JavaTM programmas vai lietotu 
viedtàlruni modema vietà, ir jànoràda piek¶uves punktu 
uzstàdïjumi.

Vaicàjiet pakalpojumu sniedzºjam, kàda veida piek¶uves 
punkts ir nepiecie¹ams piek¶þstamajam pakalpojumam. 
Informàciju par GSM datu zvanu, GSM àtrdarbïgo datu 
zvanu un GPRS savienojuma pakalpojumu pieejamïbu un 
abonº¹anu lþdziet tïkla operatoram vai pakalpojumu 
sniedzºjam.
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Desk (Darbvirsma)
Nospiediet  vai statusa joslà pieskarieties , lai 
atvºrtu programmu Desk (Darbvirsma). 

Padoms. Ilgàk nospie¾ot, tiek atvºrts nesen lietoto 
lietojumprogrammu saraksts. Jþs varat pàrslºgties uz 
¹ïm programmàm.

Darbvirsma ir vieta, no kuras varat piek¶þt visàm 
programmàm un izveidot saïsnes uz objektiem, piem., 
dokumentiem, attºliem, programmàm vai kontaktu 
kartïtºm.

Ja aizverat programmu, nospie¾ot , un pàrslºdzaties uz 
citu programmu, viedtàlrunis datus saglabà pºc 
noklusºjuma.

12. attºls. Desk (Darbvirsma)

Lai atvºrtu programmu, veiciet dubultpieskàrienu 
ikonai. Pieskarieties un velciet ritjoslu labajà pusº, lai 
ekrànà pàrvietotos uz aug¹u un uz leju.

Lai noñemtu programmu, atveriet Control panel 
(Vadïbas panelis) > App. manager (Programmu 
pàrvaldïba), izvºlieties noñemamo programmatþras 
pakotni un pieskarieties Remove (Noñemt). Tiek atvºrts 
dialogs, kurà jàapstiprina dzº¹ana. Nospiediet Remove.

Lai objektam pievienotu saïsni, atveriet programmu, 
kuras objektu pievienosit darbvirsmai, un atlasiet ¹o 
objektu. Nospiediet  un izvºlnº atrodiet komandu 
Add to Desk... (Pievienot darbvirsmai). Piem., programmà 
Images (Attºli) izvºlieties Tools (Rïki) > Add to Desk... 
Atlasiet darbvirsmas grupu, kurai jàpievieno saïsne, un 
pieskarieties OK (Labi).

Lai izdzºstu saïsni vai programmas ikonu, iezïmºjiet 
ikonu, nospiediet  un izvºlieties Edit (Redi»ºt) > 
Delete (Dzºst). Ievºrojiet, ka programmu ikonas nevar 
noñemt no grupas All (Visi).

Lai ikonas pàrkàrtotu, pieskarieties ikonai un turiet 
irbuli uz tàs aptuveni sekundi. Pºc tam ar irbuli velciet 
ikonu uz jauno atra¹anàs vietu displejà.

Lai palielinàtu vai samazinàtu ikonas, nospiediet  
vai  un izvºlieties Display (Ràdït) > Zoom in 
(Tuvinàt) vai Zoom out (Tàlinàt).
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Lai pievienotu fona attºlu, nospiediet  un 
izvºlieties Display > Set background image... (Uzstàdït 
fona attºlu). Izvºlieties attºlu. Lai apskatïtu attºlu, 
pieskarieties Preview (Apskatït). Pretºjà gadïjumà 
pieskarieties OK (Labi). Citas displeja personalizàcijas 
iespºjas, sk. noda¶à “Themes” 124. lpp.

Darbs ar grupàm
Programmà Desk ràdïtàs programmas un saïsnes varat 
sadalït grupàs. Grupas atvieglo darbu ar daudzajàm 
programmàm un saïsnºm. Viena programma vai saïsne var 
bþt iek¶auta vairàkàs grupàs.

Lai izveidotu jaunu grupu, nospiediet , izvºlieties 
Group (Grupa) > New... (Jauna) un pie¹óiriet jaunajai 
grupai nosaukumu.

Lai pàrslºgtos no vienas grupas uz citu, nospiediet 
, izvºlieties View group (Skatït grupu) un izvºlieties 

grupu.

Lai izvºlºto programmu vai saïsni pievienotu grupai, 
nospiediet , izvºlieties Group > Add to group... 
(Pievienot grupai) un izvºlieties grupas, kuràm objekts 
jàpievieno.

Lai grupai pievienotu objektus vai tos noñemtu, 
nospiediet  un izvºlieties Group > Edit... (Redi»ºt). 
Ievºrojiet, ka ¹ï iespºja nav pieejama grupai All. Lai 
grupai pievienotu programmu vai saïsni, iezïmºjiet to 
sarakstà pa kreisi. Pieskarieties Add (Pievienot). Lai 

noñemtu programmu vai saïsni, iezïmºjiet to sarakstà 
pa labi un pieskarieties Remove (Noñemt).

Lai pàrdºvºtu grupu, nospiediet , izvºlieties Group 
> Manage groups... (Darbs ar grupàm). Izvºlieties 
pàrdºvºjamo grupu un pieskarieties Rename 
(Pàrdºvºt).

Lai izdzºstu grupu, nospiediet , izvºlieties Group > 
Manage groups... Izvºlieties dzº¹amo grupu un 
pieskarieties Delete (Dzºst). Grupu All nevar ne 
pàrdºvºt, ne dzºst.
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Teksta rakstï¹ana
Burtus, ciparus un speciàlàs rakstzïmes var ievadït divºjàdi. 
Rokraksta atpazï¹ana sniedz iespºju rakstït ar roku tie¹i uz 
ekràna, izmantojot irbuli. Varat izmantot arï ekràna 
tastatþru, kur jàpieskaras ievadàmajàm rakstzïmºm.

Lietojumprogrammu nodro¹inàtàji var piedàvàt arï citas 
ievades metodes. Ierïcº ¹àdas ievades meto¾u programmas 
var izmantot tikai tad, ja tàs ir instalºtas ierïces atmiñà. Ja 
tàs ir instalºtas atmiñas kartº, ierïce ¹ïs programmas 
izmantot ne¶aus.

Lai rakstïtu tekstu, pieskarieties ekràna apgabalam, 
kurà rakstïsit. Tiek atvºrts rokraksta atpazï¹anas logs vai 
ekràna tastatþra. Lai rokraksta atpazï¹anu nomainïtu 
ar ekràna tastatþru, pieskarieties . Lai pàrslºgtos uz 
rokraksta atpazï¹anu, pieskarieties . Sàciet 
rakstït.

Svarïgi! Izmantojiet vienïgi tàdus irbu¶us, ko Nokia 
apstiprinàjusi lieto¹anai kopà ar ¹o ierïci. Izmantojot citus 
irbu¶us, garantijas, kas sniegtas attiecïbà uz ¹o ierïci, var 
zaudºt spºku, kà arï var tikt bojàts ekràns. Neieskràpºjiet 
ekrànu. Rakstï¹anai uz ekràna neizmantojiet parasto 
pildspalvu vai zïmuli vai kàdu citu asu priek¹metu.

Lai pàrvietotu ievades logu, pieskarieties un 
velciet .

Lai paslºptu ievades logu, pieskarieties .

Lai mainïtu ievades valodu, pieskarieties  un 
sarakstà izvºlieties valodu.

Rokraksta atpazï¹ana
Padoms. Rokraksta logà pieskarieties , lai atvºrtu 
palïdzïbas funkciju. Palïdzïbà ir sniegta detalizºta 
informàcija par rakstzïmju ievadi un vºl citi noderïgi 
padomi.

13. attºls. Rokraksta atpazï¹anas logs

Lai lietotu rokraksta atpazï¹anas funkciju, rokraksta 
logà ar irbuli pa vienai velciet rakstzïmes.

Padoms. Ievºrojiet, ka atpazï¹anu ietekmº loga da¶a, 
kurà rakstàt. Rakstiet ar roku tie¹i virs tievàs bàzlïnijas. 

Lai pàrslºgtos no automàtiskàs sàk¹anas ar lielo 
burtu uz lielajiem vai mazajiem burtiem un pretºji, 



Te
ks

ta
 r

ak
st

ï¹
an

a

34 Copyright © 2005 Nokia. All rights reserved. 

pieskarieties . Varat izvºlºties vàrdu sàkt ar lielo vai 
mazo burtu. Vàrda vidþ varat izvºlºties lielo vai mazo 
burtu lieto¹anu. Visi teikumi aiz rakstzïmºm ! ? ¿ ¡ un 
. tiek automàtiski sàkti ar lielo burtu, ja ¹o iespºju 
neesat izslºdzis vadïbas pane¶a uzstatïjumu grupà Pen 
Input (Ievade ar rakstàmrïku). 

Ievºrojiet, ka burtu re»istrs ir atkarïgs nevis no tà, kà 
uzrakstàt burtu ekrànà, bet no izvºlºtà alfabºta re¾ïma. Ja 
sistºma labàk atpazïst rakstï¹anu ar lielajiem burtiem, 
varat rakstït lielos burtus, lai iegþtu mazos. Ievºrojiet, ka 
nevarat izvºlºties re¾ïmu AB tàda vàrda sàkumà, kas tiek 
automàtiski rakstïts ar lielo burtu.

Padoms. Citi automàtiskàs lielo burtu rakstï¹anas 
uzstàdïjumi ir noràdïti sada¶à “Uzstàdïjumi ievadei ar 
rakstàmrïku” 35. lpp.

Lai rakstïtu ciparus, speciàlàs rakstzïmes vai zïmes 
rokrakstà, pieskarieties , lai iegþtu ciparus, vai 

— lai iegþtu speciàlàs rakstzïmes. Kà ievadït 
atstarpes, atpaka¶atkàpes un citas zïmes, sk. 14. att.

14. attºls. Zïmes rokrakstà: 1 — atstarpe, 2 — 
atpaka¶atkàpe, 3 — ievadï¹ana, 4 — tabulators

Lai izdzºstu tekstu, atlasiet tekstu, velkot irbuli tam 
pàri. Uzvelciet atpaka¶atkàpes zïmi. Sk. 14. att.

Lai sistºmai iemàcïtu jþsu personisko rakstï¹anas 
stilu, izvºlieties programmu Control panel un Pen 
Input Settings (Uzstàdïjumi ievadei ar rakstàmrïku), 
pºc tam pieskarieties Training (Trenº¹ana). Veiciet 
dubultpieskàrienu rakstzïmju kopai (lielie vai mazie 
burti, cipari vai speciàlàs rakstzïmes) un izvºlieties 
rakstzïmi, ko trenºsit. Pieskarieties Train (Trenºt). 
Uzvelciet rakstzïmi savà rokrakstà un pieskarieties OK 
(Labi). Lai mainïtu sistºmai iemàcïto rakstï¹anas 
stilu, vºlreiz atveriet dialogu Draw character 
(Rakstzïmju vilk¹ana) un pieskarieties Clear (Notïrït), 
lai noñemtu eso¹o stilu. Velciet jauno rakstzïmi un 
pieskarieties OK.

Trenºjiet tikai tàs rakstzïmes, kuras sistºmai ir visgrþtàk 
atpazït. Ja centïsities iemàcït sistºmai atpazït visas 
rakstzïmes, ierïcei var pietrþkt atmiñas.

Ekràna tastatþra
Lai lietotu ekràna tastatþru, pieskarieties tastatþras 
taustiñiem ar irbuli.
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15. attºls. Ekràna tastatþra

1 Ievades lauks. Ràda rakstïtàs rakstzïmes.
2 Atpaka¶atkàpes taustiñ¹. Dzº¹ rakstzïmi pa kreisi no 

kursora.
3 Ievadï¹anas taustiñ¹. Sàk jaunu rindiñu vai pievieno 

jaunas rindas.
4 Tabulº¹anas taustiñ¹. Ievieto tabulº¹anas atstarpi vai 

pàrvieto kursoru uz nàkamo lauku.
5 Lielo burtu slºgs. Ieslºdz lielo burtu re¾ïmu.
6 Pàrslºg¹anas taustiñ¹. ¦auj ievadït lielo burtu, kad 

rakstàt ar mazajiem burtiem.
7 Atstarpes taustiñ¹. Ievieto atstarpi.

Lai pàrslºgtos no lielajiem burtiem uz mazajiem un 
pretºji, pieskarieties . Lai ieslºgtu lielo burtu slºgu, 
pieskarieties . Visi teikumi aiz rakstzïmºm ! ? ¿ ¡ un 
. tiek automàtiski sàkti ar lielo burtu, ja ¹o iespºju 

neesat izslºdzis vadïbas pane¶a uzstatïjumu grupà Pen 
Input (Ievade ar rakstàmrïku).

Lai rakstïtu ciparus vai speciàlàs rakstzïmes, 
nospiediet . Pieskarieties , lai apskatïtu citas 
speciàlàs rakstzïmes.

Padoms. Lai rakstïtu burtus ar uzsvariem, ja uzsvara 
zïmes ir tikai tastatþrà, vispirms pieskarieties 
uzsvara zïmei un pºc tam burtam. Lai izvºlºtos 
burtus ar uzsvariem, varat pieskarties arï , ja tas 
ir pieejams. 

Lai izdzºstu tekstu, atlasiet tekstu, velkot irbuli tam 
pàri. Pieskarieties atpaka¶atkàpes ikonai.

Uzstàdïjumi ievadei ar 
rakstàmrïku

Lai konfigurºtu teksta ievades uzstàdïjumus, 
izvºlieties Control panel > Pen Input Settings 
(Uzstàdïjumi ievadei ar rakstàmrïku). Noràdiet 
vajadzïgos uzstàdïjumus.

Input language: (Ievades valoda) — ¹is uzstàdïjums noràda, 
kuras valodai raksturïgàs rakstzïmes rokrakstà tiek 
atpazïtas, kà arï ekràna tastatþras izkàrtojuma veidu. 

Character recognition: (Rakstzïmju atpazï¹anas àtrums) — 
noràdiet àtrumu, kàdà tiek veikta rokraksta 
atpazï¹ana.
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Line width: (Lïnijas platums) — mainiet irbu¶a vilktàs lïnijas 
biezumu.

Keyboard size: (Tastatþras lielums) — izvºlieties virtuàlàs 
tastatþras lielumu. 

Input method: (Ievades metode) — ¹ajà ierïcº pºc 
noklusºjuma ir divas teksta ievades metodes: ekràna 
tastatþra un rokraksta atpazï¹ana. ©is uzstàdïjums nav 
jànoràda, ja ierïcº nav instalºtas vºl citas ievades 
metodes.

Capitalise: (Lielie burti) — lai sàktu ar lielo burtu vàrdus aiz 
rakstzïmºm .! ? ¿ ¡ ar atstarpi, izvºlieties After '.', '?' or 
'!' with space (Pºc '.', '?' un '!' ar atstarpi). Lai tos sàktu 
ar lielo burtu bez atstarpes, izvºlieties After '.', '?' or '!' 
(Pºc '.', '?' un '!'). Lai lielo burtu rakstï¹anu izslºgtu, 
izvºlieties No (Nº).

Padoms. Lai ïsziñàs ietilptu vairàk teksta, tàs rakstot, 
izmantojiet uzstàdïjumu After '.', '?' or '!'.



Te
le

ph
on

e 
(T

àl
ru

ni
s)

37Copyright © 2005 Nokia. All rights reserved.

Telephone (Tàlrunis)
Atveriet Desk (Darbvirsma) > Telephone (Tàlrunis).

Mikrofons un klausules elements atrodas ierïces priek¹pusº 
(sk. 1. att. 12. lpp.).

Zvanï¹ana
Lai piezvanïtu, izmantojot ciparu tastatþru, atveriet 
programmu Telephone (Tàlrunis), pieskaroties 
tastatþrai, ievadiet tàlruña numuru un pieskarieties 
Call (Zvanït). Lai izdzºstu ievadïtos ciparus, 
pieskarieties . Lai pàrslºgtos starp skatiem, 
nospiediet 

Lai veiktu starptautisku zvanu, pievienojiet starptautisko 
prefiksu + (veiciet dubultpieskàrienu pogai * un turot pie 
tàs irbuli, uznirsto¹ajà sarakstà izvºlieties +) un pºc tam 
ievadiet valsts kodu, rajona kodu un tàlruña numuru.

Ja SIM karte ir izñemta vai bojàta, var veikt vienïgi zvanus 
uz avàrijas dienestu izsauk¹anas numuriem. Lai varºtu 
veikt zvanus da¾os tïklos, ierïcº jàbþt pareizi ievietotai 
derïgai SIM kartei.

Ja nav iespºjams piezvanït uz avàrijas dienestu izsauk¹anas 
numuru parastajà veidà, var ievadït ierïcº ieprogrammºto 
avàrijas dienestu izsauk¹anas numuru koda ievades laukà 
un pieskarties Call (Zvanït).

Lai piezvanïtu katalogà iek¶autam numuram, logà 
Dialler (Numuru izsauk¹ana) pieskarieties Contacts 
(Kontakti), katalogà izvºlieties kontaktu un 
pieskarieties Call. Ja kontaktpersonai ir vairàki tàlruñu 
numuri, tiek atvºrts saraksts, kurà ir visi numuri. 
Sarakstà izvºlieties numuru un pieskarieties OK (Labi).

Padoms. Tekstlodziñà vai dokumentà tàlruña numuru 
var izmantot kà hipersaiti. Pieskarieties ar irbuli 
numuram vai ar ritinà¹anas taustiña palïdzïbu 
ievietojiet tajà kursoru; tas k¶þst par saiti ar nelielu 
ikoniñu. Pieskarieties ikonai, lai piezvanïtu uz tàlruña 
numuru.

Lai numuru no numura lauka pievienotu kontaktu 
katalogam, pieskarieties Add to Contacts (Pievienot 
kontaktu katalogam), izvºlieties kontaktpersonu vai 
izveidojiet jaunu kontaktu un ievadiet 
kontaktinformàciju. Pla¹àku informàciju sk. sada¶à 
“Contacts (Kontaktu katalogs)” 63. lpp.

Lai piezvanïtu uz numuru, kas iek¶auts pºdºjo zvanu 
sarakstà, logà Dialler pieskarieties Recent calls 
(Pºdºjie zvani). Vienà no sarakstiem izvºlieties numuru 
un pieskarieties Call. Lai numuru pievienotu 
kontaktu katalogam, atlasiet numuru un pieskarieties 
Add to contacts.
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Lai izmantotu àtro zvanu iespºju, nospiediet , 
izvºlieties View (Skats) > Speed dialling (Àtrie zvani) un 
pieskarieties vàrdam vai numuram, kuram vºlaties 
piezvanït. Àtro zvanu iespºja ¶auj àtri piezvanït uz bie¾i 
izmantotiem numuriem.

16. attºls. Àtrie zvani

Lai pievienotu àtro zvanu numurus, atveriet àtro 
zvanu skatu (nospiediet , izvºlieties View (Skatït) > 
Speed dialling (Àtrie zvani)). Pieskarieties neaizñemtam 
àtrà zvana numuram un atvºrtajà dialogà pieskarieties 
Assign (Pie¹óirt). Izvºlieties kontaktu, kam pie¹óirsit 
àtrà zvana numuru, un pieskarieties Select (Pañemt). 
Ja izvºlei tiek piedàvàti vairàki tàlruñu numuri, 
izvºlieties vienu un pieskarieties OK (Labi).

Lai pàrslºgtos no skata Dialler (Numuru izsauk¹ana) 
uz skatu Speed dialling (Àtrie zvani) un pretºji, 
nospiediet .

Lai varºtu piezvanït uz balss pastkasti, vaicàjiet tïkla 
operatoram balss pastkastes numuru (tïkla 
pakalpojums). Skatà Speed dial numurs 1 ir rezervºts 
zvaniem uz noklusºjuma balss pastkasti. Pla¹àku 
informàciju sk. sada¶à “Balss pastkastes uzstàdïjumi” 
41. lpp.

Lai sarunas laikà regulºtu ska¶umu, pieskarieties 
Audio settings (Audio uzstàdïjumi). Pàrvietojot slïdni, 
regulºjiet skañas lïmeni. Izvºlieties Loudspeaker: 
(Ska¶runis), lai lietotu brïvroku re¾ïma ska¶runi un 
mikrofonu, vai Mute: (Izslºgt skañu), lai izslºgtu 
mikrofona skañu.

Padoms. Sarunas laikà nospiediet , lai atvºrtu 
audio uzstàdïjumus. Nospiediet  un  vai 
ritinà¹anas taustiñà nospiediet  un , lai attiecïgi 
samazinàtu vai palielinàtu ska¶umu. 

Lai sarunas laikà veiktu jaunu zvanu, pieskarieties 
Dialler (Numuru izsauk¹ana). Lai pàrslºgtos no vienas 
sarunas uz otru, pieskarieties Unhold (Atlaist) vai Hold 
(Aizturºt). Lai sarunà savienotu abus pàrºjos 
dalïbniekus un pats atvienotos no sarunas, 
nospiediet , izvºlieties Options (Iespºjas) > Transfer 
(Pàrsþtït). Lai vienlaikus runàtu ar abiem sarunu 
partneriem, pieskarieties Conference (Konference). 
Konferences zvanà var bþt ne vairàk kà pieci dalïbnieki. 
Konferences sarunas laikà pieskarieties Conf. options 
(Konferences iespºjas), lai atvienotu dalïbniekus vai lai 
runàtu ar tiem individuàli. Konferences zvans un zvanu 
pàrsþtï¹ana ir tïkla pakalpojumi.
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Padoms. Kà pàrraudzït neatbildºtos, sañemtos un 
veiktos zvanus un uzzinàt sarunu ilgumu, sk. noda¶à 
“Log (®urnàls)” 139. lpp.

Atbildº¹ana
Lai atbildºtu uz zvanu, pieskarieties Answer (Atbildºt) 
vai nospiediet . Lai atteiktu zvanu, pieskarieties 
Reject (Atteikt) vai nospiediet . Lai beigtu zvanu, 
nospiediet . Lai izslºgtu zvana signàlu, 
pieskarieties Silence (Klusums). Kà izslºgt signàlu un 
atbildºt ar standarta ziñu, skatiet noda¶à “Citi 
uzstàdïjumi” 41. lpp.

Balss iezvane
Varat veikt tàlruña zvanu, izrunàjot kontakta kartïtei 
pievienotu balss fràzi. Balss fràze var bþt jebkur¹ izrunàts 
vàrds vai vàrdi. 

Pirms balss frà¾u lieto¹anas atcerieties:
• Balss fràzes neiz¹óir valodas. Tàs ir atkarïgas no 

runàtàja balss.
• Vàrds jàizrunà tie¹i tàpat kà brïdï, kad tas tika 

ierakstïts. 
• Ierakstot un izrunàjot balss fràzes, runàjiet ska¶i. Ja 

runàjat klusu, sistºma balss fràzi var neatpazït.
• Balss fràzes ir jutïgas pret fona trok¹ñiem. Balss fràzes 

ierakstiet un lietojiet klusumà.

• ¦oti ïsi vàrdi nav izmantojami. Lietojiet garus vàrdus 
un izvairieties izmantot lïdzïgus vàrdus da¾àdiem 
numuriem.
Piezïme. Trok¹ñainà vidº vai àrkàrtas situàcijàs balss 
frà¾u lieto¹ana var bþt apgrþtinàta, tàpºc nekàdà 
gadïjumà nevajadzºtu pa¶auties tikai uz balss iezvanes 
iespºju.

Kà pievienot balss fràzes, sk. “Balss fràzes” 65. lpp.

Lai lietotu balss iezvani, nospiediet un turiet  
vai austiñu pogu, lïdz atskan sàkuma signàls vai 
displejà tiek paràdïts noràdïjums. Izrunàjiet izsaucamà 
numura balss fràzi. Lai mº»inàtu vºlreiz, ja balss fràze 
netika atpazïta, nospiediet un da¾as sekundes turiet 
taustiñu . Lai pàrietu uz parasto numura 
sastàdï¹anu, ïsi nospiediet taustiñu  vai austiñu 
pogu un nospiediet taustiñu ESC. 

Tàlruña uzstàdïjumi

Zvanu pàradresàcija (tïkla 
pakalpojums)
Zvanu pàradresàcija ¶auj ienàko¹os balss zvanus novirzït 
uz citu tàlruña numuru. To dºvº arï par zvanu pàrsþtï¹anu.
1 Nospiediet  un izvºlieties Tools (Rïki) > Settings 

(Uzstàdïjumi) > Call divert... (Zvanu pàradresàcija). Tiek 
atvºrts dialogs.

2 Atveriet lapu Voice calls (Balss zvani).
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3 Noràdiet vajadzïgos uzstàdïjumus.
Divert all calls: (Pàradresºt visus zvanus) — ja ir 
aktivizºta ¹ï iespºja, tiek pàradresºti visi zvani.
Divert if busy: (Pàradresºt, ja aizñemts) — ja ir aktivizºta 
¹ï iespºja, ienàko¹ie zvani tiek pàradresºti, kamºr 
veicat citu zvanu.
Divert if not answered: (Pàradresºt, ja neatbild) — ja ir 
aktivizºta ¹ï iespºja, ienàko¹ie zvani tiek pàradresºti, ja 
uz tiem neatbildat noteiktà laika posmà.
Divert if out of reach: (Pàradresºt, ja nav sasniedzams) — 
ja ir aktivizºta ¹ï iespºja, ienàko¹ie zvani tiek 
pàradresºti, kad ierïce ir izslºgta vai atrodas àrpus tïkla 
uztver¹anas zonas.
Divert if not available: (Pàradresºt, ja nav pieejams) — ar 
vienu darbïbu ¹ïs iespºjas ieslºg¹ana aktivizº iespºjas 
Divert if busy:, Divert if out of reach: un Divert if not 
answered:.
Tiek piedàvàtas ¹àdas iespºjas:
Activate (Aktivizºt) — atvºrtajà dialogà ievadiet 
numuru, uz kuru jàpàradresº zvani, un — ja pieejama 
¹àda iespºja — laika posmu, pºc kàda zvans 
jàpàradresº, ja uz to neatbild. Pieskarieties , lai 
izvºlºtos balss pastkastes numuru vai citus 
noklusºjuma numurus, ja tàdi pieejami. Pieskarieties 
Select contact (Izvºlieties kontaktu), lai tàlruña 
numuru meklºtu programmà Contacts (Kontakti).
Cancel (Atcelt) — pàradresàcija tiek atcelta.
Check status (Pàrbaudït statusu) — pàrbauda, vai 
pàradresàcija ir aktivizºta.

Lai atceltu visu zvanu pàradresàciju, pieskarieties 
Cancel all diverts (Atcelt visas pàradresàcijas).

Datu un faksa zvanu pàradresàcija 
(tïkla pakalpojums)
1 Nospiediet  un izvºlieties Tools (Rïki) > Settings 

(Uzstàdïjumi) > Call divert... (Zvanu pàradresàcija).
2 Atveriet lapu Data & Fax calls (Datu un faksa zvani) un 

izvºlieties vienu no ¹ïm iespºjàm, kà pàradresºt visus 
datu zvanus vai visus faksa zvanus:
Activate (Aktivizºt) — atvºrtajà dialogà ievadiet 
numuru, uz kuru jàpàradresº zvani, un laika posmu, pºc 
kàda zvans jàpàradresº, ja uz to neatbild. Varat 
pieskarties lodziñam, lai izvºlºtos iepriek¹ pievienotus 
numurus (ja tàdi biju¹i).
Cancel (Atcelt) — pàradresàcija tiek atcelta.
Check status (Pàrbaudït statusu) — pàrbauda, vai 
aktivizàcija ir aktïva.

Zvanu liegumi (tïkla pakalpojums)
Zvanu liegumi ¶auj ierobe¾ot zvanï¹anu un zvanu 
sañem¹anu jþsu viedtàlrunï. Lai lietotu ¹o funkciju, no 
pakalpojumu sniedzºja ir jàsañem liegumu parole.
1 Nospiediet  un izvºlieties Tools > Settings > Call 

barring... (Zvanu liegumi). Tiek atvºrts dialogs.
2 Noràdiet vajadzïgos uzstàdïjumus.

All incoming calls: (Visi ienàko¹ie zvani) — ja ir aktivizºta 
¹ï iespºja, zvanus nevar sañemt.
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Incoming calls when abroad: (Ienàko¹ie zvani, atrodoties 
àrzemºs) — ja ir aktivizºta ¹ï iespºja, zvanus nevar 
sañemt, ja neatrodaties màjas valstï.
All outgoing calls: (Visi izejo¹ie zvani) — ja ir aktivizºta ¹ï 
iespºja, nevar piezvanït.
International calls: (Starptautiskie zvani) — ja ir 
aktivizºta ¹ï iespºja, nevar veikt zvanus uz citàm 
valstïm vai re»ioniem.
Int. calls except to home country: (Starptautiskie zvani, 
izñemot uz màjas valsti) — ja pie tïkla operatora esat 
aktivizºjis starptautisko viesabonº¹anu, tad, atrodoties 
àrzemºs, var piezvanït tikai uz màjas valsti.
Tiek piedàvàtas ¹àdas iespºjas:
Activate — tiek aktivizºti liegumi.
Cancel — liegumi tiek izslºgti.
Check status (Pàrbaudït statusu) — pàrbauda, vai zvanu 
liegumi ir aktivizºti.

3 Ievadiet liegumu paroli un pieskarieties OK (Labi), lai 
aktivizºtu pakalpojumu.

Ja SIM karte atbalsta divu lïniju pakalpojumu, balss zvanu 
liegums attiecas tikai uz izvºlºto lïniju.

Lai atceltu visus zvanu liegumus, pieskarieties Cancel 
all barrings (Atcelt visus liegumus).

Informàciju par datu zvanu liegumiem sk. noda¶à “Data call 
barring” 112. lpp.

Vienlaikus nevar bþt aktivizºti zvanu lieguma un zvanu 
pàradresàcijas pakalpojumi. Ja ir liegti zvani, tomºr var 
piezvanït uz ierïcº ieprogrammºto oficiàlo avàrijas 
dienestu izsauk¹anas numuru.

Balss pastkastes uzstàdïjumi 
Informàciju par zvanï¹anu uz balss pastkasti (tïkla 
pakalpojums) sk. noda¶à “Zvanï¹ana” 37. lpp.
1 Nospiediet  un izvºlieties Tools (Rïki) > Settings 

(Uzstàdïjumi) > Voice mailbox... (Balss pastkaste).
2 Noràdiet balss pastkastes numuru un, ja vºlaties, 

DTMF toni (balss pastkastes paroli):
Number: (Numurs) — ievadiet no pakalpojumu 
sniedzºja sañemto balss pastkastes numuru.
DTMF: — noràdiet balss pastkastes DTMF toñus. 
Pla¹àku informàciju par DTMF toñiem sk. sada¶à 
“DTMF toñu sþtï¹ana” 43. lpp.

Ja SIM karte atbalsta divu lïniju pakalpojumu, varat 
noràdït balss pastkastes uzstàdïjumus abàm lïnijàm.

Citi uzstàdïjumi
Nospiediet  un izvºlieties Tools (Rïki) > Settings 
(Uzstàdïjumi) > Other settings... (Citi uzstàdïjumi). Noràdiet 
vajadzïgos uzstàdïjumus.

Lapa Call (Zvanï¹ana)
Call waiting: (Zvanu gaidï¹ana) — ja esat aktivizºjis zvanu 
gaidï¹anas pakalpojumu, notieko¹as sarunas laikà tïkls jþs 
informº par jaunu ienàko¹o zvanu (tïkla pakalpojums). 
Iespºja Check status (Pàrbaudït statusu) ¶auj pàrbaudït, vai 
zvanu gaidï¹ana ir aktivizºta.

Send my caller ID: (Sava numura sþtï¹ana) — nosaka, vai 
jþsu numurs tiek slºpts vai ràdïts personai, kurai zvanàt 
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(tïkla pakalpojums). Uzstàdïjumu var noràdït tïkla 
operators vai pakalpojumu sniedzºjs abonementa iegàdes 
brïdï (Set by network (Nosaka tïkls)). 

Summary after call: (Pàrskats pºc zvana) — ja izvºlaties 
iespºju On (Ieslºgts), pºc sarunas tiek paràdïts tàs 
aptuvenais ilgums.

Automatic redial: (Automàtisks pàrzvans) — ja izvºlaties 
iespºju On un zvanàt uz numuru, kur¹ ir aizñemts vai 
neatbild, ierïce automàtiski mº»ina piezvanït uz ¹o 
numuru. Tas notiek ne vairàk kà 10 reizes.

Reject with message: (Atteikt ar ziñu) — izvºloties iespºju 
On (Ieslºgts), tiek atvºrts tekstlodziñ¹, kurà varat ierakstït 
ziñu, ko atbildes veidà var nosþtït zvanïtàjam, ja izslºdzat 
ienàko¹o tàlruña zvanu skañu. Lai ziñu vºlàk modificºtu, 
izvºlieties iespºju Edit message (Redi»ºt ziñu).

Line in use: (Lietotà lïnija) — ja SIM karte atbalsta divu 
lïniju pakalpojumu, izvºlieties lïniju, ko izmantosit (tïkla 
pakalpojums). 

Block line change: (Lïnijas maiña) — ja SIM karte atbalsta 
divu lïniju pakalpojumu un jþs izvºlàties ¹o iespºju, jþs 
nevarat mainït izmantoto lïniju. Lai mainïtu ¹o 
uzstàdïjumu, jàievada PIN2 kods. 

Lapa Network (Tïkls)
Operator selection: (Operatora izvºle) — ¶auj mainït tïkla 
izvºles veidu, kà arï re»istrºties cità tïklà. Ja noràdàt 
automàtisku tïkla izvºli, ierïce izvºlas visatbilsto¹àko. 
Manuàla tïkla izvºle nozïmº, ka ierïce meklº pieejamos 

tïklus un piedàvà atrasto tïklu sarakstu. Jþs varat 
izvºlºties, kuru tïklu lietosit. Ievºrojiet, ka iespºja mainït 
tïklu, ir atkarïga no tïkla operatora.

Cell info display: (©þnas informàcijas ràdï¹ana) — izvºlieties 
On, lai noràdïtu, ka ierïce tiek lietota mikro¹þnu tïklà 
(Micro Cellular Network — MSN). Tàlruña numura laukà 
tiek ràdïts MCN ¹þnas indikators. Zvana laikà indikators 
netiek ràdïts.

Lapa Security (Dro¹ïba)
Ja tiek izmantotas zvanus ierobe¾ojo¹as dro¹ïbas funkcijas 
(piemºram, zvanu liegumi, slºgtas lietotàju grupas un 
fiksºtie zvani), tomºr var piezvanït uz ierïcº 
ieprogrammºto oficiàlo avàrijas dienestu izsauk¹anas 
numuru.

Closed user group: (Slºgta lietotàju grupa) — noràdiet 
cilvºku grupu, kuriem varat piezvanït un kuri var piezvanït 
jums. Izvºlieties Default (Galvenà), lai aktivizºtu grupu, par 
kuru esat vienojies ar tïkla operatoru. Izvºlieties On 
(Ieslºgts), lai aktivizºtu ¹o tïkla pakalpojumu. Jàievada no 
tïkla operatora sañemtais grupas numurs.

Fixed dialling: (Fiksºtie zvani) — ja SIM karte atbalsta ¹o 
pakalpojumu, varat piezvanït tikai uz ierobe¾otu SIM kartº 
glabàtu numuru grupu. Ja ir aktivizºts fiksºto zvanu 
pakalpojums, SIM kartes tàlruñu katalogà tiek ràdïti tikai 
tie numuri, kuri iek¶auti fiksºto zvanu sarakstà. Kontaktu 
katalogam joprojàm var piek¶þt, taèu uz tajà 
saglabàtajiem numuriem nevar piezvanït.
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Lai mainïtu uzstàdïjumus vai apskatïtu fiksºtos numurus, 
jàievada PIN2 kods. Izvºlieties Contacts (Kontakti), lai 
numurus pievienotu, labotu vai izdzºstu.

Vàrdi un numuri jàievada fiksºto zvanu sarakstà.

Piezïme. Fiksºtie zvani ietekmº arï pakalpojumu 
pieprasïjumus (jeb SS un USSD komandas), piem., tïkla 
pakalpojumu aktivizàcijas komandas.

DTMF toñu sþtï¹ana
DTMF (Dual Tone Multi-Frequency — divtoñu 
daudzfrekvenèu) toñi atskan, kad tàlruña programmas 
ciparu tastatþrà pieskaraties ciparu taustiñiem. Piem., 
DTMF toñi ¶auj sazinàties ar balss pastkastºm un 
datorizºtajàm telefonijas sistºmàm.

DTMF toñus var sþtït tïklà, lai, piem., piek¶þtu 
automatizºtajiem tàlruñu pakalpojumiem, balss 
pastkastºm vai banku sistºmàm.

Ja DTMF toni esat pievienojis programmas Contacts 
kontaktu kartïtes lodziñà DTMF, DTMF toñus var sþtït 
automàtiski. DTMF toñus var sþtït arï manuàli tàlruña 
skatà Dialler (Numuru sastàdï¹ana). Manuàla DTMF toñu 
pàrsþtï¹ana noder, ja DTMF toñu virkne ir ïsa.

Lai zvana laikà automàtiski nosþtïtu DTMF toñu 
virknes, nospiediet  un izvºlieties Options (Iespºjas) 
> Send DTMF... (Sþtït DTMF). Ja kontaktu katalogà 
pa¹reizºjam zvanam ir DTMF virkne, tiek atvºrts dialogs 
Send DTMF (DTMF sþtï¹ana). Pieskarieties Send (Sþtït), 
lai DTMF toni nosþtïtu automàtiski, vai Enter manually 

(Ievadït manuàli), lai izmantotu skatu Dialler. Ja 
kontaktu katalogà ¹im zvanam nav nevienas DTMF 
virknes, automàtiski tiek atvºrts skats Dialler.

Lai DTMF toñus ievadïtu manuàli sarunas laikà, 
pieskarieties Dialler (Numuru izsauk¹ana) vai 
nospiediet . Ievadiet DTMF virkni.

Padoms. Ir divas speciàlàs rakstzïmes, kuras var 
ievietot, tastatþrà veicot dubultpieskàrienu *:

• p (pauze) — DTMF toñu virknº starp cipariem 
tiek ievietota trïs sekun¾u gara pauze. Visi 
cipari, kuri tiek sþtïti pºc pauzes, tiek 
uzskatïti par DTMF toñiem.

• w (gaidï¹ana) — aptur DTMF ciparu sþtï¹anu, 
lïdz pieskaraties Send. Pàrºjà virknes da¶a 
tiek nosþtïta uz tïklu. Visi cipari, kuri tiek 
sþtïti pºc gaidï¹anas, tiek uzskatïti par DTMF 
toñiem.

Varat pievienot DTMF toñus kontaktu kartïtes laukam 
DTMF.

Padomi par efektïvu tàlruña lieto¹anu
• Ja esat aktivizºjis profilu Silent (Klusums), statusa 

indikatoru apgabalà tiek ràdïts klusuma indikators 
. Pieskaroties ¹im indikatoram, tiek atvºrts dialogs, 

kurà var mainït profilu. Ja aktivizºjat citu profilu, ¹is 
indikators tiek izñemts no statusa indikatoru 
apgabala.
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• Lai aizturºtu pa¹reizºjo sarunu vai aktivizºtu aizturºtu 
zvanu, sarunas laikà zvanu apstràdes skatà nospiediet 

. Ja saruna nenotiek, nospiediet , lai tiktu 
paràdïts pºdºjo veikto zvanu saraksts.

• Àtràs zvanï¹anas skatà ar irbuli velkot pie¹óirtàs àtro 
zvanu pogas, varat tàs pàrkàrtot. Fiksºto balss zvanu 
pogu nevar pàrvietot.
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Profiles (Profili)
Atveriet Desk (Darbvirsma) > Profiles (Profili).

Ar profilu palïdzïbu var noràdït viedtàlruña signàlus un 
ska¶umu da¾àdàs darbïbas vidºs, da¾àdu pasàkumu laikà 
un attiecïbà uz da¾àdàm zvanïtàju grupàm.

Lai mainïtu profilu, izvºlieties profilu sarakstà un 
pieskarieties Activate (Aktivizºt).

Lai izdzºstu profilu, sarakstà to iezïmºjiet, nospiediet 
 un izvºlieties Profile (Profils) > Delete (Dzºst). 

Ievºrojiet, ka noklusºjuma profilus nevar izdzºst.

Padoms. Profilus var mainït arï, ïsi nospie¾ot 
ieslºg¹anas/izslºg¹anas taustiñu.

Lai izveidotu jaunu profilu, nospiediet  un 
izvºlieties Profile > New... (Jauns). Pla¹àku informàciju 
par uzstàdïjumiem sk. “Profilu redi»º¹ana” 46. lpp.

Lai noràdïtu laiku, kad beidzas izvºlºtà profila 
darbïbas laiks, pieskarieties Set time (Uzstàdït laiku). 
Pieskarieties  un pºc tam ar bultiñu palïdzïbu 
mainiet laiku. Kad beidzas profila darbïbas laiks, atkal 
stàjas spºkà iepriek¹ºjais izmantotais profils. Ievºrojiet, 
ka dro¹ïbas apsvºrumu dº¶ laiku nevar uzstàdït profilam 
Flight (Lidojums).

Lai zvanïtàju grupu pievienotu izvºlºtajam profilam, 
pieskarieties Personalise (Personalizºt) un Alert for 
(Brïdinàt par). Izvºlieties grupu vai grupas un 

pieskarieties OK (Labi). Viedtàlrunis atskaño izvºlºto 
zvana melodiju vai brïdinàjuma signàlu tikai tad, ja 
jums zvana vai atsþta ziñu grupà iek¶auta persona (ja 
kopà ar zvanu tiek atsþtïts arï zvanïtàja numurs un 
ierïce to atpazïst). Sañemot citu zvanïtàju zvanus un 
ziñas, tiek lietots profils Silent (Klusums).

Lai lietotu viedtàlruni bez savienojuma ar GSM 
bezvadu tïklu, izvºlieties profilu Flight (Lidojums) un 
pieskarieties Activate. Tiek novºrsta iespºja no 
viedtàlruña un Bluetooth savienojumiem raidït un tajà 
sañemt GSM mobilà tàlruña un FM radiosignàlus, taèu 
joprojàm var veikt uzdevumus, kuriem nav 
nepiecie¹ams bezvadu tïkls. Piem., joprojàm varat 
klausïties audioklipus vai rakstït ziñas.

UZMANÏBU! Lidojuma profils ne¶auj veikt (vai sañemt) 
jebkàdus zvanus, ieskaitot àrkàrtas zvanus, kà arï 
izmantot citas funkcijas, kuràm nepiecie¹ams tïkla 
pàrklàjums. Lai varºtu zvanït, nomainiet profilu, 
aktivizºjot tàlruña funkcijas. Ja ierïce ir bijusi bloóºta, 
ievadiet bloóº¹anas kodu. Ja jàzvana uz avàrijas 
dienestu izsauk¹anas numuru, kad ierïce ir bloóºta vai 
tajà uzstàdïts lidojuma profils, mº»iniet bloóº¹anas 
koda laukà ievadït ierïcº ieprogrammºto avàrijas 
dienestu izsauk¹anas numuru un pieskarieties Call 
(Zvanït). Ierïce apstiprina, ka tþlït tiks izslºgts lidojuma 
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profils un sàkts zvans uz avàrijas dienestu izsauk¹anas 
numuru.

UZMANÏBU! Nelietojiet ierïci vietàs, kur mobilo ierïèu 
lieto¹ana ir aizliegta vai var radït traucºjumus un ir 
bïstama.

Profilu redi»º¹ana
Lai redi»ºtu profilu, izvºlieties profilu sarakstà un 
pieskarieties Personalise (Personalizºt). Ievºrojiet, ka 
atsevi¹óus uzstàdïjumus nevar mainït visos profilos. 
Noràdiet vajadzïgos uzstàdïjumus.

Profile name: (Profila nosaukums) — pàrdºvºjiet profilu.

Ringing tone: (Zvana signàls) — pieskarieties , lai 
izvºlºtos skañas failu, kur¹ izmantojams kà zvana 
signàls balss zvaniem. Lai noklausïtos izvºlºto 
signàlu, pieskarieties Play tone (Atskañot signàlu). 
Tàpat varat izvºlºties arï skañas failu da¾àdu veidu 
ziñàm.

Incoming call alert: (Ienàko¹o zvanu signàls) — ja izvºlaties 
Ascending (Pieaugo¹s), signàla ska¶ums atskaño¹anas 
sàkumà atbilst zemàkajam lïmenim, bet pakàpeniski pa 
lïmenim pieaug lïdz uzstàdïtajam ska¶uma lïmenim.

Ringing volume: (Signàla ska¶ums) — uzstàdiet ska¶umu, 
spie¾ot <+> vai <->. Vienàds signàla ska¶ums tiek 
izmantots ienàko¹ajiem balss zvaniem, ziñàm un 
brïdinàjumiem.

Vibrating alert: (Vibrozvans) — uzstàdiet, lai viedtàlrunis 
vibrºtu, sañemot balss zvanus, ziñas un brïdinàjumus.

Message alerts: (Ziñu signàli) — izvºlieties, lai ieslºgtu ziñu 
signàlus.

Text msg. alert tone: (Ïsziñu signàls) — pieskarieties , lai 
izvºlºtos ïsziñu sañem¹anas signàlu. Ja nav izvºlºta 
iespºja Message alerts:, ¹ï iespºja nav pieejama.

Multimedia alert tone: (Multiziñu signàls) — pieskarieties 
, lai izvºlºtos multiziñu sañem¹anas signàlu. Ja nav 

izvºlºta iespºja Message alerts:, ¹ï iespºja nav pieejama.

E-mail alert tone (E-pasta signàls) — pieskarieties , lai 
izvºlºtos e-pasta ziñu sañem¹anas signàlu. Ja nav 
izvºlºta iespºja Message alerts:, ¹ï iespºja nav pieejama.

Key tones: (Taustiñu toñi) — uzstàdiet taustiñu klik¹óu 
ska¶umu.

Touch screen tones: (Skàrienekràna toñi) — uzstàdiet, cik 
ska¶u skañu rada pieskar¹anàs displejam.

Warning tones: (Brïdinàjuma toñi) — viedtàlrunis atskaño 
informatïvu signàlu, ja, piem., akumulatorà beidzas 
ener»ija.

Lai aizvºrtu dialogu un atsauktu visas veiktàs izmaiñas, 
nospiediet .
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Messaging (Ziñapmaiña)
Atveriet Desk (Darbvirsma) > Messaging (Ziñapmaiña).

Programmà Messaging var veidot, sþtït, sañemt, apskatït, 
redi»ºt un kàrtot da¾àda veida ziñas: ïsziñas, multiziñas, 
e-pasta ziñas un viedziñas — ïpa¹as informatïvas ïsziñas ar 
datu saturu. Ziñas un datus var sañemt arï, izmantojot 
Bluetooth, kà arï sañemt WAP pakalpojumu ziñas, ¹þnu 
apraides ziñas un nosþtït pakalpojumu komandas.

17. attºls. Messaging

Piezïme. Multiziñas var sañemt un paràdït tikai ierïcºs, 
kuràs ir nodro¹inàta saderïgu multiziñu vai e-pasta 
funkcija.

Padoms. Lai varºtu sþtït un sañemt e-pasta ziñas un 
multiziñas, jànoràda interneta piek¶uves punkta 
uzstàdïjumi. Sk. “Interneta piek¶uves punkta 
uzstàdï¹ana” 114. lpp. Atkarïbà no izmantotàs SIM 

kartes veida ¹ï ierïce, iespºjams, var automàtiski 
pievienot pareizos WWW pàrlþko¹anas un MMS 
uzstàdïjumus.

Padoms. Ziñu var sàkt veidot jebkurà programmà, kurà 
ir piedàvàta iespºja Send (Sþtït) vai izvºlnes komanda 
Send. Izvºlieties failu (attºlu, tekstu), kur¹ jàpievieno 
ziñai, un pieskarieties Send.

Padoms. Ja ziñu nosþtïtu ziñu redi»º¹anas skatà, ja 
laukà To: (Kam) ir ievadïta pareiza adrese, nospiediet 

, lai ziñu nosþtïtu.

Lai galvenajà logà pielàgotu komandu pogas, 
nospiediet , izvºlieties Display (Ràdït) > Command 
bar buttons... (Komandu joslas pogas), izvºlieties katrai 
pogai atbilsto¹o komandu un pieskarieties OK (Labi).

Lai kàrtotu ziñas, nospiediet , izvºlieties Display > 
Sort... (Kàrtot). Izvºlieties piemºrotàko kàrto¹anas 
metodi un secïbu un pieskarieties OK.

Sañemtàs ziñas 
Ikonas noràda ziñas veidu, prioritàti un iespºjamos 
pielikumus. Var tikt paràdïtas ¹àdas ikonas:

Jauna e-pasta ziña attàlajà pastkastº

Jauna ïsziña
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Jauna multiziña

Jauns kalendàra aicinàjums

Nelasïta e-pasta ziña

Augstas prioritàtes e-pasta ziña

Zemas prioritàtes e-pasta ziña attàlajà 
pastkastº

Pielikums

Ziñu statusi izsþtnº
E-pasta ziñàm un ïsziñàm izsþtnº var bþt ¹àds statuss:

Sending (Sþta) — ziña  pa¹laik tiek sþtïta.

On request (Pºc pieprasïjuma) — e-pasta ziña vai ïsziña 
tiek nosþtïta tikai tad, ja skatà Outbox pieskaraties 
iespºjai Send (Sþtït).

Waiting (Gaida) — ïsziña ir ievietota rindà un tiks nosþtïta, 
tiklïdz tas bþs iespºjams. Piem., ziña var tikt ievietota 
rindà, ja viedtàlrunis ir ieslºgts, bet gaida, kad bþs 
pietiekami spºcïgs signàls vai tiks pabeigts iepriek¹ºjais 
tàlruña zvans. E-pasta ziñu statuss Waiting nozïmº, ka 
ziña tiks nosþtïta nàkamreiz, kad izveidosit savienojumu 
ar attàlo pastkasti. 

Failed (Neizdevàs) — ziñu nevarºja nosþtït.

Deferred (Atlikts) — ziñas sþtï¹anu esat apturºjis. Ziñas 
sþtï¹anu var atsàkt, skatà Outbox pieskaroties iespºjai 
Send (Sþtït).

Mapes
Atverot programmu Messaging, var redzºt pºdºjàs 
atvºrtàs mapes saturu.

Lai atvºrtu citu mapi, nospiediet  un izvºlieties 
Folders (Mapes). Ir ¹àdas mapes:

Inbox (Sañemtàs ziñas) — tajà ir sañemtàs ziñas, izñemot 
¹þnu apraides ziñas.

Outbox (Izsþtne) — ïslaicïga novietne ziñàm, kuras gaida 
nosþtï¹anu. Piem., ziñas tiek ievietotas mapº Outbox, ja 
viedtàlrunis atrodas àrpus tïkla pàrklàjuma. Varat arï 
ieplànot, lai e-pasta ziñas tiktu nosþtïtas nàkamajà reizº, 
kad tiek izveidots savienojums ar attàlo pastkasti. 
Pieskarieties Defer sending (Atlikt sþtï¹anu), lai ziña tiktu 
aizturºta mapº Outbox.

Drafts (Melnraksti) — tajà ir melnraksta ziñas, kuras vºl nav 
nosþtïtas.

Sent (Nosþtïtàs) — tajà tiek glabàtas nosþtïtàs ziñas. 
Ievºrojiet, ka ziñas vai dati, kuri nosþtïti, izmantojot 
Bluetooth savienojumu, netiek saglabàti mapº Sent.

 Remote mailbox (Attàlà pastkaste) — atverot ¹o 
mapi, varat izveidot savienojumu ar attºlo pastkasti, lai 
ielàdºtu jaunàs e-pasta ziñas, vai bezsaistº apskatït 
iepriek¹ ielàdºtàs ziñas. Sk. “E-pasta ziñas” 49. lpp.

Lai izveidotu jaunu mapi, nospiediet  un 
izvºlieties Tools (Rïki) > Manage folders... (Darbs ar 
mapºm). Pieskarieties New (Jauna) un pie¹óiriet 
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jaunajai mapei nosaukumu. Ziñas varat kàrtot ¹ajàs 
mapºs.

Lai pàrdºvºtu vai izdzºstu mapes, nospiediet  un 
izvºlieties Tools > Manage folders... Ievºrojiet, ka 
noklusºjuma mapes nevar izdzºst.

E-pasta ziñas
Lai varºtu sañemt un nosþtït e-pasta ziñas, jàuzstàda 
attàlàs pastkastes pakalpojums. ©o pakalpojumu piedàvà 
interneta pakalpojumu sniedzºjs, tïkla pakalpojumu 
sniedzºjs vai uzñºmums, kurà stràdàjat.

Attàlàs pastkastes uzstàdï¹ana
1 Programmas Messaging galvenajà skatà nospiediet 

 un izvºlieties Tools > New mailbox... (Jauna 
pastkaste). Pieskarieties Next (Tàlàk).

2 Pastkastes uzstàdï¹anas vednï noràdiet ¹àdus 
uzstàdïjumus:
Mailbox name: (Pastkastes nosaukums) — ievadiet 
raksturojo¹u attàlàs pastkastes nosaukumu.
Mailbox type: (Pastkastes veids) — izvºlieties attàlàs 
pastkastes pakalpojumu sniedzºja ieteikto e-pasta 
protokolu. Ievºrojiet, ka ¹o uzstàdïjumu var izvºlºties 
tikai vienu reizi; tas vairs nav mainàms, ja esat 
saglabàjis uzstàdïjumus vai izgàjis no pastkastes 
uzstàdïjumiem. Pieskarieties Next.
Name: (Vàrds) — ievadiet savu vàrdu.

User name: (Lietotàjvàrds) — ievadiet savu 
pakalpojumu sniedzºja izsniegto lietotàjvàrdu. 
Password: (Parole) — ievadiet paroli. Ja ¹o lauku 
neaizpilda, parole tiks prasïta, veidojot savienojumu ar 
attàlo pastkasti.
My e-mail address: (Mana e-pasta adrese) — ievadiet 
savu pakalpojumu sniedzºja izsniegto e-pasta adresi. 
Adresº jàbþt rakstzïmei @. Atbildes uz jþsu ziñàm tiek 
sþtïtas uz ¹o adresi. Pieskarieties Next.
Incoming server (POP3): vai Incoming server (IMAP4): 
(Ienàko¹o ziñu serveris (POP3 vai IMAP4)) — jþsu 
e-pastu sañemo¹à datora IP adrese vai hostdatora 
vàrds.
Outgoing server (SMTP): (Izejo¹o ziñu serveris (SMTP)) — 
jþsu e-pasta ziñu sþto¹à datora IP adrese vai 
hostdatora vàrds. Pieskarieties Next.

3 Kad ir noràdïti ¹o iespºju uzstàdïjumi, pieskarieties 
Finish (Beigt), lai atgrieztos programmà Messaging, 
vai pieskarieties Advanced (Papildu), lai noràdïtu 
e-pasta ziñu papilduzstàdïjumus. Pla¹àku informàciju 
sk. sada¶à “E-pasta papilduzstàdïjumi” 49. lpp.
Lai redi»ºtu attàlàs pastkastes uzstàdïjumus, 
nospiediet  un izvºlieties Tools > Message settings 
(Ziñu uzstàdïjumi) > E-mail... (E-pasts). Izvºlieties 
redi»ºjamo pastkasti, pieskarieties Edit (Redi»ºt) un 
veiciet iepriek¹ aprakstïtàs izmaiñas. Ievºrojiet — ja ir 
aktïvs savienojums ar attàlo pastkasti, pastkastes 
uzstàdïjumus nevar redi»ºt.

Lai pastkasti noràdïtu kà galveno pastkasti, 
nospiediet  un izvºlieties Tools > Message settings 
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> E-mail... Izvºlieties pastkasti, kura jàuzstàda kà 
galvenà pastkaste, un pieskarieties Set as default 
(Uzstàdït kà galveno).

E-pasta papilduzstàdïjumi
Kad pastkastes uzstàdï¹anas vednï Mailbox setup wizard 
esat noràdïjis vai redi»ºjis uzstàdïjumus (atveriet 
programmu Messaging (Ziñapmaiña), nospiediet , 
izvºlieties Tools (Rïki) > Message settings (Ziñu uzstàdïjumi) 
> E-mail... (E-pasts)), varat konfigurºt arï pastkastes 
papilduzstàdïjumus.

Lapa Retrieval (Ielàde)
Retrieve: (Ielàdºt) — noràda, kas jàielàdº no attàlàs 
pastkastes, kad tiek izveidots savienojums. Iespºja 
Messages (Ziñas) ir pieejama tikai tad, ja pastkastes veids 
ir IMAP4.

E-mail size limit: (E-pasta maksimàlais lielums) — noràdiet 
ziñu lielumu, par kuru lielàkas ziñas neielàdº, kad 
izvºlaties komandu E-mail > Retrieve and send (Ielàdºt un 
sþtït). Mazàkà iespºjamà vºrtïba ir 1 KB, bet lielàkà — 
1000 KB. Ja ziñas lielums pàrsniedz maksimàlo, tiek 
ielàdºts vienïgi ziñas virsraksts.

No. of e-mails to retrieve: (Ielàdºjamo e-pasta ziñu skaits) — 
noràdiet, cik jaunu ziñu virsrakstu jàràda sañemto ziñu 
mapº. Ja sañemat jaunus virsrakstus un virsrakstu 
kopºjais skaits mapº Inbox (Sañemtàs ziñas) pàrsniedz 
maksimàlo, tiek izdzºsti vecàkie virsraksti. ©ï iespºja ir 
pieejama tikai tad, ja pastkastes veids ir IMAP4.

Password authentication: (Paroles autentifikàcija) — to 
izmanto kopà ar protokolu POP3, lai ¹ifrºtu paro¶u 
sþtï¹anu uz attàlo pasta serveri.

Retrieve e-mails to inbox: (Ielàdºt e-pasta ziñas sañemto 
ziñu mapº) — izvºlieties, lai no ¹ï konta sañemtu ziñas 
sañemto ziñu mapº. Ja ¹ï iespºja nav izvºlºta, ziñas tiek 
sañemtas atsevi¹óàs pastkastes mapºs, kas neatrodas 
sañemto ziñu mapº.

Lapa Sending (Sþtï¹ana)
Default e-mail format: (Noklusºjuma e-pasta formàts) — 
pasta sþtïjumu veids, kàdà varat ¹ajà viedtàlrunï rakstït un 
no tàs sþtït.

Send e-mail: (Sþtït e-pastu) — kà e-pasta ziñas tiek sþtïtas 
no viedtàlruña.

Include original in reply: (Atbildº iek¶aut ori»inàlu) — 
izvºlieties, lai atbildº uz ziñu iek¶autu atsþtïto ziñu.

Request read report: (Pieprasït lasï¹anas atskaiti) — 
izvºloties ¹o iespºju, sañemat paziñojumu, ka adresàts ir 
ziñu atvºris. ©àdu paziñojumu var sañemt tikai tad, ja 
adresàta e-pasta programma nodro¹ina ¹àdu funkciju.

Lapa Outgoing server (SMTP) (Izejo¹ais serveris 
(SMTP))
Authentication required: (Obligàta autentifikàcija) — 
izvºlieties ¹o iespºju, ja SMTP (Simple Mail Transfer 
Protocol — vienkàr¹ais pasta pàrsþtï¹anas protokols) 
serveris pieprasa autentifikàciju. Atsevi¹ói serveri pirms 
e-pasta sþtï¹anas pieprasa lietotàja autentifikàciju.
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User name: (Lietotàjvàrds) — ievadiet savu lietotàjvàrdu 
SMTP serverim.

Password: (Parole) — ievadiet savu paroli SMTP serverim.

Lapa Other (Citi uzstàdïjumi)
Security (Dro¹ïba) — noràdiet servera dro¹ïbas protokolu.

Incoming e-mail port: (Ienàko¹à e-pasta ports) — ievadiet 
ienàko¹à pasta servera porta numuru. Noklusºjuma vºrtïba 
parasti nav jàmaina.

Outgoing e-mail port: (Izejo¹à e-pasta ports) — ievadiet 
izejo¹à pasta servera porta numuru. Noklusºjuma vºrtïba 
parasti nav jàmaina.

Access point in use: (Izmantotais piek¶uves punkts) — 
izvºlieties, vai savienojums jàveido, izmantojot kàdu no 
piedàvàtajiem piek¶uves punktiem vai piek¶uves punktu 
noràdot pirms katra savienojuma izveides.

Set as default mailbox: (Uzstàdït kà noklusºjuma 
pastkasti) — ja tiek atzïmºta ¹ï izvºles rþtiña, ¹ï pastkaste 
k¶þst par noklusºjuma pastkasti.

E-pasta ziñu ielàde no pastkastes
Padoms. Lai atbrïvotu vietu atmiñà, regulàri izdzºsiet 
no viedtàlruña vai pàrvietojiet uz citurieni e-pasta 
ziñas.

Jums sþtïtàs e-pasta ziñas automàtiski sañem nevis 
viedtàlrunis, bet gan jþsu attàlà pastkaste. Lai izlasïtu 
e-pasta ziñas, vispirms izveidojiet savienojumu ar attàlo 

pastkasti un pºc tam izvºlieties ziñas, kuras ielàdºsit 
viedtàlrunï. Savienojums ar attàlo pastkasti tiek izveidots, 
izmantojot datu zvanu.

Visas ziñas tiek sañemtas attàlàs pastkastes mapºs, ja 
vien neesat noràdïjis, ka ziñas jàsañem mapº Inbox 
(Sañemtàs ziñas).

Padoms. Kà noràdït e-pasta ielàdes iespºjas, sk. 
sada¶à “E-pasta papilduzstàdïjumi” 50. lpp.

Lai ielàdºtu e-pasta ziñas no attàlàs pastkastes, 
nospiediet  un izvºlieties E-mail (E-pasts) > 
Retrieve and send (Ielàdºt un sþtït). Izvºlieties 
atbilsto¹o komandu, lai iegþtu e-pasta ziñas no visàm 
pastkastºm vai no izvºlºtàs pastkastes. Ievºrojiet — ja 
mapº Outbox ir ievietotas ziñas, tàs tiek nosþtïtas lïdz 
ar ziñu ielàdi.

Padoms. Ja attàlàs pastkastes uzstàdïjumos 
nenoràdïjàt paroli, tà tiek prasïta, veidojot 
savienojumu ar attàlo pastkasti. Atvºrtajà dialogà 
ievadiet paroli un pieskarieties OK (Labi).

Lai ielàdºtu izvºlºtàs ziñas saturu, nospiediet  un 
izvºlieties E-mail > Retrieve e-mail contents (Ielàdºt 
e-pasta ziñas saturu).

Lai atvienotos no pastkastes, nospiediet  un 
izvºlieties E-mail > Disconnect from Internet 
(Atvienoties no interneta). Datu zvans tiek beigts.

Padoms. Lai iegþtu izvºlºtas e-pasta ziñas saturu, 
pieskarieties ziñai. Ziñas saturs tiek ielàdºts 
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viedtàlrunï, un, ja attàlajà pastkastº ir jaunas ziñas, 
vienlaikus tiek atjauninàts arï ziñu saraksts.

E-pasta ziñu lasï¹ana un atbildº¹ana uz 
tàm

Lai atvºrtu mapi Inbox vai jebkuru citu mapi, 
nospiediet  un izvºlieties Folders (Mapes) > Inbox/
Outbox/Drafts/Sent vai attàlàs pastkastes nosaukumu, 
ja tàds ir.

Lai atvºrtu ziñu, veiciet dubultpieskàrienu tai. Ziñà 
iek¶autu Web saiti var atvºrt, tai pieskaroties.

Padoms. E-pasta sþtïtàjam var izveidot jaunu 
kontakta kartïti. Nospiediet  un izvºlieties Tools 
(Rïki) > Add to Contacts... (Pievienot kontaktiem).

Lai atvºrtu ziñas pielikumu, veiciet 
dubultpieskàrienu pielikumam. Ievºrojiet, ka 
pielikumos var bþt vïrusi vai citi kaitïgi elementi. 
Vienmºr pàrliecinieties, vai sþtïtàjam varat uzticºties. 
Lai pielikumu saglabàtu, atlasiet to un pieskarieties 
Save (Saglabàt).

Lai atbildºtu uz ziñu pºc tàs izlasï¹anas, pieskarieties 
iespºjai Reply (Atbildºt). Lai atbildºtu visiem 
sañºmºjiem, ne tikai e-pasta ziñas sþtïtàjam, 
nospiediet  un izvºlieties Message (Ziña) > Reply to 
all (Atbildºt visiem).

Atbildot uz e-pasta ziñu, HTML formàta ziñas tiek 
iek¶autas kà pielikumi.

Padoms. Kà noràdït e-pasta sþtï¹anas iespºjas, sk. 
sada¶à “E-pasta papilduzstàdïjumi” 50. lpp.

Lai pàrsþtïtu e-pasta ziñu, nospiediet  un 
izvºlieties Message (Ziña) > Forward (Pàrsþtït).

Lai ziñu izdzºstu no mapes Inbox vai attàlàs 
pastkastes, pieskarieties Delete (Delete). Ja 
nepiecie¹ams, noràdiet, vai ziña jàizdzº¹ tikai no 
viedtàlruña vai gan no viedtàlruña, gan e-pasta 
servera.

E-pasta ziñu sþtï¹ana
1 Nospiediet  un programmas Messaging galvenajà 

skatà izvºlieties Message > Create (Izveidot) > E-mail 
(E-pasts).

2 Ievadiet e-pasta adresi laukà To: (Kam). Adresàtus 
atdaliet ar semikolu (;).
Ja adresàts ir iek¶auts kontaktu katalogà, pieskarieties 

. Sarakstà izvºlieties adresàtu un pieskarieties Add 
(Pievienot). Kad izvºlºti visi adresàti, pieskarieties 
Done (Gatavs).

3 Aizpildiet lauku Subject (Tºma) un uzrakstiet ziñas 
tekstu. Pieskarieties Send (Sþtït).
Padoms. Tekstlodziñà vai dokumentà e-pasta adresi 
var izmantot kà hipersaiti. Pieskarieties ar irbuli adresei 
vai ar ritinà¹anas taustiña palïdzïbu ievietojiet tajà 
kursoru; tà k¶þst par saiti ar nelielu ikoniñu. 
Pieskarieties ikonai, lai atvºrtu e-pasta redaktoru.
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Ja ievadïtais adresàta vàrds atbilst vairàkiem vàrdiem vai ja 
personai ir vairàkas e-pasta adreses, sarakstà izvºlieties 
pareizo vàrdu vai e-pasta adresi un pieskarieties OK (Labi).

Padoms. Vienà reizº var izvºlºties vairàkas 
kontaktpersonas. Sk. “Bie¾àkàs darbïbas programmàs” 
22. lpp.

Lai pasta ziñu redaktorà tiktu ràdïti lauki Cc: 
(Kopija) un Bcc: (Diskrºtà kopija), nospiediet  un 
izvºlieties Display (Ràdït) > Cc field (Kopijas lauks) Bcc 
field (Diskrºtàs kopijas lauks). Ja laukà Cc: ievietojat 
adresàtu, viñam tiek nosþtïta ziñas kopija un adresàta 
vàrdu var redzºt pàrºjie ziñas sañºmºji. Ja laukà Bcc: 
ievietojat adresàtu, viñam tiek nosþtïta ziñas kopija, 
bet pàrºjie ziñas sañºmºji nevar redzºt adresàta vàrdu.

Lai saglabàtu, bet nenosþtïtu  tikko uzrakstïtu 
e-pasta ziñu, pieskarieties Close (Aizvºrt). Ziña tiek 
saglabàta mapº Drafts (Melnraksti). Saglabàtà ziña 
aizstàj tàs pa¹as ziñas iepriek¹ saglabàto versiju.

Lai noràdïtu konkrºtàs e-pasta ziñas sþtï¹anas 
iespºjas, pieskarieties Sending options (Sþtï¹anas 
iespºjas). Ievºrojiet, ka visas ¹ajà dialogà veiktàs 
izmaiñas tiek attiecinàtas tikai uz konkrºto e-pasta 
ziñu, kuru gatavojaties nosþtït, un ietekmº ziñas 
formàtu, adresàtam to atverot. Piem., formàts var 
ietekmºt rakstzïmju salasàmïbu. Noràdiet vajadzïgos 
uzstàdïjumus.

Priority: (Prioritàte) — ziñas svarïguma pakàpe.

E-mail format: (E-pasta formàts) — ziñas formatºjuma 
stils. Izvºlieties Formatted text (HTML) (Formatºts teksts 
(HTML)), lai varºtu lietot papla¹inàtas teksta 
formatº¹anas iespºjas. Izvºlieties Plain text (Vienkàr¹s 
teksts), lai izmantotu standarta interneta formàtu, vai 
Plain text (no MIME) (Parasts teksts bez MIME), ja zinàt, 
ka sañemo¹à e-pasta sistºma nevar paràdït e-pasta 
ziñu, kas nosþtïta standarta interneta formàtà.

Request read report: (Pieprasït atskaiti par lasï¹anu) — 
izvºlieties ¹o iespºju, lai sañemtu ziñu, tiklïdz adresàts 
ir atvºris jþsu sþtïjumu.

Mailbox in use: (Izmantotà pastkaste) — attàlà 
pastkaste, kura tiek izmantota ¹ïs ziñas sþtï¹anai.

Send e-mail: (Sþtït e-pasta ziñu) — noràdiet, kad ziña 
jànosþta. Immediately (Tþlït) nozïmº, ka ziña tiek 
nosþtïta cik àtri vien iespºjams, ja ir izveidots 
savienojums ar attàlo pastkasti. Ja savienojums nav 
izveidots, tiek mº»inàts to izveidot. Iespºja When 
connection available (Kad savienojums ir pieejams) 
nozïmº, ka e-pasta ziña tiek nosþtïta, kad nàkamreiz 
izveidojat savienojumu ar attàlo pastkasti. Iespºja On 
request (Pºc pieprasïjuma) nozïmº, ka, pieskaroties 
Send (Sþtït), ziña tiek saglabàta mapº Outbox. Ziña 
tiek nosþtïta tad, kad mapº Outbox atlasàt to un 
pieskaraties Send.
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E-pasta ziñu stils
Teksta un rindkopu formatº¹ana ir iespºjama tikai tad, ja 
pa¹reizºjàs e-pasta ziñas sþtï¹anas iespºjai E-mail format: 
(E-pasta formàts) ir noràdïts Formatted text (HTML) 
(Formatºts teksts (HTML)).

Lai formatºtu atlasïto tekstu, nospiediet  un 
izvºlieties Format (Formatºt) > Font... (Fonts). Rïkjoslà 
ekràna lejasda¶à arï ir iek¶auti teksta redi»º¹anas rïki. 
Ja rïkjosla nav redzama, nospiediet  un izvºlieties 
Display (Ràdït) > Toolbar (Rïkjosla).

Lai lïdzinàtu atlasïtàs rindkopas, nospiediet  un 
izvºlieties Format > Alignment (Lïdzinàjums) > Left (Pa 
kreisi), Right (Pa labi) vai Centred (Centrà).

Grafiks 
Varat noràdït, kad un cik bie¾i viedtàlrunim jàmº»ina 
izveidot savienojumu ar attàlo pastkasti, lai nosþtïtu vai 
sañemtu e-pasta ziñas.

Lai noràdïtu e-pasta grafiku, nospiediet , 
izvºlieties E-mail (E-pasts) > Auto-retrieve and send... 
(Automàtiski ielàdºt un nosþtït) un pieskarieties Edit 
(Redi»ºt). Noràdiet sañem¹anas un sþtï¹anas sàkuma 
laiku, beigu laiku un intervàlu: Pieskarieties  un 
pieskarieties  un , lai mainïtu laiku. Ja izmantojat 
12 stundu pulksteña formàtu, pºc vajadzïbas 
pieskarieties laukam am/pm (priek¹pusdienà/
pºcpusdienà). Logà Days: (Dienas) iezïmºjiet nedº¶as 

dienas, kad jàveido savienojums. Pieskarieties OK 
(Labi).

Lai grafiku aktivizºtu vai deaktivizºtu, nospiediet 
, izvºlieties E-mail > Auto-retrieve and send... un 

atzïmºjiet vai notïriet savienojuma izvºles rþtiñu, tàdà 
veidà aktivizºjot vai deaktivizºjot tà izveides grafiku.

Piezïme. Ja nav nepiecie¹ams, neatstàjiet ¹o iespºju 
aktivizºtu. Katru reizi, kad ierïce izveido savienojumu, 
iespºjams, par to ir jàmaksà.

E-pasta ziñu pielikumi
Lielàko da¶u dokumentu un citàs viedtàlruña programmàs 
izveidoto ziñu var nosþtït kà e-pasta pielikumus. 

Svarïgi! E-pasta ziñàs var bþt vïrusi vai tàs var citàdi 
kaitºt jþsu ierïcei vai personàlajam datoram. Neatveriet 
pielikumus, ja neesat pàrliecinàts par sþtïtàja uzticamïbu.

Lai pievienotu e-pasta pielikumus, e-pasta redaktorà 
nospiediet  un izvºlieties Attachment (Pielikums) > 
Attach file (Pievienot failu). Atrodiet un atlasiet failu, 
kur¹ jàpievieno e-pasta ziñai.

Padoms. Lai kà pielikumu pievienotu savu kontakta 
kartïti, nospiediet  un izvºlieties Attachment > 
Attach 'My contact card' (Pievienot manu kontakta 
kartïti).

Lai apskatïtu pielikumus, atveriet sañemto vai sþtïto 
e-pasta ziñu, kurai ir pielikumi, un veiciet 
dubultpieskàrienu pielikuma ikonai ziñas beigàs. Ja 
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sistºma neatpazïst pielikuma faila formàtu, tiek ràdïta 
jautàjuma zïmes ikona. 

Lai saglabàtu pielikumus, atveriet e-pasta ziñu, kurai 
ir pielikumi, atlasiet pielikumu ziñas beigàs un 
pieskarieties Save (Saglabàt).

Lai e-pasta ziñas veido¹anas laikà izdzºstu 
pielikumu, atlasiet pielikumu ziñas beigàs, nospiediet 

 un izvºlieties Attachment > Remove (Noñemt).

Paraksti
Lai izveidotu e-pasta konta parakstu, nospiediet , 
izvºlieties E-mail > Signatures... (Paraksti), pieskarieties 
Edit un parakstieties. Izvºlieties Attach 'My contact card': 
(Pievienot manu kontakta kartïti), lai visàm sþtïtajàm 
e-pasta ziñàm tiktu pievienota jþsu kontakta kartïte.

Lai aktivizºtu vai deaktivizºtu e-pasta konta 
parakstu, nospiediet , izvºlieties E-mail > 
Signatures... un atzïmºjiet vai notïriet parakstu izvºles 
rþtiñas. Lai parakstu varºtu aktivizºt, tam ir jàbþt 
izveidotam.

Ïsziñas
Ïsziñu pakalpojums (Short Message Service — SMS) ¶auj 
sþtït un sañemt ïsziñas digitàlajà bezvadu tïklà.

Ïsziñu sþtï¹ana
1 Programmas Messaging galvenajà logà pieskarieties 

New text message (Jauna ïsziña).
2 Ievadiet tàlruña numuru laukà To: (Kam). Adresàtus 

atdaliet ar semikolu (;).
Ja adresàts ir iek¶auts kontaktu katalogà, pieskarieties 

. Sarakstà izvºlieties adresàtu un pieskarieties Add 
(Pievienot). Kad izvºlºti visi adresàti, pieskarieties 
Done (Gatavs).

3 Ievadiet ziñas tekstu un pieskarieties Send (Sþtït). 
Ïsziñà var iek¶aut tikai neformatºtu, vienkàr¹u tekstu. 
Padoms. Ja sþtàt ïsziñas, kuràs ir speciàlàs rakstzïmes 
vai uzsvara zïmes, ievºrojiet, ka ne visi tàlruñi 
nodro¹ina speciàlo rakstzïmju izmanto¹anu.

©is viedtàlrunis nodro¹ina iespºju sþtït ïsziñas, kuru 
garums pàrsniedz 160 rakstzïmju standarta limitu. Ja 
ïsziña ir garàka par 160 rakstzïmºm, tà tiek nosþtïta kà 
divu vai vairàku ziñu virkne.

Rakstzïmju skaitïtàjs ïsziñas loga lejasda¶à ràda, cik 
rakstzïmju konkrºtajà brïdï jau ievadïtas. Ja rakstzïmju 
skaits pàrsniedz 160, tiek paràdïts arï, cik ïsziñàs tiks 
nosþtïta konkrºtà ïsziña. 

Ja ïsziñà ir speciàlàs rakstzïmes, indikators neràda precïzu 
ziñas garumu.

Rakstzïmes, kas neietilpst latïñu alfabºtà, vai speciàlàs 
(unikoda) rakstzïmes, piem., à, º, è, ¶, aizñem vairàk vietas. 
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Ievºrojiet arï to, ka ziñas sþtï¹ana vairàkàs da¶às var 
izmaksàt dàrgàk nekà vienas ïsziñas nosþtï¹ana.

Lai noràdïtu konkrºtàs ziñas sþtï¹anas iespºjas, 
pieskarieties Sending options (Sþtï¹anas iespºjas). 
Ievºrojiet, ka visas ¹ajà dialogà veiktàs izmaiñas tiek 
attiecinàtas tikai uz konkrºto ziñu, kuru gatavojaties 
nosþtït. Noràdiet vajadzïgos uzstàdïjumus.

Lapa General (Vispàrïgie uzstàdïjumi)
Message centre in use: (Izmantotais ïsziñu centrs) — 
izvºlieties, kur¹ ïsziñu centrs jàizmanto ïsziñu sþtï¹anai.

Receive report: (Atskaite par sañem¹anu) — izvºloties ¹o 
iespºju, programmà Log (®urnàls) var apskatït nosþtïtàs 
ziñas statusu (tïkla pakalpojums). Ja ¹o izvºles rþtiñu 
neatzïmº, programmà Log tiek ràdïts tikai statuss Sent 
(Nosþtïta).

Send message: (Sþtït ïsziñu) — noràdiet, kad ïsziña 
jànosþta. Iespºja On request (Pºc pieprasïjuma) nozïmº, ka, 
pieskaroties Send (Sþtït), ziña tiek saglabàta mapº 
Outbox. Ziña tiek nosþtïta tad, kad mapº Outbox atlasàt 
to un pieskaraties Send.

Lapa Advanced (Papildu uzstàdïjumi)
Message validity: (Ïsziñas derïgums) — ja derïguma perioda 
laikà ïsziñas adresàts nav sasniedzams, ïsziña tiek dzºsta 
no ïsziñu centra (tïkla pakalpojums). Ievºrojiet, ka ¹ai 
funkcijai nepiecie¹ams tïkla nodro¹inàjums. Maximum 
time (Maksimàlais laiks) ir ilgàkais tïkla at¶autais laiks.

Reply via same centre: (Atbildºt, izmantojot to pa¹u 
centru) — izvºlieties ¹o iespºju, lai atbildes ziña tiktu 
nosþtïta, izmantojot to pa¹u ïsziñu centra numuru (tïkla 
pakalpojums).

Message sent as: (Ïsziña jàsþta kà) — ¹ïs iespºjas 
uzstàdïjumu mainiet tikai tad, ja esat pàrliecinàts, ka 
ïsziñu centrs spºj ïsziñas konvertºt citos formàtos. 
Sazinieties ar tïkla operatoru.

Ïsziñu sañem¹ana
Ïsziñas tiek sañemtas automàtiski, ja ¹is pakalpojums ir 
pieejams un viedtàlrunis ir ieslºgts un atrodas tïkla 
pàrklàjuma zonà.

Ja tiek sañemta jauna ïsziña, atskan signàls (izñemot 
gadïjumus, kad viedtàlrunï ir aktivizºts profils Silent) un 
displejà tiek paràdïts dialogs. Lai atvºrtu ziñu, pieskarieties 
Open (Atvºrt). Lai atvºrtu ziñu mapº Inbox, veiciet ziñai 
dubultpieskàrienu.

Padoms. Lai ïsziñas sþtïtàjam izveidotu kontakta 
kartïti, nospiediet  un izvºlieties Tools (Rïki) > Add 
to Contacts... (Pievienot kontaktu katalogam).

Lai atbildºtu uz ïsziñàm, atveriet atsþtïto ziñu un 
nospiediet Reply (Atbildºt). Ievadiet atbildes tekstu un 
pieskarieties Send. Atsþtïtà ziña tiek iek¶auta atbildº, 
ja ïsziñu uzstàdïjumos esat atzïmºjis izvºles rþtiñu 
Include original in reply: (Atbildº iek¶aut ori»inàlu).

Lai pàrvietotu, kopºtu vai izdzºstu ziñas no SIM 
kartes, nospiediet  un izvºlieties Message (Ziña) > 
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SIM messages... (SIM ziñas). Atlasiet ziñas un 
pieskarieties atbilsto¹ajai pogai.

Ïsziñu uzstàdïjumi
Visas izmaiñas, kuras veicat ïsziñu uzstàdïjumos, ietekmº 
ïsziñu sþtï¹anas un sañem¹anas veidu.

Programmas Messaging galvenajà skatà nospiediet  un 
izvºlieties Tools > Message settings (Ziñu uzstàdïjumi) > Text 
message... (Ïsziña). Noràdiet vajadzïgos uzstàdïjumus.

Lapa General (Vispàrïgie uzstàdïjumi)
Message centre in use: (Izmantotais ïsziñu centrs) — 
izvºlieties, kur¹ ïsziñu centrs jàizmanto ïsziñu sþtï¹anai.

Receive report: (Atskaite par sañem¹anu) — izvºloties ¹o 
iespºju, programmà Log (®urnàls) var apskatït nosþtïtàs 
ziñas statusu (tïkla pakalpojums). Ja ¹o izvºles rþtiñu 
neatzïmº, programmà Log tiek ràdïts tikai statuss Sent 
(Nosþtïta).

Send message: (Sþtït ïsziñu) — noràdiet, kad ïsziña jànosþta. 
Iespºja On request (Pºc pieprasïjuma) nozïmº, ka, ziñu 
redaktora skatà pieskaroties iespºjai Send (Sþtït), ziña tiek 
saglabàta mapº Outbox. Ziña tiek nosþtïta tad, kad mapº 
Outbox atlasàt to un pieskaraties Send.

Lapa Advanced (Papildu uzstàdïjumi)
Message validity: (Ïsziñas derïgums) — ja derïguma perioda 
laikà ïsziñas adresàts nav sasniedzams, ïsziña tiek dzºsta 
no ïsziñu centra. Ievºrojiet, ka ¹ai funkcijai nepiecie¹ams 

tïkla nodro¹inàjums. Maximum time (Maksimàlais laiks) ir 
ilgàkais tïkla at¶autais laiks.

Reply via same centre: (Atbildºt, izmantojot to pa¹u 
centru) — izvºlieties ¹o iespºju, lai atbildes ziña tiktu 
nosþtïta, izmantojot to pa¹u ïsziñu centra numuru (tïkla 
pakalpojums). 

Include original in reply: (Atbildº iek¶aut ori»inàlu) — 
noràda, vai sañemtàs ziñas teksts tiek kopºts atbildes 
ïsziñà.

Preferred connection: (Vºlamais savienojums) — ïsziñas var 
sþtït, izmantojot parasto GSM tïklu vai GPRS 
pakalpojumu (ja to nodro¹ina tïkls).

Lai pievienotu jaunu ïsziñu centru, nospiediet  
un izvºlieties Tools (Rïki) > Message settings (Ziñu 
uzstàdïjumi) > Text message... (Ïsziña). Pieskarieties 
Msg. centres (Ïsziñu centri), pºc tam New (Jauns). 
Ievadiet ïsziñu centra nosaukumu un numuru. Numuru 
izsniedz pakalpojumu sniedzºjs. Atzïmºjiet izvºles 
rþtiñu Set as default centre: (Uzstàdït kà galveno 
centru), lai ïsziñu nosþtï¹anai vienmºr izmantotu ¹o 
ïsziñu centru.

Par ïsziñu pakalpojumiem
Ïsziñas var nosþtït un sañemt pat balss vai datu zvanu 
laikà. Ziñas var lasït jebkurà mobilajà tàlrunï, kurà ir tàda 
iespºja. Ja tàlrunis, kam jàsañem ïsziña, sþtï¹anas laikà ir 
izslºgts, ïsziñu centrs atkàrtoti mº»ina nosþtït ziñu, lïdz 
beidzas tïklà noteiktais ziñas derïguma laiks.
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Ja ïsziñà sþtàt tekstu, ko esat uzrakstïjis vai redi»ºjis cità 
programmà, zþd visi iegultie objekti un bagàtinàtais 
teksta formatºjums. Arï pielikumus nevar sþtït kà ïsziñas.

Multiziñas
Multiziña var ietvert tekstu, attºlus, videoklipus un/vai 
skañas klipus.

Autortiesïbu aizsardzïbas likumi, iespºjams, nepie¶auj 
atsevi¹óu attºlu, zvana melodiju un citu materiàlu 
kopº¹anu, modificº¹anu, pàrvieto¹anu vai pàrsþtï¹anu.

Multiziñu izveide
1 Nospiediet  un izvºlieties Message (Ziña) > Create 

(Izveidot) > Multimedia message (Multiziña).
2 Laukà To: (Kam) ievadiet adresàta tàlruña numuru. 

Adresàtus atdaliet ar semikolu (;).
Ja adresàts ir iek¶auts kontaktu katalogà, pieskarieties 

. Sarakstà izvºlieties adresàtu un pieskarieties Add 
(Pievienot). Kad izvºlºti visi adresàti, pieskarieties 
Done (Gatavs).

3 Ievadiet ziñas tekstu un pievienojiet multivides 
objektu. Lai ziñai pievienotu attºlus, skañas vai video 
klipus, izmantojiet rïkjoslu vai izvºlnes komandu Insert 
(Ielikt). Sïkàku informàciju skatiet tàlàk tekstà. Ja 
rïkjosla nav redzama, nospiediet  un izvºlieties 
Display (Ràdït) > Toolbar (Rïkjosla).

4 Kad ziña ir pabeigta, pieskarieties Send.

18. attºls. Multiziñu sþtï¹ana

Padoms. Multiziñàm var bþt vairàkas lapas. Lai 
pievienotu lapas, pieskarieties rïkjoslas ikonai  vai 
nospiediet  un izvºlieties Insert (Ielikt) > Page break 
(Lapas pàrtraukums). Ja, pievienojot lapu, kursors 
atrodas laukà To: (Kam), Cc: (Kopija) vai Subject: (Tºma), 
jaunà lapa k¶þst par ziñas pirmo lapu. Pretºjà gadïjumà 
jaunà lapa tiek ievietota pºc lapas, kurà atrodas 
kursors. Ievºrojiet, ka katrà lapà var bþt tikai viens 
video vai viens skañas klips. Taèu vienà ziñà var bþt 
vairàkas lapas ar video vai skañas klipu. ©is viedtàlrunis 
¶auj nosþtït un sañemt multiziñas, kuru lielums 
nepàrsniedz 100 kB. Kà ierobe¾ot multiziñu satura 
lielumu, sk. sada¶à par MMS uzstàdïjumiem “Lapa 
General (Vispàrïgie uzstàdïjumi)” 61. lpp.

Lai ziñà ieliktu eso¹u attºlu, skañas vai video klipu, 
izmantojiet rïkjoslu vai nospiediet  un izvºlieties 
Insert > Image... (Attºls), Track... (Dziesma) vai Media 
clip... (Multivides klips). Atrodiet objektu un 
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pieskarieties Insert, lai to pievienotu ziñai. Ievºrojiet, ka 
bezvadu sakaru tïkls var ierobe¾ot multiziñu lielumu. Ja 
ievietotais attºls ir lielàks par maksimàlo, viedtàlrunis 
to var samazinàt, lai varºtu nosþtït multiziñà.

Lai ziñai izveidotu jaunu attºlu, zïmºjumu vai skañas 
klipu, izmantojiet rïkjoslu vai nospiediet  un 
izvºlieties Insert > New image/Media clip... (Jauns attºls/
Multivides klips), New sketch... (Jauns zïmºjums) vai 
Sound clip... (Skañas klips). Tiek atvºrta atbilsto¹à 
programma. Pla¹àku informàciju sk. “Attºlu 
uzñem¹ana” 78. lpp., “Attºlu redi»º¹ana” 84. lpp. vai 
“Voice recorder (Balss ierakstï¹ana)” 96. lpp. 
Pieskarieties Insert, lai objektu pievienotu ziñai.

Ievºrojiet — ja da¾i izvºlnes Tools (Rïki) elementi nav 
pieejami vai ja, mº»inot ievietot multivides objektu, tiek 
paràdïts k¶þdas paziñojums, iespºjams, ka uzstàdïjumi ir 
pàràk ierobe¾oti. Pla¹àku informàciju sk. sada¶à par 
multivides uzstàdïjumiem “Lapa General (Vispàrïgie 
uzstàdïjumi)” 61. lpp.

Lai mainïtu teksta novietojumu attiecïbà pret attºlu 
vai videoklipu, atlasiet teksta lauku, nospiediet  un 
izvºlieties Tools (Rïki) > Page layout (Lapas izkàrtojums) 
> Place text on right (Tekstu novietot pa labi) vai Place 
text on left (Tekstu novietot pa kreisi). (Nav pieejams, ja 
izvºlºts Restricted mode: (Ierobe¾otais re¾ïms).)

Lai formatºtu tekstu, atlasiet to, velkot irbuli pàr 
tekstu, nospiediet  un izvºlieties Tools > Format 
text... (Formatºt tekstu). Varat arï vispirms izvºlºties 

formatºjumu un pºc tam sàkt rakstït. (Nav pieejams, ja 
izvºlºts Restricted mode: (Ierobe¾otais re¾ïms).)

Lai mainïtu ziñas fona kràsu, nospiediet  un 
izvºlieties Tools > Set background colour... (Uzstàdït fona 
kràsu). Pieskarieties kràsu lodziñam un izvºlieties 
jaunu kràsu. (Nav pieejams, ja izvºlºts Restricted mode: 
(Ierobe¾otais re¾ïms).)

Lai multivides objektiem pievienotu efektus, atlasiet 
objektu, nospiediet  un izvºlieties Tools > Transition 
settings... (Pàreju uzstàdïjumi). Varat noràdït, cik ilgi 
objekts tiek ràdïts un kà tiek atvºrts jauns objekts. (Nav 
pieejams, ja izvºlºts Restricted mode: (Ierobe¾otais 
re¾ïms).)

Multiziñu izskats var at¹óirties atkarïbà no sañemo¹às 
ierïces.

Lai no ziñas izdzºstu multivides objektu, atlasiet 
objektu, nospiediet  un izvºlieties Edit (Redi»ºt) > 
Delete (Dzºst). Izvºlieties atbilsto¹o komandu.

Padoms. Lai multiziñai pievienotu jaunas lapas, 
nospiediet  un izvºlieties Insert > Page break (Lapas 
pàrtraukums). Ja, pievienojot lapu, kursors atrodas 
laukà To: (Kam), Cc: (Kopija) vai Subject: (Tºma), jaunà 
lapa k¶þst par ziñas pirmo lapu. Pretºjà gadïjumà jaunà 
lapa tiek ievietota pºc lapas, kurà atrodas kursors.

Lai izdzºstu lapu, atveriet to, nospiediet  un 
izvºlieties Edit > Delete > Page (Lapa).
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Lai noràdïtu konkrºtàs ziñas sþtï¹anas iespºjas, 
nospiediet  un izvºlieties Tools (Rïki) > Sending 
options... (Sþtï¹anas iespºjas). Ievºrojiet, ka visas ¹ajà 
dialogà veiktàs izmaiñas tiek attiecinàtas tikai uz 
konkrºto ziñu, kuru gatavojaties nosþtït. Noràdiet 
vajadzïgos uzstàdïjumus.

Receive report: (Atskaite par sañem¹anu) — izvºlieties ¹o 
iespºju, lai sañemtu paziñojumu, kad ziña ir nogàdàta 
multiziñu centrà (tïkla pakalpojums). 

Message validity: (Ziñas derïgums) — ja derïguma perioda 
laikà ziñas adresàts nav sasniedzams, ziña tiek dzºsta 
no multiziñu centra (tïkla pakalpojums). Ievºrojiet, ka 
¹ai funkcijai nepiecie¹ams tïkla nodro¹inàjums. 
Maximum time (Maksimàlais laiks) ir ilgàkais tïkla 
at¶autais laiks.

Lai ziñu pirms nosþtï¹anas apskatïtu, nospiediet  un 
izvºlieties Message > Preview (Apskate).

Rïkjosla
Ja rïkjosla nav redzama, nospiediet  un izvºlieties 
Display (Ràdït) > Toolbar (Rïkjosla). 

1 Uzñemt attºlu vai ierakstït video.
2 Ierakstït skañas klipu vai ievietot eso¹u skañas klipu.
3 Izveidot zïmºjumu.
4 Ievietot attºlu.
5 Ievietot mþzikas klipu.

6 Ievietot videoklipu.
7 Ievietot lappuses pàrtraukumu.

Multiziñu sañem¹ana
Multiziñas tiek sañemtas mapº Inbox, un tàs var atvºrt, 
pàrsþtït vai uz tàm atbildºt tàpat kà uz citàm ziñàm.

Jums var tikt atsþtïtas multiziñas ar objektiem, kurus 
nevar apskatït, jo ¹is viedtàlrunis nenodro¹ina ¹àdu 
objektu izmanto¹anu. Taèu ¹àdas ziñas var pàrsþtït uz citu 
ierïci.

Svarïgi! Multiziñu objektos var bþt vïrusi vai tie var 
citàdi kaitºt jþsu ierïcei vai personàlajam datoram. 
Neatveriet pielikumus, ja neesat pàrliecinàts par sþtïtàja 
uzticamïbu.

 Lai saglabàtu atlasïto multivides objektu, nospiediet 
 un izvºlieties Tools (Rïki) > Save object... (Saglabàt 

objektu).

Lai apskatïtu objekta deta¶as, veiciet tam 
dubultpieskàrienu.

Lai apskatïtu visu ziñà iek¶auto objektu sarakstu, 
nospiediet  un izvºlieties Tools (Rïki) > View objects... 
(Skatït objektus). Lai objektu saglabàtu, atlasiet to un 
pieskarieties Save (Saglabàt). Lai objektu atskañotu, 
atlasiet to un pieskarieties Open (Atvºrt).



M
es

sa
gi

ng
 (

Zi
ña

pm
ai

ña
)

61Copyright © 2005 Nokia. All rights reserved.

Multiziñu uzstàdïjumi
Visas izmaiñas, kuras veicat multiziñu uzstàdïjumos, 
ietekmº ¹o ziñu sþtï¹anas un sañem¹anas veidu. 
Uzstàdïjumus var sañemt kà speciàlu ïsziñu no 
pakalpojumu sniedzºja.

Programmas Messaging galvenajà skatà nospiediet  un 
izvºlieties Tools > Message settings (Ziñu uzstàdïjumi) > 
Multimedia message... (Multiziña). Noràdiet vajadzïgos 
uzstàdïjumus.

Lapa Sending (Sþtï¹ana)
Access point in use: (Izmantotais piek¶uves punkts) — 
izvºlieties interneta piek¶uves punkta (Internet Access 
Point — IAP) savienojumu, kur¹ jàizmanto ziñu sþtï¹anai. 
Kà izveidot IAP, sk. noda¶à “Interneta piek¶uves punkta 
uzstàdï¹ana” 114. lpp.

Homepage: (Màjas lapa) — ievadiet multiziñu centra adresi.

Receive report: (Atskaite par sañem¹anu) — izvºlieties ¹o 
iespºju, lai sañemtu paziñojumu, kad ziña ir nogàdàta 
noràdïtajam adresàtam. Iespºjams, nevar sañemt atskaiti 
par tàdas multiziñas piegàdi, kura nosþtïta uz e-pasta 
adresi.

Send message: (Sþtït ziñu) — izvºlieties, kad ziña jànosþta.

Message validity: (Ziñas derïgums) — ja derïguma perioda 
laikà ziñas adresàts nav sasniedzams, ziña tiek dzºsta no 
multiziñu centra (tïkla pakalpojums). Ievºrojiet, ka ¹ai 
funkcijai nepiecie¹ams tïkla nodro¹inàjums. Maximum time 
(Maksimàlais laiks) ir ilgàkais tïkla at¶autais laiks.

Lapa Retrieval (Ielàde)
On receiving messages: (Sañemot ziñas) — izvºlieties 
Retrieve immediately (Ielàdºt nekavºjoties), lai sañemtu 
multiziñas. Izvºlieties Defer retrieval (Atlikt ielàdi), lai 
multiziñu centrs saglabàtu ziñas ielàdei vºlàk.  Izvºlieties 
Reject message (Atteikt ziñu), lai atteiktu multiziñu 
sañem¹anu. Multiziñu centrs izdzºsïs ziñas. Izvºlieties 
Only in home network (Tikai màjas tïklà), lai nesañemtu 
multiziñas, izmantojot viesabonº¹anu àrpus màjas tïkla. 
©àdà gadïjumà ziñas paliek serverï un tàs var ielàdºt vºlàk.

Receive advertisements: (Sañemt reklàmas) — izvºlieties ¹o 
iespºju, lai ¶autu tàdu ziñu sañem¹anu, kuras ir 
uzskatàmas par reklàmàm.

Allow anonymous messages: (At¶aut anonïmas ziñas) — 
izvºlieties ¹o iespºju, lai at¶autu sañemt ziñas no 
nepazïstamiem sþtïtàjiem.

Lai noràdïtu interneta piek¶uves punktu, nospiediet 
 un izvºlieties Tools (Rïki) > Message settings (Ziñu 

uzstàdïjumi) > Multimedia message... (Multiziña). 
Pieskarieties Internet setup (Interneta uzstàdï¹ana) 
un Next (Tàlàk). Pla¹àku informàciju sk. noda¶à 
“Interneta piek¶uves punkta uzstàdï¹ana” 114. lpp.

Lapa General (Vispàrïgie uzstàdïjumi)
Multimedia mode (Multivides re¾ïms) — izvºlieties 
Restricted mode: (Ierobe¾otais re¾ïms), lai ierobe¾otu 
multiziñu iespºju izvºli un ziñas bþtu saderïgàkas ar 
citiem tàlruñiem. Tiek ierobe¾otas formatº¹anas un 
multivides iespºjas. Izvºlieties Guided mode: (Vadïts 
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re¾ïms), lai tiktu piedàvàts vairàk iespºju, bet ziñots, kad 
pamatiespºju robe¾as tiek pàrsniegtas. Izvºlieties Free 
mode: (Brïvais re¾ïms), lai izmantotu visu multiziñu iespºju 
piedàvàjuma klàstu.

Viedziñas
©is viedtàlrunis var sañemt da¾àda veida viedziñas jeb 
ïsziñas, kuràs ir dati; tàs dºvº arï par ºtera ziñàm (Over-
The-Air — OTA). ©àdas ziñas, piem., ir grafiskàs ïsziñas, 
vizïtkartes, zvana signàli vai kalendàra ieraksti.

ªtera ziñu veidà var sañemt arï ïsziñu pakalpojuma 
numuru, balss pastkastes numuru, profila uzstàdïjumus 
attàlajai sinhronizàcijai, piek¶uves punkta uzstàdïjumus 
pàrlþkprogrammai, multivides ziñapmaiñai vai e-pastam, 
piek¶uves punkta pieteik¹anàs skripta uzstàdïjumus vai 
e-pasta uzstàdïjumus.

Pakalpojumu ziñas
Pakalpojumu ziñas ir informàcija par, piem., jaunàkajàm 
ziñàm, un tajàs var bþt teksts vai saite. Informàciju par 
pieejamïbu un abonº¹anu lþdziet pakalpojumu 
sniedzºjam.
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Contacts (Kontaktu katalogs)
Atveriet Desk (Darbvirsma) > Contacts (Kontaktu 
katalogs).

Programmà Contacts var izveidot, redi»ºt un kàrtot visu 
kontaktinformàciju — tàlruñu numurus un adreses.

Informàciju par kontaktinformàcijas sinhronizº¹anu ar 
saderïgàm personàlo datoru programmàm sk. 
programmatþras rokasgràmatà Nokia PC Suite Guide, kas 
atrodama komplektàcijà iek¶autajà kompaktdiskà.

Kontaktu apskate un meklº¹ana
Lai apskatïtu kontakta kartïti, kontaktu sarakstà 
pieskarieties kontaktpersonas vàrdam. Kontakta kartïtei 
veicot dubultpieskàrienu, tà tiek atvºrta redi»º¹anai.

Padoms. Lai piezvanïtu kontaktpersonai, labajà rþtï 
veiciet dubultpieskàrienu tàs tàlruña numuram. Arï 
e-pasta ziñu var nosþtït, veicot dubultpieskàrienu 
e-pasta adresei.

Lai meklºtu kontakta kartïti, apak¹ºjà rindà 
pieskarieties burtiem, kuri atbilst vàrdam meklºjamajà 
kartïtº. Piem., vienu reizi pieskarieties, lai redzºtu 
kontaktus, kuru vàrdi sàkas ar burtu M, divas reizes — 
lai redzºtu kontaktus, kuru vàrdi sàkas ar burtu N, bet 
trïs reizes — lai redzºtu kontaktus, kuru vàrdi sàkas ar 
burtu O. Vai arï nospiediet  un izvºlieties Display 

(Ràdït) > Search field (Meklº¹anas lauks), lai tiktu ràdïts 
meklº¹anas lauks. Meklº¹anas laukà sàciet ievadït 
kontaktpersonas vàrdu. Kontaktu saraksts mainàs, 
paràdot ievadïtajiem burtiem atbilsto¹as 
kontaktpersonas.

19. attºls. Programmas Contacts galvenais logs ar 
meklº¹anas lauku.

Lai mainïtu kontaktu kàrto¹anas secïbu, nospiediet 
, izvºlieties Display > Sort by (Kàrtot pºc) un 

izvºlieties piemºrotàko kàrtïbu.

Kontaktu izveide un redi»º¹ana
Lai izveidotu jaunu kontakta kartïti, pieskarieties 
New contact (Jauns kontakts), pieskarieties tuk¹am 
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laukam un ievadiet informàciju. Sk. arï “Lauki kontaktu 
kartïtºs” 64. lpp.

Lai redi»ºtu kontakta kartïti, sarakstà veiciet 
dubultpieskàrienu kontaktam, lai to atvºrtu, redi»ºjiet 
kartïti pºc vajadzïbas un pieskarieties Done (Gatavs).

Lai izdzºstu kontakta kartïti, atlasiet kontaktu, 
nospiediet  un izvºlieties Contact (Kontakts) > 
Delete (Dzºst). Ievºrojiet, ka savu kartïti nevar izdzºst.

Lai kontaktu pievienotu àtro zvanu sarakstam, 
atveriet kontaktu, veicot tam dubultpieskàrienu, un 
pieskarieties tàlruña numura laukam, kurà jàpievieno 
àtro zvanu funkcija. Nospiediet , izvºlieties Tools 
(Rïki) > Assign speed dial... (Pie¹óirt àtro zvanu), 
izvºlieties àtrà zvana numuru un pieskarieties Assign 
(Pie¹óirt).

Lai kontaktam uzstàdïtu noteiktu zvana signàlu, 
atveriet kontaktu, veicot tam dubultpieskàrienu. Ja 
kartïtº nav lauka Ringing tone (Zvana signàls), 
pieskarieties Add field (Pievienot lauku), no saraksta 
izvºlieties atbilsto¹o lauku un pieskarieties OK (Labi). 
Veiciet dubultpieskàrienu laukam Ringing tone. 
Izvºlieties zvana signàlu. Pieskarieties Play (Atskañot), 
lai noklausïtos signàlu.

Lai ieliktu attºlu, atveriet kontaktu ar 
dubultpieskàrienu un veiciet dubultpieskàrienu attºla 
vietturim aug¹ºjà labajà stþrï. Izvºlieties attºlu un 
pieskarieties Add (Pievienot), lai to pievienotu 
neredi»ºjot vai Edit (Redi»ºt), lai attºlu atvºrtu attºlu 

redaktorà, kur to var pàrveidot. Lai atlasïtu ievietojamà 
attºla apgabalu, izmantojiet irbuli vai ritinà¹anas 
taustiñus. Izmantojiet rïkjoslu attºla tuvinà¹anai, 
apvºr¹anai vai pagrie¹anai, kà arï kràsainas apmales 
pievieno¹anai. Kad esat apmierinàts ar iegþto attºlu, 
pieskarieties Add, lai pievienotu attºlu kontakta 
kartïtei. Lai attºlu noñemtu, nospiediet  un 
izvºlieties Image (Attºls) > Remove (Noñemt).

Lai paràdïtu pareizo jþsu mïtnes zemes vai re»iona 
adreses formàtu, nospiediet , izvºlieties Tools 
(Rïki) > Address format... (Adreses formàts) un no 
saraksta izvºlieties valsti vai re»ionu. Jaunais 
uzstàdïjums attiecas uz visàm kartïtºm, ja tas noràdïts 
galvenajà skatà, vai tikai uz atvºrto kartïti, ja noràdïts 
redi»ºjot kartïti.

Lai izveidotu vai redi»ºtu kontaktu kartïtes SIM 
kartº, nospiediet  un izvºlieties Tools > SIM 
directory... (SIM katalogs). Pieskarieties New (Jauns) vai 
izvºlieties kontaktu un pieskarieties Edit (Redi»ºt). SIM 
kataloga kontaktu kartïtes tiek saglabàtas tikai SIM 
kartº, nevis viedtàlruña atmiñà.

Ievadàmà vàrda un tàlruña numura garumu nosaka SIM 
karte. Piem., atsevi¹óàs SIM kartºs var ievadït ne vairàk kà 
14 rakstzïmju.

Lauki kontaktu kartïtºs
Lai kontakta kartïtº pievienotu vºl papildu laukus, 
atveriet kontakta kartïti un pieskarieties Add field. 
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Sarakstà izvºlieties atbilsto¹o lauku. Lai atlasïto lauku 
noñemtu, nospiediet  un izvºlieties Contact > 
Remove field (Noñemt lauku). ©ïs izmaiñas ietekmº tikai 
pa¹reiz pàrveidojamo kartïti.

Lai pàrdºvºtu lauku, atlasiet lauku, nospiediet  un 
izvºlieties Contact > Rename field... (Pàrdºvºt lauku). 
Ievadiet jauno nosaukumu. Ja komanda Rename field... 
izvºlnº ir pelºkota, tas nozïmº, ka ¹o lauku nevar 
redi»ºt.

Lai pàrveidotu kontaktu kartï¹u veidni, nospiediet 
 un izvºlieties Tools > Card template... (Kartïtes 

veidne). Pieskarieties Add field, lai pievienotu jaunu 
lauku, vai atlasiet lauku un pieskarieties Remove field, 
lai to izdzºstu. Ievºrojiet, ka atsevi¹óus laukus nevar 
dzºst. ©ïs izmaiñas ietekmº visas kontaktu kartïtes, 
izñemot SIM kataloga kontaktu kartïtes. 

Kontaktu pàrsþtï¹ana
Ievºrojiet, ka kontaktu informàciju var nosþtït tikai uz 
saderïgàm ierïcºm un no tàdàm sañemt.

Lai nosþtïtu kontakta kartïti, nospiediet  un 
izvºlieties Contact (Kontakts) > Send (Sþtït). Izvºlieties 
sþtï¹anas metodi. Lai nosþtïtu savu kontakta kartïti, 
atlasiet to un pieskarieties Send. Izvºlieties ziñas veidu. 
Jþsu kontakta kartïte tiek nosþtïta vizïtkartes formàtà 
vCard. Pla¹àku informàciju par sþtï¹anas iespºjàm sk. 
noda¶à “Messaging (Ziñapmaiña)” 47. lpp. un “Datu 
sþtï¹ana, izmantojot Bluetooth” 144. lpp.

Lai kontaktu kopºtu SIM kartº, nospiediet  un 
izvºlieties Contact > Copy to SIM directory... (Kopºt SIM 
katalogà).

Lai kopºtu atsevi¹óus kontaktus no SIM kartes uz 
kontaktu katalogu, nospiediet  un izvºlieties Tools 
(Rïki) > SIM directory... (SIM katalogs). Izvºlieties 
kontaktpersonu un pieskarieties Copy to Contacts 
(Kopºt uz kontaktu katalogu). Lai kopºtu visus SIM 
kartes kontaktus uz kontaktu katalogu, nospiediet 

 un izvºlieties Tools > Copy SIM directory to 
Contacts... (Kopºt SIM katalogu uz kontaktu katalogu). 
Pieskarieties Copy (Kopºt).

Balss fràzes
Ja kontakta kartïtei pievieno balss fràzi, kontaktpersonai 
var piezvanït, aktivizºjot balss iezvani un izrunàjot 
ierakstïto balss fràzi. Pla¹àku informàciju sk. sada¶à “Balss 
iezvane” 39. lpp.

Lai kontaktam uzstàdïtu balss fràzi, atveriet 
kontaktu, veicot tam dubultpieskàrienu. Nospiediet 

 un izvºlieties Tools > Add voice tag... (Pievienot 
balss fràzi). Atlasiet tàlruña numuru, kuram pievienosit 
balss fràzi, un pieskarieties OK (Labi). Pieskarieties 
Start (Sàkt). Pºc signàla mikrofonà skaidri ierunàjiet 
vàrdu(s), kas jàieraksta kà balss fràze. Pºc ierakstï¹anas 
viedtàlrunis atskaño ierakstïto fràzi un saglabà to.

Lai apskatïtu balss frà¾u sarakstu, nospiediet  un 
izvºlieties Tools > Voice tags... (Balss fràzes). Sarakstà 
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tiek paràdïti visi kontakti, kuriem ir pievienotas balss 
fràzes. Balss fràzes var pievienot lïdz 50 tàlruñu 
numuriem.

Lai redi»ºtu vai izdzºstu balss fràzi, nospiediet  
un izvºlieties Tools > Voice tags... Pieskarieties Change 
(Mainït) vai Delete (Izdzºst).

Kontaktu grupas
Kontaktus var sakàrtot grupàs un katrai grupai — 
izvºlºties individuàlu zvana signàlu.

Lai izveidotu jaunu grupu, nospiediet  un 
izvºlieties Group (Grupa) > New... (Jauna). Ievadiet 
grupas nosaukumu.

Lai pàrslºgtos no vienas grupas uz citu, nospiediet 
 un izvºlieties View group (Skatït grupu). Izvºlieties 

apskatàmo grupu.

Lai grupai pievienotu kontaktu, izvºlieties kontaktu 
un nospiediet . Izvºlieties Group > Add to group... 
(Pievienot grupai), atzïmºjot izvºles rþtiñu, atlasiet 
grupu un pieskarieties OK.

Lai pàrdºvºtu vai izdzºstu grupu, nospiediet , 
izvºlieties Group > Manage groups... (Grupu pàrvaldïba), 
izvºlieties grupu un atbilsto¹o komandu. Ievºrojiet, ka 
grupu All contacts (Visi kontakti) nevar ne pàrdºvºt, ne 
izdzºst.

Lai grupai pievienotu jaunus dalïbniekus vai 
izdzºstu no tàs dalïbniekus, izvºlieties pàrveidojamo 

grupu, nospiediet  un izvºlieties Group > Edit 
group... (Redi»ºt grupu). Sarakstà pa kreisi izvºlieties 
kontaktu, kas jàpievieno grupai. Pieskarieties Add 
(Pievienot). Lai noñemtu grupas dalïbnieku, sarakstà pa 
labi izvºlieties kontaktu un pieskarieties Remove 
(Noñemt).

Lai grupai pievienotu zvana signàlu, atveriet 
programmu Profiles. Izvºlieties profilu, kuru pie¹óirsit 
grupai, un pieskarieties Personalise (Personalizºt), pºc 
tam Alert for (Brïdinàt par). Izvºlieties grupu un 
pieskarieties OK. Ja jums zvana vai atsþta ziñu grupà 
iek¶auta persona, viedtàlrunis atskaño izvºlºto zvana 
melodiju vai brïdinàjuma signàlu (ja kopà ar zvanu tiek 
atsþtïts arï zvanïtàja numurs un viedtàlrunis to 
atpazïst). Sañemot citu zvanïtàju zvanus un ziñas, tiek 
lietots profils Silent (Klusums). Pla¹àku informàciju par 
profiliem sk. sada¶à “Profiles (Profili)” 45. lpp.
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Calendar (Kalendàrs)
Atveriet Desk (Darbvirsma) > Calendar (Kalendàrs).

Programmà Calendar var izveidot un kontrolºt plànotos 
pasàkumus un tik¹anàs. Visiem kalendàra ierakstiem var arï 
uzstàdït signàlus.

Savienojot viedtàlruni ar saderïgu personàlo datoru, 
kalendàru var sinhronizºt ar programmu Microsoft 
Outlook 98/2000/2002/2003, Microsoft Outlook Express, 
Lotus Notes 5.0/6.0 un Lotus Organizer 5.0/6.0. 
Informàciju par sinhronizàciju sk. programmatþras Nokia 
PC Suite rokasgràmatà, kura atrodama kompaktdiskà.

Dienas skats

20. attºls. Dienas skats

Ja izmantojat noklusºjuma motïvu, ¹ïsdienas datums ir 
ieràmºts, datumi, kuros ir ieplànoti kàdi pasàkumi, ir 
treknrakstà, bet pa¹reiz atlasïtais datums ir iezïmºts ar 
brþnu kràsu.

Pa¹laik atlasïtà datuma pasàkumi tiek ràdïti ràmï pa labi.

Lai atvºrtu datumu, kas tiek ràdïts ràmï pa kreisi, 
pieskarieties tam. Lai pàrvietotos uz iepriek¹ºjo vai 
nàkamo gadu, pieskarieties  vai  blakus 
gadskaitlim kreisà ràmja aug¹da¶à. Tàpat, lai 
pàrvietotos uz iepriek¹ºjo vai nàkamo mºnesi, 
pieskarieties bultiñàm blakus mºne¹a nosaukumam 
kreisà ràmja lejasda¶à.

Lai pàrietu uz konkrºtu datumu, pieskarieties Go to 
date (Iet uz datumu) un noràdiet dienu, mºnesi un 
gadu.

Lai pàrietu uz ¹ïsdienas datumu, pieskarieties Go to 
today (Iet uz ¹odienu).

Darbs ar ierakstiem
Lai izveidotu jaunu kalendàra ierakstu, atlasiet 
datumu dienas skatà un pieskarieties New entry (Jauns 
ieraksts). Aizpildiet laukus. Ja notikuma ieraksts 
attiecas uz visu dienu, atzïmºjiet izvºles rþtiñu All-day 
entry: (Visas dienas ieraksts) un noràdiet notikuma 
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sàkuma un beigu datumu. Ja tas neattiecas uz visu 
dienu, noràdiet notikuma sàkuma un beigu laiku. Lai 
ierakstam uzstàdïtu atgàdinàjumu, atzïmºjiet izvºles 
rþtiñu Alarm: (Signàls). Noràdiet dienu un laiku, kad 
signàlam jàatskan. Lai ierakstu atkàrtotu, 
pieskarieties Repeat (Atkàrtot). Noràdiet atkàrto¹anas 
bie¾umu un iespºjamo beigu datumu. Kad noràdïta 
visa vajadzïgà informàcija, pieskarieties Done (Gatavs).

Lai ierakstu redi»ºtu, veiciet tam dubultpieskàrienu 
un pºc tam — izmaiñas. Pºc tam pieskarieties Done.

Lai nosþtïtu kalendàra ierakstu, nospiediet  un 
izvºlieties Entry (Ieraksts) > Send (Sþtït). Izvºlieties 
sþtï¹anas metodi.

Lai ierakstu uzstàdïtu kà pagaidu, nospiediet  un 
izvºlieties Entry > Mark as tentative (Atzïmºt kà 
pagaidu). Ierakstu sarakstà pagaidu ieraksti ir pelºkoti.

Lai ierakstu uzstàdïtu kà privàtu un, veicot kalendàra 
sinhronizàciju ar tïklà saslºgta personàlà datora 
kalendàru, tà informàcija netiktu ràdïta citiem 
lietotàjiem, nospiediet  un izvºlieties Entry > Mark 
as private (Atzïmºt kà privàtu).

Lai izdzºstu ierakstu, nospiediet  un izvºlieties 
Edit (Redi»ºt) > Delete (Dzºst). Lai izdzºstu ierakstu 
virkni, nospiediet  un izvºlieties Tools (Rïki) > 
Delete entries... (Dzºst ierakstus). Noràdiet laika posmu, 
kura ieraksti jàdzº¹.

Lai noràdïtu ierakstu noklusºjuma uzstàdïjumus, 
nospiediet  un izvºlieties Tools > Entry template... 

(Ieraksta veidne). Noràdiet, kàda veida ierakstus lietosit 
visbie¾àk.

Lai apskatïtu uzdevumus, nospiediet  un 
izvºlieties Display (Ràdït) > To-do notes (Uzdevumi).

Lai meklºtu ierakstu, nospiediet  un izvºlieties 
Edit > Find... (Atrast). Ievadiet tekstu meklº¹anas laukà. 
Varat pieskarties Options (Iespºjas) un noràdït periodu, 
kurà jàmeklº. Pieskarieties Find, lai sàktu meklº¹anu.

Nedº¶as skats

21. attºls. Nedº¶as skats

Nedº¶as skatà kà joslas ir redzamas stundas, kuras ¹ajà 
nedº¶à ir aizñemtas. Pa¹reiz atlasïtais laika posms ir 
ieràmºts.

Lai atvºrtu nedº¶as skatu, nospiediet  un 
izvºlieties View (Skats) > Week (Nedº¶a) vai 
nospiediet .
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Lai atlasïtu laika lodziñu, pieskarieties tam. Lai 
pievienotu jaunu ierakstu, veiciet dubultpieskàrienu 
laika lodziñam. Lai pàrvietotos uz iepriek¹ºjo vai 
nàkamo nedº¶u, nedº¶as skatà pieskarieties bultiñàm 
aug¹ºjos stþros.

Ja laika lodziñà ir kàds ieraksts, ekràna lejasda¶à tiek 
paràdïtas ieraksta deta¶as. Ja vienà laika lodziñà ir 
vairàki ieraksti, skaitlis labajà stþrï noràda ierakstu 
skaitu. Piem., 1/3 nozïmº, ka laika lodziñà ir trïs ieraksti 
un pa¹laik tiek ràdïtas pirmà ieraksta deta¶as.

Lai apskatïtu visus laika lodziña ierakstus, 
pieskarieties  vai arï pieskarieties ieraksta skaitlim 
apak¹ºjà labajà stþrï.

Ikonas 
Programmà Calendar tiek ràdïti ¹àdi simboli:

 — ieraksts ar signàlu

 — visas dienas pasàkums

 — atkàrtots ieraksts

 — ieraksts ar piezïmi
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To-do (Uzdevumi)
Atveriet Desk (Darbvirsma) > To-do (Uzdevumi).

Programmà To-do var izveidot un stràdàt ar uzdevumu 
sarakstiem.

Lai izveidotu jaunu uzdevumu, pieskarieties New to-
do note (Jauns uzdevums). Aizpildiet laukus. Lai 
uzdevumam uzstàdïtu atgàdinàjumu, atzïmºjiet Due 
date: (Termiñ¹) un Alarm: (Signàls) un noràdiet dienu un 
laiku, kad signàlam jàatskan. Lai uzdevumu atkàrtotu, 
pieskarieties Repeat (Atkàrtot). Noràdiet atkàrto¹anas 
bie¾umu un iespºjamo beigu datumu.

Lai redi»ºtu uzdevumu, veiciet tam dubultpieskàrienu 
un pºc tam — izmaiñas.

Lai atlasïto uzdevumu atzïmºtu kà pabeigtu, 
nospiediet  un izvºlieties To-do note > Mark as 
completed (Atzïmºt kà pabeigtu).

Lai uzdevumu uzstàdïtu kà privàtu un, veicot 
kalendàra sinhronizàciju ar tïklà saslºgta personàlà 
datora kalendàru, tà informàcija netiktu ràdïta citiem 
lietotàjiem, nospiediet  un izvºlieties To-do note > 
Mark as private (Atzïmºt kà privàtu).

Lai izdzºstu uzdevumu, atlasiet to un pieskarieties 
Delete (Dzºst). Lai izdzºstu uzdevumu virkni, 
nospiediet  un izvºlieties Tools (Rïki) > Delete to-do 

notes... (Dzºst uzdevumus). Noràdiet laika posmu, kura 
ieraksti jàdzº¹.

Lai noràdïtu uzdevumu noklusºjuma uzstàdïjumus, 
nospiediet  un izvºlieties Tools > To-do note 
template... (Uzdevuma veidne). Noràdiet, kàda veida 
uzdevumus lietosit visbie¾àk.

Uzdevumu grupº¹ana
Lai uzdevumu pievienotu grupai, izvºlieties uzdevumu 
un nospiediet . Izvºlieties Group (Grupa) > Add to 
group... (Pievienot grupai) un pieskarieties OK (Labi).

Lai izveidotu jaunu grupu, nospiediet  un 
izvºlieties Group (Grupa) > New... (Jauna). Ievadiet 
grupas nosaukumu.

Lai pàrslºgtos no vienas grupas uz citu, nospiediet 
 un izvºlieties View group (Skatït grupu). Izvºlieties 

apskatàmo grupu.

Lai pàrdºvºtu vai izdzºstu grupu, nospiediet , 
izvºlieties Group > Manage groups... (Grupu pàrvaldïba), 
izvºlieties grupu un atbilsto¹o komandu.
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Ikonas 
Programmà To-do tiek ràdïti ¹àdi simboli:

 — uzdevums

 — uzdevums ar augstu svarïguma pakàpi

 — uzdevums ar zemu svarïguma pakàpi

 — uzdevums ar signàlu

 — atkàrtots uzdevums
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Web (Tïkls Web)
Atveriet Desk (Darbvirsma) > Web (Tïkls Web).

Lai izveidotu savienojumu ar tïklu Web:
• izmantotajam bezvadu tïklam ir jànodro¹ina datu 

zvani vai GPRS izmanto¹ana;
• SIM kartº jàbþt aktivizºtiem datu pakalpojumiem;
• ir jàkonfigurº interneta piek¶uves punkta un interneta 

savienojuma uzstàdïjumi. Pla¹àku informàciju sk. 
sada¶à “Internet setup” 114. lpp.

22. attºls. Web

Standarta Plug and play mobilie 
pakalpojumi
©is viedtàlrunis atbalsta Plug and Play mobilos 
pakalpojumus, kuri sniedz iespºju, piem., abonºt datu 
pakalpojumus un sañemt vajadzïgos uzstàdïjumus. 

Ievºrojiet — lai varºtu lietot ¹o funkciju, tïkla operatoram 
tà ir jànodro¹ina. Da¾os tïklos ¹ï funkcija var bþt pieejama 
neabonºjot datu pakalpojumus.

Ja mº»inàt izveidot savienojumu ar tïklu Web, bet neesat 
abonºjis datu pakalpojumus, vai ja jþsu interneta piek¶uves 
punkta vai interneta savienojuma uzstàdïjumi ir nederïgi, 
viedtàlrunis piedàvà abonºt pakalpojumu vai pa¹am 
izveidot uzstàdïjumus. 

Ja izvºlaties abonº¹anu, jþs tiekat novirzïts uz 
pakalpojuma màjas lapu, kur, izpildot noràdïjumus, varat 
pasþtït uzstàdïjumus (MMS, WAP/GPRS, e-pasts un 
internets).

Atkarïbà no izmantotàs SIM kartes veida ¹ï ierïce, 
iespºjams, var automàtiski pievienot pareizos WWW 
pàrlþko¹anas un MMS uzstàdïjumus.

Web pàrlþkprogrammas 
izmanto¹ana

Lai atvºrtu Web lapu, adreses laukà displeja lejasda¶à 
ievadiet lapas adresi un pieskarieties  vai nospiediet 
ritinà¹anas taustiñu vidþ. Ja esat noràdïjis màjas lapu, 
pieskarieties , lai atvºrtu ¹o Web lapu. Ja jums ir 
vajadzïgàs lapas gràmatzïme, pieskarieties , 
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izvºlieties gràmatzïmi un pieskarieties tai, lai atvºrtu 
atbilsto¹o Web lapu. 

Padoms. Rakstï¹anas laikà sarakstà virs adreses lauka 
tiek ràdïtas iepriek¹ izmantotàs atbilsto¹às Web adreses 
(ja tàdas biju¹as). Lai izvºlºtos adresi no saraksta, 
pieskarieties tai.

Ja, veidojot interneta savienojumus, esat atzïmºjis izvºles 
rþtiñu Ask before connecting: (Vaicàt pirms savienojuma 
izveides), tiek atvºrts dialogs, kurà jàapstiprina 
savienojuma izveide vai jàmaina piek¶uves punkts. Varat 
noràdït, lai savienojuma izveides laikà ¹is dialogs netiktu 
ràdïts. Sk. “Interneta savienojuma uzstàdïjumi” 118. lpp.

Interneta savienojuma izveidei patºrºtais laiks ir atkarïgs 
no tïkla konfiguràcijas un noslodzes. 

Ievºrojiet, ka noteikti Web satura veidi, piem., animàcijas 
vai videoklipi, var aizñemt visu pieejamo ierïces atmiñu un 
tàdºjàdi ietekmºt ierïces darbïbu. Ja rodas problºmas, sk. 
“Problºmu novºr¹ana” 151. lpp.

Ja Web lapa un tàs sastàvda¶as ir ¹ifrºtas, izmantojot 
dro¹ïbas protokolu, adreses joslà tiek paràdïta dro¹ïbas 
ikona .

Lai Web lapa aizpildïtu visu ekrànu, nospiediet  
un izvºlieties Display (Ràdït) > Full screen (Pilns ekràns) 
vai pieskarieties . Lai atkal iegþtu parasto ekràna 
lielumu, nospiediet  vai pieskarieties .

Lai regulºtu ska¶umu, nospiediet  un izvºlieties 
Tools (Rïki) > Volume... (Ska¶ums).

Padoms. Nospiediet , lai izmantotu tuvinà¹anas 
funkciju.

Lai Web lapu saglabàtu viedtàlrunï, nospiediet , 
izvºlieties File (Fails) > Save web page... (Saglabàt Web 
lapu). Pºc tam Web lapu var aplþkot, neveidojot 
savienojumu ar internetu.

Lai atvºrtu jaunu logu, nospiediet  un izvºlieties 
File > New window (Jauns logs). Atvºrto logu skaits ir 
atkarïgs no pieejamà atmiñas apjoma.

Lai pàrslºgtos no viena atvºrtà loga uz citu, 
nospiediet  vai nospiediet , izvºlieties View 
(Skats) un izvºlieties atveramo logu.

Lai aizvºrtu liekos logus, nospiediet  un 
izvºlieties File > Close (Aizvºrt) > Current window 
(Pa¹reizºjais logs) vai All windows (Visi logi).

Lai atvienotos no interneta, nospiediet  un 
izvºlieties File > Disconnect (Atvienoties).

Lai apskatïtu ielàdºtàs Web lapas, neveidojot 
savienojumu ar tïklu Web, nospiediet  un 
izvºlieties File > Browse offline (Pàrlþkot bezsaistº).

Navigàcija
Lai pàrlþkotu tïklu Web, displejà pieskarieties pogàm 
un pasvïtrotajàm saitºm, pieskarieties  vai , lai 
pàrlþkotu nesen apmeklºtas lapas, , lai vºlreiz 
ielàdºtu atvºrto lapu, vai , lai apturºtu pa¹reizºjàs 
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lapas ielàdi. Vai arï izmantojiet izvºlnes Navigate 
(Navigàcija) komandas. 

Padoms. Tekstlodziñà vai dokumentà Web adresi var 
izmantot kà hipersaiti. Pieskarieties ar irbuli adresei 
vai ar ritinà¹anas taustiña palïdzïbu ievietojiet tajà 
kursoru; tà k¶þst par saiti ar nelielu ikoniñu. 
Pieskarieties ikonai, lai piek¶þtu Web vietai (ja ir 
izveidots interneta savienojums).

Padoms. Ja komandu pogas ir paslºptas, adreses joslà 
var redzºt vairàk ikonu: nospiediet , izvºlieties 
Display (Ràdït) un pàrbaudiet, vai nav atzïmºta 
Command bar (Komandu josla).

Lai atgrieztos màjas lapà, pieskarieties  vai 
nospiediet  un izvºlieties Navigate > Home page 
(Màjas lapa). 

Lai uzstàdïtu jaunu màjas lapu, nospiediet  un 
izvºlieties Edit (Redi»ºt) > Set home page... (Uzstàdït 
màjas lapu).

Lai atvºrtajai Web lapai pievienotu gràmatzïmi, 
nospiediet  un izvºlieties Edit > Add bookmark 
(Pievienot gràmatzïmi). Pla¹àku informàciju par 
gràmatzïmºm sk. sada¶à “Gràmatzïmes” 74. lpp.

Lai ietu uz meklº¹anas lapu, nospiediet  un 
izvºlieties Navigate (Navigàcija) > Search page 
(Meklº¹anas lapa). Kà noràdït meklº¹anas lapu, sk. 
noda¶à “Lapa Address (Adrese)” 76. lpp.

Lai tiktu paràdïti Web lapas attºli, nospiediet  un 
izvºlieties Display (Ràdït) > Show images (Ràdït attºlus).

Padoms. Lai atvºrtu uznirsto¹o izvºlni, attºlam vai 
saitei pieskarieties ar irbuli un turiet to aptuveni 
sekundi. Izvºlnº tiek piedàvàtas iespºjas attºlu 
saglabàt vai atvºrt saiti jaunà logà. Iespºja Zoom 
(Tàlummaiña) uznirsto¹ajà izvºlnº ir pieejama, ja 
pieskaraties ar irbuli un turat to jebkurà Web lapas 
vietà.

Piezïme. Web lapàs, kuràs lietotas da¾àdas valodas, 
iespºjams, teksta rakstzïmes netiek ràdïtas pareizi. 
Izvºloties citu rakstzïmju kodºjumu, Web lapu var 
padarït labàk lasàmu. Nospiediet  un izvºlieties 
Tools (Rïki) > Character encoding (Rakstzïmju kodºjums). 
Izvºlieties valodu, kas visvairàk lïdzinàs tai, kas lietota 
atvºrtajà Web lapà.

Gràmatzïmes
Skatà Bookmarks (gràmatzïmes) ir uzskaitïtas saites uz 
Web lapàm atbilsto¹ajàs mapºs. Web lapu var atvºrt, 
sarakstà veicot dubultpieskàrienu gràmatzïmei.

©ajà viedtàlrunï, iespºjams, ir ielàdºtas ar Nokia nesaistïtu 
lapu gràmatzïmes. Nokia par ¹ïm lapàm nesniedz nekàdas 
garantijas un neapstiprina tajàs sniegto informàciju. Ja 
vºlaties tàs izmantot, jums jàievºro tie pa¹i piesardzïbas 
pasàkumi attiecïbà uz dro¹ïbu vai saturu, kàdus ievºrojat, 
izmantojot jebkuru interneta vietni.
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Lai apskatïtu visas gràmatzïmes, adreses joslà 
pieskarieties  vai nospiediet  un izvºlieties View 
(Skats) > Bookmarks (Gràmatzïmes).

Lai redi»ºtu gràmatzïmes nosaukumu vai adresi, 
atlasiet gràmatzïmi, nospiediet  un izvºlieties 
Bookmark > Edit... (Redi»ºt).

Lai pievienotu gràmatzïmi, pieskarieties Add 
bookmark (Jauna gràmatzïme). Ievadiet gràmatzïmes 
nosaukumu un noràdiet tàs Web adresi vai faila 
atra¹anàs vietu.

Padoms. Ja pogas komandu joslà nav redzamas, 
nospiediet  un izvºlieties Display (Ràdït) > 
Command bar (Komandu josla).

Lai mapju sistºmà pàrvietotos uz iepriek¹ºjo mapi, 
pieskarieties Up one level (Vienu lïmeni uz aug¹u).

Lai izveidotu jaunu vai jau eso¹u mapi pàrdºvºtu, 
nospiediet  un izvºlieties Bookmark > New folder... 
(Jauna mape) vai Rename folder... (Pàrdºvºt mapi).

Lapu, ke¹atmiñas, 
papildprogrammatþras, vºstures un 
lejupielàdes deta¶u apskate
Ke¹atmiña ir vieta atmiñà, kuru lieto, lai datus uzglabàtu 
ïslaicïgi. Iztuk¹ojiet ke¹atmiñu ikreiz, kad esat mº»inàjis 
piek¶þt vai piek¶uvis konfidenciàlai informàcijai, kam 
nepiecie¹amas paroles. Informàcija vai pakalpojumi, 
kuriem esat piek¶uvis, tiek glabàti ke¹atmiñà. 

Lai iztïrïtu ke¹atmiñu, nospiediet , izvºlieties 
Tools (Rïki) > Cache details (Ke¹atmiñas deta¶as) un 
pieskarieties Clear (Tïrït).

Lai apskatïtu informàciju par pa¹laik atvºrto lapu, 
nospiediet  un izvºlieties Tools > Page details (Lapas 
deta¶as).

Lai apskatïtu informàciju par apmeklºtajàm lapàm, 
nospiediet  un izvºlieties Navigate (Navigàcija) > 
History list... (Vºstures saraksts). Web lapu var atvºrt, 
nospie¾ot Open (Atvºrt). Lai iztïrïtu vºstures 
sarakstu, pieskarieties Clear all (Iztïrït visu).

Lai apskatïtu informàciju par ke¹atmiñu, nospiediet 
, izvºlieties Tools > Cache details (Ke¹atmiñas 

deta¶as). Ke¹atmiña ir apmeklºto lapu pagaidu 
novietne. Lai iztïrïtu ke¹atmiñu, pieskarieties Clear 
(Tïrït).

Lai apskatïtu Web pàrlþkprogrammai paredzºto 
instalºto papildprogrammatþru, nospiediet  un 
izvºlieties Tools > Plug-in details (Papildprogrammu 
deta¶as). Izmantojot papildprogrammatþru, var paràdït 
dokumentus, kurus Web pàrlþkprogramma nevar 
paràdït, piem., multivides klipus. 
Papildprogrammatþru var ielàdºt no tïkla Web.

Lai apskatïtu veiktàs lejupielàdes deta¶as, nospiediet 
 un izvºlieties Navigate > Downloads... 

(Lejupielàde).
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Web pàrlþkprogrammas uzstàdïjumi
Lai mainïtu Web pàrlþkprogrammas uzstàdïjumus, 
nospiediet  un izvºlieties Tools (Rïki) > Settings... 
(Uzstàdïjumi). Tiek atvºrts èetru lappu¹u dialogs. 
Noràdiet vajadzïgos uzstàdïjumus.

Lapa General (Vispàrïgie uzstàdïjumi)
Maximum cache size (kB): (Maksimàlais ke¹atmiñas 
lielums) — noràdiet iek¹ºjàs atmiñas apjomu, kuru var 
izmantot ke¹atmiñai, lai paàtrinàtu pàrlþko¹anu.

Show frames: (Ràdït ietvarus) — atsevi¹óas Web lapas ir 
sadalïtas vairàkos ietvaros, tàdºjàdi apgrþtinot lapu 
lasï¹anu. Atzïmºjiet, lai izslºgtu ietvaru ràdï¹anu. 
Ievºrojiet, ka da¾as lapas nedarbojas pareizi, ja izslºdz 
ietvaru ràdï¹anu.

Default character encoding: (Rakstzïmju noklusºjuma 
kodºjums) — izvºlieties rakstzïmju noklusºjuma kopu.

Lapa Address (Adrese)
Web address suffixes: (Web adre¹u sufiksi) — ja ¹eit ievada 
bie¾àk apmeklºto Web adre¹u URL sufiksus (piem., .com, 
.org, .net), varat tos neievadït, rakstot adresi URL adreses 
laukà.

Home page location: (Màjas lapas atra¹anàs vieta) — jþsu 
izmantotàs màjas lapas adrese.

Search page location: (Meklº¹anas lapas atra¹anàs vieta) — 
jþsu izmantotàs meklº¹anas lapas adrese.

New window content: (Jauna loga saturs) — Web lapa, kura 
tiek atvºrta, nospie¾ot  un izvºloties File (Fails) > New 
window (Jauns logs).

Lapa Plug-ins (Papildprogrammatþra)
Enable plug-ins (Iespºjot papildprogrammatþru) — 
izvºlieties, lai ar papildprogrammatþras palïdzïbu 
papla¹inàtu pàrlþkprogrammas funkcionalitàti. 
Papildprogrammatþra ¶auj izmantot Flash animàcijas un 
citas papildiespºjas.

Enable JavaScript (Iespºjot JavaScript) — JavaScript 
funkcionalitàte tiek izmantota daudzàs Web vietàs. Lai ¹ïs 
lapas tiktu ràdïtas pareizi, izvºlieties ¹o iespºju.

Lapa Privacy (Konfidencialitàte)
Allow automatic redirection: (At¶aut automàtisku 
pàrvirzï¹anu) — izvºlieties ¹o iespºju, lai, mº»inot atvºrt 
vecu lapu, kurà ir pàrvirzï¹anas komanda, tiktu 
automàtiski pàrvirzïts uz jaunu Web lapas adresi.

Enable pop-up windows: (Iespºjot uznirsto¹os logus) — 
izvºlieties ¹o iespºju, lai visi nepieprasïtie uznirsto¹ie logi 
tiktu atvºrti automàtiski.

Accept cookies: (Pieñemt sïkfailus) — atsevi¹óas Web lapas 
informàciju par jþsu viedtàlruni glabà sïkfailos. 
Izmantojiet ¹o uzstàdïjumu, lai noràdïtu, vai sïkfaili 
jàpieñem, un, ja tos pieñemat, vai pirms katra sïkfaila 
saglabà¹anas sniegsit apstiprinàjumu, vai tos pieñemsit 
vienmºr.
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Laika gaità uzkràjas daudz sïkfailu, un tie var aizñemt 
daudz vietas ierïces atmiñà. Atmiñu varat atbrïvot, 
izdzº¹ot saglabàtos sïkfailus. Lai izdzºstu sïkfailus, 
nospiediet  un izvºlieties Tools (Rïki) > Clear cookies 
(Dzºst sïkfailus). Pieskarieties Clear (Dzºst).
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Camera  (Kamera)
Izmantojot programmu Camera (Kamera), varat fotografºt 
un ierakstït video. Fotoattºlus varat apskatït un pàrveidot 
programmà Images, un nosþtït kà multiziñas. 
Videomateriàlus apskatït un nosþtït kà multiziñas varat, 
izmantojot programmu RealPlayer.

Lai pàrslºgtos no kameras uz videoieraksta re¾ïmu, 
pieskarieties atbilsto¹ajam attºlam ekràna kreisajà 
pusº.

Lai atvºrtu programmu Camera, darbvirsmà veiciet 
dubultpieskàrienu Camera vai programmà Images 
pieskarieties Go to Camera (Atvºrt programmu 
Camera).

Lai atvºrtu programmu Images, kameras re¾ïmà 
pieskarieties Go to Images (Atvºrt programmu Images) 
vai darbvirsmà veiciet dubultpieskàrienu programmai 
Images.

Lai atvºrtu programmu RealPlayer, videokameras 
re¾ïmà pieskarieties Go to RealPlayer (Atvºrt 
programmu RealPlayer).

Lai programmà RealPlayer atvºrtu programmu 
Camera, pieskarieties Go to Camera.

Kameras re¾ïms
Kameras objektïvs atrodas viedtàlruña aizmugurº. Displejs 
darbojas kà skatu meklºtàjs.

Viedtàlrunis Nokia 7710 atbalsta fotografº¹anu 
megapikse¶u (1152x864 pikse¶u) un video uzñem¹anu QCIF 
(176x144 pikse¶u) re¾ïmà. ©ajos materiàlos iek¶auto attºlu 
iz¹óirtspºja var izskatïties citàda.

Attºlu uzñem¹ana
Lai uzñemtu attºlu, iekadrºjiet fotografºjamo objektu 
un nospiediet ritinà¹anas taustiñu centrà vai 
pieskarieties Capture (Uzñemt). Ja ir ieslºgts 
uzstàdïjums Preview (Apskate), varat apskatït attºlu un 
izlemtu, vai to paturºt vai dzºst. Pieskaroties Save 
(Saglabàt) vai nospie¾ot ritinà¹anas taustiñu centrà, 
attºls tiek automàtiski saglabàts programmas Images 
mapº, kura tiek noràdïta ekràna nosaukumu joslà.
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23. attºls. Fotografº¹ana

Padoms. Skatu meklºtàja aug¹ºjà labajà stþrï tiek 
ràdïts, cik attºlu vºl var uzñemt ar pieejamo atmiñas 
apjomu. Zvaigznïtes noràda attºla kvalitàtes lïmeni. 
Pieskarieties ¹im apgabalam, lai atvºrtu programmas 
Camera uzstàdïjumus.

Lai pirms fotografº¹anas objekta attºlu palielinàtu 
vai samazinàtu, pieskarieties Zoom in (Tuvinàt) vai 
Zoom out (Tàlinàt) vai ritinà¹anas taustiñà nospiediet 

 un .

Videokameras re¾ïms
Lai pàrslºgtos uz videokameras re¾ïmu, pieskarieties 
ikonàm ekràna kreisajà pusº.

Lai ierakstïtu video, iekadrºjiet filmºjamo objektu un 
nospiediet ritinà¹anas taustiñu centrà vai pieskarieties 

Record (Ierakstït). Lai pàrtrauktu, pieskarieties Stop 
(Pàrtraukt).

Viena klipa ierakstam var izmantot ne vairàk kà stundu.

Padoms. Skatu meklºtàja aug¹ºjà labajà stþrï tiek 
ràdïts izvºlºtais video kvalitàtes lïmenis un tas, cik ilgi 
vºl var ierakstït videomateriàlu ar pieejamo atmiñas 
apjomu. Pieskarieties ¹im apgabalam, lai atvºrtu 
programmas Camera uzstàdïjumus.

Kameras uzstàdïjumi
Lai redi»ºtu kameras uzstàdïjumus, nospiediet  
un izvºlieties Tools (Rïki) > Settings... (Uzstàdïjumi). 
Noràdiet vajadzïgos uzstàdïjumus.

Lapa General (Vispàrïgie uzstàdïjumi)
©ie uzstàdïjumi attiecas gan uz fotografº¹anu, gan uz 
video ierakstï¹anu.

Contrast: (Kontrasts) — pºc vajadzïbas regulºjiet attºla vai 
video kontrastu. Tas ietekmº gan attºlu skatu 
meklºtàjà, gan uzñemto attºlu.

Brightness: (Spilgtums) — pºc vajadzïbas regulºjiet attºla 
vai video spilgtumu. Tas ietekmº gan attºlu skatu 
meklºtàjà, gan uzñemto attºlu.

Memory in use: (Lietotà atmiña) — attºlu un 
videomateriàlu glabà¹anai izvºlieties ierïces atmiñu 
vai atmiñas karti.
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Lapa Image (Attºls)
Image quality: (Attºla kvalitàte) — apzïmº ar zvaigznïtºm 

skatu meklºtàja stþrï. Jo labàka ir attºla kvalitàte, jo 
vairàk atmiñas attºls patºrº.

Default image name: (Attºla standarta nosaukums) — 
noràdiet uzñemto attºlu nosaukumu. Pºc noklusºjuma 
attºli tiek nosaukti ¹àdà formàtà: “Attºls”. Piem., ja 
uzstàdàt noklusºjuma nosaukumu “Jþrmala”, 
uzñemtie attºli programmà Camera tiek nosaukti ¹àdi: 
“Jþrmala”, “Jþrmala(01)”, “Jþrmala(02)” utt., lïdz tiek 
nomainïts ¹is uzstàdïjums.

Preview before saving: (Apskate pirms saglabà¹anas) — 
izvºloties ¹o iespºju, varat apskatït uzñemto attºlu un 
izlemt, vai to paturºt. Ja ¹ï iespºja nav atzïmºta, visi 
uzñemtie attºli tiek automàtiski saglabàti, 
nepiedàvàjot iespºju tos apskatït.

Lapa Video 
Quality: (Kvalitàte) — apzïmº ar zvaigznïtºm skatu 

meklºtàja stþrï. Jo labàka ir video kvalitàte, jo vairàk 
atmiñas videomateriàls patºrº.

Default video name: (Video standarta nosaukums) — 
noràdiet uzñemto videomateriàlu nosaukumu. Pºc 
noklusºjuma video nosaukumi tiek veidoti formàtà 
“jaunsvideo”. Piem., ja uzstàdàt noklusºjuma 
nosaukumu “Jþrmala”, uzñemtie videomateriàli tiek 
nosaukti ¹àdi: “Jþrmala(01)”, “Jþrmala(02)” utt., lïdz 
tiek nomainïts ¹is uzstàdïjums.

Kà uzñemt labus fotoattºlus
Piedàvàjam da¾us padomus, kà ar viedtàlruña kameru 
panàkt vislabàkos rezultàtus. 

Attºlu kvalitàte
Izmantojiet piemºrotu attºlu kvalitàti. Kamerai ir trïs 
attºlu kvalitàtes re¾ïmi (zema (Low), standarta (Normal) 
un augsta (High)). Izvºlieties iespºju High, lai ar kameru 
iegþtu vislabàko pieejamo attºla kvalitàti. Tomºr 
ievºrojiet — jo augstàka attºla kvalitàte, jo vairàk vietas 
tas aizñem atmiñà. Multiziñàm un e-pasta pielikumiem 
ieteicams lietot uzstàdïjumu Normal vai Low. Kvalitàti var 
noràdït uzstàdïjumos Tools (Rïki) > Settings... (Uzstàdïjumi). 
Kvalitàtes lïmenis tiek ràdïts skatu meklºtàja labajà 
aug¹ºjà stþrï.

Fons
Izmantojiet vienkàr¹u fonu. Fotografºjot portretus un 
citus skatus, kuros ir cilvºki, neizmantojiet pieblïvºtu, 
sare¾»ïtu fonu, kas varºtu novºrst uzmanïbu no 
fotografºjamà objekta. Ja iepriek¹minºtos nosacïjumus 
nevar ievºrot, pàrvietojiet kameru vai fotografºjamo 
objektu. 

Dzi¶ums
Fotografºjot ainavas un dabas skatus, attºliem var pie¹óirt 
dzi¶umu, ja priek¹plànà novieto objektus. Taèu, ja 



Ca
m

er
a 

(K
am

er
a)

81Copyright © 2005 Nokia. All rights reserved.

priek¹plànà novietotais objekts atrodas pàràk tuvu 
kamerai, tas var izskatïties izplþdis.

Apgaismojums
Gaismas avota, apjoma un virziena maiña fotoattºlu var 
pàrvºrst lïdz nepazï¹anai. Da¾i raksturïgàkie apgaismojuma 
veidi:
• Gaismas avots atrodas aiz objekta. Fotografºjamo 

objektu nevajadzºtu novietot spºcïga gaismas avota 
priek¹à. Ja gaismas avots atrodas aiz objekta vai ir 
redzams displejà, iespºjams, ka attºlam bþs vàj¹ 
kontrasts, tas bþs pàràk tum¹s, vai ar nevºlamiem 
gaismas efektiem.

• No sàniem apgaismots objekts. Spºcïgs 
apgaismojums no sàniem attºlam pie¹óir dramatismu, 
taèu var bþt pàràk raupj¹ un radït pàràk lielu kontrastu. 

• Gaismas avots atrodas objekta priek¹à. ©ï kopumà ir 
glu¾i labi izmantojama situàcija, izñemot gadïjumus, 
kad spilgtas saules dº¶ fotografºjamàs personas 
piemiedz acis. Arï kontrasts var bþt pàràk ass.

• Optimàls apgaismojums ir vietàs, kur ir daudz 
izkliedºtas, maigas gaismas, piem., gai¹à, da¶ºji 
màkoñainà dienà vai saulainà dienà koku paºnà. 
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Images
Izmantojiet programmu Images, lai apskatïtu un 
pàrveidotu attºlus. Varat uzñemt attºlus programmà 
Camera, apskatït un pàrveidot tos, izmantojot programmu 
Images, un nosþtït kà multiziñas. Varat redi»ºt ar kameru 
uzñemtos attºlus vai izveidot jaunus zïmºjumus, kuros var 
iek¶aut tekstu un »eometriskas figþras.

Lai atvºrtu programmu Images, darbvirsmà veiciet 
dubultpieskàrienu Images vai programmà Camera 
pieskarieties Go to Images (Atvºrt programmu 
Images).

Lai atvºrtu programmu Camera, programmà Images 
pieskarieties Go to Camera (Atvºrt programmu 
Camera).

Programma Images atbalsta ¹àdus faila formàtus: JPEG, 
GIF 87a/89a, animºtais GIF, TIFF/F, PNG, BMP un WBMP. 
Iespºjams, ka programma Images neatbalsta visas faila 
formàtu variàcijas.

Programma Images ir sadalïta trïs da¾àdos skatos, kur 
katrà ir da¾àdas komandas:
• Saraksta skatà var kopºt, pàrvietot, dzºst un sþtït 

viedtàlrunï glabàtos attºlus. Varat arï izveidot jaunu 
zïmºto attºlu. Attºli var tikt ràdïti sïktºlu veidà vai kà 
failu nosaukumu saraksts. Nospiediet , lai 
pàrslºgtos no sïktºliem uz sarakstu un pretºji.

• Skatïtàja skatà attºlus var apskatït; skats tiek atvºrts, 
kad saraksta skatà veic dubultpieskàrienu attºlam.

• Redaktora skatà attºlus var da¾àdi pàrveidot; skats 
tiek atvºrts, skatïtàja skatà nospie¾ot  un izvºloties 
Image (Attºls) > Open for editing (Atvºrt redi»º¹anai).

Attºlu apskate
Lai attºlu atvºrtu apskatei, saraksta skatà veiciet tam 
dubultpieskàrienu. Attºls tiek atvºrts skatïtàja skatà.

Lai apskatei atvºrtu nàkamo vai iepriek¹ºjo attºlu, 
nospiediet  un izvºlieties Image (Attºls) > Next 
(Nàkamais) vai Previous (Iepriek¹ºjais) vai nospiediet 
ritinà¹anas taustiñu pa labi vai pa kreisi.

Lai apskatàmo attºlu palielinàtu vai samazinàtu, 
nospiediet  un izvºlieties Display (Ràdït) > Zoom 
ratio (Tuvinà¹anas procents). Izvºlieties piemºrotu 
tuvinà¹anas pakàpi.

Darbs ar attºliem un mapºm
Lai apskatïtu detalizºtu informàciju par attºlu, 
atlasiet attºlu, nospiediet  un izvºlieties Tools (Rïki) 
> Details (Deta¶as). Tiek paràdïta ¹àda informàcija:
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Name: (Nosaukums) — attºla nosaukums. Standarta 
sàkotnºjo nosaukumu var mainït programmà Camera: 
nospiediet  un izvºlieties Tools > Settings... 
(Uzstàdïjumi). Redi»ºjiet nosaukumu laukà Default image 
name: (Attºla standarta nosaukums).

Type: (Veids) — attºla faila formàts. Ja faila formàts netiek 
atbalstïts, tiek ràdïts Unknown (Nav zinàms).

Size: (Lielums) — faila lielums baitos (B).

Date: (Datums) un Time: (Laiks) — attºla pºdºjàs pàrveides 
laiks.

Width: (Platums) un Height: (Augstums) — attºla 
iz¹óirtspºja pikse¶os.

Padoms. Iz¹óirtspºja ir attºla asuma un dzidruma 
ràdïtàjs. Iz¹óirtspºju izsaka kà punktu (pikse¶u) skaitu 
attºlà vai displejà. Jo vairàk pikse¶u, jo precïzàks attºls. 
Iz¹óirtspºju parasti mºra pikse¶os, piem., 640x480=300 
kilopikse¶u (kpix)=0,3 megapikse¶u (Mpix).

Protected: (Aizsargàts) — noràda, ka attºls ir aizsargàts ar 
tehniskiem aizsardzïbas lïdzek¶iem.

Read-only: (Tikai lasàms) — ja atzïmº ¹o izvºles rþtiñu, 
attºlu nevar pàrveidot.

Lai nosþtïtu attºlu, pieskarieties Send (Sþtït) un 
izvºlieties atbilsto¹o sþtï¹anas metodi.

Autortiesïbu aizsardzïbas likumi, iespºjams, nepie¶auj 
atsevi¹óu attºlu, zvana melodiju un citu materiàlu 
kopº¹anu, modificº¹anu, pàrvieto¹anu vai pàrsþtï¹anu.

Lai attºlu pievienotu kontakta kartïtei, nospiediet 
, izvºlieties Tools (Rïki) > Add to contact... (Pievienot 

kontaktam). Atvºrtajà skatà ar irbu¶a vai ritinà¹anas 
taustiña palïdzïbu atlasiet ievietojamà attºla 
apgabalu. Izmantojiet rïkjoslu attºla tuvinà¹anai, 
apvºr¹anai vai pagrie¹anai, kà arï apmales 
pievieno¹anai. Kad esat apmierinàts ar iegþto attºlu, 
pieskarieties Add (Pievienot) un izvºlieties kontakta 
kartïti, kurai pievienosit attºlu.

Lai mainïtu faila formàtu, redaktora skatà nospiediet 
 un izvºlieties Options (Iespºjas) > Convert format... 

(Pàrvºrst formàtu). Izvºlieties citu faila formàtu un 
pàrºjàs iespºjas, ja tàdas pieejamas.

Lai attºlu pàrdºvºtu, nospiediet  un izvºlieties 
Image (Attºls) > Rename... (Pàrdºvºt). Ievadiet jauno 
attºla nosaukumu.

Lai noñemtu attºlu, nospiediet  un izvºlieties 
Image > Delete (Dzºst).

©ïs komandas ir pieejamas tikai saraksta skatà:

Lai pàrvietotu attºlu uz citu mapi, nospiediet  un 
izvºlieties Edit (Redi»ºt) > Move to folder... (Pàrvietot uz 
mapi). Atrodiet vajadzïgo mapi vai pieskarieties New 
(Jauna), lai izveidotu jaunu.

Lai izveidotu attºla kopiju, nospiediet  un 
izvºlieties Edit > Duplicate (Dublikàts). Ievºrojiet, ka 
vienmºr vajadzºtu izveidot redi»ºjamà attºla kopiju un 
redi»ºt kopiju, lai ori»inàlais attºls paliktu neskarts.
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Lai apskatïtu citas mapes saturu, nospiediet  un 
izvºlieties Image > Change folder... (Mainït mapi). 
Atrodiet vajadzïgo mapi vai pieskarieties New (Jauna), 
lai izveidotu jaunu.

Lai attºlus apskatïtu sarakstà vai sïktºlu veidà, 
nospiediet  vai nospiediet , izvºlieties Display 
(Ràdït) > View (Skats) > Thumbnail (Sïktºls) vai List 
(Saraksts).

Pla¹àku informàciju par to, kà izvºlieties attºlus, veidot 
mapes un darbvirsmai pievienot saïsnes, sk. noda¶à 
“Bie¾àkàs darbïbas programmàs” 22. lpp.

Attºlu uzstàdïjumi
Lai noràdïtu uzstàdïjumus, nospiediet  un 
izvºlieties Tools (Rïki) > Settings... (Uzstàdïjumi). 
Noràdiet vajadzïgos uzstàdïjumus.

Open images in full screen mode: (Atvºrt attºlus pilnekràna 
re¾ïmà) — izvºloties ¹o iespºju, ikviens atvºrtais attºls 
tiek paràdïts pilnekràna re¾ïmà. Lai atgrieztos 
parastajà skatà, pieskarieties ekrànam.

Default sketch name: (Attºla standarta nosaukums) — 
ievadiet vàrdu, kur¹ tiek izmantots visu zïmºjumu failu 
nosaukumu pamatà. Piem., ja ievadàt “Zïmºjums”, 
turpmàko zïmºjumu noklusºjuma nosaukumi bþs 
“Zïmºjums01”, “Zïmºjums02”, “Zïmºjums03” utt., lïdz 
nomainàt ¹o uzstàdïjumu.

Da¾u attºlu formàtu ïpatnïbas
Lai mainïtu vairàklapu TIFF/F attºla lapu, nospiediet 

 un izvºlieties Tools > Page (Lapa) > Next/Previous 
(Tàlàk/Atpaka¶). Vairàklapu TIFF/F attºlus nevar redi»ºt.

Lai apskatïtu animºtos GIF attºlus, varat ¶aut 
animàcijai slïdºt uz riñói, lïdz aizverat programmu 
Images vai pàrejat uz citu attºlu. Attºlu nevar redi»ºt, 
bet to var tuvinàt vai tàlinàt un apskatït pilnekràna 
re¾ïmà.

Attºlu redi»º¹ana
Var redi»ºt JPEG, GIF, BMP, TIFF/F, PNG un WBMP formàtu 
attºlus, kà arï izveidot jaunus zïmºjumus. Ievºrojiet — 
vairàklapu TIFF/F attºlus nevar redi»ºt.

24. attºls. Attºla redi»º¹ana

Lai redi»ºtu atvºrtà attºla kopiju, nospiediet  un 
izvºlieties Image (Attºls) > Open for editing (Atvºrt 
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redi»º¹anai). Detalizºtàku informàciju par attºlu 
pàrveido¹anu sk. noda¶à “Zïmº¹anas rïki” 85. lpp. un 
“Pàrveidojumi” 85. lpp.

Lai izveidotu jaunu zïmºjumu, nospiediet  un 
izvºlieties Image > Create sketch (Izveidot zïmºjumu). 
Skatot attºlus, ¹ï komanda nav pieejama. sàciet zïmºt 
tuk¹ajà laukumà. Rïkjoslà izvºlieties zïmº¹anas rïkus. 
Lai saglabàtu zïmºjumu, pieskarieties Done (Gatavs). 
Saglabàtie zïmºjumi tiek uzskaitïti programmas Images 
saraksta skatà.

Zïmº¹anas rïki
Rïkjoslà atrodas saïsnes uz svarïgàkajiem zïmº¹anas 
rïkiem. Tie pa¹i rïki ir pieejami arï kà komandas izvºlnº: 
nospiediet  un izvºlieties Tools (Rïki) > Sketch tools 
(Zïmº¹anas rïki).

Lai paràdïtu vai paslºptu rïkjoslu, nospiediet  un 
izvºlieties Display (Ràdït) > Toolbar (Rïkjosla).

Rïkjoslas ikonas:

 — zïmºt brïvrokas lïnijas.

 — zïmºt taisnes.

 — dzºst.

 — iezïmºt laukumu. Visi pàrveidojumi attieksies tikai 
uz iezïmºto laukumu. Lai izdzºstu iezïmºto laukumu, 
pieskarieties .

 — zïmºt taisnstþri.

 — zïmºt ovàlu vai apli.

 — ielikt tekstu. Lai formatºtu tekstu, pieskarieties 
Font (Fonts).

 — izvºlºties rïka lïnijas biezumu un kràsu.

 Lai uzzïmºtu aizpildïtu taisnstþri, nospiediet  un 
izvºlieties Tools > Sketch tools > Filled rectangle 
(Aizpildïts taisnstþris).

 Lai uzzïmºtu aizpildïtu ovàlu vai apli, nospiediet 
 un izvºlieties Tools > Sketch tools > Filled oval 

(Aizpildïts ovàls).

 Lai atsauktu izmaiñas, nospiediet  un izvºlieties 
Edit (Redi»ºt) > Undo/Undo all (Atsaukt/Atsaukt visas).

Pàrveidojumi
Lai iezïmºtà laukuma fonu padarïtu caurspïdïgu, 
nospiediet  un izvºlieties Options (Iespºjas) > Make 
transparent (Padarït caurspïdïgu).

Lai attºlu pagrieztu, nospiediet  un izvºlieties 
Options > Rotate (Pagriezt) > Right (Pa labi) vai Left (Pa 
kreisi). Attºls tiek pagriezts par 90 gràdiem izvºlºtajà 
virzienà.

Lai apvºrstu attºlu, nospiediet  un izvºlieties 
Options > Flip (Apvºrst) > Horizontally (Horizontàli) vai 
Vertically (Vertikàli).

Lai mainïtu attºla lielumu, nospiediet  un 
izvºlieties Options > Resize... (Mainït lielumu). 
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Izvºlieties vienu no piedàvàtajiem lielumiem vai 
izmantojiet pielàgo¹anas iespºju un pats noràdiet 
attºla lielumu.

Lai palielinàtu kanvu, nospiediet  un izvºlieties 
Options > Increase image area... (Palielinàt attºla 
laukumu). Izvºlieties kanvas balto malu novietojumu 
un noràdiet palielinàjumu pikse¶os.

Lai attºla apgrieztu, nospiediet  un izvºlieties 
Options > Crop (Apgriezt). Attºls tiek apgriezts 
automàtiski, noñemot visas baltàs malas ap to. Ja ap 
attºlu nav balto malu, komanda ir atspºjota.
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RealPlayer
Atveriet Desk (Darbvirsma) > RealPlayer vai programmà 
Camera (videokameras re¾ïmà) pieskarieties Go to 
RealPlayer (Atvºrt programmu RealPlayer).

25. attºls. RealPlayer

Izmantojot programmu RealPlayer, var skatïties 
videoklipus, kuri uzñemti ar viedtàlrunï iebþvºto 
videokameru vai pàrsþtïti uz viedtàlruni no saderïga 
personàlà datora, tïkla Web, pa e-pastu vai no atmiñas 
kartes. Var internetà skatïties videopàrraides un klausïties 
audiopàrraides. 

Izmantojot videostraumº¹anu un citas funkcijas, kuras 
lieto GPRS tïklu, ievºrojiet, ka par datu pàrsþtï¹anu, 
izmantojot GPRS, jàmaksà pºc operatora noteiktà datu 
pàrsþtï¹anas tarifa.

RealPlayer atbalsta ¹àdus failu formàtus: .RAM, .RM, .3GP 
un .MP4.

Iespºjams, ka RealPlayer neatbalsta visas faila formàtu 
variàcijas. RealPlayer atver tikai rtsp saites, bet ne http 
saites.

Video demonstrº¹ana
Lai sàktu tikko ar viedtàlruña videokameru uzñemtà 
video demonstrº¹anu, programmà Camera 
pieskarieties Go to RealPlayer, izvºlieties tikko 
ierakstïto video un pieskarieties Open (Atvºrt).

Lai sàktu videoklipa demonstrº¹anu, atveriet 
programmu RealPlayer, sarakstà izvºlieties failu un 
pieskarieties Open.

Ievºrojiet, ka, viedtàlrunï demonstrºjot zemas kvalitàtes 
videoklipus, tiem var bþt nevºlami attºla traucºjumi.

Padoms. Video demonstrº¹anu var uzsàkt da¾àdi:

• Veiciet dubultpieskàrienu videofailam programmà File 
Manager vai saraksta skatà.

• Veiciet dubultpieskàrienu programmà Desk 
izveidotajai saïsnei uz videofailu.

• Atveriet video pielikumu, kas atsþtïts e-pasta ziñà vai 
multiziñà.
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• Pieskarieties videostraumº¹anas saitei Web pàrlþkà.
Lai pàrtrauktu video demonstrº¹anu, pieskarieties 

.

Lai sàktu demonstrºt videostraumºjumu, Web 
pàrlþkprogrammà noklik¹óiniet uz straumº¹anas saites 
vai programmà RealPlayer atveriet .RAM failu, kurà ir 
saite straumº¹anas sàk¹anai. Pirms videostraumºjuma 
vai audiostraumºjuma demonstrº¹anas pàrliecinieties, 
vai ir noràdïti pareizie uzstàdïjumi. Uzstàdïjumus sk. 
sada¶à “RealPlayer uzstàdïjumi” 121. lpp.

Padoms. Programmu RealPlayer var vadït arï no 
izvºlnes. Nospiediet , izvºlieties Options (Iespºjas) 
un atbilsto¹o izvºlnes komandu.

Lai regulºtu ska¶umu, pieskarieties ska¶uma joslai 
ekràna aug¹ºjà labajà stþrï un velciet to, vai arï 
nospiediet ritinà¹anas taustiñu  un .

Lai izslºgtu skañu, pieskarieties ska¶ruña ikonai 
blakus ska¶uma joslai.

Lai àtri patïtu uz priek¹u vai attïtu atpaka¶ atvºrto 
videoklipu, pieskarieties un velciet .

Lai uz brïdi apturºtu video, pieskarieties . 
Pieskarieties vºlreiz, lai atsàktu demonstrº¹anu.

Ievºrojiet — ja atverat izvºlni video skatï¹anàs laikà, video 
demonstrº¹ana tiek uz brïdi pàrtraukta.

Lai skatïtos videoklipu pilnekràna re¾ïmà, 
pieskarieties ekrànam. Lai atgrieztos parastajà re¾ïmà, 
vºlreiz pieskarieties ekrànam.

Lai videoklipi vienmºr tiktu atvºrti pilnekràna 
re¾ïmà, nospiediet , izvºlieties Tools (Rïki) > 
Settings... (Uzstàdïjumi) un izvºlieties Open clips in full 
screen mode (Atvºrt klipus pilnekràna re¾ïmà).

Lai saglabàtu saiti uz pa¹laik straumºto video vai 
audio, nospiediet  un izvºlieties Media clip 
(Multivides klips) > Save link... (Saglabàt saiti).

Darbs ar videoklipiem
Programmas RealPlayer saraksta skatà tiek ràdïts visu 
saglabàto videoklipu un straumºjumu sai¹u saraksts. 
Mapes nosaukums tiek ràdïts nosaukuma apgabalà. Piem., 
¹ajà skatà var apskatït viedtàlrunï saglabàtos videoklipus, 
atvºrt videoklipus demonstrº¹anai, pàrdºvºt tos un kàrtot 
mapºs.

Lai pàrvietotu videoklipu uz citu mapi, nospiediet 
 un izvºlieties Edit (Redi»ºt) > Move to folder... 

(Pàrvietot uz mapi). Atrodiet mºróa mapi.

Lai atvºrtu citu mapi, nospiediet  un izvºlieties 
Media clip > Change folder... (Mainït mapi) vai Recent 
folders (Nesenàs mapes), lai atvºrtu kàdu no pºdºjàm 
se¹àm lietotajàm mapºm.

Lai no viedtàlruña izdzºstu atlasïto videoklipu, 
nospiediet  un izvºlieties Edit > Delete (Dzºst).

Lai no viedtàlruña izdzºstu vairàkus videoklipus, 
nospiediet  un izvºlieties Edit > Mark/Unmark 
(Atzïmºt/Noñemt atzïmi) > Mark (Atzïmºt). 
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Pieskarieties izdzº¹amajiem videoklipiem, lai tos 
atzïmºtu, nospiediet  un izvºlieties Edit > Delete.

Lai kàrtotu videoklipus, nospiediet , izvºlieties 
Display (Ràdït) > Sort (Kàrtot). Failus var kàrtot pºc 
nosaukuma, datuma vai faila lieluma.

Lai apskatïtu detalizºtu informàciju par videoklipu, 
nospiediet  un izvºlieties Tools (Rïki) > Details 
(Deta¶as).

Lai videoklipus nosþtïtu, pieskarieties Send (Sþtït) un 
izvºlieties atbilsto¹o sþtï¹anas metodi.

Autortiesïbu aizsardzïbas likumi, iespºjams, nepie¶auj 
atsevi¹óu attºlu, zvana melodiju un citu materiàlu 
kopº¹anu, modificº¹anu, pàrvieto¹anu vai pàrsþtï¹anu.
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Music player (Mþzikas atskañotàjs)
Atveriet Desk (Darbvirsma) > Music player (Mþzikas 
atskañotàjs).

Izmantojot programmu Music player, var klausïties 
mþziku un citus audiofailus, kas glabàjas viedtàlrunï vai 
atmiñas kartº. Mþzikas atskañotàjs atbalsta ¹àdus failu 
formàtus: MP3, WAV, MIDI, AAC, AMR, AU, RMF un M3U. 
Iespºjams, ka mþzikas atskañotàjs neatbalsta visas faila 
formàtu variàcijas.

26. attºls. Music player

Padoms. Informàciju par mþzikas ierakstu pàrsþtï¹anu 
no saderïga personàlà datora uz viedtàlruni sk. 
programmatþras Nokia PC Suite rokasgràmatà, kas 
atrodama komplektàcijà iek¶autajà kompaktdiskà.

Mþziku var klausïties pa iebþvºto ska¶runi vai saderïgàs 
austiñàs, turklàt vienlaikus izmantot citas viedtàlruña 
programmas.

Saskañà ar starptautiskiem lïgumiem un valstu 
autortiesïbu aizsardzïbas likumiem mþziku aizsargà 
autortiesïbas. Lai pavairotu vai kopºtu mþzikas ierakstus, 
iespºjams, ir jàiegàdàjas at¶auja vai licence. Da¾às valstïs 
likumi privàtpersonàm aizliedz kopºt ar autortiesïbàm 
aizsargàtus materiàlus. Noskaidrojiet likumu prasïbas 
attiecïgajà valstï attiecïbà uz ¹àdu materiàlu lieto¹anu.

Mþzikas atskañotàja vadïba
 — pieskarieties, lai atskañotu izvºlºto ierakstu.

 — pieskarieties, lai pàrtrauktu ieraksta atskaño¹anu.

 — pieskarieties, lai ieraksta atskaño¹anu uz brïdi 
apturºtu un atsàktu.

 — pieskarieties un velciet, lai regulºtu ska¶umu.

 — pieskarieties slïdnim un velciet to, lai atrastu 
noteiktu vietu pa¹reiz atskañotajà ierakstà. Atbilsto¹i 
mainàs laika indikators virs slïdña.

Padoms. Programmu Music player var vadït arï no 
izvºlnes. Nospiediet , izvºlieties Options (Iespºjas) 
un atbilsto¹o izvºlnes komandu.
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Ierakstu atskaño¹ana
Lai atskañotu ierakstu, veiciet tam dubultpieskàrienu 
vai atlasiet to un pieskarieties .

Padoms. Programmu Music player var atvºrt arï, 
programmà File manager (Failu pàrvaldïba) vai 
Messaging (Ziñapmaiña) veicot dubultpieskàrienu 
saderïgam skañas failam vai atverot saïsni darbvirsmà.

Lai atskañotu ierakstus pºc kàrtas, nospiediet  
un izvºlieties Options (Iespºjas) > Play options 
(Atskaño¹anas iespºjas) > Normal (Standarta). 
Izvºlieties ierakstu un pieskarieties , lai sàktu 
atskaño¹anu.

Lai ierakstus atskañotu brïvà secïbà, nospiediet  
un izvºlieties Options > Play options > Random (Jaukti).

Lai atskañotu pa vienam ierakstam, nospiediet  
un izvºlieties Options > Play options > Play selected track 
(Atskañot izvºlºto ierakstu). Lai atkàrtotu ieraksta 
atskaño¹anu, nospiediet  un izvºlieties Options > 
Play options > Repeat (Atkàrtot). Ieraksts tiek atskañots 
tik ilgi, lïdz noñemat atzïmi no izvºlnes komandas 
Repeat. Lai pàrietu uz nàkamo ierakstu, nospiediet 

 un izvºlieties Options > Next track (Nàkamais 
ieraksts).

Lai regulºtu ska¶umu, pieskarieties ska¶uma joslai 
ekràna aug¹ºjà labajà stþrï un velciet to, vai arï 
nospiediet ritinà¹anas taustiñu  un .

UZMANÏBU! Klausieties mþziku mºrenà ska¶umà. 
Ilgsto¹i klausoties ska¶u mþziku, var tikt bojàta dzirde.

Lai izslºgtu skañu, pieskarieties ska¶ruña ikonai 
blakus ska¶uma joslai.

Darbs ar ierakstiem
Lai ierakstu pàrvietotu uz citu mapi, nospiediet  
un izvºlieties Edit (Redi»ºt) > Move to folder... (Pàrvietot 
uz mapi). Atrodiet mºróa mapi.

Padoms.Lai izvºlºtos vairàkus ierakstus, pieskarieties 
ierakstam, lai to atlasïtu, nospiediet  un izvºlieties 
Edit > Mark/Unmark (Atzïmºt/Noñemt atzïmi) > Mark 
(Atzïmºt). Pieskarieties, lai atzïmºtu pàrºjos atlasàmos 
ierakstus.

Lai ieraksta saïsni pievienotu programmai Desk, 
nospiediet  un izvºlieties Tools (Rïki) > Add to Desk... 
(Pievienot programmai Desk).

Lai no viedtàlruña izdzºstu ierakstu, nospiediet  
un izvºlieties Track (Ieraksts) > Delete track (Dzºst 
ierakstu).

Lai kàrtotu ierakstus, nospiediet  un izvºlieties 
Display (Ràdït) > Sort (Kàrtot). Failus var kàrtot pºc 
nosaukuma, datuma vai faila lieluma.

Lai apskatïtu detalizºtu informàciju par ierakstu, 
nospiediet  un izvºlieties Tools > Details (Deta¶as).
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Lai nosþtïtu ierakstu, nospiediet  un izvºlieties 
Track > Send (Sþtït) un izvºlieties sþtï¹anas metodi.

Autortiesïbu aizsardzïbas likumi, iespºjams, nepie¶auj 
atsevi¹óu attºlu, zvana melodiju un citu materiàlu 
kopº¹anu, modificº¹anu, pàrvieto¹anu vai pàrsþtï¹anu.

Lai saglabàtu ierakstu, kas sañemts kà multiziñas 
pielikums, atveriet pielikumu programmà Messaging 
(Ziñapmaiña), nospiediet  un pieskarieties Save 
(Saglabàt). 

Ierakstu saraksti
Ievºrojiet, ka programmà Music player nevar izveidot 
jaunus dziesmu sarakstus, taèu uz viedtàlruni var pàrsþtït 
citur izveidotus ierakstu sarakstus. Lai pàrsþtïtu ierakstu 
sarakstus, var izmantot atmiñas karti vai saderïgu datoru. 
Informàciju par ierakstu sarakstu pàrsþtï¹anu uz ¹o 
viedtàlruni sk. programmatþras Nokia PC Suite 
rokasgràmatà, kas atrodama komplektàcijà iek¶autajà 
kompaktdiskà.

Lai atvºrtu ierakstu sarakstu, nospiediet  un 
izvºlieties Track (Ieraksts) > Change track list... (Mainït 
ierakstu sarakstu) vai Recent track lists (Neseno ierakstu 
saraksti), lai atvºrtu vienu no pºdºjiem se¹iem 
lietotajiem ierakstu sarakstiem.
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Visual Radio
Atveriet Desk (Darbvirsma) > Visual Radio.

Programmu Visual RadioTM var izmantot kà tradicionàlo FM 
radio ar automàtisku staciju meklº¹anu un iepriek¹ 
uzstàdïtàm stacijàm vai kà radio kopà ar displejà vienlaikus 
ràdïtu vizuàlo informàciju (ja ir izvºlºta stacija, kura 
piedàvà pakalpojumu Visual Radio). Pakalpojums Visual 
Radio izmanto GPRS (tïkla pakalpojums). Klausoties FM 
radio, vienlaikus var izmantot citas viedtàlruña 
programmas.

27. attºls. Visual Radio

Lai lietotu pakalpojumu Visual Radio, ir nepiecie¹ami ¹àdi 
priek¹nosacïjumi:

• ¹is pakalpojums ir jàatbalsta stacijai, kuru klausàties, 
un tïkla operatoram;

• viedtàlrunim ir jàbþt ieslºgtam;

• viedtàlrunï jàbþt ievietotai derïgai SIM kartei;
• interneta piek¶uves punkts jàdefinº tà, lai varºtu 

piek¶þt operatora Visual Radio serverim;
• iepriek¹ uzstàdïtajàm radiostacijàm jànoràda 

pareizs pakalpojuma Visual Radio identifikators un 
jàaktivizº pakalpojums Visual Radio. Pla¹àku 
informàciju sk. noda¶à “Iepriek¹ uzstàdïtas stacijas” 
94. lpp.

Ja jums nav piek¶uves pakalpojumam Visual Radio, jþsu 
re»iona operatori un radiostacijas nenodro¹ina Visual 
Radio. Pakalpojums Visual Radio visos re»ionos un valstïs 
nav pieejams.

Radio kà antenu izmanto austiñu vadu. Lai radio darbotos 
pareizi, viedtàlrunim jàpievieno saderïgas austiñas.

Klausoties radio, parasti var piezvanït un atbildºt uz 
zvaniem. Sarunu laikà radio tiek izslºgts. Pºc sarunas 
beigàm radio, iespºjams, ir jàieslºdz manuàli.

Radio klausï¹anàs
Ievºrojiet, ka radio pàrraides kvalitàte ir atkarïga no 
radiostacijas pàrklàjuma. 

Lai ieslºgtu vai izslºgtu radio, pievienojiet 
viedtàlrunim saderïgas austiñas un programmà Visual 
Radio pieskarieties .
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Padoms. Radio var vadït arï no izvºlnes. Nospiediet 
, izvºlieties Radio un atbilsto¹o izvºlnes komandu.

Lai radio klausïtos austiñàs vai pa ska¶runi, 
pàrbaudiet, vai austiñas ir pievienotas viedtàlrunim, 
nospiediet  un izvºlieties Tools (Rïki) > Speaker in 
use (Izmantotais atskaño¹anas elements) > Headset 
(Austiñas) vai Loudspeaker (Ska¶runis). Austiñu vads 
darbojas kà radioantena, tàpºc tam jàkaràjas brïvi.

Lai regulºtu ska¶umu, pieskarieties un velciet 
 vai piespiediet  un .

Lai manuàli meklºtu radiostacijas, pieskarieties  
vai .

Lai stacijas meklºtu automàtiski, pieskarieties  
vai . Atrodot staciju, meklº¹ana tiek apturºta.

Lai apskatïtu konkrºtajà vietà pieejamàs stacijas, 
nospiediet  un izvºlieties Tools (Rïki) > Channel 
directory... (Staciju katalogs). Izvºlieties vietu un 
radiostaciju. Visual Radio ¹o staciju atrod automàtiski. 
Lai staciju saglabàtu iepriek¹ uzstàdïto staciju 
sarakstà, pieskarieties Save (Saglabàt). Pla¹àku 
informàciju sk. noda¶à “Iepriek¹ uzstàdïtas stacijas” 
94. lpp. Lai apskatïtu informàciju par staciju, piem., 
vizuàlà pakalpojuma identifikatoru, pieskarieties 
Details (Deta¶as).

Lai pàrslºgtos uz stereo vai mono atskaño¹anas 
re¾ïmu, nospiediet  un izvºlieties Tools > Sound 
(Skaña) > Stereo vai Mono.

Satura skatï¹anàs
Lai skatïtu pieejamo vizuàlo saturu, izvºlieties 
iepriek¹ uzstàdïtu staciju un pieskarieties . Lai 
beigtu skatïties vizuàlo saturu, pieskarieties . 
Ievºrojiet, ka jàbþt noràdïtam pareizam vizuàlà 
pakalpojuma identifikatoram un jàbþt aktivizºtam 
pakalpojumam Visual Radio. Sïkàku informàciju sk. 
sada¶à “Iepriek¹ uzstàdïtas stacijas”.

Iepriek¹ uzstàdïtas stacijas
Programmà Visual Radio var saglabàt lïdz 20 
radiostacijàm.

Lai saglabàtu staciju, pieskaroties  un , 
atrodiet staciju. Nospiediet  un izvºlieties Channel 
(Stacija) > Save... (Saglabàt). Izvºlieties stacijas vietu un 
ievadiet saglabàtàs stacijas nosaukumu. Ja 
nepiecie¹ams, mainiet frekvenci. Ja stacija piedàvà 
vizuàlo saturu, pievienojiet pakalpojuma Visual Radio 
identifikatoru un atzïmºjiet izvºles rþtiñu Enable visual 
service: (Aktivizºt vizuàlo pakalpojumu), lai ¶autu 
sañemt vizuàlo saturu.

Padoms. Lai atrastu stacijas vizuàlà pakalpojuma 
identifikatoru, nospiediet  un izvºlieties Tools (Rïki) 
> Channel directory... (Staciju katalogs). Izvºlieties 
radiostaciju un pieskarieties Details.

Lai klausïtos iepriek¹ uzstàdïtu staciju, saraksta skatà 
pieskarieties stacijai.
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Lai redi»ºtu iepriek¹ uzstàdïtu staciju, nospiediet 
 un izvºlieties Channel (Stacija) > Edit... (Redi»ºt).

Lai pàrkàrtotu iepriek¹ uzstàdïtàs stacijas, izvºlieties 
staciju, nospiediet  un izvºlieties Channel > 
Reorder... (Pàrkàrtot). Sarakstà izvºlieties stacijas vietu. 
Lai apstiprinàtu pàrvieto¹anu, nospiediet ritinà¹anas 
taustiñu centrà.

Lai izdzºstu iepriek¹ uzstàdïtu staciju, nospiediet  
un izvºlieties Channel > Delete (Dzºst).

Padoms. Lietojot saderïgas austiñas, nospiediet 
austiñu pogu, lai atrastu nàkamo radiostaciju vai 
nàkamo saglabàto staciju (ja ir izvºlºts saglabàto 
staciju saraksts).

Visual Radio uzstàdïjumi
Lai pàrveidotu uzstàdïjumus, nospiediet  un 
izvºlieties Tools (Rïki) > Settings... (Uzstàdïjumi). 
Noràdiet vajadzïgos uzstàdïjumus.

Auto-start visual service: (Automàtiska vizuàlà pakalpojuma 
startº¹ana) — ja ir atzïmºta ¹ï iespºja, pakalpojums 
Visual Radio tiek sàkts automàtiski, pieskaroties 
iepriek¹ saglabàtai stacijai, kura piedàvà vizuàlo 
pakalpojumu.

Access point: (Piek¶uves punkts) — izvºlieties piek¶uves 
punktu, kas izmantojams datu savienojumam. Pla¹àku 
informàciju sk. sada¶à “Interneta piek¶uves punkta 
uzstàdï¹ana” 114. lpp. Ievºrojiet, ka ¹is piek¶uves punkts 

nav nepiecie¹ams, lai programmu Visual Radio 
izmantotu kà parastu FM radio.
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Voice recorder (Balss ierakstï¹ana)
Atveriet Desk (Darbvirsma) > Voice recorder (Balss 
ierakstï¹ana).

Programma Voice recorder ¶auj ierakstït balss piezïmes. 
Varat arï noklausïties savas ierakstïtàs piezïmes un citus 
skañas failus vai multiziñàs ievietot balss klipus. 

Ieraksta maksimàlais garums ir atkarïgs no pieejamàs 
vietas atmiñà.

Var atvºrt failus, kuri saglabàti ¹àdos failu formàtos: WAV 
un AMR.

Ierakstï¹ana un atskaño¹ana
Lai sàktu ierakstï¹anu, pieskarieties . Tiek ràdïts 
laiks, kas pagàjis kop¹ ieraksta sàkuma. Lai pàrtrauktu 
ierakstï¹anu, pieskarieties .

Padoms. Nospiediet , lai àtri sàktu un 
pàrtrauktu ierakstï¹anu.

Lai atskañotu izvºlºto skañas klipu, pieskarieties 
.

Lai uz brïdi apturºtu skañas klipa atskaño¹anu, 
pieskarieties . Pieskarieties vºlreiz, lai atsàktu 
demonstrº¹anu.

Lai regulºtu ska¶umu, pieskarieties ska¶uma joslai 
ekràna aug¹ºjà labajà stþrï un velciet to, vai arï 
nospiediet ritinà¹anas taustiñu  un .

Lai àtri patïtu uz priek¹u vai attïtu atpaka¶ atvºrto 
skañas klipu, pieskarieties un velciet .

Lai pàrtrauktu atskaño¹anu, pieskarieties .

Padoms. Programmu Voice recorder var vadït arï no 
izvºlnes. Nospiediet , izvºlieties Options (Iespºjas) 
un atbilsto¹o izvºlnes komandu.

Darbs ar skañas klipiem
Lai nosþtïtu balss klipu, nospiediet  un izvºlieties 
Sound clip (Skañas klips) > Send (Sþtït) un izvºlieties 
sþtï¹anas metodi.

Lai kàrtotu skañas klipu sarakstu, nospiediet  un 
izvºlieties Display (Ràdït) > Sort (Kàrtot). Skañas failus 
var kàrtot pºc nosaukuma, datuma vai faila lieluma.

Lai izvºlºto skañas klipu pàrdºvºtu vai izdzºstu, 
nospiediet , izvºlieties Sound clip (Skañas klips) un 
atbilsto¹o komandu.

Lai atvºrtu citu mapi, nospiediet  un izvºlieties 
Sound clip > Change folder... (Mainït mapi).
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Lai skañas klipa saïsni pievienotu programmai Desk, 
nospiediet  un izvºlieties Tools (Rïki) > Add to Desk... 
(Pievienot programmai Desk).

Lai apskatïtu detalizºtu informàciju par skañas 
klipu, nospiediet  un izvºlieties Tools > Details 
(Deta¶as).

Balss ierakstï¹anas uzstàdïjumi
Lai redi»ºtu Voice recorder uzstàdïjumus, nospiediet 

 un izvºlieties Tools > Settings... (Uzstàdïjumi). 
Noràdiet vajadzïgos uzstàdïjumus.

Clip name: (Klipa nosaukums) — ievadiet vàrdu, kur¹ 
jàizmanto visu skañas failu nosaukumu pamatà. Piem., 
ja ievadàt “Skaña”, turpmàko skañas klipu noklusºjuma 
nosaukumi bþs Skaña(01), Skaña(02), Skaña(03) utt.

Clip format: (Klipu formàts) — izvºlieties faila formàtu, kurà 
skañas klipi jàsaglabà pºc noklusºjuma.
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Documents (Dokumenti)
Atveriet Desk (Darbvirsma) > Documents (Dokumenti).

Programmu Documents var izmantot, lai rakstïtu jaunus 
teksta dokumentus un redi»ºtu eso¹os. Dokumentos var 
ievietot un apskatït attºlus un citus failus. Dokumentus 
varat arï nosþtït un sañemt ïsziñu, multiziñu vai e-pasta 
pielikumu veidà, kà arï izmantojot tehnolo»iju Bluetooth.

Var atvºrt, redi»ºt un saglabàt dokumentus, kuri izveidoti 
programmà Microsoft Word for Windows 97 vai jaunàkàs 
versijàs. Ievºrojiet, ka atsevi¹óas ori»inàla dokumentu 
funkcijas un formatºjums netiek atbalstïts. Dokumenta 
ori»inàlam nedrïkst bþt uzstàdïta aizsardzïba ar paroli. 
Dokumenti, kuri izveidoti citàs Microsoft Word versijàs, ir 
tikai apskatàmi.

Darbs ar dokumentiem
Lai izveidotu, atvºrtu vai pàrdºvºtu dokumentu, 
nospiediet  un izvºlnº Document (Dokuments) 
izvºlieties atbilsto¹o komandu.

Lai ievietotu speciàlàs rakstzïmes, nospiediet  un 
izvºlieties Insert (Ielikt) > Special character... (Speciàlà 
rakstzïme). Izvºlieties ievietojamo rakstzïmi vai 
simbolu un pieskarieties OK (Labi).

Lai dokumentà ievietotu datumu, nospiediet  un 
izvºlieties Insert > Date (Datums).

Lai atsauktu k¶þdas, nospiediet  un izvºlieties Edit 
(Redi»ºt) > Undo (Atsaukt).

Lai ràdïtu vai paslºptu teksta maróierus, nospiediet 
 un izvºlieties Tools (Rïki) > Formatting marks... 

(Formatºjuma atzïmes). Izvºlieties maróierus, kuriem 
dokumentà jàbþt redzamiem, un pieskarieties OK.

Lai saskaitïtu vàrdus, nospiediet  un izvºlieties 
Tools > Word count... (Vàrdu skaits).

Lai ne¶autu redi»ºt dokumentu , nospiediet  
saraksta skatà un izvºlieties Tools > Details (Deta¶as). 
Atzïmºjiet izvºles rþtiñu Read-only: (Tikai lasàms) un 
pieskarieties OK. Dokuments tagad ir apskatàms, bet to 
nevar redi»ºt.

Lai nosþtïtu dokumentu, pieskarieties Send (Sþtït), 
izvºlieties sþtï¹anas metodi un pieskarieties OK.

Lai apskatïtu dokumenta struktþru, nospiediet  
un izvºlieties Display (Ràdït) > Outline view... 
(Struktþrskats).

Padoms. Ja dokumentà ierakstàt tàlruña numuru, 
e-pasta adresi vai Web adresi, to var izmantot kà 
hipersaiti. Pieskarieties ar irbuli numuram vai adresei 
vai ar ritinà¹anas taustiña palïdzïbu ievietojiet tajà 
kursoru; objekts k¶þst par saiti ar nelielu ikoniñu. 
Pieskarieties ikonai, lai piezvanïtu uz tàlruña numuru, 
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atvºrtu e-pasta redaktoru vai piek¶þtu Web vietai (ja ir 
izveidots interneta savienojums).

Rindkopu stilu redi»º¹ana
Rindkopas stils ir formatºjuma rakstzïmju kopa, ar kuras 
palïdzïbu var àtri mainït teksta noformºjumu.
1 Nospiediet  un pieskarieties Format (Formatºt) > 

Style... (Stils).
2 Izvºlieties redi»ºjamo stilu un pieskarieties Edit 

(Redi»ºt). Pieskarieties New (Jauns), lai izveidotu jaunu 
stilu.

3 Pie¹óiriet jaunajam stilam nosaukumu un izvºlºties 
strukturºjuma lïmeni. Lïmenis 0 nozïmº, ka teksts ar 
¹àdu stilu netiek ràdïts strukturºjuma skatà.

4 Pieskarieties Format (Formatºt), izvºlieties, ko 
redi»ºsit, un vºlreiz pieskarieties Format, lai sàktu 
redi»º¹anu. Jþs varat mainït ¹àdas vºrtïbas:
Font (Fonts) — var mainït fonta veidu, lielumu un kràsu. 
Varat pievienot arï treknraksta, slïpraksta, pasvïtrojuma 
un pàrsvïtrojuma formatºjumu. Izvºloties aug¹raksta 
vai apak¹raksta formatºjumu, tekstu var paaugstinàt 
vai pazeminàt. Lai apskatïtu, kà izskatïsies veiktàs 
izmaiñas, pieskarieties Preview (Apskate).
Paragraph (Rindkopa) — varat mainït rindkopas malu 
izskatu, tàs da¾àdi izlïdzinot. Varat mainït atstarpes 
starp teksta rindiñàm, izveidot rindkopu atkàpes, kà arï 
ievietot tabulº¹anas pieturas, lai noràdïtu teksta 
pozïciju lapà.

Borders (Apmales) — jebkurà lapas malà varat ievietot 
apmali un izvºlºties tàs stilu un kràsu.
Bullets (Aizzïmes) — varat izvºlºties kàdu no èetriem 
aizzïmju stiliem, noràdït to lielumu, kràsu un atkàpi no 
malas.

5 Kad esat beidzis redi»ºt stila vºrtïbu, pieskarieties OK.
6 Pieskarieties Close (Aizvºrt), lai aizvºrtu dialogu.
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Sheet (Darblapa)
Atveriet Desk (Darbvirsma) > Sheet (Darblapa).

Programmà Sheet varat stràdàt un datus glabàt failà, ko 
sauc par darbgràmatu. Katrà darbgràmatà ir vismaz viena 
darblapa. Darbgràmatà var bþt arï diagrammas; 
diagrammu lapa ir lapa, kurà diagramma veidota, 
izmantojot darblapas datus.

Programmà Sheet var atvºrt dokumentus, kuri veidoti, 
izmantojot programmu Microsoft Excel 97 for Windows 
vai jaunàkas versijas. Ievºrojiet, ka atsevi¹óas ori»inàla 
dokumentu funkcijas un formatºjums netiek atbalstïts. 
Vienà ¹þnà var iek¶aut ne vairàk kà 256 rakstzïmes. Ja 
¹þnà ir vairàk rakstzïmju, tad, pàrvºr¹ot faila formàtu, 
¹þnas saturs tiek saïsinàts.

Darbgràmatas
Lai ne¶autu redi»ºt darbgràmatu, saraksta skatà 
nospiediet  un izvºlieties Tools > Details (Deta¶as). 
Atzïmºjiet izvºles rþtiñu Read-only: (Tikai lasàms) un 
pieskarieties OK (Labi). Darbgràmata tagad ir 
apskatàma, bet to nevar redi»ºt.

Lai izveidotu, atvºrtu vai pàrdºvºtu darbgràmatu, 
nospiediet  un izvºlnº Workbook (Darbgràmata) 
izvºlieties atbilsto¹o komandu.

Darbs ar darblapàm
Lai izveidotu darblapas dublikàtu, pieskarieties 
Worksheets / Charts (Darblapas/Diagrammas). 
Izvºlieties lapu un pieskarieties Duplicate (Dublikàts).

Lai pàrdºvºtu darblapu, pieskarieties Worksheets / 
Charts. Izvºlieties lapu un pieskarieties Rename 
(Pàrdºvºt). Ievadiet jauno nosaukumu un pieskarieties 
OK.

Lai atlasïtu ¹þnu ar nosaukumu, nospiediet  un 
izvºlieties Edit (Redi»ºt) > Mark/Unmark (Atzïmºt/
Noñemt atzïmi). Diapazonam izvºlieties iespºju Named 
area (Apgabals ar nosaukumu) un sarakstà izvºlieties 
vajadzïgo ¹þnu, pºc tam pieskarieties OK.

Lai rindas bþtu redzamas ritinà¹anas laikà, atlasiet 
rindu zem apgabala, kuram jàpaliek redzamam.Lai bþtu 
redzamas kolonnas, atlasiet kolonnu pa labi no 
apgabala, kam jàpaliek redzamam. Pºc tam rïkjoslà 
pieskarieties ikonai  vai nospiediet  un 
izvºlieties Display (Ràdït) > Freeze panes (Sasaldºt rþtis).

Lai pàrietu uz konkrºtu ¹þnu vai apgabalu ar 
nosaukumu, pieskarieties Go To (Iet uz). Noràdiet ¹þnu 
vai apgabalu ar nosaukumu, uz kuru jàpàriet, un 
pieskarieties OK.
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Padoms. Izmantojot rïkjoslas ikonu , var 
automàtiski ievietot ¹þnu diapazona summu. Atlasiet 
¹þnu, kurà jàievieto summa, un pieskarieties . 
Piedàvàtà formula tiek ràdïta formulu laukà darblapas 
aug¹da¶à. Piedàvàto formulu var mainït, to redi»ºjot 
formulu laukà. Izejot no ¹þnas, formula tiek akceptºta.

Darblapu formatº¹ana
Vispirms atlasiet ¹þnu vai ¹þnas, kuras formatºsit.

Lai formatºtu fontus, nospiediet  un izvºlieties 
Format (Formatºt) > Font (Fonts). Var mainït fonta 
veidu, lielumu un kràsu. Varat pievienot arï treknraksta, 
slïpraksta, pasvïtrojuma un pàrsvïtrojuma 
formatºjumu. Izvºloties aug¹raksta vai apak¹raksta 
formatºjumu, tekstu var paaugstinàt vai pazeminàt. Lai 
apskatïtu, kà izskatïsies veiktàs izmaiñas, pieskarieties 
Preview (Apskate).

Lai mainïtu skait¶u formàtu, nospiediet  un 
izvºlieties Format > Numbers (Skait¶i). Piem., varat 
noràdït, kà jàparàda datums, laiks vai naudas vienïbas.

Lai lïdzinàtu ¹þnu saturu, nospiediet  un 
izvºlieties Format > Alignment (Lïdzinàjums). Izvºloties 
iespºju Wrap text to cell: (Aplauzt tekstu ¹þnà), atlasïtàs 
¹þnas rindas augstums tiek pielàgots, lai tiktu paràdïts 
viss ¹þnas saturs.

Lai pielàgotu rindas augstumu vai kolonnas 
platumu, velciet malu zem rindas virsraksta vai 

kolonnas virsraksta labàs puses malu, lïdz rinda/
kolonna ir vajadzïgajà lielumà. Lai precïzàk noràdïtu 
augstumu vai platumu, nospiediet un izvºlieties 
Format > Row height (Rindas augstums) vai Column 
width (Kolonnas platums). Noràdiet augstumu vai 
platumu un pieskarieties OK (Labi).

Lai formatºtu ¹þnu apmales, nospiediet  un 
izvºlieties Format > Borders (Apmales). Apmali var 
pievienot jebkurà ¹þnas malà. Izvºlieties apmales stilu 
un kràsu un pieskarieties OK.

Lai mainïtu ¹þnas fona kràsu, nospiediet  un 
izvºlieties Format > Background colour (Fona kràsa). 
Izvºlieties kràsu un pieskarieties OK.

Lai tiktu ràdïtas re¾»lïnijas, nulles vºrtïbas un 
virsraksti, nospiediet  un izvºlieties Tools (Rïki) > 
Settings (Uzstàdïjumi). Izvºlieties objektus, kuriem 
darblapà jàbþt redzamiem, un pieskarieties OK.

Diagrammu lapas
Lai detalizºti formatºtu diagrammu, nospiediet  
un izvºlieties Format. Izvºlieties redi»ºjamo objektu. 
Uzstàdïjumu atlase ir atkarïga no diagrammas veida.

Padoms. Lai piek¶þtu atsevi¹óiem uzstàdïjumu 
dialogiem, varat pieskarties atbilsto¹ajam objektam 
diagrammà. Piem., dialogs X-axis settings (X ass 
uzstàdïjumi) tiek atvºrts, ja diagrammà veicat 
dubultpieskàrienu x asij.
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Font (Fonts) — var mainït fonta veidu, lielumu un kràsu. 
Varat pievienot arï treknraksta, slïpraksta, pasvïtrojuma 
un pàrsvïtrojuma formatºjumu. Izvºloties aug¹raksta vai 
apak¹raksta formatºjumu, tekstu var paaugstinàt vai 
pazeminàt. Lai apskatïtu, kà izskatïsies veiktàs izmaiñas, 
pieskarieties Preview (Apskate).

Chart (Diagramma) — varat izvºlieties diagrammas veidu, 
izveidot telpisku diagrammu, kà arï mainït fona un asu 
kràsu. Varat mainït arï diagrammas nosaukumu un x un y 
ass nosaukumus.

X-axis (X ass) — varat izvºlºties maróºjuma veidu un 
ievadït tà datu diapazonu, paràdït vai paslºpt ass lïniju un 
pievienot atzïmes. Varat arï ievadït kategorijas skaitli, kur 
krustojas abas asis, un mainït sadalïjuma palïgatzïmju 
skaitu katrà kategorijà.

Y-axis (Y ass) — varat noràdït, vai vºrtïbas diagrammà 
jàràda, noteikt lielàko un mazàko ràdïto vºrtïbu, kà arï 
vietu, kurà asis krustojas. Varat arï izmantot logaritmisko 
lineàlu, mainït intervàlu, pºc kura tiek ievietotas galvenàs 
sadalïjuma atzïmes, un mainït skait¶u formàtu.

Legend (Apzïmºjumi) — varat pievienot lodziñu, kurà 
paskaidrotas diagrammà izmantotàs kràsas, kà arï noràdït 
lodziña atra¹anàs vietu.

Gridlines (Re¾»lïnijas) — varat izvºlieties, vai galvenajàm 
asïm un palïgasïm ir re¾»lïnijas.

Series (Sºrija) — varat diagrammai pievienot jaunu datu 
sºriju vai redi»ºt eso¹o sºriju. Varat noràdït, vai sºrija 
diagrammà jàràda, mainït sºrijas datu diapazonu, 

izvºlºties maróºjuma veidu un ievadït tam datu 
diapazonu. Varat arï noràdït kràsu, kàdà tiek ràdïta sºrija. 
Ievºrojiet — sektoru diagrammàs var bþt tikai viena datu 
sºrija.

Lai izveidotu diagrammu lapas dublikàtu, 
pieskarieties Worksheets / Charts (Darblapas/
Diagrammas). Izvºlieties diagrammu un pieskarieties 
Duplicate (Dublikàts).

Lai pàrdºvºtu diagrammu lapu, pieskarieties 
Worksheets / Charts. Izvºlieties diagrammu un 
pieskarieties Rename (Pàrdºvºt). Ievadiet jauno 
nosaukumu un pieskarieties OK.
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Presentations (Prezentàcijas)
Atveriet Desk (Darbvirsma) > Presentations 
(Prezentàcijas).

Varat atvºrt un apskatït prezentàcijas, kuras veidotas 
programmà Microsoft PowerPoint 97 vai jaunàkàs versijàs. 
Ievºrojiet, ka atsevi¹óas ori»inàla dokumentu funkcijas un 
formatºjums netiek atbalstïts. ©ïs prezentàcijas var nosþtït 
un sañemt pa e-pastu vai izmantojot tehnolo»iju 
Bluetooth.

Saraksta skatà tiek paràdïts visu atlasïtajà mapº iek¶auto 
prezentàciju saraksts. Mapes nosaukums tiek ràdïts 
nosaukuma apgabalà. ©ajà skatà var stràdàt ar 
prezentàcijàm, neatverot atbilsto¹os failus. Piem., ar 
izvºlnes joslas komandu palïdzïbu prezentàcijas var 
pàrvietot vai kopºt.

Padoms. Pla¹àku informàciju par pieejamajàm 
komandàm sk. noda¶à “Bie¾àkàs darbïbas programmàs” 
22. lpp.

Lai atvºrtu prezentàciju, sarakstà veiciet 
dubultpieskàrienu ¹ai prezentàcijai. Ja fails atrodas cità 
mapº, nospiediet  un izvºlieties Presentation 
(Prezentàcija) > Change folder... (Mainït mapi). 
Izvºlieties mapi, kurà prezentàcija tiek saglabàta. 
Ievºrojiet, ka vienlaikus var bþt atvºrta tikai viena 
prezentàcija.

Lai pàrvietotos no viena slaida uz citu, izmantojiet 
pogas Next (Nàkamais) un Previous (Iepriek¹ºjais). Lai 
pàrvietotos uz konkrºtu slaidu, nospiediet  un 
izvºlieties Presentation > Go to slide (Iet uz slaidu). 
Sarakstà izvºlieties slaidu un pieskarieties OK (Labi).

Lai apskatïtu slaidus pilnekràna re¾ïmà, nospiediet 
 un izvºlieties Display (Ràdït) > Full screen 

(Pilnekràns). Lai atgrieztos standarta skatà, nospiediet 
 un izvºlieties Display, pºc tam notïriet iespºju Full 

screen.

Lai apskatïtu papildu piezïmes prezentàcijà, 
nospiediet  un izvºlieties View (Skatït) > Notes 
(Piezïmes). Lai atgrieztos slaidu standarta skatà, 
nospiediet  un izvºlieties View > Slide (Slaids).

Lai apskatïtu visu prezentàciju kopumà, nospiediet 
 un izvºlieties View > Outline (Strukturºjums). Lai 

izvºlºto slaidu atvºrtu slaidu standarta skatà, 
pieskarieties Slide view (Slaidu skats) vai veiciet 
dubultpieskàrienu slaida nosaukumam.

Lai kopºtu tekstu no atvºrtà slaida, nospiediet  
un izvºlieties Edit (Redi»ºt) > Copy text (Kopºt tekstu). 
Teksts tiek iekopºts starpliktuvº. Skatà Notes 
(Piezïmes) tiek kopºts arï piezïmju saturs. Lai kopºtu 
visu prezentàcijas tekstu, nospiediet  un 
izvºlieties View > Outline. Pºc tam vºlreiz nospiediet 
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 un izvºlieties Edit > Copy all text (Kopºt visu 
tekstu). Viss slaidu un piezïmju teksts tiek iekopºts 
starpliktuvº. Lai kopºtu visu slaidu tekstu, izvºlieties 
Copy all slide text (Kopºt visu slaidu tekstu), bet, lai 
kopºtu visu piezïmju tekstu, izvºlieties Copy all note text 
(Kopºt visu piezïmju tekstu). Ievºrojiet, ka var zust da¶a 
formatºjuma.
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Clock (Pulkstenis)
Atveriet Desk (Darbvirsma) > Clock (Pulkstenis).

Lai uzstàdïtu pareizu laiku un datumu, pieskarieties 
Date and time (Datums un laiks). Lai viedtàlrunï 
uzstàdïtais laiks un datums tiktu automàtiski 
atjauninàts no tïkla, atzïmºjiet izvºles rþtiñu Auto-
update of date & time: (Datuma un laika pa¹regulàcija). 
Ievºrojiet, ka tas ir tïkla pakalpojums. Vai arï 
pieskarieties  un, pieskaroties bultiñàm, mainiet 
laiku. Pieskarieties , lai uzstàdïtu datumu. Lai tiktu 
ievºrots vasaras laiks, atzïmºjiet izvºles rþtiñu Apply 
daylight-saving: (Ievºrot vasaras laiku).

Sk. arï “Regional settings (Re»ionàlie uzstàdïjumi)” 
121. lpp.

Lai pàrslºgtos no parastà pulksteña uz elektronisko 
un pretºji, pieskarieties pulkstenim.

Lai skatà Time (Laiks) tiktu ràdïta tikai màjas 
pilsºta, nospiediet  un izvºlieties Display (Ràdït). 
Notïriet iespºju Destination city (Ce¶a mºróa pilsºta). 

Lai pàrslºgtos no skata Time (Laiks) uz skatu Alarm 
(Modinàtàjs), nospiediet  un izvºlieties View 
(Skatït) > Alarm vai Time.

28. attºls. Clock

Signàli
Lai uzstàdïtu modinàtàja signàlu, pieskarieties Set 
alarm (Uzstàdït signàlu). Ievadiet tekstu, kas tiek 
paràdïts, atskanot signàlam. Pieskarieties , pºc tam 

 un , lai uzstàdïtu signàla laiku. Pieskarieties OK 
(Labi). Noràdiet, cik bie¾i signàls jàatkàrto, un 
pieskarieties OK.

Ja signàla laiks pienàk, kad viedtàlrunis ir izslºgts, tas 
automàtiski ieslºdzas un atskan signàls.

Lai izslºgtu un noñemtu signàlu, kad tas atskan, 
pieskarieties Stop (Apturºt). Ja signàlam atskanot, 
viedtàlrunis tika izslºgts, tiek vaicàts, vai vºlaties 
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viedtàlruni ieslºgt. Nospiediet Cancel (Atcelt), lai 
viedtàlruni izslºgtu, vai Switch on (Ieslºgt), lai 
viedtàlruni ieslºgtu. Neizvºlieties Switch on, ja mobilà 
tàlruña lieto¹ana varºtu radït traucºjumus vai bþt 
bïstama.

Lai atliktu signàla atskaño¹anu uz desmit minþtºm, 
pieskarieties Snooze (Atlikt). Ja signàlam atskanot, 
viedtàlrunis tika izslºgts, pºc 10 minþtºm tas atkal 
izslºgsies un ieslºgsies.

Lai izslºgtu modinàtàja skañu, kad tas zvana, 
pieskarieties Mute (Izslºgt skañu). Modinàtàjs vairs 
nezvana, bet ekrànà tiek ràdïts paziñojums. 

Lai izdzºstu modinàtàja signàlu, nospiediet  un 
pieskarieties View (Skatït) > Alarm. Izvºlieties dzº¹amo 
signàlu un pieskarieties Remove alarm (Noñemt 
signàlu).

Lai redi»ºtu modinàtàja signàlu, nospiediet  un 
pieskarieties View > Alarm. Veiciet dubultpieskàrienu 
redi»ºjamajam signàlam.

Lai deaktivizºtu vai aktivizºtu modinàtàja signàlu, 
nospiediet  un pieskarieties View > Alarm. Atlasiet 
signàlu, kuru deaktivizºsit vai aktivizºsit, un 
pieskarieties Activate/ Deactivate (Aktivizºt/
deaktivizºt).

Pilsºtas un valstis
Lai skatà Time (Laiks) mainïtu pilsºtu, atlasiet kreiso 
ràmi un mainiet pa¹laik izvºlºto pilsºtu vai — ràmi pa 
labi, un mainiet ce¶a mºróa pilsºtu. Pieskarieties 
Change city (Mainït pilsºtu) un, velkot ritjoslu, 
izskatiet sarakstu vai ievadiet pilsºtas nosaukumu 
meklº¹anas lodziñà zem saraksta. Ar katru ievadïto 
rakstzïmi meklº¹anas laukà saraksts mainàs, paràdot 
iespºjamos atbilsto¹os variantus. Izvºlieties pilsºtu un 
pieskarieties OK (Labi). Ja pilsºtas nav sarakstà, 
pieskarieties New city (Jauna pilsºta), lai to pievienotu 
sarakstam.

Lai pievienotu jaunu pilsºtu, valsti vai re»ionu, 
nospiediet  un izvºlieties City (Pilsºta) vai Country/
Region (Valsts/Re»ions) > New... (Jauns).

Lai redi»ºtu pa¹laik atlasïto pilsºtu, valsti vai 
re»ionu, nospiediet  un izvºlieties City vai Country/
Region > Edit... (Redi»ºt).

Lai kopºtu izvºlºtàs pilsºtas tàlruñu kodu, nospiediet 
 un izvºlieties Tools (Rïki) > Copy dialling code (Kopºt 

tàlruñu kodu).
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Calculator (Kalkulators)
Viedtàlrunï ir programma Calculator (Kalkulators), kas ¶auj 
veikt vienkàr¹us aprºóinus.

Piezïme.  ©ï kalkulatora precizitàte ir ierobe¾ota, un tas 
ir paredzºts vienkàr¹iem aprºóiniem.

29. attºls. Kalkulators

Lai veiktu aprºóinus, pieskarieties pogàm displejà.

Kalkulators izpilda darbïbas tàdà secïbà, kàdà tàs tiek 
ievadïtas, neraugoties uz operatoru veidu hierarhisko 
at¹óirïbu. Lai mainïtu darbïbu veik¹anas secïbu, nevar 
izmantot iekavas. 

Padoms. Lietojot procentu simbolu, x% ir vienàds 
ar x/100.

Lai ievades laukà izdzºstu skait¶us, pieskarieties .

No ievades lauka nevar dzºst ievadïtas darbïbas simbolu. 
Ja vienu aiz otra ievada divus operatora simbolus, pºdºjais 
aizstàj pirmo. Lai aprºóina redi»º¹anas laikà izdzºstu 
pºdºjo ievadïto vºrtïbas rakstzïmi, varat arï izmantot 
atpaka¶atkàpi.

Lai pàrslºgtos no parastà kalkulatora skata uz kases 
èeku rullï¹a kalkulatora skatu , nospiediet  un 
izvºlieties View (Skats) > Normal (Parastais) vai Till roll 
(Kases èeku rullïtis). Rullï¹a kalkulatorà redzami visi 
iepriek¹ºjie aprºóini.

Lai notïrïtu visu èeku rullïti, nospiediet  un 
izvºlieties Edit (Redi»ºt) > Clear till roll (Notïrït èeku 
rullïti).

Lai apvºrstu pogu un ievades lauka novietojumu, 
nospiediet  un izvºlieties Display (Ràdït) > Flip 
layout (Apvºrstais izkàrtojums).

Kalkulatora atmiñas izmanto¹ana
Kalkulatora atmiñà vienà reizº var saglabàt vienu skaitli 
un pºc tam to izmantot, atmiñà saglabàtajam skaitlim 
pieskaitot vai no tà atñemot citus skait¶us. Kad atmiñà tiek 
saglabàta skaitliska vºrtïba, izñemot nulli (0), ievades 
lauka aug¹ºjà kreisajà stþrï tiek paràdïts burts M. Ja tiek 
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saglabàta nulle (0), tas nozïmº to pa¹u, ko atmiñas 
tïrï¹ana.

©ïs ir atmiñas komandas:
MR — vºrtïba no atmiñas tiek izcelta ievades laukà.
M+ — vºrtïba ievades laukà tiek pieskaitïta atmiñà 
saglabàtajai vºrtïbai.
M- — vºrtïba ievades laukà tiek atñemta no atmiñà 
saglabàtàs vºrtïbas.
MS — pa¹reizºjà vºrtïba tiek saglabàta atmiñà.

Nemainïga lieluma funkcija
Nemainïga lieluma funkciju var izmantot, lai ïslaicïgi 
saglabàtu vºrtïbu, kas pastàvïgi tiek lietota pieskaitot, 
atñemot, reizinot vai dalot.

Lai izmantotu nemainïgo lielumu, ievadiet vºrtïbu, 
kam jàbþt nemainïgam lielumam, un divas reizes 
pieskarieties operatora simbolam. Kad nemainïgais 
lielums ir saglabàts, aprºóina rindà tiek paràdïts burts 
K. Ievadiet jaunu vºrtïbu un pieskarieties vienlïdzïbas 
zïmei (=), lai veiktu aprºóinu.

Piemºrs. Kalkulatorà ievadiet ciparu 2. Divas reizes 
pieskarieties pluszïmei (+). Nemainïgà vºrtïba 2 tiek 
saglabàta. Ievadiet ciparu 5 un pieskarieties 
vienlïdzïbas zïmei (=). Tiek paràdïta summa (7). 
Ievadiet skaitli 10,2 un pieskarieties =. Tiek paràdïta 
summa (12,2).



Co
nt

ro
l p

an
el

 (
Va

dï
ba

s 
pa

ne
lis

)

109Copyright © 2005 Nokia. All rights reserved.

Control panel (Vadïbas panelis)
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis).

Vadïbas panelï varat noràdït un modificºt da¾àdus 
viedtàlruña uzstàdïjumus. Modificºjot ¹os uzstàdïjumus, 
vairàkàs programmàs tiek ietekmºta viedtàlruña darbïba.

Lai atjaunotu rþpnïcas uzstàdïjumus, nospiediet  
un izvºlieties Restore original settings (Atjaunot 
sàkotnºjos uzstàdïjumus). Lai apstiprinàtu, pieskarieties 
Restore (Atjaunot).

Application manager
Atveriet Desk > Control panel > App. manager 
(Programmu pàrvaldïba).

Izmantojot programmu Application Manager (Programmu 
pàrvaldïba), var apskatït informàciju par viedtàlrunï 
instalºtajàm programmàm vai tàs dzºst no viedtàlruña. 
Varat noràdït arï instalàcijas uzstàdïjumus.

Programmas nevar instalºt programmà Application 
manager. Informàciju par programmatþras instalº¹anu sk. 
noda¶à “Programmatþras instalº¹ana” 27. lpp.

Atverot programmu Application manager, lapà Installed 
applications (Instalºtàs programmas) tiek uzskaitïtas visas 

instalºtàs programmatþras pakotnes, noràdot to 
nosaukumu, versiju, veidu un lielumu.

30. attºls. Application Manager

Lai tiktu paràdïta informàcija par instalºtu 
programmatþras pakotni, pieskarieties Details 
(Deta¶as).

Lai no viedtàlruña izdzºstu instalºtu 
programmatþras pakotni, atlasiet dzº¹amo 
programmatþru un pieskarieties Remove (Noñemt). 
Tiek atvºrts dialogs, kurà jàapstiprina dzº¹ana. 
Nospiediet Remove.

Atsevi¹óas programmatþras pakotnes atjaunina eso¹o 
programmatþru, un pºc instalº¹anas, iespºjams, var 
noñemt nevis atjauninàjumu, bet tikai visu 
programmatþras pakotni.
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Ja noñemat programmatþru, to atkàrtoti var instalºt 
vienïgi, izmantojot sàkotnºjo programmatþras pakotnes 
failu vai atjaunojot pilnu dublºjumkopiju, kurà ir noñemtà 
programmatþras pakotne. Noñemot programmatþras 
pakotni, iespºjams, vairs nevarºsit atvºrt ar ¹o 
programmatþru veidotos dokumentus. Ja no noñemtàs 
programmatþras pakotnes ir atkarïga cita 
programmatþras pakotne, tà var pàrtraukt darboties. 
Sïkàku informàciju sk. instalºtàs programmatþras 
pakotnes dokumentàcijà.

Lai apskatïtu, kàdas programmas instalºtas un 
noñemtas, atveriet lapu Installation log (Instalàcijas 
¾urnàls). ©ajà sarakstà uzskaitïts, kàda programmatþra 
tikusi instalºta un kàda — noñemta, kà arï laiks, kad 
tas noticis. Ja pºc programmatþras instalº¹anas ar 
viedtàlruni rodas problºmas, ar ¹ï saraksta palïdzïbu 
varat noskaidrot, kura programmatþras pakotne varºtu 
bþt problºmas cºlonis. ©ajà sarakstà iek¶autà 
informàcija var arï palïdzºt noskaidrot problºmas, 
kuras rodas savstarpºji nesaderïgu programmatþras 
pakotñu dº¶.

Lai konfigurºtu instalàcijas uzstàdïjumus, atveriet 
lapu Options (Iespºjas). ©eit var izvºlieties ar 
programmatþras instalº¹anu saistïtas iespºjas. 
Noràdiet vajadzïgos uzstàdïjumus.

Delete files after installation: (Dzºst failus pºc 
instalº¹anas) — ja ir izvºlºta ¹ï iespºja, 
programmatþras pakotnes instalº¹anas fails pºc 
instalº¹anas no viedtàlruña tiek dzºsts. Ja 

programmatþras pakotnes tiek ielàdºtas, izmantojot 
Web pàrlþkprogrammu, ¹àda iespºja var palïdzºt 
samazinàt nepiecie¹amo vietu atmiñà. Lai 
programmatþras pakotnes failu saglabàtu atkàrtotai 
instalº¹anai vºlàk, ja tas bþtu nepiecie¹ams, uzstàdiet 
¹o iespºju uz No (Nº) vai pàrbaudiet, vai personàlajà 
datorà vai kompaktdiskà ir programmatþras pakotnes 
faila kopija.

Default installation language: (Instalàcijas noklusºjuma 
valoda) — ja programmatþras pakotnº programmatþra 
ir vairàku valodu versijàs, tiek instalºta ¹eit noràdïtà 
valoda.

Software installation: (Programmatþras instalàcija) — 
noràdiet, kàda veida SIS instalàcijas ir at¶autas. 
Izvºlieties On (Ieslºgta), lai at¶autu visas instalàcijas, 
Signed only (Tikai ar parakstu), lai at¶autu tikai tàdu SIS 
failu instalàcijas, kuriem ir derïgs paraksts vai 
sertifikàts, vai Off (Izslºgta), lai neat¶autu SIS 
instalàcijas.

Bluetooth
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > Bluetooth.

Sk. “Bluetooth savienojums” 143. lpp.
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Certificate manager
Atveriet Desk > Control panel > Certificate manager 
(Sertifikàtu pàrvaldïba).

Programma Certificate manager ¶auj pàrvaldït digitàlos 
sertifikàtus, kuri tiek izmantoti, veidojot savienojumus ar 
Web vietàm, pasta serveriem, kà arï instalºjot 
programmatþru. Digitàlos sertifikàtus var izmantot ¹àdiem 
nolþkiem:
• savienojuma izveidei ar elektronisko banku vai citu 

Web vietu vai attàlo serveri, lai veiktu darbïbas, kuru 
laikà jàpàrsþta konfidenciàla informàcija;

• vïrusu vai citas ¶aunpràtïgas programmatþras riska 
samazinà¹anai un programmatþras autentiskuma 
pàrbaudei ielàdes vai instalº¹anas laikà.
Svarïgi! Pat ja sertifikàtu izmanto¹ana ievºrojami 

samazina risku, kas saistïts ar attàlajiem savienojumiem un 
programmatþras instalº¹anu, sertifikàti jàlieto pareizi, lai 
tie sniegtu visas uzlabotas dro¹ïbas priek¹rocïbas. 
Sertifikàta esamïba pati par sevi nepiedàvà nekàdu 
aizsardzïbu; lai bþtu pieejama lielàka dro¹ïba, sertifikàtu 
pàrvaldniekà jàbþt pareiziem, autentiskiem un uzticamiem 
sertifikàtiem. Sertifikàtiem ir ierobe¾ots derïguma laiks. Ja 
tiek ràdïts paziñojums “Sertifikàta termiñ¹ beidzies” vai 
“Sertifikàts nav derïgs”, kaut gan sertifikàtam vºl jàbþt 
spºkà, pàrbaudiet, vai viedtàlrunï ir uzstàdïts pareizs 
datums un laiks.

Pirms sertifikàtu uzstàdïjumu maiñas jàpàrliecinàs, vai 
sertifikàta ïpa¹nieks tie¹àm ir uzticams un vai sertifikàts 
patiesi pieder noràdïtajam ïpa¹niekam.

31. attºls. Sertifikàtu pàrvaldïba

Lai apskatïtu sertifikàta deta¶as, veiciet 
dubultpieskàrienu sertifikàtam. Lai izdzºstu 
sertifikàtu, pieskarieties Delete.

Lai noràdïtu sertifikàta lieto¹anu, veiciet 
dubultpieskàrienu sertifikàtam un pieskarieties Trust 
settings (Uzticamïbas uzstàdïjumi). Noràdiet 
vajadzïgos uzstàdïjumus.

SIS installation (SIS instalº¹ana) — atzïmºjiet ¹o izvºles 
rþtiñu, lai ar ¹o sertifikàtu varºtu apstiprinàt jaunas 
SIS programmatþras izcelsmi.

Application installation (Programmu instalº¹ana) — 
atzïmºjiet ¹o izvºles rþtiñu, lai ar ¹o sertifikàtu varºtu 
apstiprinàt jaunas Java programmatþras izcelsmi.
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Web and e-mail (Web un e-pasts) — atzïmºjiet ¹o izvºles 
rþtiñu, lai ar ¹o sertifikàtu varºtu apstiprinàt Web 
vietas un pasta serverus.

Sertifikàta ïstuma pàrbaude
1 Izvºlieties sertifikàtu un pieskarieties Details 

(Deta¶as). Tiek atvºrta informàcija par sertifikàtu.
2 Laukà Issued to: (Kam izdots) tiek noràdïts ¹ï sertifikàta 

ïpa¹nieks. Pàrbaudiet, vai ¹eit ir noràdïts tàs personas 
vàrds vai puses nosaukums, kurai, pºc jþsu domàm, 
sertifikàts pieder.

3 Ritiniet dialogu, lïdz ir redzams lauks Fingerprint: 
(Kods), ar kuru sertifikàts tiek unikàli identificºts. 
Sazinieties ar sertifikàta ïpa¹nieka (sk. 2. punktu) 
palïdzïbas dienestu vai klientu apkalpo¹anas dienestu 
un lþdziet sertifikàta MD5 fingerprint kodu. Salïdziniet 
sañemto kodu ar to, kas tiek ràdïts dialogà. Ja tie 
saskan, sertifikàtam jàbþt autentiskam.

Ikreiz, pievienojot jaunu sertifikàtu, izmantojiet ¹o 
autentifikàcijas procedþru.

Data call barring
Atveriet Desk (Darbvirsma) > Control panel > Data call 
barring (Datu zvanu liegums).

©àdu veidu datu zvanus var aizliegt vai at¶aut:

All incoming calls: (Visi ienàko¹ie zvani) — ja ir aktivizºta ¹ï 
iespºja, datu zvanus nevar sañemt.

Incoming calls when abroad: (Ienàko¹ie zvani, atrodoties 
àrzemºs) — ja ir aktivizºta ¹ï iespºja, datu zvanus nevar 
sañemt, ja neatrodaties màjas valstï.

All outgoing calls: (Visi izejo¹ie zvani) — ja ir aktivizºta ¹ï 
iespºja, datu zvanus nevar veikt.

International calls: (Starptautiskie zvani) — ja ir aktivizºta ¹ï 
iespºja, nevar veikt datu zvanus uz citàm valstïm vai 
re»ioniem.

International calls except to home country: (Starptautiskie 
zvani, izñemot uz màjas valsti) — ja pie tïkla operatora 
esat aktivizºjis starptautisko viesabonº¹anu, tad, 
atrodoties àrzemºs, var veikt datu zvanus tikai uz màjas 
valsti.

Tiek piedàvàtas ¹àdas iespºjas:

Activate — tiek aktivizºti liegumi.

Cancel — liegumi tiek izslºgti.

Check status (Pàrbaudït statusu) — pàrbauda, vai datu 
zvanu liegumi ir aktivizºti.

Lai modificºtu ¹os uzstàdïjumus, no pakalpojumu 
sniedzºja ir jàsañem liegumu parole.

Lai atceltu visus datu zvanu liegumus, pieskarieties 
Cancel all barrings (Atcelt visus liegumus).
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Date and time
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > Date and time (Datums un laiks).

Lai uzstàdïtu pareizu laiku un datumu, ievadiet laiku un 
datumu tie¹i atbilsto¹ajos laukos vai pieskarieties  un 

. Pieskaroties bultiñàm, mainiet laiku un datumu.

Lai viedtàlruña laiks un datums tiktu automàtiski 
atjauninàts no tïkla, izvºlieties Auto-update of date & 
time: (Datuma un laika pa¹regulàcija). ©is ir tïkla 
pakalpojums. Ievºrojiet, ka tas var izraisït atsevi¹óu 
signàlu atskaño¹anu (ja uzstàdïtais signàla laiks ir starp 
veco un jauno laiku). 

Lai tiktu ievºrots vasaras laiks, atzïmºjiet Apply 
daylight-saving: (Ievºrot vasaras laiku).

Display
Atveriet Desk > Control panel > Display (Displejs).

32. attºls. Displejs

Lai mainïtu displeja spilgtumu, pieskarieties <+> vai 
<->.

Lai noràdïtu, pºc cik ilga laika displeja spilgtums 
samazinàs ener»ijas taupï¹anas nolþkà, ja ekrànam 
nepieskaras, izvºlieties vajadzïgo spilgtuma 
saglabà¹anas posmu.

Padoms. Izvºloties zemu spilgtuma pakàpi un ïsu laika 
posmu, tiek taupïts akumulators un paildzinàts 
viedtàlruña darbïbas laiks.

Lai noràdïtu, pºc cik ilga laika tiek ieslºgts 
ekrànsaudzºtàjs, ja ekrànam nepieskaras, iespºjai 
Screen saver time-out: (Ekrànsaudzºtàja taimauts) 
izvºlieties vajadzïgo laika limitu. Ievºrojiet — 
ekrànsaudzºtàja izskatu nevar mainït.

Lai ieslºgtu automàtisko skàrienekràna un 
tastatþras bloóº¹anu, atzïmºjiet izvºles rþtiñu Screen 
saver locks display & keys: (Ekrànsaudzºtàjs bloóº 
displeju un taustiñus). Skàrienekràns un tastatþra tiek 
bloóºta automàtiski, kad tiek aktivizºts 
ekrànsaudzºtàjs. Pla¹àku informàciju sk. sada¶à 
“Skàrienekràna un tastatþras bloóº¹ana” 25. lpp.

Enhancements
Atveriet Desk > Control panel > Enhancements 
(Papildierïces).

©eit var noràdït atsevi¹óus kopà ar viedtàlruni lietoto 
austiñu un induktïvàs saites uzstàdïjumus. 
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Lai modificºtu papildierïèu iespºjas, pieskarieties 
Edit (Redi»ºt) un noràdiet ¹àdus uzstàdïjumus:

Default profile: (Galvenais profils) — izvºlieties profilu, kur¹ 
tiks aktivizºts, viedtàlrunim pievienojot austiñas vai 
induktïvo saiti.

Automatic answer: (Automàtiskà atbilde) — noràdiet, vai 
viedtàlrunim, ja tam ir pievienotas austiñas vai 
induktïvàs saites ierïce, uz sañemtu zvanu ir jàatbild 
automàtiski pºc piecàm sekundºm.

Internet setup
Atveriet Desk > Control panel > Internet setup 
(Interneta uzstàdï¹ana).

Lai izveidotu savienojumu ar internetu:
• izmantotajam bezvadu tïklam ir jànodro¹ina datu 

zvani vai GPRS izmanto¹ana;
• SIM kartº jàbþt aktivizºtiem datu pakalpojumiem;
• no interneta pakalpojumu sniedzºja (ISP) jàsañem 

interneta piek¶uves punkts;
• jàbþt konfigurºtiem pareiziem interneta 

uzstàdïjumiem.

Interneta piek¶uves punkta uzstàdï¹ana
Atkarïbà no izmantotàs SIM kartes veida ¹ï ierïce, 
iespºjams, spºj automàtiski pievienot pareizos WWW 
pàrlþko¹anas un MMS uzstàdïjumus. Atsevi¹ói interneta 
pakalpojumu sniedzºji piedàvà iespºju konfigurºt 

interneta piek¶uves punktu, nosþtot jums ïsziñu. ©àdi 
samazinàs to uzstàdïjumu skaits, kas jums jàievada pa¹am, 
vai arï ¹àda nepiecie¹amïba zþd pilnïbà. Pla¹àku 
informàciju sk. “Standarta Plug and play mobilie 
pakalpojumi” 72. lpp.

Pareizàs uzstàdïjumu vºrtïbas parasti nodro¹ina 
pakalpojumu sniedzºjs. Izpildiet pakalpojumu sniedzºja 
noràdïjumus ¶oti precïzi.

Var uzstàdït vairàkus interneta savienojumus atkarïbà no 
tà, kàdàm lapàm vºlaties piek¶þt. Piem., interneta 
pàrlþko¹anai var uzstàdït vienu savienojumu, bet 
uzñºmuma iek¹tïkla pàrlþko¹anai izmantot citu.

Arï programma Messaging (Ziñapmaiña) e-pasta ziñu un 
multiziñu sþtï¹anai un sañem¹anai izmanto interneta 
piek¶uves punktu. Sk. “Messaging (Ziñapmaiña)” 47. lpp.

Ievºrojiet, ka par datu pàrsþtï¹anu, izmantojot GPRS, 
jàmaksà pºc operatora noteiktà datu pàrsþtï¹anas tarifa.

Lai uzstàdïtu interneta piek¶uves punktu, 
pieskarieties New access pt. (Jauns piek¶uves punkts). 
Lai redi»ºtu eso¹u interneta piek¶uves punktu, 
pieskarieties Access pts. (Piek¶uves punkti). Interneta 
uzstàdï¹anas vednï noràdiet vºrtïbas ¹àdos laukos:

Connection name: (Savienojuma nosaukums) — ievadiet 
apraksto¹u savienojuma nosaukumu.

Data bearer: (Datu nesºjs) — izvºlieties datu savienojuma 
veidu. Pla¹àku informàciju par datu savienojumu 
veidiem sk. “Datu savienojumi” 29. lpp.
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Atkarïbà no izvºlºtà datu savienojuma veida 
turpmàkajàs vedña lapàs ir pieejami atsevi¹ói no tàlàk 
noràdïtajiem uzstàdïjumu laukiem.

GSM datu zvana deta¶as
Dial-up number: (Iezvanes numurs) — piek¶uves punkta 
modema tàlruña numurs.

GPRS deta¶as
Network type: (Tïkla veids) — izvºlieties, kuru interneta 

protokolu izmantosit.

Auto-retrieve access point: (Automàtiski ielàdºt piek¶uves 
punktu) — ja tïkla operators nodro¹ina ¹àdu funkciju, 
piek¶uves punkta nosaukumu var automàtiski ielàdºt no 
tïkla. Piek¶uves punkts ir nepiecie¹ams, lai izveidotu 
savienojumu ar GPRS tïklu.

Access point name: (Piek¶uves punkta nosaukums) — ja 
neizmantojat iespºju Auto-retrieve access point: 
(Automàtiski ielàdºt piek¶uves punktu), noràdiet 
piek¶uves punkta nosaukumu. Piek¶uves punkta 
nosaukumu var uzzinàt no tïkla operatora vai 
pakalpojumu sniedzºja.

Pieteik¹anàs deta¶as
Prompt password at every login: (Ikreiz piesakoties, prasït 
paroli) — izvºlieties ¹o iespºju, ja katru reizi, piesakoties 
serverï, ir jàievada jauna parole vai ja nevºlaties saglabàt 
paroli viedtàlrunï.

User name: (Lietotàjvàrds) — ievadiet lietotàjvàrdu, ja to 
prasa pakalpojumu sniedzºjs. Lietotàjvàrds var bþt 
nepiecie¹ams, lai veidotu datu savienojumus, un to 
parasti nodro¹ina pakalpojumu sniedzºjs. Lietotàjvàrds 
bie¾i vien ir re»istrjutïgs.

Password: (Parole) — parole var bþt nepiecie¹ama, lai 
izveidotu datu savienojumu; parasti to izsniedz 
pakalpojumu sniedzºjs. Parole bie¾i vien ir re»istrjutïga.

VPN deta¶as
Ievºrojiet — lai varºtu definºt VPN piek¶uves punktu, ir 
nepiecie¹ams vismaz viens interneta piek¶uves punkts un 
jàbþt instalºtai vismaz vienai VPN politikai. Pla¹àku 
informàciju par VPN politiku instalº¹anu sk. “VPN politiku 
pàrvaldïba” 126. lpp.

Internet access point: (Interneta piek¶uves punkts) — 
izvºlieties piek¶uves punktu, kas jàlieto VPN piek¶uvei.

VPN policy: (VPN politika) — izvºlieties VPN politiku, kas 
jàlieto VPN piek¶uvei.

Interneta papilduzstàdïjumi
Kad interneta uzstàdï¹anas vednï Internet setup wizard 
(Control panel > Internet setup > New access pt.), esat 
noràdïjis vai redi»ºjis interneta piek¶uves uzstàdïjumus 
varat konfigurºt arï papilduzstàdïjumus. No tà, vai esat 
izvºlºjies pake¹datu (GPRS), GSM datu zvana vai VPN 
savienojumu, ir atkarïgs, kàdas lapas un iespºjas ir 
pieejamas.
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Lapa Data call (Datu zvani)
Call type: (Zvanu veids) — noràdiet GSM datu zvanu veidu. 
Varat izvºlºties: Normal (Standarta) vai High speed data 
(GSM only) (Àtrdarbïgie dati (tikai GSM)).

Lai varºtu izmantot High speed data (GSM only), tïkla 
pakalpojumu sniedzºjam ir jànodro¹ina ¹ï funkcija un, ja 
nepiecie¹ams, tà ir jàaktivizº jþsu SIM kartº.

Modem type: (Modema veids) — Analogue (Analogais), ISDN 
V.110 vai ISDN V.120 — noràda, vai viedtàlrunis izmanto 
analogo vai digitàlo savienojumu. ©is uzstàdïjums ir 
atkarïgs gan no GSM tïkla operatora, gan interneta 
pakalpojumu sniedzºja, jo da¾i GSM tïkli nenodro¹ina 
atsevi¹óus ISDN savienojumus. Sïkàku informàciju lþdziet 
interneta pakalpojumu sniedzºjam. Ja ir pieejami ISDN 
savienojumi, tos var izveidot àtràk nekà analogos 
savienojumus.

Maximum data speed: (Maksimàlais datu àtrums) — ¹ï 
iespºja ¶auj ierobe¾ot maksimàlo savienojuma àtrumu, ja 
tiek izmantoti àtrdarbïgie dati. Atkarïbà no tïkla 
pakalpojumu sniedzºja lielàki datu àtrumi var maksàt 
vairàk.

©eit noràdïtais àtrums ir lielàkais àtrums, kàdà darbosies 
savienojums. Savienojuma laikà darbïbas àtrums var bþt 
mazàks — tas ir atkarïgs no tïkla.

Modem initialisation: (Modema inicializº¹ana) — 
viedtàlruni varat vadït, izmantojot modema AT komandas. 
Ja nepiecie¹ams, ievadiet GSM tïkla pakalpojumu 

sniedzºja vai interneta pakalpojumu sniedzºjas noràdïtàs 
rakstzïmes.

Lapa Proxies (Starpniekserveri)
Lai paàtrinàtu piek¶uvi internetam, ieteicams izmantot 
starpniekserveri. Ñemiet vºrà arï to, ka atsevi¹ói interneta 
pakalpojumu sniedzºji pieprasa Web starpniekserveru 
izmanto¹anu. Sazinieties ar interneta pakalpojumu 
sniedzºju, lai precizºtu informàciju par 
starpniekserveriem.

Ja esat izveidojis interneta savienojumu ar jþsu uzñºmuma 
iek¹tïklu, bet nevarat ielàdºt Web lapas no interneta, 
iespºjams, jàizveido savienojums ar starpniekserveri, lai 
ielàdºtu Web lapas, kuras pieejamas àrpus uzñºmuma 
iek¹tïkla.

Protocol: (Protokols) — izvºlieties starpniekservera 
protokola veidu. Katram protokolam var noràdït da¾àdus 
starpniekserveru uzstàdïjumus.

Use proxy: (Izmantot starpniekserveri) — lai izmantotu 
starpniekserveri, atzïmºjiet ¹o iespºju.

Proxy server address: (Starpniekservera adrese) — 
starpniekservera IP adrese vai domºna vàrds. Domºna 
vàrdu piemºri: uzñºmums.com un organizàcija.org.

Port number: (Porta numurs) — starpniekservera porta 
numurs. Porta numurs ir saistïts ar protokolu. Parasti ¹ïs 
vºrtïbas ir 8000 un 8080, taèu katram starpniekserverim tà 
ir sava.
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Do not use proxy for: (Neizmantot starpniekserveri) — ¹eit 
noràdiet domºnus, kuriem HTTP vai HTTPS starpniekserveri 
nav nepiecie¹ami. Sarakstà domºnu nosaukumi ir jàatdala 
ar semikoloniem.

Lapa IP addresses  (IP adreses)
Ievºrojiet — katram protokolam (IPv4 un IPv6) jànoràda 
nedaudz at¹óirïgi uzstàdïjumi.

Auto-retrieve IP address: (Automàtiski iegþt IP adresi) — 
izvºloties ¹o iespºju, IP adrese no servera tiek iegþta 
automàtiski. ©o uzstàdïjumu dºvº arï par dinamisko IP 
adresi.

IP address: (IP adrese) — viedtàlruña IP adrese. Ja IP adrese 
tiek iegþta automàtiski, informàcija ¹ajà laukà nav 
jàievada.

DNS address: (DNS adrese) — IPv4 protokolam izvºloties 
iespºju Auto-retrieve, DNS (domºna vàrdu serveris — 
Domain Name Server) adrese no servera tiek iegþta 
automàtiski. IPv6 protokolam atbilsto¹à vºrtïba ir Use well-
known (Lietot zinàmo). DNS ir interneta pakalpojums, kur¹ 
pàrvºr¹ domºnu vàrdus (piem., www.nokia.com) par IPv4 
adresºm (192.100.124.195) vai IPv6 adresºm 
(3ffe:2650:a640:1c2:341:c39:14).

Primary DNS address: (Primàrà DNS adrese) — primàrà DNS 
servera IP adrese. Ja IP adrese tiek iegþta automàtiski, 
informàcija ¹ajà laukà nav jàievada.

Secondary DNS address: (Sekundàrà DNS adrese) — 
sekundàrà DNS servera IP adrese.

Lapa Login scripts (Pieteik¹anàs skripti)
Use login script: (Izmantot pieteik¹anàs skriptu) — 
izvºloties ¹o iespºju, pieteik¹anàs skriptus var rakstït vai 
importºt vienkàr¹a teksta formàtà. Skriptu var redi»ºt 
laukà ekràna lejasda¶à.

Display post-dial terminal: (Ràdït pºciezvanes terminàli) — 
ja izvºlºta ¹ï iespºja, pºc datu savienojuma izveides 
ekrànà tiek ràdïts terminà¶a logs.

Padoms. Iespºjams, interneta pakalpojumu sniedzºjs 
var izsniegt skriptus.

Piezïme. Izveidojot savienojumu, skripti parasti nav 
vajadzïgi. Informàciju par skriptu nepiecie¹amïbu 
vaicàjiet interneta pakalpojumu sniedzºjam.

Lapa Other (Citi uzstàdïjumi)
Allow plain text login: (At¶aut pieteik¹anos vienkàr¹a teksta 
formàtà) — izvºloties ¹o iespºju savienojumam vajadzïgo 
paroli var nosþtït vienkàr¹a teksta formàtà. Lai panàktu 
optimàlu dro¹ïbu, notïriet izvºles rþtiñu. Atsevi¹ói 
interneta pakalpojumu sniedzºji pieprasa izvºlºties ¹o 
iespºju.

Use PPP compression: (Izmantot PPP saspie¹anu) — 
izvºloties ¹o iespºju, datu pàrsþtï¹ana paàtrinàs (ja ¹àdu 
iespºju nodro¹ina attàlais PPP serveris). Ja rodas grþtïbas 
ar savienojuma izveidi, ieteicams neatzïmºt ¹o izvºles 
rþtiñu. Lþdziet padomu interneta pakalpojumu 
sniedzºjam.
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Callback type: (Atzvanï¹anas veids) — vaicàjiet interneta 
pakalpojumu sniedzºjam, kur¹ ir pareizais uzstàdïjums. ©is 
uzstàdïjums ir atkarïgs no pakalpojumu sniedzºja 
konfiguràcijas.

Callback number: (Atzvanï¹anas numurs) — ievadiet 
viedtàlruña datu tàlruña numuru, kuru izmanto 
atzvanï¹anas serveris. Parasti ¹is numurs ir viedtàlruña 
datu zvanu tàlruña numurs.

Interneta savienojuma uzstàdïjumi
Lai konfigurºtu interneta savienojuma 
uzstàdïjumus, noràdiet vºrtïbas ¹ajà noda¶à 
uzskaitïtajos laukos.

Vispàrïgi uzstàdïjumi
Preferred access point: (Vºlamais piek¶uves punkts) — 
izvºlieties piek¶uves punktu savienojuma ar internetu 
izveidei.

Ask before connecting: (Vaicàt pirms savienojuma 
izveides) — izvºloties ¹o iespºju, ikreiz, veidojot 
savienojumu ar internetu, tiek atvºrts dialogs, kurà 
jàapstiprina savienojuma izveide vai jàmaina piek¶uves 
punkts.

Datu zvans
Disconnect when idle for: (Atvienot, ja neizmanto) — 
izvºlieties laika posmu, pºc kura datu zvans tiek 
pàrtraukts automàtiski, ja savienojums netiek izmantots.

 Reizºm interneta savienojumi var ¹óist neaktïvi, taèu fonà 
joprojàm tiek sþtïti un sañemti dati. ©ie savienojumi var 
aizkavºt ¹eit noràdïto neizmanto¹anas perioda sàkumu, 
tàdºjàdi uz vºlàku laiku pàrce¶ot savienojuma 
pàrtrauk¹anu.

Datu zvanu uzstàdïjumi ietekmº visus piek¶uves punktus, 
kuri izmanto datu zvanu un àtrdarbïgo datu zvanu. 
Pla¹àku informàciju par datu savienojumiem sk. “Datu 
savienojumi” 29. lpp.

GPRS
Disconnect when idle for: (Atvienot, ja neizmanto) — 
izvºlieties laika posmu, pºc kura GPRS pàrslºdzas uz 
gaidï¹anas re¾ïmu, ja savienojums netiek izmantots.

GPRS connection: (GPRS savienojums) — izvºlieties When 
available (Kad pieejams), lai paturºtu GPRS savienojumu 
gatavïbas re¾ïmà un varºtu àtri ieslºgt pake¹datu 
pàrsþtï¹anu, ja nepiecie¹ams. Izvºloties When needed (Kad 
nepiecie¹ams), viedtàlrunis GPRS savienojumu izmanto 
vienïgi tad, ja startºjat programmu vai darbïbu, kurai ir 
nepiecie¹ams ¹àds savienojums. Ievºrojiet — ja nav GPRS 
pàrklàjuma un esat izvºlºjies iespºju When available, 
viedtàlrunis periodiski mº»ina izveidot GPRS savienojumu.

GPRS uzstàdïjumi ietekmº visus piek¶uves punktus, kuri 
izmanto GPRS savienojumu.



Co
nt

ro
l p

an
el

 (
Va

dï
ba

s 
pa

ne
lis

)

119Copyright © 2005 Nokia. All rights reserved.

VPN pàrvaldïba
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > VPN management (VPN pàrvaldïba). Pla¹àku 
informàciju sk. “Virtuàlà privàtà tïklo¹ana (VPN)” 125. lpp.

Memory 
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > Memory (Atmiña).

©eit var apskatït, cik brïvas vietas ir atlicis atmiñà un cik 
daudz atmiñas patºrº da¾àdi objekti viedtàlrunï un 
atmiñas kartº.

Padoms. Lai viedtàlruña atmiñu pàrmºrïgi neaizñemtu, 
dati ir regulàri jàizdzº¹ vai jàpàrvieto uz atmiñas karti 
vai personàlo datoru.

Pla¹àku informàciju sk. sada¶à “Atmiñas pàrvaldïba” 
24. lpp.

Pen input settings
Atveriet Desk > Control panel > Pen input settings 
(Uzstàdïjumi ievadei ar rakstàmrïku).

Sk. “Uzstàdïjumi ievadei ar rakstàmrïku” 35. lpp.

Pozicionº¹anas uzstàdïjumi
Atveriet Desk > Control panel > Positioning settings 
(Pozicionº¹anas uzstàdïjumi).

Da¾i tïkli at¶auj citiem pieprasït jþsu viedtàlruña 
atra¹anàs vietu (tïkla pakalpojums). ©o pakalpojumu un 
uzstàdïjumus varat izmantot tikai tad, ja esat instalºjis 
programmas, kuras atbalsta ¹àdu pakalpojumu.

Noràdiet vajadzïgos uzstàdïjumus.

Priority:
Lapà Priority (Prioritàte) varat noràdït da¾àdu 
pozicionº¹anas meto¾u prioritàtes.

Lai mainïtu vietas noteik¹anas metodes prioritàti, 
pieskarieties  un izvºlieties metodi, kura jàievieto ¹ajà 
vietà.

Details
 Lapà Details (Deta¶as) varat apskatït meto¾u rekvizïtus un 
modificºt to izmaksas.

Jþs varat apskatït ¹àdus rekvizïtus: 

Average positioning time: (Vidºjais pozicionº¹anas laiks) — 
laiks, cik vidºji ilgst pozicionº¹anas process.

Rate: (Izmaksas) — metodes aptuvenais izmaksu tarifs.

Battery use: (Akumulatora patºriñ¹) — metodes aptuvenais 
ener»ijas patºriñ¹.
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Accuracy: (Precizitàte) — metodes horizontàlà precizitàte.

Lai modificºtu metodes izmaksas, pieskarieties Edit 
(Redi»ºt) un pieskarieties , lai izvºlºtos metodi. 

Konfidencialitàtes uzstàdïjumi
Atveriet Desk > Control panel > Privacy settings 

(Konfidencialitàtes uzstàdïjumi).

Vispàrïgi uzstàdïjumi
©ajà lapà noràdïtie uzstàdïjumi anulº visus atsevi¹óos 
uzstàdïjumus. Noràdiet vajadzïgos uzstàdïjumus.

Position request rule: (Pozïcijas pieprasïjuma noteikums) — 
noràdiet globàlàs konfidencialitàtes uzstàdïjumu. 
Izvºlieties Use individual req. rules (Izmantot individuàlo 
pieprasïjumu noteikumus), lai izmantotu uzstàdïjumus, ko 
noràdàt katram kontaktam un pakalpojumam lapà 
Individual (Individuàli). Izvºlieties Confirm first (Vispirms 
apstiprinàt), lai visiem vietas noteik¹anas pieprasïjumiem 
tiktu prasïts apstiprinàjums neatkarïgi no lapà Individual 
noràdïtajiem uzstàdïjumiem. Izvºlieties Always accept 
(Vienmºr pieñemt) vai Always reject (Vienmºr noraidït), lai 
pieñemtu vai noraidïtu vietas noteik¹anas pieprasïjumus 
neatkarïgi no lapà Individual noràdïtajiem uzstàdïjumiem.

Valid until: (Derïgs lïdz) — noràdiet pieñem¹anas vai 
noraidï¹anas (ja to izvºlaties) laika ierobe¾ojumu. Kad 
laika ierobe¾ojums beidzas, konfidencialitàtes lïmenis 
pàrslºdzas uz Use individual req. rules.

Notify when position sent: (Informºt, kad nosþta atra¹anàs 
vietu) — noràdiet globàlàs informº¹anas uzstàdïjumu. ©ï 
iespºja ir pieejama vienïgi tad, ja verifikàcijas politikas 
uzstàdïjumam esat izvºlºjies iespºju Always accept 
(Vienmºr pieñemt).

Individual
Lapà Individual (Individuàli) varat noràdït 
konfidencialitàtes uzstàdïjumus noteiktam kontaktam vai 
pakalpojumam.

Lapà ir sniegts to kontaktu un pakalpojumu saraksts, 
kuriem ir ïpa¹i konfidencialitàtes uzstàdïjumi. Kad 
kontaktpersona vai pakalpojums ir pieprasïjis atra¹anàs 
vietu, tas ir pievienots konfidencialitàtes sarakstam. ©ajà 
dialogà kontaktpersonas var tikai pievienot sarakstam.

Lai pievienotu kontaktu, pieskarieties Add 
(Pievienot), pieskarieties kontaktam sarakstà un 
pieskarieties Close (Labi). Noràdiet individuàlos 
konfidencialitàtes uzstàdïjumus. Iespºjas ir tàdas pa¹as, 
kàdas piedàvàtas lapà Global. Lai turpinàtu, pieskarieties 
Close.

Lai redi»ºtu kontaktu, pieskarieties Edit (Redi»ºt) un 
modificºjiet individuàlus konfidencialitàtes uzstàdïjumus. 
Iespºjas ir tàdas pa¹as, kàdas piedàvàtas lapà Global. Lai 
turpinàtu, pieskarieties Close.

Pla¹àku informàciju par kontaktu izvºli sk. “Kontaktu 
apskate un meklº¹ana” 63. lpp.
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RealPlayer uzstàdïjumi
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > RealPlayer settings (RealPlayer uzstàdïjumi).

Noràdiet vajadzïgos uzstàdïjumus.

Network (Tïkls)
Data speed: (Datu àtrums) — izvºlieties savienojuma 
darbïbas àtrumu. Ievºrojiet, ka iespºjas Very fast (¦oti àtri) 
un Slow (Lºni) var ietekmºt video kvalitàti.

Connection time-out: (Savienojuma taimauts) — izvºlieties 
laika periodu sekundºs, pºc kura savienojums tiek 
pàrtraukts, ja tas nav sekmïgs.

Server time-out: (Servera taimauts) — ja serveris nevar 
nosþtït pietiekami daudz datu un ir daudz buferizàcijas, 
iespºjams, ir jànosaka servera taimauts.

Port range: (Porta diapazons) — savienojumam izmantoto 
porta numuru diapazons. Noklusºjuma vºrtïbas ir tàdas 
pa¹as kà interneta uzstàdïjumiem.

Default access point: (Galvenais piek¶uves punkts) — 
savienojums, kas izmantojams kà galvenais savienojums. 
Noklusºjuma vºrtïba ir tàda pati kà interneta 
uzstàdïjumiem.

Proxy (Starpniekserveris)
Use proxy: (Izmantot starpniekserveri) — lai izmantotu 
starpniekserveri, atzïmºjiet ¹o iespºju.

Server address: (Servera adrese) — servera IP adrese vai 
domºna vàrds. Domºna vàrdu piemºri: uzñºmums.com un 
organizàcija.org.

Port number: (Porta numurs) — starpniekservera porta 
numurs. Porta numurs ir saistïts ar protokolu. 
Noklusºjuma ports ir 1091.

Regional settings (Re»ionàlie 
uzstàdïjumi)
Atveriet Desk > Control panel > Regional settings 
(Re»ionàlie uzstàdïjumi).

Vietºjà laika, datuma, skait¶u formàta un valþtas pieraksta 
uzstàdïjumus var noràdït atbilsto¹às lapàs.

Time (Laiks)
Time format: (Laika formàts) — izvºlieties 24 stundu vai 
12 stundu sistºmu.

Am/pm format: (Priek¹pusdienà/pºcpusdienà) — ja 
iepriek¹ºjà laukà izvºlºjàties 12 stundu pulksteni, 
izvºlieties ¹o apzïmºjumu atra¹anàs vietu un 
noformºjumu.

Separator: (Atdalïtàjs) — izvºlieties, ar ko tiek atdalïtas 
stundas un minþtes.
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Date (Datums)
Date format: (Datuma formàts) — izvºlieties datuma 
elementu secïbu.

Separator: (Atdalïtàjs) — izvºlieties datuma elementu 
atdalïtàju.

Week starts on: (Nedº¶as pirmà diena) — izvºlieties nedº¶as 
pirmo dienu.

Working days: (Darba dienas) — noràdiet nedº¶as darba 
dienas.

Numbers (Skait¶i)
Decimal separator: (Decimàlzïme) — izvºlieties zïmi, kas 
tiek izmantota par decimàlda¶u atdalïtàju.

Thousands separation: (Tþksto¹u atdalï¹ana) — atzïmºjiet 
¹o izvºles rþtiñu, lai tiktu atdalïti tþksto¹i un simti.

Thousands separator: (Tþksto¹u atdalïtàjs) — izvºlieties 
tþksto¹u atdalïtàju.

Measurement unit: (Mºrvienïba) — izvºlieties vietºjo 
garuma mºrvienïbu.

Currency (Valþta)
Currency symbol: (Valþtas simbols) — ievadiet vietºjàs 
valþtas simbolu.

Decimal places: (Decimàlvietas) — pieskarieties - vai +, lai 
izvºlºtos, cik decimàlvietu jàizmanto naudas summàs.

Symbol position: (Simbola vieta) — izvºlieties simbola 
atra¹anàs vietu attiecïbà pret skaitli.

Negative value format: (Negatïvas vºrtïbas formàts) — 
izvºlieties, kà tiek atspogu¶ota negatïva naudas summa.

Security
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > Security (Dro¹ïba).

©eit var noràdït viedtàlruña tàlruña dro¹ïbas pakàpi.

Kodi tiek ràdïti kà zvaigznïtes. Mainot kodu, ir jàievada 
pa¹reizºjais kods un pºc tam divas reizes — jaunais kods. 
Pla¹àku informàciju par piek¶uves kodiem sk. “Piek¶uves 
kodi” 24. lpp.

Lai nejau¹i neizsauktu avàrijas dienestu numuru, 
neizmantojiet kodus, kuri ir lïdzïgi avàrijas dienestu 
izsauk¹anas numuriem, piem., 112.

Ierïces bloóº¹ana
Autolock period: (Automàtiskàs bloóº¹anas periods) — var 
noràdït automàtiskàs bloóº¹anas periodu; laiku, pºc kura 
viedtàlrunis tiek automàtiski bloóºts un to var izmantot 
tikai tad, ja ievada pareizu bloóº¹anas kodu.

Piezïme. Ja ierïce ir bloóºta, tomºr var piezvanït uz 
ierïcº ieprogrammºto oficiàlo avàrijas dienestu 
izsauk¹anas numuru.
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Lock code: (Bloóº¹anas kods) — Bloóº¹anas kodà jàbþt no 
pieciem lïdz desmit cipariem. Bloóº¹anas koda rþpnïcas 
uzstàdïjums ir 12345. Lai novºrstu viedtàlruña neat¶autu 
lieto¹anu, nomainiet ¹o bloóº¹anas kodu. Neizpaudiet kodu 
un glabàjiet to dro¹à vietà, atsevi¹ói no viedtàlruña.

Lock if SIM card changed: (Bloóºt, ja mainïta SIM karte) — 
var uzstàdït, lai viedtàlrunis prasïtu bloóº¹anas kodu, ja 
viedtàlrunï tiek ievietota nepazïstama, jauna SIM karte. 
Viedtàlrunis uztur to SIM kar¹u sarakstu, kuras tiek 
atpazïtas kà ïpa¹nieka kartes.

PIN kodi
PIN code request: (PIN koda pieprasïjums) — ja ¹ï iespºja ir 
aktivizºta, ikreiz, ieslºdzot viedtàlruni, ir jàievada kods. 
Atsevi¹óas SIM kartes var neat¶aut PIN koda pieprasïjuma 
izslºg¹anu. Ja trïs reizes pºc kàrtas ievada nepareizu PIN 
kodu, SIM karti var atbloóºt, ievadot PUK (PIN Unblocking 
Key — PIN atbloóº¹anas atslºga) kodu. Ja SIM karte ir 
bloóºta, var piezvanït vienïgi uz ieprogrammºtajiem 
avàrijas dienestu izsauk¹anas numuriem. Pretºjà gadïjumà 
viedtàlruni nevar izmantot, ja neievada vajadzïgos kodus. 

Ievºrojiet, ka ¹o uzstàdïjumu nevar mainït, ja tàlrunis ir 
izslºgts vai ja nav ievietota derïga SIM karte. Atcerieties arï 
to, ka atsevi¹óas SIM kartes neat¶auj izslºgt PIN koda 
pieprasïjumu.

Confirm SIM services: (Apstiprinàt SIM pakalpojumus) — lai 
viedtàlrunis ràdïtu apstiprinàjuma paziñojumus, kad 
izmantojat SIM kartes pakalpojumus (tïkla pakalpojums).

PIN code: (PIN kods) — PIN kodà jàbþt 4–8 cipariem.

PIN2 code: (PIN2 kods) — PIN2 kodà jàbþt 4–8 cipariem. 
PIN2 kods ir nepiecie¹ams, lai piek¶þtu atsevi¹óàm 
funkcijàm, piem., zvanu izmaksu uzstàdïjumiem 
(nodro¹ina SIM karte). Ja trïs reizes pºc kàrtas ievadàt 
nepareizu PIN2 kodu, to var atbloóºt, ievadot PUK2 kodu. 
Jaunajà PIN2 kodà jàbþt 4–8 cipariem.

Zvanu liegumi
Barring password: (Liegumu parole) — pieskarieties Change 
(Mainït), lai mainïtu liegumu paroli. Lieguma parolº jàbþt 
èetràm rakstzïmºm. Ja trïs reizes pºc kàrtas ievadïtu 
nepareizu paroli, parole tiek bloóºta, un jums tïkla 
pakalpojumu sniedzºjam jàlþdz jauna parole.

Screen calibration
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > Screen calibration (Ekràna kalibrº¹ana).

Ja ekràna skàrienjutïgais apgabals rea»º neprecïzi, 
iespºjams, ka ekràns ir jàkalibrº. Izpildiet ekrànà sniegtos 
noràdïjumus.
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Themes
Atveriet Desk > Control panel > Themes (Motïvi).

Motïvi ir ïpa¹i faili, kuros ir ietverta formatºjuma 
informàcija, attºli un skañas. Izmantojot motïvus, var 
mainït viedtàlruña izskatu un skañas.

Lai mainïtu viedtàlruña izskatu vai skañas, 
pieskarieties Themes. Sarakstà izvºlieties motïvu un 
pieskarieties Apply (Lietot). Lai apskatïtu izvºlºto 
motïvu, pieskarieties Test (Pàrbaude), pºc tam 
pieskarieties Preview (Apskate). Pieskarieties Sounds 
(Skañas), lai noklausïtos motïva skañas.

Device language
Atveriet Desk > Control panel > Device language (Ierïces 
valoda).

Lai mainïtu viedtàlruña valodu, pieskarieties Device 
language:. Mainot valodu, tiek ietekmºti arï da¾i 
re»ionàlie uzstàdïjumi, piem., valþtas simboli un 
mºrvienïbas.

Service commands
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > Service commands (Pakalpojumu komandas).

Pakalpojumu sniedzºjam var nosþtït pakalpojumu 
pieprasïjumus, piemºram, tïkla pakalpojumu aktivizº¹anas 

komandas. Pla¹àku informàciju lþdziet pakalpojumu 
sniedzºjam.

Lai nosþtïtu pieprasïjumu, ievadiet to laukà un 
pieskarieties Send (Sþtït). 
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Virtuàlà privàtà tïklo¹ana (VPN)
Izmantojot virtuàlo privàto tïklo¹anu — Virtual Private 
Networking (VPN) — var veidot ¹ifrºtus savienojumus, lai 
piek¶þtu informàcijai, kad neesat birojà. Jþs nezaudºjat ne 
sakaru, ne pàrvaldïbas iespºjas, pateicoties ¹ifrºtajai 
piek¶uvei sava uzñºmuma tïklam, lai varºtu izmantot 
e-pastu, datu bàzu programmas un iek¹tïklu.

Attàlà tïkla trafiks ir jàaizsargà. Iespºjams, ka jþsu 
uzñºmums izmanto VPN, lai tunelºtu tïkla trafiku un 
izmantotu piemºrotas dro¹ïbas politikas. VPN palïdz 
nodro¹inàt tïkla transakcijàm gan konfidencialitàti, gan 
integritàti, kà arï ¶auj autentificºt lietotàjus un apstiprinàt 
viñu piek¶uvi tïkliem un tïkla pakalpojumiem.

Lai izveidotu VPN, vàrteja un viedtàlrunis viens otru 
autentificº un vienojas par ¹ifrº¹anas un autentifikàcijas 
algoritmiem, kas palïdz aizsargàt tàs informàcijas 
konfidencialitàti un integritàti, kurai piek¶þstat.

Viedtàlruña Nokia 7710 VPN sistºma pagaidàm nodro¹ina 
¹àdas vàrtejas: Nokia IP VPN Gateway, Cisco VPN 3000 
Concentrator Series un Nokia IP Security Platform. 
Jaunàko informàciju par piemºrotajàm vàrtejàm meklºjiet 
www.nokia.com.

Virtuàlàs privàtàs tïklo¹anas 
pàrvaldïba
Lai izmantotu VPN savienojumus, vispirms jàizveido VPN 
piek¶uves punkti, kuri pºc tam jàizvºlas, izmantojot 
programmas, lai izveidotu savienojumu ar uzñºmumu. 
VPN savienojums ar uzñºmuma tïklu tiek veidots, 
izmantojot cita veida interneta piek¶uves punkta 
savienojumu. Savienojums tiek veidots un ¹ifrºts atbilsto¹i 
VPN politikai, kas tiek ielàdºta, veidojot savienojumu ar 
VPN piek¶uves punktu.

 Lai varºtu izmantot virtuàlo privàto tïklo¹anu
1 Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 

panelis) > VPN management (VPN pàrvaldïba).
2 Noràdiet savienojumu ar VPN politiku serveri. 

VPN politikas servera uzstàdïjumus var noràdït izvºlnº 
VPN management vai instalºt no faila Symbian 
installation system (SIS) (Symbian instalº¹anas 
sistºma).
Pla¹àku informàciju sk. “Savienojuma izveide ar VPN 
politiku serveriem” 129. lpp.

Piezïme. Ja VPN politikas instalºjat no SIS failiem, 
jums nav jàveido savienojumi ar VPN politiku 
serveriem.

3 Instalºjiet VPN politikas no VPN politiku servera.
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Pla¹àku informàciju sk. “VPN politiku instalº¹ana no 
VPN politiku serveriem” 126. lpp.

4 Izveidojiet VPN piek¶uves punktus.
VPN piek¶uves punkti noràda interneta piek¶uves 
punktu un VPN politiku. Pla¹àku informàciju par 
piek¶uves punktu izveidi sk. “Interneta piek¶uves 
punkta uzstàdï¹ana” 114. lpp.

Piezïme. VPN piek¶uves punkti apvieno VPN 
politikas ar interneta piek¶uves punktiem. Pirmoreiz 
sinhronizºjot VPN politiku serveri, katrai 
viedtàlrunï instalºtajai politikai tiek izveidoti 
atbilsto¹i VPN piek¶uves punkti. 

5 Izvºlieties VPN piek¶uves punktu, ja izmantojat 
programmas, lai veidotu savienojumu ar uzñºmuma 
tïklu.
Pla¹àku informàciju sk. “VPN izmanto¹ana ar 
programmàm” 134. lpp.
VPN savienojums tiek veidots pàr interneta piek¶uves 
punkta savienojumu.

VPN politiku pàrvaldïba
VPN politikas definº metodi, ko izmanto VPN klients (VPN 
client) un VPN vàrteja, lai viens otru autentificºtu, kà arï 
¹ifrº¹anas algoritmus, ko tie izmanto, lai aizsargàtu datu 
konfidencialitàti. Administratori izveido VPN politikas un 
saglabà tàs VPN politiku serveros vai piegàdà tàs jums kà 
SIS failus. Jþs VPN politikas instalºjat no VPN politiku 
servera izvºlnº VPN management.

VPN politiku instalº¹ana no VPN 
politiku serveriem
Izvºlnº VPN management var instalºt VPN politikas no VPN 
politiku servera.

Padoms. VPN politiku serveri ir serveri uzñºmuma 
tïklà, kuros ir VPN politikas.

 Lai instalºtu VPN politikas
1 Atveriet Control panel (Vadïbas panelis) > VPN 

management (VPN pàrvaldïba). 
2 Pieskarieties Yes (Jà), kad programma VPN management 

piedàvà instalºt VPN politikas.
3 Pieskarieties Yes vºlreiz, lai pievienotu VPN politiku 

serverus.
4 Noràdiet uzstàdïjumus savienojumam ar VPN politiku 

serveri un pieskarieties Done (Gatavs).
Pla¹àku informàciju sk. “Savienojuma izveide ar VPN 
politiku serveriem” 129. lpp.

5 Pieskarieties Yes, lai sinhronizºtu VPN politiku serveri.
6 Izveidojiet atslºgu kràtuves paroli un pieskarieties OK 

(Labi).
Padoms. Atslºgu kràtuves parole palïdz aizsargàt 

VPN politiku un VPN politiku servera savienojumu 
privàtàs atslºgas pret nesankcionºtu izmanto¹anu.

Pla¹àku informàciju sk. “Atslºgu kràtuves paroles 
izveide vai mainï¹ana” 133. lpp.
Viedtàlrunis izveido savienojumu ar VPN politiku 
serveri.
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7 Pàrbaudiet VPN politiku servera identitàtes kodu un 
ievadiet trþksto¹às rakstzïmes, lai izveidotu 
uzticamïbas saikni starp viedtàlruni un VPN politiku 
serveri un pieskarieties OK. 
Varat izlaist ¹o soli, ja VPN politiku servera 
uzstàdïjumus instalºjat no SIS faila.

Padoms. VPN politiku servera identitàtes kods ir 
VPN politiku servera sertifikàta pirksta nospiedums, 
kas identificº sertifikàtu.

Pla¹àku informàciju sk. “VPN politiku serveru 
pievieno¹ana” 130. lpp.

8 Ievadiet autentifikàcijas informàciju, lai piek¶þtu VPN 
politiku serverim, un pieskarieties OK.
Administratori noràdïs, kàda informàcija ir jàievada.

VPN politikas tiek instalºtas viedtàlrunï. 

Piezïme. Ja pieskaraties Cancel (Atcelt), VPN politikas 
netiek instalºtas. Izvºlieties Install (Instalºt), lai 
instalºtu VPN politikas no VPN politiku servera.

VPN politiku instalº¹ana no SIS failiem
Administratori VPN politikas var jums piegàdàt SIS failos. 
Ja VPN politikas instalºjat no SIS failiem, jums nav jàdefinº 
savienojumi ar VPN politiku serveriem. Kad VPN politikas ir 
instalºtas, varat izveidot VPN piek¶uves punktus un saistït 
tos ar programmàm.

Ja VPN politikas ietver privàtàs atslºgas un atbilsto¹us 
sertifikàtus, administratori definº atslºgu importº¹anas 
paroles, kas palïdz aizsargàt privàtàs atslºgas. 

Administratoriem ir jàizmanto dro¹a metode, lai 
piegàdàtu jums atslºgu importº¹anas paroli.

Padoms. Atslºgu importº¹anas parole palïdz 
aizsargàt privàtàs atslºgas VPN politiku failà.

 Lai instalºtu VPN politikas no SIS failiem, ievadiet 
atslºgu importº¹anas paroli laukà Key import pass.: 
(Atslºgu importº¹anas parole) un pieskarieties OK (Labi). 
Pºc tam ievadiet atslºgu kràtuves paroli laukà Key store 
password (Atslºgu kràtuves parole) un pieskarieties OK.

VPN politiku apskate
Izvºlnº VPN management var apskatït, atjauninàt un 
izdzºst viedtàlrunï instalºtàs VPN politikas.

 Lai apskatïtu VPN politikas deta¶as, izvºlieties VPN 
politiku un pieskarieties Open (Atvºrt), lai apskatïtu 
papildinformàciju.

Ritinot apskatiet ¹àdu informàciju par katru VPN politiku:
• Description: (Apraksts) — noràdïta papildinformàcija 

par VPN politiku. Apraksts tiek nolasïts no VPN 
politikas. Administratori definº aprakstu, kad tiek 
veidota VPN politika.

• Policy status: (Politikas statuss) — noràdïts, vai VPN 
politika ir gatava lieto¹anai, vai arï tà jau tiek 
izmantota. 

• Certificate status: (Sertifikàta statuss) — noràdïts, vai 
viedtàlrunï ir pieejami derïgi lietotàja sertifikàti.
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• Policy name: (Politikas nosaukums) — noràdïts VPN 
politikas nosaukums. Administratori definº 
nosaukumu, kad tiek veidota VPN politika.

• Policy server: (Politiku serveris) — noràdïts tà VPN 
politiku servera nosaukums, no kura ir instalºta VPN 
politika. VPN politiku serveru nosaukumi tiek pie¹óirti, 
definºjot savienojumus ar VPN politiku serveriem. ©is 
lauks ir paslºpts, ja VPN politika ir instalºta no SIS 
faila.

• Updated: (Atjauninàta) — noràdïts datums, kad VPN 
politika ir pºdºjoreiz tikusi atjauninàta no VPN politiku 
servera. ©is lauks ir paslºpts, ja VPN politika ir instalºta 
no SIS faila. 

Politikas statusa pàrbaude
Policy status: (Politikas statuss) var saturºt ¹àdas vºrtïbas:

In use (Lieto¹anà) — jþs esat izveidojis savienojumu ar VPN 
piek¶uves punktu, kas ir saistïts ar VPN politiku. Veidojot 
savienojumu, VPN politika tiek aktivizºta.

Associated with VPN access point (Saistïta ar VPN piek¶uves 
punktu) — jþs esat VPN politiku saistïjis ar vienu vai 
vairàkiem VPN piek¶uves punktiem. Varat izvºlºties 
jebkuru no VPN piek¶uves punktiem, lai aktivizºtu VPN 
politiku.

Not associated with VPN access point (Nav saistïta ar VPN 
piek¶uves punktu) — lai aktivizºtu VPN politiku, jums VPN 
politika ir jàsaista ar VPN piek¶uves punktu.

Piezïme. VPN politikas deta¶u skats netiek 
atsvaidzinàts, ja laikà, kamºr ¹is skats ir atvºrts, 
politikas statuss mainàs.

Sertifikàta statusa pàrbaude
Certificate status: (Sertifikàtu statuss) var saturºt ¹àdas 
vºrtïbas:

Unknown (Nezinàms) — VPN klients nevar noteikt 
sertifikàtu statusu.

OK (Labi) — viedtàlrunï ir pieejams vismaz viens derïgs 
sertifikàts vai arï jþs neizmantojat sertifikàtus, lai 
autentificºtu VPN vàrtejas.

Expired (Beidzies termiñ¹) — vienam vai vairàkiem 
sertifikàtiem ir beidzies derïguma termiñ¹. Ja nevarat 
izveidot VPN savienojumu, atjauniniet VPN politiku, lai 
re»istrºtu jaunus sertifikàtus. 

No certificate (Nav sertifikàtu) — viedtàlrunï nevar atrast 
vienu vai vairàkus no nepiecie¹amajiem sertifikàtiem. Ja 
nevarat izveidot VPN savienojumu, mº»iniet atjauninàt 
VPN politiku, lai re»istrºtu jaunus sertifikàtus.

Not yet valid (Vºl nav derïgi) — viens vai vairàki sertifikàti ir 
paredzºti izmanto¹anai vºlàk. ©ï vºrtïba var noràdït arï to, 
ka viedtàlrunï ir uzstàdïts nepareizs datums un laiks vai 
laika josla, vai arï nav aktivizºts vasaras laiks.

 Lai izdzºstu VPN politiku, pieskarieties Delete (Dzºst). 

Lai aizvºrtu VPN politikas deta¶as, pieskarieties Close 
(Aizvºrt).
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VPN politiku atjauninà¹ana
Veidojot savienojumu ar VPN piek¶uves punktu, VPN klients 
(VPN client) pàrbauda VPN politikas statusu, kas saistïta ar 
VPN piek¶uves punktu no VPN politiku servera. Ja 
administratori ir izveidoju¹i jaunu VPN politikas versiju, 
jaunà versija tiek instalºta viedtàlrunï. Ja administratori 
izdzº¹ VPN politiku no VPN politiku servera, VPN politika 
tiek izmesta no viedtàlruña. 

Izmaiñas stàjas spºkà nàkamreiz, kad veidojat savienojumu 
ar VPN piek¶uves punktu. Tàdºjàdi tàs neietekmº pa¹reizºjo 
VPN savienojumu.

VPN politiku var atjauninàt arï izvºlnº VPN management.

 Lai atjauninàtu VPN politiku, izvºlieties VPN politiku 
un pieskarieties Update (Atjauninàt). VPN klients (VPN 
client) pàrbauda VPN politikas status no VPN politiku 
servera.

VPN politiku dzº¹ana
Ja administratori ir izdzºsu¹i VPN politikas no VPN politiku 
servera, tàs tiek izdzºstas automàtiski, kad atjauninàt VPN 
politiku vai sinhronizºjat VPN politiku serveri. 

Ja izdzº¹at VPN politiku izvºlnº VPN management, tà 
joprojàm pastàv VPN politiku serverï. Lïdz ar to VPN 
politika tiek instalºta atkal, kad sinhronizºjat VPN politikas 
no VPN politiku servera.

Lai izdzºstu VPN politiku, izvºlieties VPN politiku un 
pieskarieties Delete (Dzºst). 

VPN piek¶uves punktu nevar izmantot, ja esat izdzºsis ar 
to saistïto VPN politiku.

VPN politiku serveru pàrvaldïba
Izmantojot iespºju Policy servers (Politiku serveri), varat 
instalºt VPN politikas no VPN politiku serveriem. Kad 
izveidojat savienojumu ar VPN piek¶uves punktu, 
viedtàlrunis automàtiski izveido savienojumu ar VPN 
politiku serveri, lai atjauninàtu ar VPN piek¶uves punktu 
saistïto VPN politiku. Lai atjauninàtu visas VPN politikas, 
sinhronizºjiet VPN politiku serverus ar viedtàlruni.

Savienojuma izveide ar VPN politiku 
serveriem
Instalºjot VPN politikas no VPN politiku servera, tiek 
izveidota uzticamïbas saikne starp viedtàlruni un VPN 
politiku serveri. Lai izveidotu uzticamïbas saikni, jums ir 
jàautentificº VPN politiku serveris un VPN politiku 
serverim ir jàautentificº jþs. 

Kad VPN politiku serveris ir jþs autentificºjis, VPN klients 
(VPN client) »enerº privàto atslºgu un re»istrº jums 
atbilsto¹u sertifikàtu. Privàtà atslºga un sertifikàts tiek 
saglabàts viedtàlruña atslºgu kràtuvº. Sertifikàts 
autentificº jþs VPN politiku serverï.

Padoms. Administratori var nodro¹inàt jums SIS failu, 
kurà ir uzstàdïjumi savienojumam ar VPN politiku 
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serveri, vai arï jþs varat pievienot VPN politiku serveri 
izvºlnº VPN management (VPN pàrvaldïba).

Uzstàdïjumu instalº¹ana no SIS failiem
VPN politiku servera uzstàdïjumus var instalºt no SIS faila. 
Uzstàdïjumus viedtàlrunï var instalºt tàpat, kà instalºjat 
citu programmatþru. 

Uzstàdïjumi ietver VPN politiku servera adresi un servera 
sertifikàtu. Servera sertifikàts liek viedtàlrunim uzticºties 
VPN politiku serverim, un jums savas identitàtes 
pieràdï¹anai ir jànoràda tikai lietotàjvàrds un parole.

SIS fails neietver interneta piek¶uves punkta uzstàdïjumus 
savienojumam ar VPN politiku serveri. Lai noràdïtu 
interneta piek¶uves punktu, redi»ºjiet VPN politiku servera 
uzstàdïjumus. Interneta piek¶uves punktu var arï 
izvºlºties, veidojot savienojumu ar VPN politiku serveri.

Ja administratori neparaksta SIS failu, to instalºjot, tiek 
paràdïts dro¹ïbas brïdinàjums. Varat ¹o brïdinàjumu 
ignorºt, ja esat pàrliecinàts, ka SIS fails ir sañemts no 
administratoriem.

Pirms instalºjat uzstàdïjumus no SIS faila, ir jàiziet no 
programmas VPN management. Pretºjà gadïjumà 
instalº¹ana neizdodas.

VPN politiku serveru pievieno¹ana
Izvºlnº Policy servers var noràdït VPN politiku servera 
uzstàdïjumus, ja tos neinstalºjat no SIS faila.

Pirmoreiz veidojot savienojumu ar VPN politiku servera 
adresi, viedtàlrunis neuzticas VPN politiku serverim, tàpºc 
jums VPN politiku serveris ir jàautentificº. VPN politiku 
servera identitàtes kodu var sañemt no administratoriem. 
Jums VPN politiku servera identitàtes kods ir jàpàrbauda 
un jànoràda lïdz galam, bet pºc tam to pàrbauda VPN 
klients (VPN client).

Pºc veiksmïgas autentificº¹anas VPN klients (VPN client) 
re»istrº sertifikàtu no VPN politiku servera turpmàkai 
autentificº¹anai VPN politiku serverï.

 Lai pievienotu VPN politiku serveri, pieskarieties 
New (Jauns). Ievadiet ¹àdus uzstàdïjumus:
• Server name: (Servera nosaukums) — varat izvºlºties 

jebkàdu nosaukumu, taèu tam jàbþt unikàlam sarakstà 
Policy servers (Politiku serveri). 
Ja ¹o lauku atstàjat tuk¹u, tajà tiek ievadïta vºrtïba no 
lauka Server address: (Servera adrese). 
Politiku servera nosaukums tiek paràdïts VPN politiku 
serveru sarakstà.

• Server address: (Servera adrese) — tà VPN politiku 
servera hostservera nosaukums vai IP adrese, no kura 
jàinstalº VPN politikas. Varat noràdït arï porta numuru, 
atdalot to ar kolu (:).
Politiku servera adresi var sañemt no administratoriem.

• Internet access point: (Interneta piek¶uves punkts) — 
interneta piek¶uves punkts, kas jàizmanto 
savienojumiem ar ¹o VPN politiku serveri. 
To, kur¹ piek¶uves punkts jàizvºlas, noràda 
administratori.
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 Lai instalºtu VPN politikas no VPN politiku servera, 
pieskarieties Yes (Jà), kad programma VPN management 
(VPN pàrvaldïba) piedàvà sinhronizºt VPN politiku serveri.

Padoms. Sinhronizº¹ana nozïmº, ka VPN klients (VPN 
client) izveido savienojumu ar VPN politiku serveri, lai 
pàrbaudïtu, vai tajà nav pievienotas jaunas, 
atjauninàtas vai arï no tà nav izdzºstas VPN politikas, 
un instalºtu VPN politikas viedtàlrunï.

Pirmoreiz veidojot savienojumu ar VPN politiku servera 
adresi, viedtàlrunis neuzticas VPN politiku serverim, tàpºc 
jums VPN politiku serveris ir jàautentificº. VPN politiku 
servera identitàtes kodu var sañemt no administratoriem.

 Lai pàrbaudïtu VPN politiku servera identitàti, 
uzmanïgi salïdziniet VPN politiku servera identitàtes kodu, 
kas noràdïts dialogà VPN policy server identity code (VPN 
politiku servera identitàtes kods), ar kodu, ko esat sañºmis 
no administratoriem, ievadiet trþksto¹às rakstzïmes laukà 
Missing chars.: (Trþksto¹às rakstzïmes) un pieskarieties OK 
(Labi).

Piezïme. Ja VPN politiku servera uzstàdïjumus 
instalºjat no SIS faila, jums nav jàpàrbauda VPN servera 
identitàte, un ¹is skats netiek paràdïts.

 Lai autentificºtu VPN politiku serveri, ievadiet savu 
lietotàjvàrdu dialoga VPN policy server authentication (VPN 
politiku servera autentifikàcija) laukà User name: 
(Lietotàjvàrds) un paroli — laukà Password: (Parole), bet pºc 
tam pieskarieties OK (Labi).

Administratori noràda lietotàjvàrdu un paroli, kas jàievada.

Padoms. Politiku servera lietotàjvàrds un parole 
palïdz aizsargàt VPN politiku serveri pret 
nesankcionºtu piek¶uvi.

VPN klients (VPN client) re»istrº sertifikàtu turpmàkajàm 
autentifikàcijàm VPN politiku serverï un instalº VPN 
politikas viedtàlrunï.

Padoms. Sertifikàta re»istrº¹ana nozïmº, ka 
sertificº¹anas iestàdei tiek nosþtïts sertifikàcijas 
pieprasïjums un tiek sañemts sertifikàts.

Tagad jþs varat veidot VPN piek¶uves punktus un piesaistït 
tos programmàm.

VPN politiku serveru redi»º¹ana
Izvºlnº Policy servers (Politiku serveri) var apskatït, 
redi»ºt, sinhronizºt un izdzºst VPN politiku serverus.

 Lai apskatïtu vai mainïtu VPN politiku servera 
uzstàdïjumus, izvºlieties VPN politiku serveri un 
pieskarieties Edit (Redi»ºt). Pºc tam varat mainït ¹àdus 
uzstàdïjumus:
• Server name: (Servera nosaukums) — politiku servera 

nosaukums. Sarakstà Policy servers tiek paràdïts jaunais 
nosaukums.

• Internet access point: (Interneta piek¶uves punkts) — 
interneta piek¶uves punkts, kas jàizmanto 
savienojumiem ar ¹o VPN politiku serveri. 
Ja izdzº¹at piek¶uves punktu, kas ir saistïts ar VPN 
politiku serveri, laukà Internet access point: (Interneta 
piek¶uves punkts) tiek paràdïts teksts Not selected (Nav 
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izvºlºts). Ja izdzº¹at visus piek¶uves punktus, 
programma VPN management nevar saglabàt 
uzstàdïjumus.

Kad esat instalºjis VPN politikas no VPN politiku servera, 
servera adresi (Server address:) vairs nevar mainït, jo VPN 
politiku serveris pirmà savienojuma laikà to nosþta VPN 
pàrvaldïbai.

 Lai izdzºstu VPN politiku serveri, pieskarieties Delete 
(Dzºst). 

Lai saglabàtu uzstàdïjumus, pieskarieties Done 
(Gatavs).

Padoms. Lai aizvºrtu skatu, nesaglabàjot izmaiñas, 
nospiediet taustiñu Esc .

VPN politiku serveru sinhronizº¹ana
 Lai instalºtu un atjauninàtu politikas no VPN 

politiku servera, izvºlieties VPN politiku serveri un 
pieskarieties Synchronise (Sinhronizºt). VPN klients (VPN 
client) izveido savienojumu ar VPN politiku serveri, lai 
pàrbaudïtu, vai administratori nav pievienoju¹i, 
atjauninàju¹i vai izdzºsu¹i VPN politikas. 

Ja VPN politiku serverï ir jaunas VPN politikas vai jaunas 
VPN politiku versijas, VPN politikas tiek instalºtas 
viedtàlrunï. Ja administratori ir izdzºsu¹i VPN politikas no 
VPN politiku servera, VPN politikas tiek izmestas no 
viedtàlruña. 

Piezïme. Pirmoreiz sinhronizºjot VPN politiku serveri, 
katrai viedtàlrunï instalºtajai politikai tiek izveidoti 
atbilsto¹i VPN piek¶uves punkti. VPN piek¶uves punkti 
apvieno VPN politikas ar interneta piek¶uves punktiem. 
Kad izveidojat savienojumu ar VPN politiku serveri, lai 
instalºtu vai atjauninàtu VPN politikas, iespºjams, jums 
ir jàre»istrº VPN sertifikàti no VPN politiku servera.

VPN sertifikàtu re»istrº¹ana
VPN klients (VPN client) izveido sertifikàcijas pieprasïjumu 
katram nepiecie¹amajam sertifikàtam un nosþta ¹os 
pieprasïjumus VPN politiku serverim. VPN politiku serveris 
re»istrº katru pieprasïto sertifikàtu sertificº¹anas iestàdº 
un nosþta to atpaka¶ VPN klientam (VPN client). 

Sertificº¹anas pieprasïjums un atbilsto¹ais sertifikàts 
ietver lietotàja identitàti. Atkarïbà no VPN politiku servera 
konfiguràcijas kà lietotàja identitàte VPN sertifikàtos var 
tikt izmantota VPN politiku servera lietotàja identitàte. Ja 
tas nav iespºjams, programma VPN management pieprasa 
jums lietotàja identitàti konkrºtajam domºnam. 
Administratori noràdïs, kàda informàcija ir jàievada.

 Lai izveidotu sertifikàcijas pieprasïjumus, dialoga 
VPN user identity (VPN lietotàja identitàte) laukà User 
identity: (Lietotàja identitàte) ievadiet savu sertifikàta 
lietotàja identitàti noràdïtajam domºnam un pieskarieties 
OK (Labi).
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VPN ¾urnàla apskate
®urnàlà ir ¾urnàla ziñas, kas tiek re»istrºtas, kad atjauninàt 
un sinhronizºjat VPN politikas, kà arï izmantojat VPN 
piek¶uves punktus, lai veidotu VPN savienojumus ar VPN 
vàrtejàm. 

VPN ¾urnàlà Log var apskatït un izdzºst ¾urnàla ziñas. 
Varat apskatït ziñu ierakstus, laiku, kad katra ziña ir 
re»istrºta, kà arï ¾urnàla ziñas sàkumu. 

  noràda k¶þdu,  — brïdinàjumu un  — informàciju.

 Lai apskatïtu visu ¾urnàla ziñu, pieskarieties Open 
(Atvºrt).

Log (®urnàls) kàrto ziñas pºc laika un datuma, kad tàs ir 
re»istrºtas, novietojot jaunàkàs ziñas sàkumà. Varat 
apskatït tàs ziñas, kas re»istrºtas lïdz brïdim, kad atvºràt 
¾urnàlu (Log). 

Lai apskatïtu jaunàkàs ¾urnàla ziñas, pieskarieties 
Reload (Ielàdºt vºlreiz).

®urnàla ziñas var ietvert k¶þda, statusa un iemesla kodu. Ja 
ziñojat par k¶þdàm, ¹ie kodi ir jàpaziño administratoriem.

 Lai izdzºstu visas ¾urnàla ziñas, pieskarieties Clear log 
(Nodzºst ¾urnàlu).

®urnàla ziñas tiek re»istrºtas riñóveida buferï. Kad ¾urnàla 
lielums sasniedz 20 kilobaitus, jaunàs ¾urnàla ziñas 
pàrraksta vecàkàs ¾urnàla ziñas.

Atslºgu kràtuves paroles
Funkcija Key store password (Atslºgu kràtuves parole) ¶auj 
izveidot vai mainït atslºgu kràtuves paroli. Atslºgu 
kràtuves parole palïdz aizsargàt viedtàlruña un VPN 
politiku servera savienojumu privàtàs atslºgas pret 
nesankcionºtu izmanto¹anu. 

Atslºgu kràtuves paroles izveide vai 
mainï¹ana
Atslºgu kràtuves parole tiek veidota, instalºjot pirmo VPN 
politiku. Veidojiet tàdas atslºgu kràtuves paroles, kuras ir 
pietiekami garas un grþti uzminamas, lai pienàcïgi 
aizsargàtu viedtàlrunï eso¹o informàciju. Ja atslºgu 
kràtuves parole tiek uzlauzta, uzñºmuma tïkls var k¶þt 
pieejams nesakcionºtai piek¶uvei.

Padoms. Atslºgu kràtuves parolei jàbþt vismaz se¹as 
rakstzïmes garai, un tà var ietvert gan burtus, gan 
ciparus, gan arï speciàlàs rakstzïmes.

 Lai mainïtu atslºgu kràtuves paroli, pieskarieties Set 
(Uzstàdït).

Ievadiet laukà New password: (Jauna parole) paroli, ko 
jums ir viegli iegaumºt, bet kuru jebkuram citam bþtu 
grþti uzminºt. Lai izvairïtos no pàrrakstï¹anàs k¶þdàm, 
ievadiet paroli vºlreiz laukà Verify password: (Atkàrtojiet 
paroli) un pieskarieties OK (Labi).
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Atslºgu kràtuves paro¶u ievadï¹ana
Atslºgu kràtuves parole ir jàievada, ja:
• no VPN politiku serveriem instalºjat jaunas VPN 

politikas vai atjauninàt eso¹às;
• izmantojat programmas, lai veidotu savienojumu ar 

VPN piek¶uves punktiem, kuri pieprasa sertifikàta 
autentificº¹anu. 

VPN izmanto¹ana ar 
programmàm
Ja izmantojat programmu, lai veidotu savienojumu ar VPN 
piek¶uves punktu, tàlrunis veic ¹àdas darbïbas:
• izveido savienojumu ar interneta piek¶uves punktu, kas 

ir saistïts ar VPN piek¶uves punktu;
• ielàdº VPN politiku, kas ir saistïta ar VPN piek¶uves 

punktu;
• izveido savienojumu ar VPN vàrteju, lai izveidotu VPN 

savienojumu.

VPN vàrteju autentificº¹ana
Piesakoties uzñºmuma VPN, jums ir jàpieràda sava 
identitàte. Lietoto autentifikàcijas metodi nosaka VPN 
politika:
• Autentificº¹ana ar sertifikàtu — jums ir nepiecie¹ams 

uzticamas sertificº¹anas iestàdes parakstïts 
sertifikàts. Jþs izmantojat sertifikàtu re»istrº¹anu 

tie¹saistº, lai iegþtu sertifikàtu, vai instalºjat 
sertifikàtus kopà ar VPN politiku no SIS faila.

• Mantotà autentificº¹ana — jþs autentifikàcijai 
izmantojat lietotàjvàrdus un paroles vai piek¶uves 
kodus. Administratori izveido lietotàjvàrdus un paroles 
vai pie¹óir jums SecurID maróierus piek¶uves kodu 
»enerº¹anai.

 Ja autentificº¹anai lietojat sertifikàtus, ievadiet 
atslºgu kràtuves paroli.

 Ja izmantojat mantoto autentificº¹anu, ievadiet 
VPN autentifikàcijas informàciju, kad izmantojat 
programmas, lai veidotu savienojumus ar VPN piek¶uves 
punktiem un viedtàlrunis vienojas par ¹ifrºtiem 
savienojumiem ar VPN vàrteju.

 Lai VPN vàrtejas autentificº¹anai izmantotu 
lietotàjvàrdus un paroles, ievadiet savu VPN lietotàjvàrdu 
laukà VPN user name: un VPN paroli laukà VPN password:. 
Pieskarieties OK (Labi).

 Lai VPN vàrtejas autentificº¹anai izmantotu 
lietotàjvàrdus un piek¶uves kodus, ievadiet savu VPN 
lietotàjvàrdu laukà VPN user name:. «enerºjiet SecurID 
piek¶uves kodu un ievadiet to laukà VPN passcode:. 
Pieskarieties OK (Labi).

Ja SecurID maróieris ir zaudºjis sinhronizàciju ar servera 
ACE/Server laiku, jums tiek pieprasïts nàkamais piek¶uves 
kods, ko serveris ACE/Server izmanto kà jauno atsauci uz 
maróiera laika bàzi. Ievadiet savu VPN lietotàjvàrdu laukà 
VPN user name:. «enerºjiet un ievadiet jauno piek¶uves 
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kodu laukà Next passcode: (Nàkamais piek¶uves kods) un 
pieskarieties OK. Ja tas neizdodas, sazinieties ar 
administratoriem.

Problºmu novºr¹ana
©ajà sada¶à ir noràdïti k¶þdu ziñojumi alfabºtiskà secïbà, 
aprakstïti iespºjamie k¶þdu iemesli un ieteikta rïcïba, kà 
novºrst k¶þdas.

Authentication failed. Check user name and password.
• Izpildot autentifikàciju VPN politiku serverï vai 

piesakoties VPN, esat ievadïjis nepareizu lietotàjvàrdu 
vai paroli.

• Esat ievadïjis nepareizu piek¶uves kodu, kad jums tika 
pieprasïts nàkamais piek¶uves kods.

Izmº»iniet ¹àdus risinàjumus:
• Pàrbaudiet savu lietotàjvàrdu un paroli un mº»iniet 

vºlreiz.
• «enerºjiet un ievadiet piek¶uves kodu.

Unable to log on to policy server. Enter policy server user name 
and password.

Sertifikàtam, kas jþs autentificº VPN politiku serverï, ir 
beidzies derïgums vai administratori ir anulºju¹i 
sertifikàtu.

Ziñojiet par ¹o k¶þdu administratoriem, kuri jums izsniegs 
vienreiz lietojamu pieteik¹anàs paroli. Ievadiet 
lietotàjvàrdu un vienreiz lietojamo paroli, lai izpildïtu 

autentifikàciju VPN politiku serverï. VPN klients (VPN 
client) re»istrº jums jaunu sertifikàtu.

Unable to log on to policy server. See VPN log for details.

Vºl nav pienàcis derïguma termiñ¹ sertifikàtam, kas jþs 
autentificº VPN politiku serverï.

Pàrbaudiet datuma un laika uzstàdïjumus vai pagaidiet, 
lïdz sàkas sertifikàta derïguma termiñ¹.

Unable to use VPN client. Cryptographic library is too weak.

Ja viedtàlrunï instalºtà ¹ifrº¹anas bibliotºka ir par vàju, 
jþs nevarat izmantot VPN savienojumus.

Sazinieties ar administratoriem.

Incorrect password

Esat ievadïjis nepareizu atslºgu kràtuves paroli vai atslºgu 
importº¹anas paroli.

Pàrbaudiet paroli un mº»iniet vºlreiz.

Atslºgu importº¹anas paroli var sañemt no 
administratoriem. Atslºgu kràtuves parole ir jàizveido 
pa¹am.

Policy server is currently in use. Unable to delete.

VPN politiku serveri nevar izdzºst, kamºr atjauninàt VPN 
politikas no ¹ï servera. Ja izmantojat programmu, kura 
veido savienojumu ar VPN piek¶uves punktu, VPN politikas 
tiek atjauninàtas automàtiski.

Pagaidiet, lïdz beidzas VPN politiku atjauninà¹ana, un 
mº»iniet vºlreiz.
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Unable to log on to policy server. Delete server and redefine 
details.

Ir beidzies VPN politiku servera sertifikàta derïgums.

 Lai izdzºstu VPN politiku serveri, izvºlieties VPN 
politiku serveri sarakstà Policy servers (Politiku serveri) un 
pieskarieties Delete (Dzºst). 

 Lai atkal pievienotu VPN politiku serveri, 
pieskarieties New (Jauns) vai lþdziet administratoram SIS 
failu, kurà ir jaunie VPN politiku servera uzstàdïjumi.

Unable to update policy. See VPN log for details.

Unable to synchronise. See VPN log for details.

Lejupielàdºjot VPN politikas no VPN politiku servera vai 
instalºjot tàs viedtàlrunï, ir radusies k¶þda.

Lai atjauninàtu VPN politiku, izvºlieties VPN politiku 
sarakstà Policies (Politikas) un pieskarieties Update 
(Atjauninàt).

 Lai instalºtu politikas no VPN politiku servera, 
izvºlieties VPN politiku serveri sarakstà Policy servers 
(Politiku serveri) un pieskarieties Synchronise 
(Sinhronizºt).

Incorrect server identity code

Jþs noràdïjàt nepareizu kodu, kad tika pieprasïts ievadït 
VPN politiku servera identitàtes kodu.

Uzmanïgi salïdziniet VPN politiku servera identitàtes kodu 
ar kodu, ko sañºmàt no administratoriem, un ievadiet 
trþksto¹às rakstzïmes vºlreiz.

Unable to activate VPN connection. See VPN log for details.

Mantotà autentificº¹ana nav izdevusies, trþkst sertifikàta, 
kuru izmantojat, lai autentificºtos VPN vàrtejà, vai arï ¹im 
sertifikàtam ir beidzies vai nav vºl sàcies derïgums 
termiñ¹.

Pàrbaudiet datuma un laika uzstàdïjumus viedtàlrunï.

 Lai atjauninàtu VPN politiku, izvºlieties VPN politiku 
sarakstà Policies (Politikas) un pieskarieties Update 
(Atjauninàt).

VPN policy deleted. Try redefining VPN access point.

VPN politika, kas bija piesaistïta VPN piek¶uves punktam, ir 
novecojusi un tika automàtiski izdzºsta.

Lai VPN piek¶uves punktam piesaistïtu citu VPN politiku, 
izvºlieties Control Panel > Internet Setup (Vadïbas panelis, 
Interneta uzstàdïjumi), vºlreiz izvºlieties VPN savienojumu 
un piesaistiet tam derïgu politiku.
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File manager (Failu pàrvaldïba)
Atveriet Desk (Darbvirsma) > File manager (Failu 
pàrvaldïba).

Programmà File manager var pàrvietot, kopºt, pàrdºvºt un 
atvºrt failus un mapes.

Autortiesïbu aizsardzïbas likumi, iespºjams, nepie¶auj 
atsevi¹óu attºlu, zvana melodiju un citu materiàlu 
kopº¹anu, modificº¹anu, pàrvieto¹anu vai pàrsþtï¹anu.

Padoms. Lai failus un mapes izñemtu no ierïces 
iek¹ºjàs atmiñas, tàdºjàdi atbrïvojot tajà vietu, 
izmantojiet programmu File manager un atmiñas karti. 
Sk. “Darbs ar atmiñas kartºm” 138. lpp.

33. attºls. File manager

Lai atvºrtu failu vai mapi, veiciet tai 
dubultpieskàrienu.

Lai atkàrtoti atvºrtu nesen atvºrtu failu, nospiediet 
 un izvºlieties File (Fails) > Recent files (Nesenie 

faili). Izvºlieties atveramo failu.

Lai apskatïtu faila vai mapes deta¶as, nospiediet  
un izvºlieties Tools (Rïki) > Details (Deta¶as). Ja 
atzïmºjat izvºles rþtiñu Read-only: (Tikai lasàms), failu 
nevar pàrveidot.

Darbs ar failiem
Lai atrastu failu, pieskarieties Find (Atrast). Ievadiet 
meklºjamà faila nosaukumu vai da¶u nosaukuma. 
Meklº¹anu var veikt arï pºc failu tipiem. Lai 
sa¹aurinàtu meklº¹anu, pieskarieties Options 
(Iespºjas) un noràdiet vietu, kur jàmeklº, kà arï 
meklºjamo failu datumu diapazonu. Pieskarieties Find, 
lai sàktu meklº¹anu.

Lai izveidotu jaunu failu, nospiediet  un 
izvºlieties File > New file... (Jauns fails). Noràdiet faila 
veidu un vietu, kur jaunais fails tiks saglabàts.

Lai mainïtu failu kàrto¹anas secïbu, nospiediet  
un izvºlieties Display (Ràdït) > Sort... (Kàrtot). Izvºlieties 
gan kategoriju, pºc kuras faili kàrtojami, gan 
kàrto¹anas secïbu.
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Darbs ar mapºm
Lai aizvºrtu mapi un pàrvietotos uz aug¹u mapju 
sistºmà, pieskarieties Up one level (Vienu lïmeni uz 
aug¹u).

Lai izveidotu jaunu mapi, nospiediet  un 
izvºlieties File > New folder... (Jauna mape). Pie¹óiriet 
jaunajai mapei nosaukumu un izvºlieties atra¹anàs 
vietu.

Lai pàrdºvºtu atlasïtu failu vai mapi, nospiediet  
un izvºlieties File > Rename... (Pàrdºvºt).

Darbs ar atmiñas kartºm
Lai pàrslºgtos no iek¹ºjà diska uz atmiñas karti, 
nospiediet  un izvºlieties Browse (Navigàcija) > 
Memory (Atmiña) > Memory card (Atmiñas karte).

Lai pàrdºvºtu atmiñas karti, nospiediet  un 
izvºlieties Memory card > Rename... (Pàrdºvºt).

Lai formatºtu atmiñas karti, nospiediet  un 
izvºlieties Memory card > Format (Formatºt). Visi dati 
no atmiñas kartes tiks neatgriezeniski izdzºsti! 
Pieskarieties Format, lai turpinàtu formatº¹anu.

Lai izveidotu informàcijas dublºjumkopiju atmiñas 
kartº, nospiediet , izvºlieties Tools (Rïki) > Backup/
Restore... (Dublºjums/Atjauno¹ana) un pieskarieties 
Backup (Dublºjumkopija). Izvºlieties, vai 
dublºjumkopija jàizveido visiem datiem vai tikai 

noràdïto veidu failiem. Pieskarieties OK (Labi), lai sàktu 
kopº¹anu. Ieteicams regulàri veidot viedtàlruña datu 
dublºjumkopijas.

Lai atjaunotu informàciju no atmiñas kartes, 
nospiediet , izvºlieties Tools (Rïki) > Backup/
Restore... (Dublºjums/Atjauno¹ana) un pieskarieties 
Restore (Atjauno¹ana).

Pla¹àku informàciju par atmiñas kartºm sk. “Atmiñas 
kartes izñem¹ana un ievieto¹ana” 16. lpp.

Ievºrojiet arï, ka varat izveidot datu dublºjumkopiju 
datorà, izmantojot datorprogrammatþras komplektu 
Nokia PC Suite 6.41 vai tà jaunàku versiju. Pla¹àku 
informàciju par programmatþrà Nokia PC Suite 
pieejamajàm dublºjumkopiju veido¹anas iespºjàm sk. 
kompaktdiskà iek¶autajà Nokia PC Suite lietotàja 
rokasgràmatà.
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Log (®urnàls)
Atveriet Desk (Darbvirsma) > Log (®urnàls).

Izmantojot programmu Log, var pàrraudzït viedtàlruña 
re»istrºtos tàlruñu zvanus, ziñas un datu savienojumus. 
®urnàlu var filtrºt, lai apskatïtu tikai viena veida 
notikumus, un izveidot kontaktu kartïtes, izmantojot 
¾urnàla informàciju.

Lai izvºlºtos, kàda veida notikumus apskatïsit, 
nospiediet  un izvºlieties View group (Skatït grupu) 
> All communication (Visa saziña)/Voice calls (Balss 
zvani)/Messages (Ziñas)/GPRS connections (GPRS 
savienojumi)/Data calls (Datu zvani). Ievºrojiet, ka 
atsevi¹ói notikumi, piem., ïsziña, kas nosþtïta vairàkàs 
da¶às, vai GPRS savienojumi, tiek re»istrºti ¾urnàlà kà 
viens saziñas notikums.

Lai kàrtotu notikumu sarakstu, pieskarieties Sort 
(Kàrtot) un izvºlieties secïbu, kàdà jàkàrto saraksts.

Lai apskatïtu notikuma deta¶as, atlasiet notikumu 
¾urnàlà un pieskarieties Details (Deta¶as). Piem., varat 
apskatït sþtïtàja vai adresàta vàrdu, tàlruña numuru, 
pakalpojumu sniedzºja nosaukumu vai piek¶uves 
punktu. Lai kopºtu ¾urnàla notikumà ràdïto tàlruña 
numuru, pieskarieties Copy number (Kopºt numuru).

Lai notïrïtu visa ¾urnàla saturu, nospiediet  un 
izvºlieties Edit (Redi»ºt) > Clear log (Notïrït ¾urnàlu). 
Tiek notïrïts arï pºdºjo zvanu saraksts. Lai no ¾urnàla 

izdzºstu atsevi¹óu notikumu, atlasiet notikumu, 
nospiediet  un izvºlieties Edit > Delete 
communication detail (Izdzºst saziñas informàciju).

Lai noràdïtu ¾urnàla darbïbas laiku, nospiediet  
un izvºlieties Tools (Rïki) > Log duration... (®urnàla 
darbïbas laiks). Lai noràdïtu dienu skaitu, pieskarieties 
<+> un <->. Notikumi ¾urnàlà paliek viedtàlruña 
atmiñà noràdïto dienu skaitu un pºc tam tiek 
automàtiski izdzºsti, lai atbrïvotu atmiñu. Ievºrojiet — 
izvºloties nulli (0), re»istrº¹ana ¾urnàlà tiek izslºgta un 
viss ¾urnàla saturs, pºdºjo zvanu saraksti un 
ziñapmaiñas piegàdes atskaites tiek neatgriezeniski 
izdzºstas. Ievºrojiet arï, ka ¾urnàlà nevar re»istrºt 
vairàk kà 300 notikumu. Pàrsniedzot ¹o skaitu, 
notikumi tiek izdzºsti, sàkot ar vecàkajiem 
notikumiem.

 Lai piezvanïtu uz tàlruña numuru, kur¹ tiek ràdïts 
¾urnàlà, atlasiet notikumu ¾urnàlà un pieskarieties 
Call (Zvanït). Lai nosþtïtu ziñu uz numuru, nospiediet 

 un izvºlieties Options (Iespºjas) > Create  (Izveidot) 
> Text message / Multimedia message (Ïsziñu/multiziñu).

Lai tàlruña numuru pievienotu kontaktu katalogam, 
nospiediet  un izvºlieties Options (Iespºjas) > Add to 
Contacts... (Pievienot kontaktu katalogam).
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Pºdºjie zvani
Dialogà Recent calls (Pºdºjie zvani) var apskatït zvanïtos 
numurus, sañemtos zvanus un neatbildºtos zvanus. Varat 
arï atlasït tàlruña numuru un uz to piezvanït vai pievienot 
kontaktu katalogam.

Lai pàrraudzïtu zvanïtos numurus, kà arï sañemto 
zvanu un neatbildºto zvanu numurus, nospiediet 

 un izvºlieties Options > Recent calls (Pºdºjie zvani). 
Viedtàlrunis re»istrº neatbildºtos un sañemtos zvanus 
vienïgi tad, ja tïkls nodro¹ina ¹ïs funkcijas, viedtàlrunis 
ir ieslºgts un atrodas tïkla pàrklàjuma zonà.

Lai izdzºstu pºdºjo zvanu sarakstu, programmas Log 
galvenajà skatà nospiediet  un izvºlieties Edit > 
Clear log (Notïrït ¾urnàlu). Tiek notïrïts gan pºdºjo 
zvanu saraksts, gan viss notikumu ¾urnàls.

Sarunu ilguma un GPRS datu 
skaitïtàjs

Lai pàrraudzïtu sarunu ilgumu, nospiediet  un 
izvºlieties Tools (Tools) > Call duration (Sarunu ilgums). 
Sarakstà tiek uzràdïts aptuvenais sañemto zvanu un 
veikto zvanu ilgums. Lai notïrïtu sarunu ilguma 
skaitïtàjus, pieskarieties Clear timers (Notïrït 
skaitïtàjus). Lai to izdarïtu, ir nepiecie¹ams bloóº¹anas 
kods.

Piezïme. Faktiskais pakalpojumu sniedzºja rºóins par 
sarunu laiku var at¹óirties atkarïbà no tïkla iespºjàm, 
aprºóinu noapa¶o¹anas metodºm utt.

Lai apskatïtu GPRS datu skaitïtàju, nospiediet  
un izvºlieties Tools > GPRS data counter (GPRS datu 
skaitïtàjs). Sarakstà tiek paràdïts, kàds datu apjoms ir 
nosþtïts un sañemts pake¹datu (GPRS) savienojumu 
laikà. Piem., samaksa par GPRS savienojumiem var tikt 
aprºóinàta pºc nosþtïtà un sañemtà datu apjoma. Lai 
notïrïtu GPRS datu skaitïtàjus, pieskarieties Clear 
counters (Notïrït skaitïtàjus). Lai to izdarïtu, ir 
nepiecie¹ams bloóº¹anas kods.
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Cell Broadcast (©þnu apraide)
Vietàs, kur ir pieejams ¹þnu apraides pakalpojums (Cell 
Broadcast Service — CBS), no pakalpojumu sniedzºja var 
sañemt ziñas par da¾àdàm tºmàm, piem., laika ziñas vai 
informàciju par satiksmes apstàk¶iem. Pieejamàs tºmas un 
atbilsto¹os tºmu numurus vaicàjiet pakalpojumu 
sniedzºjam.

©þnu apraide ir tïkla pakalpojums. Uzziniet no 
pakalpojumu sniedzºja, vai CBS ir pieejams.

Ievºrojiet, ka pake¹datu (GPRS) savienojums var ne¶aut 
¹þnu apraides uztver¹anu. Pareizos GPRS uzstàdïjumus 
vaicàjiet tïkla operatoram.

Ziñu lasï¹ana un darbs ar tàm
Lai lasïtu ziñu, pieskarieties Read (Lasït).

Lai saglabàtu ziñu, kuru lasàt, nospiediet  un 
izvºlieties Edit (Redi»ºt) > Save message (Saglabàt ziñu).

Lai izdzºstu ziñu, kuru lasàt, nospiediet  un 
izvºlieties Edit > Delete message (Dzºst ziñu).

Lai bloóºtu ziñu, kuru lasàt, nospiediet  un 
izvºlieties Edit > Lock message (Bloóºt ziñu). Ziñu var 
bloóºt, lai ne¶autu to izdzºst, kad tiek sañemtas jaunas 
ziñas par ¹o pa¹u tºmu.

Lai atvºrtu nàkamo vai iepriek¹ºjo ziñu, pieskarieties 
Next (Nàkamà) vai Previous (Iepriek¹ºjà).

Lai sàktu vai apturºtu CBS ziñu sañem¹anu, 
pieskarieties Reception on (Sañem¹ana ieslºgta) vai 
Reception off (Sañem¹ana izslºgta).

Darbs ar tºmàm
Padoms. Varat meklºt da¾àdas tºmas. Meklº¹anas 
laukà ievadiet tºmas nosaukumu.

Lai sañemtu informàciju par jaunu konkrºtu tºmu, 
nospiediet  un izvºlieties Topic (Tºma) > Hotmark 
(Jaunums). Jaunà tºma tiek apzïmºta ar izsaukuma 
zïmi (!).

Lai redi»ºtu vai noñemtu tºmas, ja sañem¹ana ir 
izslºgta, nospiediet  un izvºlieties Topic > More 
options (Citas iespºjas) > Edit topic... (Redi»ºt tºmu) vai 
Delete topic(s) (Dzºst tºmu(as)). Ievºrojiet, ka tºmas 
nevar redi»ºt saraksta skatà All (Visas).

Lai abonºtu, ritinot atrodiet tºmu un nospiediet 
Subscribe (Abonºt). Izvºles rþtiñà tºmas kreisajà pusº 
tiek paràdïta atzïme. Lai pàrtrauktu abonº¹anu, 
pieskarieties Unsubscribe (Atteikt abonº¹anu).
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Lai izveidotu jaunu tºmu sarakstu, nospiediet  
un izvºlieties Lists (Saraksti) > Manage lists... (Darbs ar 
sarakstiem). Pieskarieties New (Jauns) un ievadiet 
jaunà saraksta nosaukumu.

Lai mainïtu tºmu saraksta nosaukumu, nospiediet 
 un izvºlieties Lists > Manage Lists... Izvºlieties 

pàrdºvºjamo sarakstu un pieskarieties Rename 
(Pàrdºvºt). Ievºrojiet, ka sañem¹anai ir jàbþt izslºgtai.

Lai atvºrtu citu tºmu sarakstu, nospiediet , 
izvºlieties Lists un izvºlieties atveramo tºmu sarakstu.

Pàrºjos tºmu sarakstos tºmas joprojàm var abonºt vai 
pàrtraukt to abonº¹anu, kà arï noràdït tàs kà aktuàlàs 
tºmas.

©þnu apraides uzstàdïjumi
Lai pàrveidotu uzstàdïjumus, nospiediet  un 
izvºlieties Tools > Settings... (Uzstàdïjumi). Noràdiet 
vajadzïgos uzstàdïjumus.

Add new topics to list: (Sarakstam pievienot jaunas 
tºmas) — izvºloties ¹o iespºju, visas jaunàs tºmas tiek 
automàtiski pievienotas pa¹reizºjam tºmu sarakstam. Ja 
neizvºlas ¹o iespºju, tiek sañemtas vienïgi ziñas par 
abonºtajàm vai aktuàlajàm tºmàm, kuras jau ir iek¶autas 
tºmu sarakstà.

Language: (Valoda) — noràdiet, kàdà valodà vºlaties 
sañemt ziñas par tºmàm. Izvºlieties All (Visas), lai 
sañemtu ziñas par tºmàm visàs valodàs.

Padoms. Lai sañemtu pilnu ¹ajà vietà pieejamo tºmu 
sarakstu, izveidojiet jaunu, neaizpildïtu tºmu sarakstu, 
atzïmºjiet iespºju Add new topics to list: un noràdiet 
visas valodas, kà minºts iepriek¹.

Reception on: (Sañem¹ana ieslºgta) — izvºlieties ¹o iespºju, 
lai ziñas tiktu sañemtas automàtiski.

Reception on' time: (Sañem¹anas sàkuma laiks) — 
pieskarieties , lai noràdïtu laiku, kad jàsàkas 
automàtiskajai sañem¹anai.

Reception off' time: (Sañem¹anas beigu laiks) — 
pieskarieties , lai noràdïtu laiku, kad jàbeidzas 
automàtiskajai sañem¹anai.

Message deletion interval (hours): (Ziñu dzº¹anas 
intervàls) — noràdiet, cik bie¾i tiek izdzºstas visas lasïtàs 
ziñas.
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Savienojumi
Bluetooth savienojums
Atveriet Desk (Darbvirsma) > Control panel (Vadïbas 
panelis) > Bluetooth.

©is viedtàlrunis atbilst Bluetooth specifikàcijai 1.1, kura 
atbalsta ¹àdus profilus: iezvanes tïklo¹anas, objekta 
pakalpojumu, failu pàrsþtï¹anas un brïvroku profilu. Lai to 
varºtu izmantot kopà ar citàm ierïcºm, kuras atbalsta 
Bluetooth tehnolo»iju, lietojiet papildierïces, kuras Nokia ir 
apstiprinàjusi lieto¹anai kopà ar ¹o modeli. Informàciju par 
citu ierïèu saderïbu ar ¹o ierïci sañemsit no to ra¾otàjiem.

Tehnolo»ija Bluetooth nodro¹ina bezvadu savienojumus 
attºlu, teksta, vizïtkar¹u vai kalendàra ierakstu sþtï¹anai, 
kà arï iespºju izveidot bezvadu savienojumu ar saderïgàm 
ierïcºm, kuràs iestràdàta bezvadu tehnolo»ija Bluetooth, 
piem., datoriem.

Tà kà Bluetooth ierïces savà starpà sazinàs, izmantojot 
radiovi¶ñus, ¹im viedtàlrunim un otrai ierïcei nav jàatrodas 
tie¹as redzamïbas zonà. Abàm ierïcºm vienïgi jàbþt ne 
vairàk kà 10 metru attàlumà, lai gan savienojumu var 
traucºt tàdi ¹óºr¹¶i kà sienas vai citas elektroierïces.

Atsevi¹óos re»ionos, iespºjams, pastàv Bluetooth 
tehnolo»ijas lieto¹anas ierobe¾ojumi. Noskaidrojiet to 
vietºjàs varas iestàdºs vai pie pakalpojumu sniedzºja.

Funkcijas, kuras lieto tehnolo»iju Bluetooth, vai ¹àdu 
funkciju izmanto¹ana fonà, vienlaikus izmantojot citas 
funkcijas, palielina akumulatora ener»ijas patºriñu, kà arï 
saïsina akumulatora ekspluatàcijas laiku.

Bluetooth programmas pirmà 
aktivizº¹ana
1 Atveriet programmu Control panel (Vadïbas panelis) un 

izvºlieties Bluetooth.
2 Pie¹óiriet viedtàlrunim Bluetooth nosaukumu. Ievadiet 

¹o nosaukumu (ne vairàk kà 82 rakstzïmes) vai 
izmantojiet standarta nosaukumu. Ja sþtàt datus, 
izmantojot Bluetooth, pirms viedtàlrunim esat pie¹óïris 
individuàlu Bluetooth nosaukumu, tiek izmantots 
standarta nosaukums.

3 Atzïmºjiet izvºles rþtiñu Switch Bluetooth on: (Ieslºgt 
Bluetooth). Notïrot ¹o izvºles rþtiñu, tiek pàrtraukti visi 
aktïvie Bluetooth savienojumi un tehnolo»iju 
Bluetooth nevar izmantot datu sþtï¹anai vai 
sañem¹anai.

4 Atzïmºjiet izvºles rþtiñu Visible to all: (Redzama visiem), 
lai citi Bluetooth ierïèu lietotàji varºtu redzºt jþsu 
viedtàlruni un tam izvºlºto nosaukumu. Notïrot ¹o 
izvºles rþtiñu, ierïèu meklº¹anas laikà pàrºjàs ierïces 
nevar atrast jþsu viedtàlruni.



Sa
vi

en
oj

um
i

144 Copyright © 2005 Nokia. All rights reserved. 

5 Pieskarieties OK (Labi), lai saglabàtu uzstàdïjumus un 
aizvºrtu dialogu.
Lai deaktivizºtu Bluetooth programmu, statusa 
indikatoru apgabalà pieskarieties  un izvºlieties 
Switch off (Izslºgt). Bluetooth var izmantot datu 
sþtï¹anai vai sañem¹anai pºc tam, kad atkal tiek 
atzïmºta izvºles rþtiña Switch Bluetooth on:. Ievºrojiet, 
ka parasti Bluetooth savienojums pºc datu nosþtï¹anas 
vai sañem¹anas tiek atvienots automàtiski. Vienïgi ar 
atsevi¹óàm palïgierïcºm, piem., austiñàm, savienojums 
var saglabàties pat tad, ja netiek aktïvi izmantots.

Datu sþtï¹ana, izmantojot Bluetooth
Vienlaikus var sþtït datus tikai uz vienu ierïci.
1 Atveriet programmu, kurà tiek glabàts sþtàmais 

objekts. Piem., lai nosþtïtu fotoattºlu uz citu ierïci, 
atveriet programmu Images (Attºli).

2 Iezïmºjiet sþtàmo objektu un pieskarieties Send 
(Sþtït) vai nospiediet  un atrodiet komandu Send > 
Via Bluetooth (Pa Bluetooth).

3 Ja iepriek¹ ir meklºtas Bluetooth ierïces, vispirms tiek 
paràdïts atrasto ierïèu saraksts. Var redzºt ierïces 
ikonu un ierïces Bluetooth nosaukumu.

4 Lai sàktu jaunu meklº¹anu, pieskarieties New search 
(Jauna meklº¹ana).

5 Izvºlieties ierïci, ar kuru veidosit savienojumu, un 
pieskarieties Send (Sþtït).

6 Ja pirms datu pàrsþtï¹anas otra ierïce pieprasa 
savienojumu pàrï, ir jàievada paroles kods. Izveidojiet 

savu paroles kodu (1–16 cipari) un vienojieties ar otras 
Bluetooth ierïces ïpa¹nieku par tà pa¹a koda 
izmanto¹anu. ©is paroles kods tiek lietots tikai vienu 
reizi, tàpºc tas nav jàiegaumº. Ierïcºs, kuràs nav 
lietotàja interfeisa, ir ra¾otàja uzstàdïts paroles kods. 
Kad savienojums ir sekmïgi izveidots, tiek paràdïts 
paziñojums Sending (Sþta).

Pa Bluetooth sañemtos datus var atrast programmas 
Messaging (Ziñapmaiña) mapº Inbox (Sañemtàs ziñas). 
Pla¹àku informàciju sk. sada¶à “Mapes” 48. lpp.

Ievºrojiet — ja sþtï¹ana neizdodas, ziña vai dati tiek 
izdzºsti. Programmas Messaging melnrakstu mapº Drafts 
netiek saglabàtas ziñas, kas sþtïtas pa Bluetooth.

Datu sañem¹ana, izmantojot Bluetooth
Lai varºtu sañemt datus pa Bluetooth, pàrbaudiet, vai 
Bluetooth ir aktivizºts un dialoga Bluetooth izvºles rþtiña 
Visible to all: (Redzama visiem) ir atzïmºta.

Sañemot datus pa Bluetooth no ierïces, kura nav 
autorizºta, vispirms jàatbild, vai vºlaties pieñemt 
Bluetooth ziñu. Ja pieñemat, objekts tiek ievietots 
programmas Messaging mapº Inbox.

Pàrï savienotas ierïces
Savieno¹ana pàrï nozïmº autentifikàciju. Savieno¹ana pàrï 
ar ierïci paàtrina un atvieglo ierïèu meklº¹anu.
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Ar Bluetooth tehnolo»iju aprïkoto ierïèu lietotàjiem 
vajadzºtu savstarpºji vienoties par paroles kodu un 
izmantot vienu un to pa¹u kodu abàm ierïcºm, kuras tiek 
savienotas pàrï.

Ierïèu savieno¹ana pàrï
1 Atveriet programmu Control panel (Vadïbas panelis) un 

izvºlieties Bluetooth. Ierïces var savienot pàrï arï pirms 
datu pàrsþtï¹anas.

2 Pieskarieties Paired devices (Pàrï savienotas ierïces). 
Pàrï savienotas ierïces tiek paràdïtas sarakstà. 

3 Pieskarieties Search (Meklºt), lai atvºrtu dialogu 
Search for devices (Ierïèu meklº¹ana). Ja iepriek¹ ir 
meklºtas Bluetooth ierïces, vispirms tiek paràdïts 
atrasto ierïèu saraksts.

4 Pieskarieties New search (Jauna meklº¹ana), lai 
atjauninàtu atrasto ierïèu sarakstu, ja nepiecie¹ams, 
izvºlieties ierïci, ar kuru jàsavieno pàrï, un pieskarieties 
Pair (Savienot pàrï).

5 Ievadiet paroles kodu un pieskarieties OK (Labi).
Lai pàrï savienotàm ierïcºm pie¹óirtu ïsos 
nosaukumus, atveriet programmu Control panel, 
izvºlieties Bluetooth, pºc tam pieskarieties Paired 
devices. Atlasiet ierïci, kuras nosaukumu mainïsit, un 
pieskarieties Edit (Redi»ºt). Ïso nosaukumu (segvàrdu, 
aizstàjºjvàrdu) noràda, lai bþtu ºrtàk atpazït ierïci. ©is 
nosaukums tiek glabàts ierïces atmiñà, un to neredz citi 
Bluetooth ierïèu lietotàji.

Padoms. Izvºlieties viegli iegaumºjamu un 
atpazïstamu nosaukumu. Vºlàk, ja meklºsit ierïces vai 

cita ierïce prasïs izveidot savienojumu, jþsu izvºlºtais 
nosaukums ¶aus identificºt jþsu ierïci.

Lai atceltu savienojumu pàrï, atveriet programmu 
Control panel, izvºlieties Bluetooth, pºc tam 
pieskarieties Paired devices. Atlasiet ierïci, kuras 
savienojumu pàrï atcelsit, un pieskarieties Delete 
(Dzºst). Ja pa¹laik ir izveidots savienojums ar citu ierïci 
un savienojumu pàrï ar ¹o ierïci dzº¹at, savienojums 
pàrï tiek noñemts uzreiz un savienojums tiek 
pàrtraukts.

Lai autorizºtu pàrï savienotas ierïces, atveriet 
programmu Control panel, izvºlieties Bluetooth, pºc 
tam pieskarieties Paired devices. Izvºlieties 
autorizºjamàs pàrï savienotàs ierïces un pieskarieties 
Edit. Notïriet izvºles rþtiñu Confirm connection requests: 
(Apstiprinàt savienojuma pieprasïjumus). 
Savienojumus starp jþsu viedtàlruni un citu ierïci var 
izveidot bez jþsu ziñas. Nav nepiecie¹ama atsevi¹óa 
piekri¹ana vai autorizàcija. ©o statusu izmantojiet 
savàm ierïcºm, piem., savam personàlajam datoram 
vai ierïcºm, kuras pieder personai, kam uzticaties. 
Ikona  ierïèu sarakstà tiek ievietota pie 
autorizºtàm ierïcºm. Lai uzstàdïtu, ka pàrï 
savienotas ierïces nav autorizºtas, atzïmºjiet izvºles 
rþtiñu Confirm connection requests: (Apstiprinàt 
savienojuma pieprasïjumus). Savienojuma 
pieprasïjumi no ¹ïs ierïces katru reizi ir atsevi¹ói 
jàapstiprina.
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Viedtàlruña savieno¹ana ar 
saderïgu datoru
©o viedtàlruni var savienot ar saderïgu personàlo datoru, 
izmantojot komplektàcijà iek¶auto savienojuma kabeli 
DKU-2. Pla¹àku informàciju par to, kà izveidot 
savienojumu ar saderïgu datoru, izmantojot Bluetooth, un 
kà instalºt programmatþru Nokia PC Suite 6.41 vai tàs 
jaunàku versiju, sk. programmatþras Nokia PC Suite 
rokasgràmatà, kura atrodama kompaktdiskà. Pla¹àku 
informàciju par to, kà izmantot programmatþru Nokia PC 
Suite, sk. PC Suite elektroniskajà palïdzïbà.

Pirms savienot viedtàlruni ar personàlo datoru, izmantojot 
savienojuma kabeli, beidziet tàlruña sarunas, aizveriet 
dokumentus un viedtàlrunï pàrtrauciet visus citus aktïvos 
procesus.

Kompaktdiska izmanto¹ana
Komplektàcijà iek¶autais kompaktdisks ir saderïgs ar 
sistºmu Windows 2000/XP. Kad kompaktdisks ievietots 
saderïga datora CD-ROM diskdzinï, tam bþtu jàstartºjas 
automàtiski. Ja tà nenotiek, rïkojieties ¹àdi:
1 Noklik¹óiniet uz sistºmas Windows pogas Start (Sàkt) 

un izvºlieties Programs (Programmas) > Windows 
Explorer.

2 CD-ROM diskdzinï atrodiet failu ar nosaukumu 
Nokia7710.exe un veiciet uz tà dubultklik¹ói. Tiek 
atvºrts kompaktdiska interfeiss.

3 Programmatþra Nokia PC Suite 6.41 vai tàs jaunàkà 
versija atrodas kompaktdiska sada¶à “Install Software” 
(Programmatþras instalº¹ana). Veiciet dubultklik¹ói uz 
Nokia PC Suite 6. Instalº¹anas vednis palïdz paveikt 
instalº¹anu.

Viedtàlruña izmanto¹ana modema 
vietà
Ievºrojiet — lietojot viedtàlruni modema vietà, nevar veikt 
tàlruña zvanus.

Informàciju par multivides ierïces savieno¹anu ar saderïgu 
personàlo datoru sk. programmatþras Nokia PC Suite 
dokumentàcijà. Informàciju par datu saziñas programmu 
sk. programmas dokumentàcijà.

Nokia PC Suite
Programmatþra Nokia PC Suite ir atrodama viedtàlruña 
komplektàcijà iek¶autajà kompaktdiskà. Izmantojot Nokia 
PC Suite, varat, piem., viedtàlrunï un datorà sinhronizºt 
tàlruñu kataloga saturu un kalendàru, izveidot datu 
dublºjumkopijas personàlajà datorà, kà arï apstràdàt ar 
ierïces kameru uzñemtos fotoattºlus.

Pla¹àku informàciju par programmàm, kuras pieejamas 
kopà ar programmatþru Nokia PC Suite, sk. PC Suite 
rokasgràmatà — kompaktdiskà un katras programmas 
elektroniskajà palïdzïbà.
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Lai varºtu izmantot Nokia PC Suite, instalºjiet to saderïgà 
personàlajà datorà un datoru savienojiet ar multivides 
ierïci, izmantojot Bluetooth vai USB kabeli DKU-2.

Datu kopº¹ana no saderïgas ierïces
Izmantojot programmatþru PC Suite 6.41 vai tàs jaunàku 
versiju, ¹ajà viedtàlrunï varat kopºt informàciju no 
daudziem da¾àdiem Nokia tàlruñiem vai saderïgiem 
personàlajiem datoriem. Pla¹àku informàciju sk. Nokia PC 
Suite rokasgràmatà, kas atrodama komplektàcijà 
iek¶autajà kompaktdiskà. Komplektàcijà iek¶autais 
kompaktdisks ir saderïgs ar sistºmu Windows 2000/XP.

Attàlà konfigurº¹ana (tïkla 
pakalpojums)
Atveriet Desk (Darbvirsma) > Device manager (Ierïces 
pàrvaldnieks).

Programma Device manager palïdz konfigurºt viedtàlruña 
savienojuma uzstàdïjumus, piem., e-pasta, multiziñu vai 
interneta uzstàdïjumus. Parasti, ja ierïces uzstàdïjumi ir 
jàatjaunina, attàlàs konfigurº¹anas savienojumu sàk 
serveris.

Attàlà konfiguràcija notiek, izmantojot GSM datu zvanu 
vai GPRS savienojumu.

Attàlàs konfiguràcijas programma izmanto tehnolo»iju 
SyncML Device Management, versija 1.1.1. Informàciju par 
programmas Remote Configuration saderïbu vaicàjiet tà 

konfiguràciju risinàjuma ra¾otàjam, ar kuru gatavojaties 
pàrvaldït viedtàlruña uzstàdïjumus.

Lai sàktu konfiguràcijas sesiju, atveriet programmu 
Device manager. Sarakstà izvºlieties profilu, 
nospiediet  un izvºlieties Configuration 
(Konfiguràcija) > Start (Sàkt).

Lai apskatïtu konfiguràcijas ¾urnàlu, kad 
konfiguràcijas sesija ir beigusies, pieskarieties Log 
(®urnàls). ®urnàla failà tiek ràdïts izvºlºtà profila 
konfiguràcijas statuss.

Lai deaktivizºtu konfiguràciju, nospiediet  un 
izvºlieties Configuration > Disable all (Deaktivizºt visu). 
Konfiguràcijas uzstàdïjumus nevar sañemt no 
konfiguràcijas serveriem, kuriem izveidots profils. Lai 
varºtu sañemt konfiguràcijas uzstàdïjumus no 
serveriem, kuriem esat izveidojis profilu un at¶àvis 
konfigurº¹anu, notïriet ¹ïs komandas izvºles rþtiñu.

Jauna konfiguràcijas servera profila 
izveide
Konfiguràcijas servera profils ir attàlà servera uzstàdïjumi. 
Ja vºlaties piek¶þt vairàkiem serveriem, var izveidot 
vairàkus profilus.

Konfiguràcijas servera profila uzstàdïjumus var sañemt kà 
speciàlu ïsziñu no pakalpojumu sniedzºja.
1 Atveriet programmu Device manager un nospiediet 

. Izvºlieties Profile (Profils) > New... (Jauns). 
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Izvºlieties, vai kopºsit eso¹a profila vºrtïbas un 
izmantosit tàs par pamatu jaunajam profilam.

2 Tiek atvºrts profila vednis Profile Wizard. Noràdiet 
vajadzïgos uzstàdïjumus.
Server name: (Servera vàrds) — ievadiet konfiguràcijas 
servera nosaukumu.
Server ID: (Servera ID) — ievadiet unikàlu konfiguràcijas 
servera identifikatoru. Pareizo vºrtïbu var uzzinàt no 
pakalpojumu sniedzºja vai sistºmas administratora.
Password: (Parole) — ievadiet paroli, ar kuru serveris 
identificºs jþsu ierïci. Apstipriniet paroli.
Access point: (Piek¶uves punkts) — izvºlieties piek¶uves 
punktu, kuru lietosit datu savienojumam ar serveri.
Host address: (Resursdatora adrese) — ievadiet servera 
URL adresi. Pareizo vºrtïbu var uzzinàt no 
pakalpojumu sniedzºja vai sistºmas administratora.
Port: (Ports) — ievadiet servera porta numuru. Pareizo 
vºrtïbu var uzzinàt no pakalpojumu sniedzºja vai 
sistºmas administratora.
User name: (Lietotàjvàrds) — ievadiet savu 
lietotàjvàrdu serverim.
Password: (Parole) — ievadiet savu paroli serverim un 
pºc tam apstipriniet to.
Allow configuration: (At¶aut konfiguràciju) — izvºlieties 
¹o iespºju, lai ¶autu serverim sàkt konfiguràcijas sesiju.
Auto-accept sync requests: (Automàtiski pieñemt 
sinhronizàcijas pieprasïjumus) — izvºlieties ¹o iespºju, 
lai serveris nevaicàtu jþsu apstiprinàjumu pirms 
konfiguràcijas sesijas sàk¹anas.

3 Pieskarieties OK (Labi), lai saglabàtu uzstàdïjumus.

Lai redi»ºtu konfiguràcijas profila uzstàdïjumus, 
izvºlieties profilu un pieskarieties Settings 
(Uzstàdïjumi).

Datu pàrsþtï¹ana
Atveriet Desk (Darbvirsma) > Data transfer (Datu 
pàrsþtï¹ana).

Programma Data transfer sniedz iespºju sinhronizºt vai 
kopºt kalendàru vai kontaktinformàciju no jþsu 
viedtàlruña uz citu mobilo tàlruni ar Bluetooth tehnolo»iju 
vai pretºji. 

Lai startºtu datu pàrsþtï¹anas vedni, pieskarieties 
New (Jauns) un izpildiet noràdïjumus. Varat noràdït 
pàrsþtï¹anas veidu un izvºlºties, ko pàrsþtïsit.

Sinhronizàcija
Atveriet Desk (Darbvirsma) > Sync (Sinhronizàcija).

Programma Sync sniedz iespºju sinhronizºt kalendàru vai 
kontaktu katalogu ar da¾àdàm kalendàru un adre¹u 
katalogu programmàm saderïgà personàlajà datorà vai 
internetà. Attàlà sinhronizàcija notiek, izmantojot GSM 
datu zvanu vai GPRS savienojumu, bet lokàlà 
sinhronizàcija notiek ar Bluetooth un USB savienojuma 
palïdzïbu.

Programma Sync attàlajai sinhronizàcijai izmanto 
tehnolo»iju SyncML (versija 1.1.1.). Informàciju par 
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SyncML saderïbu vaicàjiet tàs kalendàra vai adre¹u 
kataloga programmas ra¾otàjam, ar kuru gatavojaties 
sinhronizºt viedtàlruni.

Lai sinhronizºtu datus, atveriet programmu Sync, 
sarakstà atlasiet profilu un pieskarieties Synchronise 
(Sinhronizºt). Kad sinhronizàcija ir pabeigta, tiek 
paràdïts atbilsto¹s paziñojums.

Lai apskatïtu sinhronizàcijas ¾urnàlu, pºc 
sinhronizàcijas pabeig¹anas pieskarieties View (Skats). 
®urnàla failà tiek ràdïts izvºlºtà profila sinhronizàcijas 
statuss, kà arï pievienoto, atjauninàto, dzºsto vai 
izmesto (nesinhronizºto) kalendàra un kontaktu 
kataloga ierakstu skaits viedtàlrunï vai serverï.

Jauna sinhronizàcijasprofila izveide
Sinhronizàcijas profils ir attàlà servera uzstàdïjumi. Ja dati 
jàsinhronizº ar vairàkiem serveriem vai programmàm, var 
izveidot vairàkus profilus.

Sinhronizàcijas uzstàdïjumus var sañemt kà speciàlu ïsziñu 
no pakalpojumu sniedzºja.
1 Atveriet programmu Sync un nospiediet . 

Izvºlieties Profile (Profils) > New... (Jauns). Izvºlieties, 
vai kopºsit eso¹a profila vºrtïbas un izmantosit tàs par 
pamatu jaunajam profilam.

2 Tiek atvºrts profila vednis Profile Wizard. Noràdiet 
vajadzïgos uzstàdïjumus.
Name: (Nosaukums) — ievadiet raksturojo¹u profila 
nosaukumu.

Data bearer: (Datu nesºjs) — noràdiet, vai 
sinhronizàciju veiksit internetà vai izmantojot vietºjos 
savienojumus.
Access point: (Piek¶uves punkts) — izvºlieties piek¶uves 
punktu, kuru lietosit datu savienojumam.
Host address: (Ports) — pareizo vºrtïbu var uzzinàt no 
pakalpojumu sniedzºja vai sistºmas administratora.
Port: (Ports) — pareizo vºrtïbu var uzzinàt no 
pakalpojumu sniedzºja vai sistºmas administratora.
User name: (Lietotàjvàrds) — jþsu identifikators 
sinhronizàcijas serverim. Pareizo identifikatoru var 
uzzinàt no pakalpojumu sniedzºja vai sistºmas 
administratora.
Password: (Parole) — ievadiet savu paroli un pºc tam 
apstipriniet to. Pareizo vºrtïbu var uzzinàt no 
pakalpojumu sniedzºja vai sistºmas administratora.

3 Izvºlieties, ko sinhronizºsit: kontaktu katalogu vai 
kalendàra ierakstus.

4 Ja nepiecie¹ams, ievadiet pareizo ce¶u uz lokàlo 
kalendàru vai kontaktu datu bàzi. Ievadiet arï pareizo 
ce¶u uz attàlo kalendàru vai adre¹u gràmatu serverï. 
Noràdiet arï vºlamo sinhronizàcijas veidu (Normal 
(Standarta), To device only (Tikai uz ierïci), To server only 
(Tikai uz serveri)).

5 Pieskarieties Finish (Beigt), lai saglabàtu 
uzstàdïjumus.
Lai redi»ºtu sinhronizàcijas profila uzstàdïjumus, 
izvºlieties profilu un pieskarieties Settings 
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(Uzstàdïjumi). Papildus uzstàdïjumiem, kuri tika 
noràdïti profila izveides laikà, var noràdït arï ¹àdus:

Allow sync requests: (At¶aut sinhronizàcijas 
pieprasïjumus) — izvºloties ¹o iespºju, serveris var 
automàtiski sàkt sinhronizàcijas sesiju.

Auto-accept sync requests: (Automàtiski pieñemt visus 
sinhronizàcijas pieprasïjumus) — izvºlieties ¹o iespºju, 
lai serveris nevaicàtu jþsu apstiprinàjumu pirms 
sinhronizàcijas sesijas sàk¹anas.
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Problºmu novºr¹ana
Problºmu novºr¹ana
• Viedtàlrunis nesàk stràdàt.

- Pàrbaudiet, vai akumulators ir pareizi ievietots un 
uzlàdºts.
- Pàrbaudiet, vai akumulatora kontakti ir tïri.
- Mº»iniet ieslºgt viedtàlruni, vairàkas sekundes turot 
nospiestu ieslºg¹anas pogu .
- Izñemiet akumulatoru, pagaidiet vismaz desmit 
sekundes un ielieciet akumulatoru atpaka¶.

• Mº»inot làdºt akumulatoru, ekràns vai tàlruña 
taustiñi mirgo.
- Pàrbaudiet, vai akumulators ir pareizi ievietots.

• Akumulators kàrtïgi nelàdºjas.
- Pàrbaudiet, vai savienotàjs ir cie¹i nostiprinàts un 
stràvas kontaktligzda, kuru izmantojat, darbojas.
- Iespºjams, beidzas akumulatora ekspluatàcijas laiks 
vai akumulatoram ir kàda k¶þme. Sazinieties ar tuvàko 
Nokia produktu izplatïtàju.
- Uzlàdes laikà nelietojiet tàdas funkcijas kà Web 
pàrlþks vai RealOne atskañotàjs, jo tàs patºrº daudz 
ener»ijas. Pàràk daudz darbïbu ar ierïci, kuràs tiek 
patºrºts daudz ener»ijas, ne¶auj akumulatoram pilnïbà 
uzlàdºties.

• Ieslºdzot viedtàlruni, ekrànà ikreiz paràdàs tuk¹i, 
izbalºju¹i vai spilgti punkti.
- Tas ir raksturïgi ¹àda veida displejam.

• Skàrienekràna attºls ¹óiet neprecïzs.
- Kalibrºjiet ekrànu. Ar ritinà¹anas taustiña palïdzïbu 
atveriet programmu Control Panel (Vadïbas panelis), 
izvºlieties Screen calibration (Ekràna kalibrº¹ana) un 
izpildiet noràdïjumus.

• Viedtàlrunis pàrstàj rea»ºt uz atsevi¹óàm vai visàm 
komandàm.
– Mazliet pagaidiet. Da¾u procesu pabeig¹anai ir 
nepiecie¹ams daudz laika. Ja ierïce joprojàm nerea»º, 
iespºjams, ka programma aizñem pàràk daudz atmiñas. 
Vismaz 5 sekundes turiet nospiestu , lai atbrïvotu 
vietu atmiñà.  Ja tas nelïdz, izslºdziet un atkàrtoti 
ieslºdziet viedtàlruni. Ja arï tad tàlrunis nerea»º, 
izslºdziet to, izñemiet akumulatoru, pagaidiet vismaz 
desmit sekundes un ievietojiet akumulatoru atpaka¶. 
Lai izvairïtos no Web animàciju problºmàm, 
deaktivizºjiet papildprogrammatþru: Web pàrlþkà 
nospiediet  un izvºlieties Tools (Rïki)> Settings... 
(Iestatïjumi). Atveriet lapu Plugins 
(Papildprogrammatþra) un noñemiet atzïmi rþtiñà 
Enable plug-ins (Iespºjot papildprogrammatþru). Pºc 
papildprogrammatþras deaktivizº¹anas tiek ierobe¾ota 
Web pàrlþka funkcionalitàte.

• Programmas un ieslºg¹anas/izslºg¹anas taustiñ¹ 
nerea»º.
- Izñemiet akumulatoru, pagaidiet vismaz desmit 
sekundes un ielieciet akumulatoru atpaka¶.



Pr
ob

lº
m

u 
no

vº
r¹

an
a

152 Copyright © 2005 Nokia. All rights reserved. 

- Mº»iniet uzlàdºt viedtàlruni.
Ja iepriek¹ minºtie ieteikumi nepalïdz, pirms pºdºjàs 
iespºjas — vºr¹anàs pie vietºjà izplatïtàja — 
izmanto¹anas varat mº»inàt formatºt viedtàlruña 
iek¹ºjo atmiñu. Ievºrojiet, ka formatºjot atmiñu, 
tiek izdzºsts viss, izñemot standarta programmas, 
kuras atmiñà tika instalºtas jau rþpnïcà. 
Ja esat izveidojis atmiñas kartes dublºjumkopiju, sk. 
noda¶u “Darbs ar atmiñas kartºm” 138. lpp.
Formatºjot iek¹ºjo atmiñu, visi izveidotie vai 
pàrveidotie uzstàdïjumi, dokumenti un citi dati iek¹ºjà 
atmiñà tiek neatgriezeniski iznïcinàti. Lai formatºtu 
iek¹ºjo atmiñu, rïkojieties ¹àdi:
1 Atvienojiet làdºtàju un izñemiet akumulatoru.
2 Pagaidiet vismaz desmit sekundes un ievietojiet 

akumulatoru, lai varºtu ieslºgt viedtàlruni. 
3 Atveroties Nokia sveiciena ekrànam, uzreiz 

nospiediet un turiet taustiñus + + . 
Taustiñ¹  ir jànospie¾ pºdºjais. 

4 Apstipriniet, ka vºlaties veikt formatº¹anu. 
Formatº¹ana sàkas.

• Nevar sañemt zvanus vai nevar piezvanït.
- Pàrbaudiet, vai nav izvºlºts profils Flight (Lidojums). 
Ja ¹is profils ir aktivizºts, nevar ne piezvanït, ne 
sañemt zvanus.
- Ja varat atvºrt vienïgi programmu Telephone, lai 
veiktu zvanus uz avàrijas dienestu izsauk¹anas 
numuriem, nav ievietota SIM karte.
- Pàrbaudiet zvanu liegumu un pàradresàcijas statusu. 
Atveriet programmu Telephone (Tàlrunis), nospiediet 

 un izvºlieties Tools (Rïki) > Settings (Uzstàdïjumi) 
> Call barring... (Zvanu liegums) vai Call divert... (Zvanu 
pàradresàcija).
- Viedtàlrunis, iespºjams, ir aizñemts: tiek sþtïti vai 
sañemti dati vai viedtàlrunis tiek lietots kà modems. 
Pagaidiet, lïdz dati ir pàrsþtïti, vai pàrtrauciet datu 
zvanu.

• Zvaniem ir slikta kvalitàte.
- Jþsu atra¹anàs vietà, iespºjams, nav iegþstama 
labàka zvanu kvalitàte. Pàrvietojieties uz vietu, kur 
radiosignàli ir labàk uztverami. Uztver¹anu parasti 
sekmº atra¹anàs augstàk par zemes lïmeni, àrpus 
telpàm vai nekustïgà stàvoklï. Reizºm uztver¹anu 
uzlabo pat neliela viedtàlruña pàrvieto¹ana.

• Balss vai datu zvanus nevar pàradresºt un noteikt 
tiem liegumu.
- Jums nav atbilsto¹à pakalpojuma abonementa, vai arï 
tïkls nenodro¹ina ¹àdu pakalpojumu.
- Pàrbaudiet, vai ïsziñu centra numurs un numurs, uz 
kuru vºlaties pàradresºt zvanus, ir noràdïts un ir 
pareizs.

• Nevar nosþtït vai sañemt ziñas vai e-pasta ziñas.
- Jums nav atbilsto¹à pakalpojuma abonementa, vai arï 
tïkls nenodro¹ina ¹àdu pakalpojumu.
- Pàrbaudiet, vai esat konfigurºjis atbilsto¹os 
uzstàdïjumus.
- Viedtàlruña atmiñà, iespºjams, nepietiek vietas.
- Izmantotais numuru formàts nav derïgs.
- Viedtàlrunis, iespºjams, ir aizñemts: tiek sþtïti vai 
sañemti dati vai viedtàlrunis tiek lietots kà modems. 
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Pagaidiet, lïdz dati ir pàrsþtïti, vai pàrtrauciet datu 
zvanu.

• Nevar nosþtït multiziñas.
- Jums nav atbilsto¹à pakalpojuma abonementa, vai arï 
tïkls nenodro¹ina ¹àdu pakalpojumu.
- Pàrbaudiet, vai esat konfigurºjis atbilsto¹os 
uzstàdïjumus.
- Viedtàlruña atmiñà, iespºjams, nepietiek vietas.
- Ja, ziñà ievietojot multivides klipu, sañemat k¶þdas 
ziñojumu, pàrbaudiet, vai uzstàdïjumam Multimedia 
mode (Multivides re¾ïms), kas atrodams lapas General 
(Vispàrïgi) uzstàdïjumu grupà Multimedia message 
settings (Multiziñu uzstàdïjumi), nav noràdïta iespºja 
Restricted mode: (Ierobe¾ots re¾ïms).

• Nevar beigt Bluetooth savienojumu.
- Ja otra ierïce ir savienota pàrï ar jþsu viedtàlruni, bet 
savienojums ir atstàts atvºrts un dati netiek sþtïti, 
savienojumu var atvienot, pilnïbà deaktivizºjot 
Bluetooth saiti. Atveriet programmu Control panel 
(Vadïbas panelis) un izvºlieties Bluetooth. Notïriet 
izvºles rþtiñu Switch Bluetooth on: (Ieslºgt Bluetooth).

• Nevar atrast otru ierïci ar Bluetooth tehnolo»iju.
- Pàrbaudiet, vai abàs ierïcºs ir aktivizºts Bluetooth.
- Pàrbaudiet, vai attàlums starp abàm ierïcºm nav 
lielàks par 10 m un vai starp tàm nav sienu vai citu 
¹óºr¹¶u.
- Pàrbaudiet, vai otra ierïce neatrodas “slºptajà” 
re¾ïmà.

• Viedtàlrunï sàk pietrþkt vietas atmiñà.
- Pàrbaudiet, vai neesat sañºmis daudz e-pasta ziñu 
vai saglabàjis lielus attºlus vai citus objektus, kuri 
patºrº daudz atmiñas. Lai atbrïvotu vietu atmiñà, 
izdzºsiet nevajadzïgos datus, pàrvietojiet lielos 
objektus uz atmiñas karti vai, ja iespºjams, pàrsþtiet 
tos uz saderïgu personàlo datoru. Lai pàrbaudïtu, cik 
atmiñas ir iztºrºts, atveriet programmu Control panel 
un izvºlieties Memory (Atmiña).

• Problºmas savienojumà ar personàlo datoru.
– Pàrbaudiet, vai personàlajà datorà ir instalºta un 
darbojas programmatþra Nokia PC Suite 6.41 vai tàs 
jaunàka versija. Pla¹àku informàciju sk. PC Suite 
rokasgràmatà.
- Ja izmantojat kabe¶a savienojumu, pàrbaudiet, vai 
kabelis abos galos ir cie¹i piestiprinàts.
Ja izmantojat Bluetooth savienojumu, pàrbaudiet, vai 
personàlais dators ir saderïgs ar Bluetooth un tajà ir 
instalºti un aktivizºti Bluetooth draiveri.
– Informàciju par citàm Nokia PC Suite problºmàm sk. 
Nokia PC Suite lietotàja rokasgràmatà.

• Nav zinàmi piek¶uves kodi.
- Viedtàlruña noklusºjuma bloóº¹anas kods ir 12345. 
Ja aizmirstat vai pazaudºjat bloóº¹anas kodu, 
sazinieties ar viedtàlruña izplatïtàju.
- Ja aizmirstat vai pazaudºjat PIN vai PUK kodu vai 
neesat sañºmis ¹os kodus, sazinieties ar tïkla 
pakalpojumu sniedzºju.
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Informàcija par akumulatoriem
Uzlàdº¹ana un izlàdº¹ana
Ierïces darbïbu nodro¹ina uzlàdºjams akumulators. Jauna 
akumulatora optimàlais darbïbas lïmenis tiek sasniegts tikai 
pºc diviem vai trim pilniem uzlàdº¹anas un izlàdº¹anas 
cikliem. Akumulatoru var uzlàdºt un izlàdºt simtiem rei¾u, 
tomºr tas pamazàm nolietojas. Kad sarunu un gaidï¹anas laiks 
k¶þst ievºrojami ïsàks nekà parasti, iegàdàjieties jaunu 
akumulatoru. Lietojiet tikai Nokia apstiprinàtus akumulatorus 
un làdºjiet tos, izmantojot tikai tos làdºtàjus, kurus Nokia 
apstiprinàjusi ¹ai ierïcei.

Kad làdºtàjs netiek lietots, atvienojiet to no elektrïbas 
kontaktligzdas un ierïces. Neatstàjiet akumulatoru pievienotu 
làdºtàjam. Pàràk ilga làdº¹ana var saïsinàt akumulatora 
ekspluatàcijas laiku. Pilnïbà uzlàdºts akumulators, kas netiek 
izmantots, ar laiku izlàdºjas. Akumulatora spºju uzlàdºties 
ietekmº pàràk augsta vai zema temperatþra.

Izmantojiet akumulatoru tikai paredzºtajiem mºróiem. 
Nelietojiet bojàtu làdºtàju vai akumulatoru.

Neizraisiet akumulatora ïssavienojumu. Nejau¹s 
ïssavienojums var rasties, ja metàla priek¹mets, piemºram, 
monºta, saspraude vai pildspalva veido tie¹u savienojumu 
starp akumulatora pozitïvo (+) un negatïvo (-) elektrodu (kas 
akumulatorà atgàdina metàla sloksnïtes). Tà var gadïties, ja 
rezerves akumulatoru nºsàjat kabatà vai somà. Ïssavienojums 
starp elektrodiem var sabojàt akumulatoru vai savienojo¹o 
priek¹metu.

Akumulatora atstà¹ana karstumà vai aukstumà, piemºram, 
noslºgtà automa¹ïnà vasarà vai ziemà, samazina tà jaudu un 
ekspluatàcijas laiku. Centieties glabàt akumulatoru 
temperatþrà no 15 °C lïdz 25 °C (59 °F un 77 °F). Ierïce ar 
karstu vai aukstu akumulatoru kàdu brïdi var nestràdàt pat 
tad, ja tas ir pilnïbà uzlàdºts. Akumulatora darbïbu ïpa¹i 
ierobe¾o temperatþra zem sasal¹anas robe¾as.

Nededziniet akumulatoru! Iznïciniet akumulatorus atbilsto¹i 
vietºjiem noteikumiem. Ja iespºjams, nododiet tos otrreizºjai 
pàrstràdei. Neizmetiet kopà ar sadzïves atkritumiem.
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APKOPE UN GLABÀ©ANA
©ï ierïce ir augstvºrtïgs izstràdàjums, un ar to jàrïkojas 
saudzïgi. ©eit sniegtie noràdïjumi palïdzºs saglabàt tiesïbas uz 
garantijas pakalpojumiem.
• Sargàjiet ierïci no mitruma. Atmosfºras nokri¹ñi, mitrums 

un visu veidu ¹óidrumi var saturºt vielas, kas izraisa 
elektronisko shºmu koroziju. Ja ierïce tomºr tiek 
saslapinàta, noñemiet akumulatoru un pirms tà uzlik¹anas 
atpaka¶ ¶aujiet ierïcei pilnïbà iz¾þt.

• Nelietojiet vai neglabàjiet ierïci putek¶ainàs, netïràs vietàs. 
Var tikt bojàtas tàs kustïgàs da¶as un elektroniskie 
komponenti.

• Neglabàjiet ierïci karstumà. Augsta temperatþra var 
saïsinàt elektronisko ierïèu ekspluatàcijas laiku, bojàt 
akumulatorus, kà arï deformºt vai izkausºt atsevi¹óas 
plastmasas da¶as.

• Neglabàjiet ierïci aukstumà. Ierïcei atsilstot lïdz normàlai 
temperatþrai, tàs iek¹ienº var kondensºties mitrums, kas 
bojà elektronisko shºmu plates.

• Nemº»iniet atvºrt ierïci citàdi, nekà noràdïts ¹ajà 
rokasgràmatà.

• Sargàjiet ierïci no nokri¹anas, triecieniem un kratï¹anas. 
Pretºjà gadïjumà var tikt bojàtas elektronisko shºmu plates 
un smalkmehànika.

• Ierïces tïrï¹anai nelietojiet kodïgas óimikàlijas, ¹óïdinàtàjus 
vai koncentrºtus mazgà¹anas lïdzek¶us.

• Nekràsojiet ierïci. Kràsa var nosprostot kustïgàs da¶as un 
traucºt pareizu darbïbu.

• Stiklu (piemºram, kameras, apkàrtnes sensora un gaismas 
sensora objektïva) tïrï¹anai izmantojiet mïkstu, tïru, sausu 
dràniñu.

• Izmantojiet tikai komplektàcijà iek¶auto vai ra¾otàja 
apstiprinàtu antenu. Neapstiprinàtas antenas, to 
modifikàcijas vai papildierïces var bojàt ierïci, un to 
lieto¹anu var uzskatït par radioierïèu lieto¹anas 
noteikumu pàrkàpumu.

Visi iepriek¹ minºtie ieteikumi vienàdà mºrà attiecas uz ierïci, 
akumulatoru, làdºtàju un jebkuru papildierïci. Ja ierïce 
nedarbojas pareizi, nogàdàjiet to tuvàkajà pilnvarotajà servisa 
darbnïcà, lai veiktu apkopi.
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PAPILDU INFORMÀCIJA PAR DRO©ÏBU
Darbïbas vide

Ievºrojiet visus ïpa¹os noteikumus, kas ir spºkà konkrºtajà 
vietà, un vienmºr izslºdziet ierïci, ja tàs lieto¹ana ir aizliegta, 
var radït traucºjumus vai ir bïstama. Lietojiet ierïci, novietojot 
to vienïgi normàlajà darba stàvoklï. Lai ievºrotu 
radiofrekvenèu iedarbïbas prasïbas, lietojiet vienïgi tàdas 
papildierïces, kuru lieto¹anu kopà ar ¹o ierïci ir apstiprinàjusi 
Nokia. Ja ierïce ir ieslºgta un tiek nºsàta pie óermeña, vienmºr 
jàlieto apstiprinàts turºtàjs vai somiña.

Ierïces deta¶as ir magnºtiskas. Ierïce var pievilkt metàla 
priek¹metus, tàpºc personas, kas lieto dzirdes aparàtus, 
nedrïkst turºt ierïci pie auss, kurà ir dzirdes aparàts. Vienmºr 
nostipriniet ierïci turºtàjà, jo ska¶runis var pievilkt metàla 
priek¹metus. Nenovietojiet ierïces tuvumà kredïtkartes vai 
citus magnºtiskos datu nesºjus, jo tajos eso¹à informàcija var 
tikt izdzºsta.

Medicïniskàs ierïces

Jebkuru radiovi¶ñu ierïèu, arï mobilo tàlruñu, darbïba var 
izraisït nepietiekami aizsargàtu medicïnisko ierïèu darbïbas 
traucºjumus. Lai noskaidrotu, vai ierïce ir pietiekami 
aizsargàta pret radiofrekvenèu starojumu, kà arï citu 
jautàjumu gadïjumà sazinieties ar àrstu vai medicïniskàs 
ierïces ra¾otàju. Izslºdziet ierïci veselïbas aprþpes iestàdºs, ja 
tur pastàv atbilsto¹as prasïbas. Slimnïcàs vai veselïbas 
aprþpes iestàdºs lieto aparatþru, kas ir jutïga pret 
radiofrekvenèu starojumu.

Elektrokardiostimulatori Lai izvairïtos no iespºjamiem 
elektrokardiostimulatoru darbïbas traucºjumiem, 
elektrokardiostimulatoru ra¾otàji iesaka turºt mobilo tàlruni 
vismaz 15,3 cm (6 collu) attàlumà no 
elektrokardiostimulatora. ©ajos ieteikumos ievºrota Wireless 
Technology Research veiktà neatkarïgà izpºte un tàs sniegtie 
ieteikumi. Ieteikumi elektrokardiostimulatoru lietotàjiem:
• kad ierïce ir ieslºgta, tai jàatrodas vismaz 15,3 cm (6 collu) 

attàlumà no elektrokardiostimulatora;
• ierïci nedrïkst nºsàt krþ¹u kabatà;
• lai lïdz minimumam samazinàtu iespºjamos darbïbas 

traucºjumus, ierïce jàtur pie tàs auss, kas atrodas 
elektrokardiostimulatoram pretºjà pusº.

Ja rodas vismazàkàs aizdomas, ka ierïce rada traucºjumus, 
nekavºjoties izslºdziet to.

Dzirdes aparàti Da¾as digitàlàs mobilàs ierïces var radït 
traucºjumus atsevi¹óos dzirdes aparàtos. Ja rodas traucºjumi, 
vºrsieties pie pakalpojumu sniedzºja.

Transportlïdzek¶i

Radiosignàli var radït traucºjumus nepareizi uzstàdïtàs vai 
nepietiekami aizsargàtàs automa¹ïnu elektroniskajàs sistºmàs, 
piemºram, degvielas elektroniskàs iesmidzinà¹anas sistºmàs, 
elektroniskajàs brem¾u pretbloóº¹anas sistºmàs, 
elektroniskajàs àtruma kontroles sistºmàs, gaisa spilvenu 
sistºmàs. Pla¹àku informàciju lþdziet transportlïdzek¶a vai 
papildu aprïkojuma ra¾otàjam vai tà pàrstàvim.
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Ierïces apkope un uzstàdï¹ana automa¹ïnà jàuztic tikai 
kvalificºtam speciàlistam. Nepareiza ierïces uzstàdï¹ana var 
bþt bïstama, kà arï liegt tiesïbas uz garantijas apkopi. Regulàri 
pàrbaudiet, vai viss mobilàs ierïces aprïkojums automa¹ïnà ir 
nostiprinàts un darbojas pareizi. Nekàdà gadïjumà neglabàjiet 
ugunsbïstamus ¹óidrumus, gàzi vai spràdzienbïstamas vielas 
kopà ar ierïci, tàs deta¶àm vai papildierïcºm. Atcerieties, ka 
automa¹ïnàs, kas ir aprïkotas ar gaisa spilveniem, gaisa 
spilveni tiek piepþsti ar lielu spºku. Nenovietojiet priek¹metus, 
tai skaità uzstàdïtas vai pàrnºsàjamas mobilàs ierïces, virs 
gaisa spilveniem vai to izple¹anàs zonà. Ja automa¹ïnas 
mobilà ierïce ir uzstàdïta nevietà un gaisa spilvens tiek 
piepþsts, var gþt nopietnus savainojumus.

Ierïci aizliegts lietot, atrodoties lidma¹ïnà. Izslºdziet ierïci 
pirms iekàp¹anas lidma¹ïnà. Mobilo teleierïèu lieto¹ana 
lidma¹ïnà var bþt bïstama lidaparàta ierïèu darbïbai, radït 
mobilo sakaru tïkla pàrràvumus un bþt pretrunà ar likumu.

Spràdzienbïstama vide

Izslºdziet ierïci vietàs, kur iespºjama eksplozija, un ievºrojiet 
visas zïmes un noràdïjumus. Spràdzienbïstama vide ir vietàs, 
kur parasti lþdz izslºgt transportlïdzek¶u dzinºju. ©àdàs vietàs 
dzirkstele var izraisït eksploziju vai aizdeg¹anos, radot traumas 
vai nàvºjo¹us ievainojumus. Izslºdziet ierïci degvielas uzpildes 
stacijàs uzpildes sþkñu tuvumà. Ievºrojiet radioierïèu 
lieto¹anas ierobe¾ojumus degvielas bàzºs, glabà¹anas un 
izplatï¹anas vietàs, óïmiskajàs rþpnïcàs un vietàs, kur notiek 
spridzinà¹anas darbi. Spràdzienbïstamas vietas ne vienmºr ir 
skaidri noràdïtas. Tàs ir vietas zem ku»a klàja, óimikàliju 
transportº¹anas vai glabà¹anas tilpnes, transportlïdzek¶i, kuros 
tiek izmantota sa¹óidrinàta naftas gàze (propàns vai butàns), 

kà arï vietas, kur gaisà ir óimikàlijas vai vielu da¶iñas — 
graudiñi, putek¶i vai metàla pulveris.

Zvanï¹ana àrkàrtas situàcijàs

Svarïgi! Mobilie tàlruñi, arï ¹ï ierïce, darbojas, 
izmantojot radiosignàlus, bezvadu un kabe¶u tïklus, 
kà arï lietotàja programmºtas funkcijas. ©à iemesla 
dº¶ nevar garantºt savienojumu jebkuros apstàk¶os. 

Nepa¶aujieties tikai uz mobilajàm ierïcºm, ja jànodro¹ina 
dzïvïbai svarïgi sakari, piemºram, lai sazinàtos ar 
medicïniskàs palïdzïbas dienestiem.

Lai zvanïtu àrkàrtas situàcijàs:
 1 Ja ierïce nav ieslºgta, ieslºdziet to. Pàrbaudiet, vai signàls 

ir pietiekami stiprs.
2  Nospiediet un turiet , lai ekrànà tiktu ràdïta tàlruña 

tastatþra.
3 Ievadiet atra¹anàs vietai atbilsto¹o oficiàlo avàrijas 

dienestu izsauk¹anas numuru. Da¾àdàs vietàs avàrijas 
dienestu izsauk¹anas numuri var at¹óirties.

4 Nospiediet taustiñu .
UZMANÏBU! Lidojuma profils ne¶auj veikt (vai sañemt) 
jebkàdus zvanus, ieskaitot àrkàrtas zvanus, kà arï 
izmantot citas funkcijas, kuràm nepiecie¹ams tïkla 
pàrklàjums. Lai varºtu zvanït, nomainiet profilu, 
aktivizºjot tàlruña funkcijas. Ja ierïce ir bijusi bloóºta, 
ievadiet bloóº¹anas kodu.

Ja jàzvana uz avàrijas dienestu izsauk¹anas numuru, kad 
ierïce ir bloóºta vai tajà uzstàdïts lidojuma profils, mº»iniet 
bloóº¹anas koda laukà ievadït ierïcº ieprogrammºto avàrijas 
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dienestu izsauk¹anas numuru un pieskarieties Call (Zvanït). 
Ierïce apstiprina, ka tþlït tiks izslºgts lidojuma profils un sàkts 
zvans uz avàrijas dienestu izsauk¹anas numuru.

Pla¹àku informàciju skatiet ¹ajà lietotàja rokasgràmatà vai 
jautàjiet pakalpojumu sniedzºjam.

Lai varºtu izmantot atsevi¹óus tïklus, ierïcº jàbþt pareizi 
ievietotai derïgai SIM kartei.

Zvanot àrkàrtas situàcijà, pºc iespºjas precïzàk sniedziet visu 
nepiecie¹amo informàciju. Jþsu mobilà ierïce negadïjumà 
vietà, iespºjams, ir vienïgais sakaru lïdzeklis. Nepàrtrauciet 
sarunu, pirms jums to neat¶auj.

Informàcija par sertifikàciju (SAR)

©Ï IERÏCE ATBILST STARPTAUTISKAJÀM RADIOVI¦ÑU 
IEDARBÏBAS PRASÏBÀM.

©ï mobilà ierïce ir radiosignàlu raidïtàjs un uztvºrºjs. Tà ir 
izstràdàta un ra¾ota tà, lai nepàrsniegtu radiofrekvenèu (RF) 
iedarbïbas ierobe¾ojumus, ko nosaka starptautiskàs prasïbas 
(ICNIRP). ©ie ierobe¾ojumi ir visaptvero¹u noràdïjumu 
sastàvda¶a un nosaka iedzïvotàjiem pie¶aujamos RF starojuma 
lïmeñus. Noràdïjumus ir izstràdàju¹as neatkarïgas zinàtniskas 
organizàcijas, veicot periodisku un vispusïgu zinàtnisko 
pºtïjumu novºrtºjumu. Noràdïjumi paredz ievºrojamu 
dro¹ïbas rezervi, lai garantºtu dro¹ïbu visàm personàm 
neatkarïgi no viñu vecuma un veselïbas stàvok¶a.

Nosakot mobilo ierïèu iedarbïbas lïmeni, tiek izmantota 
mºrvienïba, ko sauc par ïpa¹às absorbcijas koeficientu 
(Specific Absorption Rate — SAR). Starptautiskajos 
noràdïjumos noteiktais SAR limits ir 2 W/kg*. SAR testº¹anu 
veic, izmantojot standarta darba stàvok¶us un ierïcei raidot ar 

tàs augstàko apstiprinàto jaudu visàs pàrbaudïtajàs frekvenèu 
joslàs. Lai gan SAR nosaka augstàkajam apstiprinàtajam 
jaudas lïmenim, reàlais SAR lïmenis ierïces darbïbas laikà var 
bþt zemàks nekà maksimàli pie¶aujamais. Tas ir tàpºc, ka ierïce 
ir paredzºta darbam vairàkos jaudas lïmeños, lai izmantotu 
tikai tik daudz jaudas, cik nepiecie¹ams tïkla sasnieg¹anai. 
Tàtad, jo tuvàk mobilàs bàzes stacijai atrodaties, jo zemàka ir 
ierïces patºrºtà jauda.

©ïs ierïces augstàkà SAR vºrtïba, pàrbaudot to lieto¹anai pie 
auss, ir 0,53 W/kg.

©ï ierïce atbilst RF iedarbïbas prasïbàm, ja to lieto, turot pie 
auss vai vismaz 2,2 cm attàlumà no óermeña. Ja ierïces 
pàrnºsà¹anai izmanto somiñu, jostas turºtàju vai 
piestiprinàtàju, ¹ïm papildierïcºm nedrïkst bþt metàla da¶u un 
tàm jàtur izstràdàjums vismaz 2,2 cm attàlumà no óermeña.

Lai pàrsþtïtu datu failus vai ziñas, ierïcei nepiecie¹ams 
kvalitatïvs savienojums ar tïklu. Atsevi¹óos gadïjumos datu 
failu vai ziñu pàrsþtï¹ana tiek atlikta, lïdz ir pieejams 
atbilsto¹s savienojums. Nodro¹iniet, lai lïdz pàrsþtï¹anas 
beigàm tiktu ievºroti iepriek¹ minºtie noràdïjumi par ierïces 
attàlumu no óermeña.

* SAR ierobe¾ojums pla¹a patºriña mobilajàm ierïcºm ir vidºji 
2 vati uz kilogramu (W/kg), rºóinot vidºji uz desmit gramiem 
óermeña audu. Noràdïjumi paredz ievºrojamu dro¹ïbas rezervi, 
lai garantºtu papildu dro¹ïbu apkàrtºjiem un ñemtu vºrà 
iespºjamàs at¹óirïbas mºrïjumos. SAR vºrtïbas var at¹óirties 
atkarïbà no vietºjàm prasïbàm un tïkla frekvences. Citu 
re»ionu informàciju par SAR skatiet pie informàcijas par 
izstràdàjumiem Web lapà www.nokia.com.
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